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Chapter 1  Introduction

1 Introduction

Managing your practice just got easier
The DAISY Practice Management System provides the tools you need to help you
increase productivity, improve cash flow, and decrease the costs of running your
dental office.

DAISY Chart is the premier solution for dentists who want to enhance the clinical side
of their practice. This flexible, electronic periodontal and hard tissue charting
application provides the latest advances in electronic charting.

This book introduces you to DAISY and DAISY Chart and gets you up and running
quickly. It provides an overview of how the software works, suggests strategies to help
you get the most from using DAISY and DAISY Chart, and helps you evaluate
workflows in your office by suggesting various scenarios and solutions.

It shows you how to do the most common tasks, where to learn more about DAISY
and DAISY Chart, and how to get help when you need it.

Getting help
DAISY customer support is committed to helping you keep your office running
smoothly. If you run into a problem while using DAISY you have a variety of resources
available to help you find an answer:

l www.softwarefordentists.com has helpful tips, learning guides and frequently
asked questions (FAQs).

l Send e-mail to daisysupport@dmcdental.com, or in any DAISY window from the
Help menu, select Contact DMC and complete our contact form.

l Training is regularly available at our offices or can be scheduled on-site at your
convenience. If you prefer training at your office, we can send a trainer on-site or
do it by phone using remote access software.

l DAISY support can provide you with immediate assistance at (800) 368-6401
outside of Portland, or (503) 765-3471 locally. Wait for the welcome message and
make the appropriate selection.

l DAISY chat is available from the Help menu (Help > Chat with a DAISY
Representative).

What's New in DAISY 4.4 1



Chapter 1  Introduction

Features and benefits

Accounting features and benefits
DAISY is designed with a rich set of features to support patient and insurance billings.

Manage your treatment plans. DAISY can track the status of treatment and quickly
provide multiple-case presentations. It is fully integrated with your fee schedule and
the patient's insurance plan. You can print a professional-looking treatment plan for
your patient that includes insurance estimated portions and sequence of treatment.

Minimize paperwork and process claims and statements efficiently. DAISY
Statement Manager helps you organize and complete your month-end statement
process from a single window. Using an Internet connection, you can transfer your
claims and statements to DMC where we use electronic claim submission, high-speed
laser printers, and mail insertion equipment to send your claims and patient billing
statements. Your office maintains complete control over message content and the
frequency of statement mailings.

Improve the effectiveness and profitability of your practice. You can generate over
100 standard reports and customize them to fit your needs. For example, you can
track production and referrals, detail adjustments, list outstanding claims, and view
account aging and recall patterns.

Improve your production-to-collection ratio. DAISY’s extensive library of reports can
be easily customized to help you identify overdue accounts and outstanding claims.

Manage and audit access to your practice’s financials. You can selectively restrict
access to certain areas of DAISY. Built-in audit trails and other safeguards help
prevent fraud.

Scheduling features and benefits
DAISY helps you simplify scheduling and tracking of patient appointments.

Schedule and track appointments quickly. View your schedules on a daily, weekly, or
monthly basis. Quickly find a scheduled appointment for any patient or search for
available appointments by time, date, and provider. DAISY Organizer helps you
efficiently track all of your cancelled appointments, “short-call” appointments and
recalls.

Quickly assess account and appointment status. You can assess a patient’s account
status for pre-medication, financial arrangements, confirmations, and appointment
status. Using our Hands-free Recall capability, recall information is automatically
transferred into DAISY Recall Manager, which makes recall notifications easy to track
and reliable.

Questions? www.softwarefordentists.com 1.800.368.64012
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Set and track production goals. With DAISY Goal Tracker, you can set daily, weekly,
or monthly production goals for your office resources, then monitor how well you are
meeting those goals.

Recall features and benefits
DAISY Recall Manager helps you keep your schedule full.

No more handwritten recall cards. With Recall Manager, you generate a list of recall
cards, and then send the list to Dentists Management Corporation (DMC) via the
Internet. DMC prints the recall cards and mails them to your patients.

Easily create the recall list you want. You won’t have to look through a long list to
find the patients who need recall cards. Recall Manager enables you to filter out
patients by recall type, account provider, notification method, date range, and
whether they are scheduled.

Prevent duplicate mailings to the same address. With Recall Manager, you can sort
your recall list by account number, patient last name, home phone, or next recall
date. For example, you can sort your recall list of patients by phone number. If you
find that more than one patient lives at the same address, you can easily arrange to
have just one card sent.

Customize recall card messages. You can set up default messages that will appear on
each recall card, then customize them to fit your immediate needs.

DAISY Chart features and benefits
DAISY Chart can help you streamline the clinical side of your practice. DAISY provides
a full range of exam options from general exam information and performed services to
tooth-by-tooth diagnosis and prognosis.

Document patient visits quickly and efficiently. Daisy Chart works the way you work.
Structured periodontal exams, known as methods, follow an efficient, yet thorough
routine that fits your own exam workflows.

Record information your way. DAISY Chart gives you the flexibility to record
periodontal exams using your voice, the keyboard and mouse, or any combination of
the three. DAISY Chart responds to voice commands that are familiar to you, so you
don’t have to learn new terminology or concepts.

Promote consistent practices throughout the operatory. Hygienists and dental
assistants can be brought up to speed on the correct periodontal exam methods and
hard tissue charting techniques quickly and easily.

Produce consistent, comprehensive records for your patients. Because exams follow
carefully defined models, they are more complete, so you know you’re making more
informed patient treatment plans and recommendations.

Improve chart availability and minimize back office paperwork. Dental records are
instantly accessible by any authorized user through the office network. Full

What's New in DAISY 4.4 3



Chapter 1  Introduction

integration with the DAISY Practice Management System helps you reduce back office
paperwork.

Enhance communications with patients, dental professionals, and insurance
companies. Onscreen, you can show patients right in the operatory what’s going on
in their mouth. Immediate feedback helps patients make more informed decisions.
With minimal effort, you can produce high-quality, professional-looking documents
for dental professionals and insurance providers that communicate your
recommendations and share relevant information.

Capture and store essential treatment and exam information. DAISY Chart provides
a variety of templates you can use to create forms for entering routine clinical
information as part of the exam, such as clinical findings, daily progress notes, and
patient medical and dental history.

Make secure records an office standard. DAISY keeps an audit trail of changes that
are made to clinical information. When users change a patient’s clinical record, DAISY
prompts them for a reason. DAISY records who performed the action, when it
occurred, and the reason for the change. Audit trails are easy to access.

DAISY overview

DAISY practice management overview
DAISY is fully integrated so you can use information you entered in one window to
complete or simplify data entry in another. This integration is possible because all
information is stored in the same database.

During the workday in a small office setting, you’ll commonly move back and forth
between different DAISY windows. For example, you might set up a patient for recall
in the Patient window, schedule a recall appointment in the Schedule window, then
use DAISY’s Recall Manager to generate a recall reminder card for this patient. DAISY
is also well-suited to larger office settings where job responsibilities are more
specialized. For more information about using DAISY in different office settings, see
"Workflow suggestions" on page 21.

Here’s how you might use DAISY to perform common tasks in a typical day:

Set up appointments and monitor goals. In the Schedule window, you schedule
appointments and the procedures for each visit, reschedule appointments, print
patient-specific route slips, and check patients in and out. You can also monitor your
production goals. You can load in procedures from a treatment plan and apply them
to the patient’s appointment. And on check-out, these procedures automatically
move to unposted transactions.

Manage accounts, treatment plans, and claims. In DAISY, you can set up and modify
accounts, view account history, and enter charges, payments, and adjustments. You
also set up treatment plans and prepare pre-authorization claims. Treatment plan
procedures can also be pulled into unposted transactions.

Questions? www.softwarefordentists.com 1.800.368.64014
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Generate recall cards. You use DAISY’s Recall Manager to generate a list of patients
who need recall notification. You determine who already has appointments and who
needs to set one up, then specify appropriate recall cards for each group. These recall
cards are stored in your DAISY Outbox until you are ready to transmit them to DMC
for processing.

Balance and post transactions, and review claims. At the end of the day, you balance
and post your day’s transactions in DAISY, then run a report that shows you a
summary of your new claims. You can use this report to verify the claims that will be
created. You can also choose to have DAISY hold secondary insurance claims until
the primary has reported back.

Run daily reports and review schedules. Using DAISY, you can generate other helpful
daily reports that show aged accounts receivable, and a detailed or summary report of
the day’s transaction activities. Also, you can use DAISY to print out the next day’s

schedule for review.

Run a backup and transmit claims, statements, and recall cards. During daily
closing, DAISY generates the claims and statements you want to send to DMC for
processing and runs a backup of your DAISY database. These claims and statements,
along with any recall cards, are automatically transmitted to DMC each evening or
you can transmit them on demand.

Check for electronic claims status reports. As your first task the following morning,
you check your DAISY Central Inbox for electronic claims status reports from
yesterday’s processing.

DAISY Chart overview
DAISY Chart is fully integrated with other DAISY applications, so you can use
information entered in one window to complete or simplify data entry in another.
This integration is possible because all information is stored in the same database.

During the workday in a small office setting, you’ll commonly move back and forth
between different DAISY and DAISY Chart windows. For example, from the back office,
you might view today’s appointments in the Schedule window and check to see if the
next patient has checked in. When a patient arrives, you can open the patient’s chart
and review the patient’s prior exam, medical alerts and history, treatment plan,
account status, and other pertinent information.

Once the patient is in the operatory, you can update the patient’s medical history,
and attach digital X-rays to the chart. Using DAISY’s voice-recognition capability, you
won’t have to wait for someone to record probing depths. If you opt to record the

patient’s tooth status from the perio exam, that information automatically becomes
available in the hard tissue chart.

When you use DAISY Chart to perform a hard tissue exam, you can record the
conditions in a patient’s mouth, including existing restorations and hard tissue
pathologies, while you record the ADA procedure codes associated with the treatment
provided. You can also use hard tissue charting to set up treatment plans, and

prescribe medications.
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Because the chart is easy-to-read and readily available onscreen, you can immediately
share and compare the results of the current exam and prior exams with the patient.

Following the exam, you can enter your progress notes directly into the patient’s
record in DAISY Chart. When you check out the patient, completed procedures are
immediately transferred into the Transactions window for posting. By the time the
patient returns to the front desk to check out, the receptionist can be ready to
complete the financial arrangements, and schedule a recall appointment in the
Schedule window. Later, DAISY’s Recall Manager can generate a recall reminder for
this patient.

DAISY Chart is also well suited to larger office settings where job responsibilities are
more specialized. For more information about using DAISY in different office settings,
see "Workflow suggestions" on page 21.

What's New in DAISY 4.4

New features

Medical history

DAISY 4.4 gives you the flexibility to maintain patient medical history in your
practice.

CHOOSE HOW YOU OBTAIN MEDICAL HISTORY INFORMATION

With this latest release, you have a variety of ways to obtain medical history from
your patients:

l Print a medical history form. Print the form using the new Detail Form report and
have the patient complete it, then transcribe the information into the patient's
medical history form on your office computer. For more information, see "Print a
medical history form" on page 479.

l Provide the form on an electronic device. Hand the patient a tablet or other device
connected to your DAISY server via wireless access. The patient uses this device in
the office to fill out and submit medical history information. The information
automatically becomes part of the patient's record in DAISY.

l Give remote access to the form. Use DAISY Forms Anywhere to enable the patient
to securely access and complete the form online from any electronic device with
an Internet connection. Dental offices can choose to email an access link to the
patient. DAISY Forms Anywhere works on Apple, Android, Kindle, Microsoft
Windows, and any other device with Internet access. For more information, see
"Use DAISY Forms Anywhere" on page 485.

Questions? www.softwarefordentists.com 1.800.368.64016
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CREATE PERSONALIZED MEDICAL HISTORY FORMS

Use the patient's existing medical history form to bring forward the most recent
entries so the patient can update information that has changed. For more
information, see "Create a medical history form" on page 477.

EASILY ACCESS PATIENT MEDICAL HISTORY

Now you can assign a Medical History property to Detail templates. All forms created
from these templates (including those created prior to version 4.4) are also designated
as medical history forms.

What's New in DAISY 4.4 7
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This property enables you to:

l Click the new Medical History button ( ) to open the most recent Medical
History form (if available) or create a new medical history form. This button is
available in the Patient, Perio Exam, Chart, Appointment, Patient History,
Treatment Plan, Confirm Appointments, Follow Up Appointments, and
Appointment Notes Review windows. For more information, see "Create a medical
history form" on page 477.

o If the patient has no medical history, you see . Click this button to open the
Search For - Medical History template window and select a Detail template to
use for a new medical history form. Only Detail templates marked with the
Medical History property show in this search window. For more information,
see "Set up Detail template properties" on page 427.

o When one or more medical history forms are attached to the patient record
(including history entered prior to DAISY 4.4), you see a paper clip on the

button . Click this button to open the patient's most recent medical history
form.

l Filter for medical history forms in the Patient History window. For more
information, see "About patient history" on page 453.

l Click in a medical history form to open the Search For - Details window filtered
for the patient's other medical history forms created from the same template.

Enhancements and fixes

Clinical notes

l Clear a response in any field, including a text box, drop-down list, check box, radio
button group, or time and date selector. For more information, see "Clear a
response in a clinical note" on page 459.

l Use the Details button to access a patient's clinical notes from the Confirm
Appointments and Follow Up Appointments windows.

Note: This button is disabled if the patient's status is "New."

l Use the new Detail Form report when you want to display the practice's name and
contact information at the top of the first page of a clinical note or medical history
form. Access this report from the Reports menu in the Patient History window or
in a specific clinical note window. For more information, see "Print a Detail form"
on page 463.

l Receive the warning "You are changing an existing clinical note" in a dialog box
whenever you start to alter a reviewed clinical note.

Questions? www.softwarefordentists.com 1.800.368.64018
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Chart

l The Chart window now includes the provider name associated with the preferred
account. View it below the patient's name and to the right of the preferred account
number.

l The new layout of Patient Chart report uses less white space.

l In the Chart window, the patient photo is larger than in prior versions of DAISY.

Clinical Notes Manager

l The new Review Clinical Notes link in the DAISY Central window opens a pre-
filtered Clinical Notes Manager window containing a list of clinical notes (and
archived documents marked as clinical notes) that apply to the current user and
whose status is "Ready for Review."

l The Clinical Notes Manager icon on the DAISY toolbar now displays with an

exclamation mark when the current user has clinical notes or archived
documents marked as clinical notes with a status of "Ready for Review."

l In the Clinical Notes Manager window, use the new Received option in the Review
Status filter to view Received items, such as medical history forms that have been
submitted by patients via DAISY Forms Anywhere. Once the office opens these
forms, the status changes to In Progress. For more information, see "Review a list
of clinical notes" on page 467.

DAISY InCharge

l If a financial arrangement uses an auto-pay profile, then a change to the Payment
Due Day field in the Account window takes effect right after you save it.

Detail templates

l Clear responses in any type of data object. For more information, see "Clear a
response in a data object" on page 448.

l Preserve tab positions in a template. Drag the tab to its new location then save the
template. For more information, see "Reorder tabs in a Detail template" on page
441.

l Add an electronic signature line, including date and time (MM/DD/YYY HH:MM
AM/PM), to the template. Unsigned electronic forms created from this template
do not display the date and time. Once submitted, this field cannot be edited. For
more information, see "Use the Editing toolbar" on page 422.

l Change the maximum length of Short Text Edit Boxes. For more information, see
"Modify data object properties" on page 430.

l When you show or hide the label for a radio button group, DAISY automatically
resizes the group to use the minimum amount of space in the template. For more

What's New in DAISY 4.4 9
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information, see "Modify the label of a data object" on page 443 and "Use the
Editing toolbar" on page 422.

l Designate which Detail templates may be used to create a Medical History form.
For more information, see "Set up Detail template properties" on page 427.

l Copy one or more tabs from a Detail template to another Detail template. For
more information, see "Copy a tab sheet from another Detail template" on page
442.

l Designate individual objects, such as text boxes, drop-down lists, radio buttons,
check boxes, and lines, as "For Office Use Only." Objects with this designation do
not display in DAISY Forms Anywhere or when you print the clinical note using the
Detail Form report. For more information, see "Modify data object properties" on
page 430.

l Select multiple objects. Once selected, they can be:

o Moved

o Deleted

o Have their labels hidden or displayed

o Resized to the same height or width

o Evenly spaced horizontally or vertically

o Aligned left, right, top, or bottom. Selected objects are aligned to the object
you right-click.

o Designated as "For Office Use Only." Objects with this designation do not
display when you view the form in DAISY Forms Anywhere or when you print
the clinical note using the Detail Form report. For more information, see
"Modify data object properties" on page 430.

For more information, see "Select multiple objects in a Detail template" on page
438.

l If a patient has access to a clinical note and you try to delete the Detail template
on which the clinical note is based, DAISY will open a dialog box that says,
"Warning, deleting this template will revoke patient access to xxxxx clinical notes
named xxxx. Are you sure you want to delete this Detail template?" Click OK in the
dialog box to revoke patient access to those clinical notes and delete the template.
For more information about patient access, see "Use DAISY Forms Anywhere" on
page 485.

l When you rename a Detail template, DAISY now opens a dialog box that says,
"There are x clinical notes named xxxx. Do you want to rename them to xxxxx?"
Click Yes to rename the existing clinical notes. If someone is remotely accessing a
clinical note derived from the template, DAISY will not rename it.

Questions? www.softwarefordentists.com 1.800.368.640110
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Electronic prescribing

l View patient-reported medications entered in DAISY eRx in the Medications tab
rather than the Prescriptions tab in the Patient window in DAISY. They also show
as medications in the Appointment Detail report, the Appointment Route Slip, and
the Current Medications report.

l When you use Rx Builder in DAISY eRx to enter a reported medication:

o The medication displays in the Medications tab in the Patient window in
DAISY.

o The Appointment Detail report lists it as a medication.

o The Activity Log does not display the reported medication.

l When a drug allergy has been expired in DAISY eRx, DAISY automatically removes
the medical alert from the Medical Alerts tab in the Patient window.

l DAISY eRx is part of DAISY EHR, which is a Drummond Certified electronic health
record (EHR). Clients who use a certified EHR program may quality for federal
incentive dollars. For more information, contact your DAISY representative.

List and procedure maintenance

l Add user defined tags that are always unique. DAISY now issues the warning "The
entry or code already exists in the system. Please enter a unique value." and
prevents your creating a duplicate.

l In the Procedure Maintenance window:

o The position marker automatically defaults to D0120 in the procedure code list
when the window first opens.

o When you click between the Fees and UCR tabs, the position marker retains its
position from the prior tab.

o When you click between fee schedules, the position marker retains its position
from the prior fee schedule.

Operating system and SQL database

l DAISY 4.4 is compatible with Microsoft Windows Server 2012, Windows 8 Pro, and
Windows 8.1 and uses Sybase 16.

l The Sybase 16 license upgrade installs automatically with DAISY 4.4 and may take
up to 20 minutes to complete. The installation uses Microsoft Windows Automatic
Updates for both the server and application versions of DAISY.

l Sybase 16 fixes the Open SSL Heartbleed security issue.

What's New in DAISY 4.4 11
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Patient history

l In the Patient History window , double-click a medical alert entry to view all of
the patient's medical alerts.

l Under Display Options in the Patient History window:

o Use the Medical History check box to control whether the patient's medical
history forms display in the window.

o The Medical Info button under Display Options selects the appropriate check
boxes for viewing all medical history forms, prescriptions, reported
medications, and medical alerts for the patient.

o Use the Clinical Notes check box to display clinical notes only. This display
option no longer displays medical history entries.

For more information about the Patient History window, see "About patient history"
on page 453.

Patient recall

l In the Recall tab in the Patient window, choose from a broader recall period: 0 to
99 months.

Reports

l Use the new Detail Form report to print clinical notes and Detail templates as
formatted. For more information, see "Print a Detail form" on page 463.

o For clinical notes, access this report from the Reports menu in the clinical note

and from the print button in the Patient History and the Appointment Notes
Review windows.

o For Detail templates, access this report from the Reports menu in the Detail

template and the print button in the specific Detail template window.

o Print all tabs or a specific tab.

o If the clinical note or Detail template has multiple tabs, the information on
each tab prints on a separate page.

o Form fields, such as text boxes, drop-down lists, radio buttons, check boxes,
and lines, that are designated as "For Office Use Only" do not print on this
report.

l Gain new access to the Clinical Note List report from the Reports menu in the
Clinical Notes Manager window.

l In the Appointment List report, view the date and status of the patient's last
medical history form (e.g., Last Medical History: 01/26/15 Ready for Review).

l In Appointment Route Slip reports with multiple pages, view the patient name on

Questions? www.softwarefordentists.com 1.800.368.640112
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the header of each page.

l In the Appointment Route Slip report, view the next recall due, regardless of type.

Scheduling

l On the Quick Access toolbar in the Schedule window, DAISY grays out the new

Details and Medical History buttons until you select an appointment.

l In the Confirm Appointments window, view the patient's DAISY Forms Anywhere
subscription status.

l In the Procedures tab in the Appointment window, view treatment plan procedures
in the same order as in the Treatment Plan window.

l In the Detail tab in the Appointment window, view the number of cancelled
appointments associated with the patient. To calculate this number, DAISY uses
the patient's cancelled appointments in the Cancellations folder in the Organizer.

o The number of cancellations displays as a red link (e.g., 1 Cancellation) below
the patient's name.

o Click the link to open the cancelled appointment, or if there is more than one
cancellation, you can select from a list of the patient's cancelled appointments.

o If you choose to use the cancelled appointment to make a new appointment,
close but do not save the blank appointment window you originally opened.

o The appointment opens with the original date and with a status of Cancelled.
To reschedule the appointment, assign it a new date and time. DAISY then
prompts you to save the appointment and to change the status to Scheduled.

For more information about the cancellations link, see "Reschedule a cancelled
appointment" on page 107.

Third-party integration

l Dexis and TigerView bridges are now compatible with Microsoft Windows 8.

User settings

l In the User window, use the new permission setting "Allow inactivate
Patient/Account?" to enable users to inactivate patients and accounts. Inactivating
hides the patient or account but does not delete the information from the
database. DAISY assigns this permission to all new users by default. For more
information, see "Manage user accounts" on page 507.
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2 Helpful strategies
The DAISY Practice Management System and DAISY Chart are designed to fit naturally
into your dental practice. DAISY and DAISY Chart are used in a variety of practices

with different workflows and requirements. Here are some strategies to help you
effectively integrate DAISY and DAISY Chart into your practice.

Simplify scheduling and maximize productivity
DAISY helps you schedule and track patient appointments, and optimize how your
resources are used.

Q. Do you have trouble keeping track of your cancelled and “short-call”
appointments?

Using DAISY’s Organizer, you can drag-and-drop these appointments off your
schedule into special folders so you can quickly find and reschedule them as needed.
You can include notes with these appointments, such as “She prefers a morning
appointment. If we get a cancellation, call her.”

Q. Do you frequently enter the same procedures for common appointments like
adult cleanings and new patient visits?

Using DAISY, you can create templates that include procedures for the most common
types of appointments. You can bundle a group of procedures under a custom name,
then simply type that one name to insert all those procedures.

Q. Do your special scheduling needs require you to use more than one appointment
book?

You can set up multiple schedules. For example, you can set up your schedules by
practice locations. Within a schedule, your resources can be set up by provider, by
operatory, or both.

Q. Do you set productivity goals and want to see how those goals are being met?

When procedures are entered on all appointments, DAISY’s Goal Tracker takes the fee
total of all the procedures and graphically displays how well you are meeting your
production goals.

Minimize the time you spend on correspondence
DAISY’s Recall Manager, Mail Merge, and Statement Manager help you stay on top of
recall, referral letters, statements and other types of correspondence to patients and
providers.
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Q. Do you find that you’re always behind on recall?

Doing recall manually takes a lot of time. You may have to handwrite the entire card,
or make and attach labels. With Recall Manager you can generate a list of recall cards
in about 10 minutes, transmit the information to DMC, and let us mail the cards to
your patients.

Q. Does correspondence take more time than you like?

Using DAISY’s Mail Merge, you can easily generate standard letters that go between
yourself, patients, and other providers. You can include balances, names, and other
important information in these letters. Click once to print and it’s done.

Q. Would you like to spend less time preparing your month-end statements?

Statement Manager helps you quickly and easily complete your month-end
statements. From a single DAISY window, you can specify which accounts should
receive statements, track which accounts have been reviewed, and preview individual
account statements for accuracy.

Control how practice information is entered and
accessed
DAISY enables you to customize what you see on the screen and to control who has
access to practice information.

Q. Do you want to enter and view practice information in a way that suits your
needs?

DAISY enables you to rearrange and customize how you search for data, enter
transactions, and view ledger and claim history information. These settings are unique
for each user and are automatically saved so you have them the next time you log in.

Q. Do you want to control the level of access your staff has to critical practice
information?

Using DAISY’s security settings, you can selectively assign access based on the user’s
login. Permissions can be fine-tuned to fit each person’s job requirements.

Increase chart availability
Because DAISY Chart is fully integrated with DAISY’s front office capabilities,
complete patient information is instantly accessible by any authorized user through
the office network.

Q. Do you spend time searching for charts when you would rather be completing
tasks?
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You and your staff don’t have to compete for access to appointment schedules, perio
and hard tissue examinations, progress notes, digital X-rays, or treatment plans. You
can pull up the most current chart information from any office computer.

Q. Are you often waiting for others to finish with a chart so you can make use of
the information?

Because records are centrally stored in a single database and are easily accessible,
data recorded in the operatory during the patient visit is immediately available to you
and your staff. For example, DAISY automatically transfers performed procedures into
the patient’s account for posting, and adds the next recall date to the patient’s
record.

Q. Are patient X-rays and intraoral images often unavailable or difficult to access?

DAISY is flexible, so you can choose the imaging software that is most appropriate for
your practice. Simply click on the camera icon on the Quick Access toolbar to launch
your imaging software application and import the patient’s X-rays and intraoral
images.

Increase office efficiency
With DAISY Chart, you can fully integrate your operatory capabilities with your front
office functions so workload can be more distributed, and back office paperwork is
eliminated or minimized.

Q. Are your front office staff overwhelmed with daily tasks, such as scheduling, and
entering charges and treatment plans?

Daisy helps you distribute tasks to clinical personnel without sacrificing financial
control. Dental assistants and hygienists can use DAISY to schedule or reschedule
appointments right from the operatory. They can also call patients who are late,
check when someone is due back, view clinical notes and images, and monitor lab
cases. They can determine a patient’s account status for pre-medication,
confirmation, and appointment status at a glance right from the schedule.

Q. Do you enter treatment plan information from a paper form?

Q. DAISY’s electronic charting eliminates the need to pass information via route
slips, hand-written treatment plans, and treatment notes from the back office to the
front office. You can enter treatment plan information during the exam, and then
the front office can immediately access that information to make financial
arrangements and set up future appointments with the patient.

Q. Do you often have to wait for someone to record periodontal probing?

With DAISY’s online voice-activated charting, the hygienist can perform hands-free
periodontal evaluations, regardless of computer proficiency. DAISY Chart responds to
voice commands that are familiar to you so you don’t have to learn new terminology
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or concepts. And voice-activated, hands-free data collection lets you focus on what
the patient is learning during a periodontal exam without losing critical information.

Improve patient communication
Because exam information is easy to read and instantly available, you can show
patients what is going on in their mouth right in the operatory. Patients get
immediate feedback so they can make more informed decisions.

Q. Do you need better tools to help patients understand your explanations about
their current dental health and treatment options?

DAISY Chart’s periodontal and hard tissue reports help you show patients right in the
operatory what treatments were performed, what needs to be done, and the overall
condition of their mouth. The Perio Exam Full View shows the patient’s periodontal
health in a graphic format right on the screen. Display options in the hard tissue chart
control what information displays (such as planned treatment, completed treatment,
conditions, and restorations) in the Chart window and when the chart is printed.

You also have quick access to third-party patient education software and digital
imaging applications from the DAISY windows you access most often, such as the
Chart, Perio Exam, Schedule, and Patient windows.

Q. Are patients having trouble remembering their treatment options and dental
health status once they leave the office?

Easy-to-print reports make it possible for patients to take information with them. For
example, the Perio Exam Comparison chart compares existing perio exam results in a
graphic format. You can explain it in the operatory and then send it home with the
patient. Patients can also take the report with them to a specialist.

Minimize the time you spend on clinical records

Q. DAISY Chart provides a variety of templates that you can use to create forms for
entering routine clinical information, such as clinical findings, daily progress notes,
hygiene progress notes, and patient medical history. These templates reduce the
need to type the same items and descriptions in your chart notes.

Some templates are designed to bring previously entered information forward, such as
a patient’s medical history, so you can note the changes since the patient's last visit.

Q. Do you consistently write the same progress notes for specific procedures?

DAISY’s Details templates let you select typical responses from pre-defined lists to
help you record information quickly and accurately. You can also create “canned” text
and apply it to your SOAP, 6X, and PARQ notes.

Q. Do you spend time searching through paper charts for all of the entries on a
particular tooth?
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DAISY’s Clinical Notes window makes it easy for you to filter by individual tooth, time
period/date range, and provider.

Create effective, professional-looking reports
With minimal effort, you can produce high-quality, professional-looking documents
that communicate your recommendations and share relevant information with
patients, insurance providers, or other dental professionals. You can also print
professional-looking treatment plans for your patients that include insurance
estimates and sequence of treatment.

Q. Are your hand-written clinical records or photocopies of patient records difficult
to read?

No more trying to produce good photocopies of hand-written chart notes. DAISY
Chart provides a variety of reports and online views that you can use to present exam
results. You can print a chart at any point, either while you’re creating it or after you
have finished.

From the Perio Exam window, you can open the Perio Exam Full View, which shows
exam results in a single view, to show to the patient onscreen. The Perio Exam
Comparison Chart lets you compare results from up to seven existing exams in a
graphic format. The Periodontal Graphic Chart provides information that is similar to
the Perio Exam Full View, but in a different layout. All of these reports can be printed.

From the Chart window, you can select which hard tissue exam results you want to
display, such as planned treatment, completed treatment, conditions, and existing
restorations, and then show them onscreen or print a hard copy.

Control how clinical information is entered and
accessed
DAISY enables you to customize what you see on the screen and to control who has
access to practice information.

Q. Do you want to enter and view clinical information in a way that suits your
needs?

DAISY Chart lets you rearrange and customize how you view clinical procedures that
have been performed.

At the bottom of the Chart window, you can easily rearrange the columns in the list of
clinical procedures. In the Clinical Notes window, you can filter a patient’s clinical
history by the dates of service, tooth number, procedure code and description, and
performing provider, and click on the column headings to sort the results. You can
also select the types of information that you want to display, such as prescriptions,
existing and planned treatment, conditions, medical alerts, and referrals. These
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settings are unique for each user and are automatically saved so you have them the
next time you log in.

You can also customize the color settings for the tooth graphic chart in the Chart
window. However, changes to these settings affect all users.

Q. Do you want to control and track your staff’s access to clinical information?

Using DAISY’s security settings, you can selectively assign access based on the user’s
login. Permissions can be fine-tuned to fit each person’s job requirements.

When changes are made to daily progress notes and other routine clinical
information, such as clinical findings or a patient’s medical or dental history, DAISY
tracks the revisions for auditing purposes. Users must also enter a reason for each
revision.
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3 Workflow suggestions
DAISY and DAISY Chart are used in a variety of practices with different workflows and
requirements. Here are some suggestions:

Process patient visits quickly
Because DAISY’s accounting, scheduling and recall capabilities are designed to work
together, you can process patient visits faster than you would with paper-based
systems.

Sheryl Perkins, the receptionist for Dr. Michael Evans, uses DAISY to set up
appointments and enter procedures. When she sets up an appointment, patient and
account status information can be viewed automatically so she can determine at a
glance if the patient has any pre-medication, has recall, or requires financial
arrangements.

When patients arrive, she uses DAISY to check them in. When she checks out a patient
and schedules the next cleaning, DAISY automatically transfers the procedures into
the patient’s account for posting, and updates Recall Manager with the next recall
date. With a paper system, she spent about two hours posting at the end of each day.
With DAISY, she posts as she goes so posting takes only 20 minutes per day.

Fully utilize your treatment plans
In a typical paper system, you might enter treatment plan procedures into the patient
chart, onto an insurance pre-authorization form, and into the appointment. After the
patient’s appointment, you might type the procedures again for posting. With DAISY,
you only have to enter these procedures once.

Karen Pham prepares pre-authorizations for Dr. Andrew Nguyen’s dental practice. Dr.
Nguyen and his clinical staff enter the patient treatment plan into DAISY Chart
during the patient exam. Karen can immediately review the treatment plan
procedures and fees, then submit a pre-authorization claim to Dentists Management
Corporation (DMC) for electronic claims processing. The treatment plan can be pulled
into the patient’s appointment detail and then into the Charges window for posting.
Since she also entered insurance plan benefit information into DAISY, the patient’s
portion after insurance is auto-estimated.
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Access patient information throughout the office
If you have a computer network in your office, you and your office staff won’t have to
compete for access to schedules and patient charts. For example, one person can
process insurance claims, while another sets up appointments and does check-in and
check-out. Still others can perform perio and hard tissue exams or handle recall
notices. Changes to patient records are immediately available to any authorized user.

Southwest Dental Clinic is a large practice with three receptionists, five dentists, and
12 dental assistants and hygienists. The receptionists log in to DAISY first thing in the
morning. Throughout the day, they use DAISY to check patients in and out. They also
use it to post transactions, manage claims, print financial reports and supporting
documentation for insurance claims, and generate walkout statements.

The dental assistants and hygienists use DAISY to schedule their appointments, call
patients who are late, and check when someone is due back. Using DAISY Chart, they
record a patient’s dental and medical history, perform perio exams, attach digital x-
rays to the chart, and monitor lab cases. The dentists use DAISY Chart to perform
hard tissue exams and complete progress notes online.

Effectively manage your accounts receivable
DAISY can help you control the financial side of your practice. You can create
customized payment and adjustment types to make tracking easier. You can view
snapshots of an account’s status, filter the content that displays in the account
ledger, and generate reports that are tailored to show you exactly what you need to
monitor your accounts. You can correct transactions without losing your audit trail
and generate customized patient billings anytime you need them or at month-end.

Monica Gonzales, the office manager for Eastside Family Dental, customized the way
she enters payments, adjustments, and charges in DAISY. Because of this customized
entry, she is able to generate reports that extract pertinent financial information when
she needs it. She uses this information to work her accounts receivable using DAISY's
account ledger and claims history windows.

From the results, she rebills insurance, generates interim account billings, and uses
DAISY’s Mail Merge to generate letters to delinquent accounts. Later, she evaluates her
work by printing customized follow-up reports. Monica also uses DAISY’s Statement
Manager to efficiently manage her month-end routine—all from a single DAISY
window.
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Process entire patient visits electronically
Because DAISY Chart is fully integrated with DAISY’s financial and scheduling
applications, as well as most digital imaging systems, you can process the entire
patient visit electronically, so it’s faster and more accurate than paper-based systems.

Patty Sheraton, the receptionist, uses DAISY to check in Earl Huffman for a
comprehensive exam. Sharon Sufka, the hygienist, sees he is checked in, so she escorts
him to the operatory where she opens his chart in DAISY Chart. First she takes digital
x-rays, which she electronically attaches to his chart. Finally, she performs a perio
exam using DAISY Chart’s voice recognition capability.

Following the perio exam, Dr. Phillips opens the hard tissue chart and reviews Earl’s
digital x-rays. He completes a hard tissue exam, then shows the patient his findings
onscreen. Dr. Phillips gives Earl a report to take home so he can talk over the
treatment plan with his wife.

Following the exam, Sharon and Dr. Phillips enter their progress notes directly into
the patient’s chart in DAISY. Sharon then checks out the patient. DAISY automatically
transfers the procedures into the patient’s account for posting, and updates the
patient record with the next recall date. The receptionist reviews the treatment plan,
schedules follow-up appointments, then completes the financial arrangements.

Create accurate treatment plans
DAISY eliminates miscommunication and speeds patient checkout through direct
entry of the treatment plan as part of the exam.

Dr. Elizabeth Cooper at Eastside Family Dental has a new patient, Rajiv Singh.
Because he is a new patient, she performs a comprehensive exam to identify treatment
needs while her assistant records exam and treatment plan information directly into
the patient’s chart on the computer in the operatory.

Once the assistant saves the exam, she checks out the patient. At the front desk,
Monica Tilden sees that the patient is checked out so she prints the treatment plan.
When Rajiv comes to the front desk, Monica already has the treatment plan
presentation ready.
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Promote consistent practices and clinical record
keeping
DAISY Chart makes it easy to promote consistent practices throughout the operatory
and ensure that records are kept up-to-date.

Dr. Sylvia Abrahms and her dental assistant Tanya view and update clinical records in
DAISY Chart when they communicate with a pharmacy, a patient calls to report a
problem following a procedure, or the office makes a post-operative call. They open
the Patient window and go directly to the Clinical Notes window to view the patient’s
notes.

At the end of the day, Dr. Abrahms checks that clinical notes were written for every
patient who had an appointment. She opens the DAISY schedule, selects an
appointment, then goes directly to the Clinical Notes window. From there, she reviews
the patient notes.

Questions? www.softwarefordentists.com 1.800.368.640124

http://www.softwarefordentists.com/


4 DAISY basics

Log in to DAISY
Before you can use DAISY, you need to log in using your username and password.

► To log in to DAISY:

1. From the Windows Start menu select Programs, select DAISY, then select DAISY.

2. Type your username and password.

3. Click Log in to DAISY.
DAISY may take a moment to open. You see the DAISY Central window.

The DAISY Central window provides a convenient summary of the most common
types of information you want to know at the start of your day.

l Recent Items lists the most recently accessed items in DAISY, such as a patient
record, an account, the ledger, or an insurance company. Double-click the item to
return to the appropriate window.

l Today’s Appointments lists the day’s scheduled appointments. It shows the
patient’s name, the start time, appointment type and description, the amount of
time assigned, and the status, as well as whether the appointment was confirmed.
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Double-click the appointment to open the appointment detail window.

l Inbox lists electronic claims status reports, DAISY’s Business Matters newsletter,
and other files. Double-click the report or newsletter to view it.

l Aging Summary lists total receivables by provider, as well as the practice. It shows
totals for the current receivables, the receivables last billed, and by aging status

(30, 60, 90 and 120 days).

Note: When you log in, only buttons that open modules you are permitted to access are
activated on the DAISY toolbar.

Tip: You can choose which categories of information you want to display in the DAISY
Central window. From the View Menu, select one or more categories to display. A check
mark indicates that the item is selected.

Use the DAISY toolbar
The DAISY toolbar is located near the top of all major DAISY windows and it can be
customized to fit your particular needs. However, when DAISY is first installed on
your system, the DAISY toolbar contains the following default set of buttons.
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Use this
button...

To do this...

Manage appointments and create appointment
templates.

Store individual patient information, such as recall
status, medical alerts, referrals, and prescriptions.

Generate a quick estimate for a patient without
creating a treatment plan or sending a pre-
authorization request to the patient’s insurance
company.

Manage charges, payments, and adjustments.

Set up new accounts, and add patients or insurance to
an existing account. Store account information, such as
the responsible party, financials, and guarantor’s
address.

View account history.

Manage insurance company information.

View detailed claim information.

Generate reports for your practice.

Open a patient’s dental chart to record and display
hard tissue measurements, and summarize and print
findings.

Open a patient’s dental chart to record and display
periodontal measurements, and summarize and print
findings.
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Use this
button...

To do this...

Use the Patient Account Wizard as an alternative way
to set up new accounts, and add patients or insurance
to an existing account.

Generate the day’s claims and QuickStatements to
send to DMC for processing. Run backups of your
DAISY database.

Generate a list of recall cards that DAISY can print and
mail to patients.

Confirm an appointment. View related information
such as account status and resources assigned to the
appointment, as well as indicate if and how an
appointment was confirmed.

View the Data Exchange Inbox to ensure that the
claims and statements sent to DAISY the previous day
were received.

Log off the current user and log in as a different user.
Logging in as a different user does not close DAISY. To
close DAISY, click the Exit button.

Log off the current user and exit all DAISY windows.

Change the Daisy toolbar
You can modify the DAISY toolbar to fit the way you work. You can choose:

l Which buttons appear on the toolbar

l Whether to show explanatory captions below the buttons

l Button order

l Button size

The DAISY toolbar can be changed from most DAISY windows.
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► To change the toolbar from the DAISY Central window:

1. From the DAISY menu, select Configure DAISY Toolbar.

2. Make the appropriate changes, then click OK.

Use the Quick Access toolbar
The Quick Access toolbar provides shortcuts to related tasks that you want to
perform. Icons that include red arrows link directly to a related window. For example,

clicking the Chart icon in the Patient window opens a chart for the selected
patient Dirk Abrahms.

Use the Search window in DAISY
Before you can view or modify information about a patient, account, or insurance
record, you have to search for it. DAISY automatically opens a Search window
whenever you click the Patient, Account, or Insurance buttons on the DAISY toolbar.
You can also search from within many DAISY windows.

Tip: Search window filters can help you narrow your search to a specific group.

From a Search window, you can quickly locate specific information in your DAISY
database, such as:

l Any person in the system

l Accounts, patients, providers, insurance companies, and employers

l Prescriptions, procedure codes, procedure fees, cities (used in addresses), and
other information stored in DAISY

Search windows are tailored to reflect the kind of information you are seeking. In the
following example, the Search window for finding patients has selections in the Search
By drop-down list such as Patient, Patient SSN, Patient DOB, or Home Phone No.
column headings also relate to patient information.
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► To do a search:

1. Open a Search window from the DAISY toolbar or within an application window.
For example, from the DAISY toolbar, click Patient.

2. In the Search By drop-down list, select the type of information to search by.
For example, you can search by patient, birth date, or Social Security number.

3. If present, choose either the Begins With or the Contains option.
For example, if you want to find a patient whose name begins with Mac, choose
Begins With. In the next text box, you’ll type Mac.

4. In the next text box, type the information you want to match.
In this example, you would type Mac.

5. Click .
Search results display in the lower half of the window.

Note: To always search automatically without having to click , check the Auto
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Search check box in the Search window.

6. Select the result you want, then click OK.

Tip: Search window filters can help you narrow your search to a specific group.

Tip: Occasionally a dialog window may get hidden behind a main DAISY window. If
DAISY does not seem to be responding, press ALT-TAB to bring the dialog box to the
front.

Use the Search window in DAISY Chart
Before you can view or modify information about a patient, chart, or clinical note,
you have to search for it. DAISY automatically opens a Search window whenever you
click the Patient, Chart, Perio Exam, or Clinical Notes button on the DAISY toolbar.
You can also search from within many DAISY windows.

From a Search window, you can quickly locate specific information in your DAISY
database, such as:

l Any person in the system

l Patients, and providers

l Prescriptions, procedure codes, procedure fees

Search windows are tailored to reflect the kind of information you are seeking. In the
following example, the Search window for finding patients has selections to search by
in the drop-down list such as Patient, Patient SSN, Patient DOB, or Home Phone No.
column headings also relate to patient information.
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► To do a search:

1. Open a Search window from the DAISY toolbar or within an application window.
For example, from the DAISY toolbar, click Patient.

2. In the drop-down list, select the type of information to search by.
For example, you can search by patient, birth date, or Social Security number.

3. If present, choose either the Begins With or the Contains option.
For example, if you want to find a patient whose name begins with Mac, choose
Begins With. In the next text box, you’ll type Mac.

4. In the next text box, type the information you want to match.
In this example, you would type Mac.

5. Click .
Search results display in the lower half of the window.

Note: To always search automatically without having to click , check the Auto
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Search check box in the Search window.

6. Select the result you want, then click OK.

Tip: Occasionally a dialog window may get hidden behind a main DAISY window. If
DAISY does not seem to be responding, press ALT-TAB to bring the dialog box to the front

Rearrange table columns
You can rearrange the order of columns in any DAISY window that contains a table,
such as the Claim History window.

► To rearrange table columns:

1. In the window, click the column heading you want to move and keep the mouse
button depressed.
You see a thick dark gray line (the cursor) running down the start of the column
you want to move.

2. Keep the mouse button depressed and drag the cursor until is just to the left of the
column that will follow the one you are moving, then release the mouse button.
Note: DAISY retains this new column order until you decide to change it.

Lock a DAISY session
l You can lock your DAISY session to prevent unauthorized access when you leave

your computer.
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l If the DAISY session is locked, the computer can still to be used for other Windows
applications.

l To unlock the DAISY session, you must enter the user account password
associated with the session.

l DAISY windows that are minimized on the Windows task bar cannot be viewed
until the session is unlocked.

l For easy access, a “Lock DAISY” button can be added to the DAISY toolbar.

► To lock a DAISY session:

1. From the File menu, select Lock DAISY.

2. In the Warning dialog box, click Yes.

You see the Unlock version of the Log In to DAISY window.
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► To add a Lock DAISY button to the DAISY toolbar:

1. From the DAISY menu, select Configure DAISY Toolbar.

2. Check the Lock DAISY check box, then click OK.

The Lock DAISY button is added to the toolbar.
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Unlock a DAISY session

► To unlock a DAISY session:

1. In the Password text box, type the password of the user account that is locked.

Note: DAISY automatically fills in the username of the account that is locked.

2. Click Log In to DAISY.
The session returns to where you left off.

Questions? www.softwarefordentists.com 1.800.368.640136

http://www.softwarefordentists.com/


5 Manage accounts

Set up a new account

To set up a new account, you need to complete the following steps in this
order:

1. Create an account and set up a guarantor.

2. Assign a provider and a fee schedule to the account.

3. Select account options, then save the account.

4. Optionally, you can also:
a. Add second guarantor.
b. Add insurance coverages.
c. Addmore patients.

Account terminology
Guarantor. The person who is financially responsible for an account.

Subscriber. The person who carries the insurance.

Patient. The person who receives treatment.

Create an account
When you open a new account, you have to assign at least one guarantor. The
guarantor is the person who is financially responsible for the account. You can have
up to two guarantors on an account.
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► To open an account and set up a guarantor:

1. From the DAISY toolbar, click .

2. In the Search For – Account window:
l To avoid creating a duplicate account, search for an existing one. If you find

one, you don’t need to create a new account.
l If you’re sure no account exists for this person, click New Account.

3. In the Search For – Guarantor for the New Account window, do one of the
following:
l Search for and select the guarantor, then click OK.
l If you’re sure this person is not in the system, click New Guarantor for the New

Account.

4. In the Personal Info window, complete this person’s information.
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5. Click , then close the Personal Info window.
Note: When you create an account, DAISY automatically adds the guarantor as a
patient on the account. If the guarantor is not also a patient, you must first add
another patient to the account, then remove the guarantor as a patient. For more
information, see "Add a patient" on page 42.
Tip: You can also use the Patient Account Wizard to set up accounts. To run the

Wizard, click on the DAISY toolbar.
Tip: Guarantor information can be modified after the account is set up.
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6. In the Account window, click the General tab.

DAISY automatically assigns a default provider and fee schedule for this account.

7. To change the provider, select a provider from the Provider drop-down list.

8. To change the Fee Schedule, select a fee schedule from the Fee Schedule drop-
down list.

9. Select from the following Account Options:
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Use this Account
Option...

To do this...

Send Statement When checked, sends the account’s
guarantor(s) an account statement.

Finance Charges When checked, the account will
incur fees on outstanding balances
when you run monthly processing.

Collection Messages When checked, adds collection
messages to the account statement.

Print Stmt Estimates When checked, the account’s
statement will print the estimated
patient and insurance portions that
are due.

Collection Account Indicates the account is in
collection. When checked, the
account does not receive
statements.

Medicaid Account Indicates that account charges are
billed to Medicaid. When checked,
the account does not receive
statements.

Ortho Account Indicates the account is reserved for
patients who receive orthodontic
charges. When checked, an Ortho
tab gets added to the Account
window.

Request Quick Statement When checked, a QuickStatement for
this account will be generated during
the next Daily Closing and no
monthly statement will be
generated.

This option disables automatically
after the next Daily Closing runs.

The option is grayed out if the
account has a zero balance and if the
Send Statement option is not
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Use this Account
Option...

To do this...

checked in the Account screen.

Statement Reviewed Indicates that the account has been
reviewed for accuracy. This option
gets checked automatically when the
Reviewed check box for the account
is checked in Statement Manager.

10. Click to save the information.

Tip: Account Options can be modified after the account is set up. From the DAISY
toolbar, click Account. Search for and select the account. Click the General tab and
change account options. Guarantor information can also be modified after the account is
set up.

Add a patient
If the guarantor is the only patient on this account, skip to "Set up insurance
coverage" on page 45.

► To add a patient:

1. In the Account window, click the Patients tab, then click in the Patients
section.
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2. In the Search For – Patient window, do one of the following:
l Search for and select the person you want, then click OK.
l If this patient is not in the system, click New Patient.

DAISY opens the Personal Info window on top of the Patient window.

3. In the Personal Info window, complete this person’s information.
Note: A yellow text box indicates that the information is required.
Important: If the contact information for this patient doesn’t match the guarantor’s
contact information, DAISY will open the Update Family Addresses window so you
can also change the contact information for people related to that person.

4. Click , then close the Personal Info window.
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The Patient window remains open. You can now add detailed information about
the patient.

5. In the Patient window, optionally enter more information about this patient.

Use this tab... To do this...

General Specify the patient’s marital status,
student status, emergency
information, and special notes about
the patient.

Referral Info Track how this patient found your
practice. Track to whom you referred
this patient.

Recall Specify the way you want to notify
this patient about recall (phone,
card, label, none) and the type of
recall (prophy, perio, etc.) you want
to track.

Prescriptions Record prescriptions your office gave
to this patient.

Insurance Coverage View details about this patient's
insurance coverage.

Reminders/Tags Use the Reminders section when you
need to follow up on a patient.

Use the User Defined Tags section to
identify individual patients or groups
of patients. For example, set up a
“short notice” tag.

Medical Alert Record important medical status
information about the patient. If a
patient has a medical alert, a red
cross symbol is displayed in the
Patient window and on the
appointment in the Schedule.

6. Click , then close the Patient window.
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Tip: To make changes to a patient’s demographic information, from the DAISY toolbar,
click Patient. Search for and select the patient, then click OK to open the Patient

window. Click in the Patient section to open the Personal Info window.

Set up insurance coverage
Since patients are sometimes covered under more than one plan, or different patients
on an account are covered by different plans, you need to add each plan to the
account. When you add insurance coverage to an account, you:

l Specify the subscriber of the plan

l Select an existing plan or add a new plan

l Assign patient relationships to the subscriber

Note: Each time you set up insurance coverage on an account, always check for an
existing plan first to avoid creating a duplicate plan in your database.

► To set up insurance coverage:

1. Open the appropriate account.

2. In the Insurance Coverage section, click .
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3. In the Search For – Subscriber window, do one of the following:
l Search for and select the subscriber, then click OK.
l If this subscriber is not in the system, click New Subscriber.

4. In the Personal Info window, complete this person’s information.

5. Click , then close the Personal Info window.

6. In the Enter the Coverage Subscriber ID dialog window, type the subscriber ID
number, then click OK.
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Note: To help ensure that electronic claims process reliably, the words “none” or
“unknown” can no longer be entered in the Subscriber ID text box. The Subscriber ID
must now contain:
l At least two characters
l Valid characters only: 0-9, a-z, A-Z, #, space, . (dot), and - (dash)

The Subscriber ID (assigned by the insurance company) can be entered in the
Insurance Coverage window or when adding insurance coverage from the Account
window. The Subscriber ID can also be viewed in Patient and Account windows.

7. In the Search For – Insurance Plan window, do one of the following:
l Search for and select the insurance plan, then click OK.
l Click New Insurance Plan and add the new plan to the system.

8. From the Pri drop-down list in the Assign Patient Coverage window, select the new
patient's primary insurance coverage.

9. From the Relationship drop-down list, select the patient's relationship to the
subscriber.

10. If there is secondary coverage, from the Sec drop-down list, select the person’s
secondary insurance, then select the patient’s relationship to the subscriber.

11. Click OK.

12. For each additional insurance plan on an account, repeat steps 2 through 11.

13. Click , then close the Account window.
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Verify mailing addresses
In the Personal Info window, you can verify mailing addresses using information from
the U.S. Postal Service (USPS). Verifying mailing addresses helps to maximize
collections and ensure that electronic claims process reliably.

► To verify a mailing address:

1. From the DAISY toolbar, click .

2. Search for and select the appropriate person, then click OK to open the Personal
Info window.

3. To the right of the Street text box, click Not Verified.
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4. Do one of the following:
l If the address matches the information in the USPS database, you see that the

address verified and the verification date. Close the window.
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l If the address cannot be verified, you see a warning. Click OK and close the
window.

Note: A correct zip code is not enough to verify an address. The street address, city, state,
and zip code must all be correct in the Personal Info window.

Work with existing accounts

Use reminders

Add an account reminder

Users can add, edit, or delete account reminders from a new Reminders tab in the
Account window. Each reminder is limited to 60 characters, including spaces.
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► To add a reminder to an account:

1. From the DAISY toolbar, click .

2. Search for and select the account, then click OK.

3. In the Account window, click the Reminders tab.

4. In the Reminders section, click .

5. In the Reminder column, do one of the following:
l Type a reminder for this account.

What's New in DAISY 4.4 51



Chapter 5  Manage accounts

l Click and select canned text for the reminder.

6. Click , then close the window.

Once the account reminder is added, the reminder pops up whenever you open:

l An account-related window for the account, such as the Account or Ledger
window.

l A patient-related window, such as Treatment Plan, for the account’s guarantor or
any patient on the account. 

In the following example, Rhonda Vineyard’s account has a reminder. Her account
includes her husband, John Vineyard. When John’s patient window is opened, both
his patient reminder and Rhonda’s account reminder show in his Reminder pop-up
window.

In the Reminder pop-up window, patient reminders are listed first. If the patient or
account has more than one reminder, the reminders are listed in date order.
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Delete an Account Reminder

► To delete a reminder for an account:

1. From the DAISY toolbar, click .

2. Search for and select the account, then click OK.

3. In the Account window, click the Reminders tab.

4. In the Reminders section, select the reminder to delete, then click .

5. In the Confirm dialog box, click Yes.

Delete a duplicate name from the Persons list

Alissa Roberts, the office manager for Dr. Michael Evans, initially set up a patient,
Susan Jones, in DAISY without her insurance information when she called to make an
initial appointment. Later, when Susan came in for her appointment, Alissa added
Susan’s insurance information, but forgot to search for Susan in the DAISY database
when she set her up as the subscriber. Now Alissa has two Susan Jones listed as persons
in DAISY. She wants to delete one of them.
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To delete a duplicate name, you need to complete the following steps in this
order:

1. Make each duplicate name distinct from the others to help you determine which of
them are used in the Account and Patient windows.

2. Open the account and check all areas where the name (or one of its variations)
appears. You’ll be able to distinguish the names now.

3. Choose the name variation you’d like to use throughout the account and replace all
others with the correct one.

4. Change the guarantor and the subscriber to match the patient name so that open
claims or treatment plans attached to the patient name are preserved.

5. Change the remaining name back to the original designation.

6. Delete the other variations.

Note: To avoid having a duplicate name problem, always search for the name before you
try to add it to DAISY.

Important: When you change information in the Person window, only update the
required fields that are specific to that person.

Use caution when you change a first name, because an error could result in inadvertent
changes to other information stored in DAISY.

Make each duplicate name distinct

The easiest way to make a name distinct is to add an initial to the first name (no
spaces). For example, if you’ve got two persons named Susan Jones, change the first
Susan Jones to SusanA Jones to distinguish it from the second one, SusanB Jones.
Make all duplicates different from each other.

Note: In the Persons window, be sure you modify the first name rather than adding an
initial in the Middle Name field. For example, SusanA Jones, rather than Susan A Jones.

About the Persons list

Each person, whether a subscriber, guarantor or patient, is stored in the Persons list.

Removing a person from an account does not remove that person from the Persons
list. All information about the person remains available in DAISY, so if you need to
add the person to an account again, you simply search for and select the person.
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Deleting a person from the Persons list makes that information permanently
unavailable. If you need to add the person to an account later on, you’ll have to
completely re-enter all of the person’s information into DAISY.

► To make each duplicate name distinct:

1. From the DAISY menu, select Configure, then Persons.

2. Search for and select one of the duplicate names, then click OK.
The Personal Info window opens.

3. Change the name to make it distinct.
For example, change Susan Jones to SusanA Jones.

4. In the Confirm dialog box, click Yes.

5. Click to save the change.

6. For each additional duplicate name, do the following:

a. Click to open the Search for - Person window.
b. Repeat steps 2 through 4.

7. Close the Personal Info window.

Select the appropriate name for the account

Open the account. Check all of the areas that may contain the name (in one or more
of its variations), then replace the guarantor and subscriber names to match the
patient name on the account.

► To select the appropriate name:

1. From the DAISY toolbar, click .

2. Search for and select the account, then click OK.
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3. Check the Guarantor, Patient and Subscriber sections to see which of the name
variations are used.
For example, SusanA Jones is the patient and guarantor. SusanB Jones is the
subscriber.

4. Replace the guarantor and the subscriber names to match the patient name.
a. To replace the guarantor name:

i. Right-click near the guarantor’s name and choose Select Guarantor on
Account.

ii. Select the same name variation as the one used for the patient name and
click OK.

b. To replace the subscriber name:
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i. In the Insurance Coverage section, click .
ii. Select the Subscriber tab.
iii. Right-click and choose Select Subscriber for Coverage.
iv. Select the same name variation as the one used for the patient name, and

click OK.

Rename the duplicate name to its original designation

Next you need to rename the duplicate name that you chose to keep to its original
designation. For example, if you kept SusanA Jones, change the name back to Susan
Jones.

► To change the name back to its original designation:

1. From the DAISY menu, select Configure, then Persons.

2. Search for and select the duplicate name you want to keep, then click OK.
The Personal Info window opens.

3. Change the name back to its original designation.
For example, Susan Jones.

4. In the Confirm dialog box, click Yes.

5. Click to save the change.
All the names in the account are the same.
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6. Close the Personal Info window.

Delete the remaining duplicate names

Finally, delete all of the other name variations that you chose not to use. For
example, SusanB Jones.

► To delete the remaining duplicate names:

1. From the DAISY menu, select Configure, then Persons.

2. Search for and select the name, then click OK.
The Personal Info window opens.

3. From the File menu, select Delete, then select Person.

4. In the Confirm dialog box, click Yes to delete the person.
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Note: If you see a dialog box that states the person cannot be deleted, followed by a
list of reasons, you must correct the problem(s) before you can delete the person.

5. For each additional duplicate name, do the following:
a. From the File menu, select Open Another Person.
b. Repeat steps 2 through 4.

6. Click Yes to confirm the change, then click OK.
All duplicate names should now be deleted.

Change the subscriber or guarantor

Change the guarantor on an account

The guarantor receives the statement and is financially responsible for the account.
Sometimes you may need to change an account’s designated guarantor. For example,
when adding an account, you might accidentally make the child, rather than the
parent, the guarantor.

Note: Never change the guarantor by editing the guarantor’s information in the Personal
Info window. This changes the identity of the patient on the account, and is equivalent to
crossing a person’s name off a paper chart and writing someone else’s name in its place.

► To change the guarantor on an account:

1. From the DAISY toolbar, click .

2. Search for and select the account you want, then click OK.

3. In the Account window, right-click and choose Select Guarantor on Account.

4. In the Search For - Guarantor window, do one of the following:
l Search for and select the new guarantor, and then click OK.
l If the guarantor is not in the system, click the New Guarantor button. In the

Personal Info window, complete the required information for the person.
Note: A yellow text box indicates the information is required.

5. Click and then close the Personal Info window.
The person you selected or added becomes the guarantor for that account.

6. Click and then close the Account window.
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Change the subscriber on an account

The subscriber, who may or may not be a patient, is the person who carries the
insurance.

► To change the subscriber to a different person:

1. From the DAISY menu, select Insurance, then Coverage.

2. Search by subscriber, then select the subscriber you want and click OK.

3. In the Coverage window, click the Subscriber tab.

4. Right-click and choose Select Subscriber for Coverage.

5. In the Search For - Subscriber window, do one of the following:
l Search for and select the new subscriber, and then click OK.
l If the subscriber is a person not currently listed in your DAISY database, click

the New Subscriber button.
DAISY opens the Personal Info window on top of the Coverage window.

6. In the Personal Info window, update or complete any required information for the
subscriber.
Note: A yellow text box indicates that the information is required.

7. Click to save the change, and then close the Personal Info window. The
Coverage window now lists the new subscriber.
The Confirm window opens.

8. To reset the subscriber ID, click Yes.

9. In the Select the Account for Coverage window, select the account.
The Assign Patient Coverage window opens.

10. From the Relationship drop-down list, select the patient’s relationship to the
subscriber, then click OK.

11. In the Coverage window, type the Subscriber ID.

12. Click to save and then close the Coverage window.

Note: To change patient relationships on insurance, see "Change patient relationships
on insurance coverage" on page 68.

Move an existing patient to a new account
Use this procedure to create a new account for a patient who is already assigned to
another account, such as when a child is no longer covered on the parent’s account,
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or when parents divorce and their child’s charges become the responsibility of a
different parent.

l The new account retains the same default provider, fee schedule, and account
options as the original account.

l Initially, this patient will be assigned as the guarantor. If the patient should not be
the guarantor, that assignment can be changed after another patient is added to
the account.

l If insurance is assigned to the patient on the original account, that information
will transfer to the new account.

► To move an existing patient to a new account:

1. From the DAISY toolbar, click .

2. Search for and select the patient’s name, then click OK.

3. In the Patient window, right-click and select New Account for Patient.
You see the Please Select Patient(s) to Add to New Account window.

4. Select the patient and click OK.

5. In the Personal Info window, update the required information for the patient.
Note: A yellow text box indicates that the information is required.

6. Click and then close the Personal Info window.
In the Account window, the new account information displays. The selected
patient is automatically assigned as the guarantor on this new account. If the
patient is not actually the guarantor, you can change this information after
another patient is added.

7. To modify the new account, do the following:
l Change account options, such as the account provider. Click the General tab

and select a provider from the Provider drop-down list.
l Change the fee schedule. Click the General tab and select a fee schedule from

the Fee Schedule drop-down list.
l Assign a different guarantor. Right-click near the guarantor’s name and choose

Select Guarantor on Account. Search for and select the guarantor you want,

What's New in DAISY 4.4 61



Chapter 5  Manage accounts

then click OK.

l Update the insurance coverage. In the Insurance Coverage section, click .
Search for and select the subscriber, then click OK. In the Personal Info
window, make appropriate changes, then close the Personal Info window.

8. Click and then close the Account window.

9. Open the original account and remove the patient.
Note: The deleted patient’s account history remains in the ledger of the original
account.

Set up a financial arrangement
When a patient needs to pay for dental services in installments, you can set up a
Financial Arrangement worksheet in the Account window to help you determine
payment information.

Note: Financial arrangement defaults for the practice are set up in the Financial Info tab
of the Practice window.

► To set up a financial arrangement:

1. From the DAISY toolbar, click .

2. Search for and select an account, then click OK.

3. Click the Financial Arrangement tab.

4. If there is an existing financial arrangement, click the Remove button.

5. Click the New button.

6. In the Enter the Amount Owed text box, type in the total amount owed.
This is the gross amount before deducting the down payment.
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7. In the Enter the Down Payment text box, type in the down payment, if any.
In the Summary section, you see that the amount financed is calculated for you; it
equals the Amount Owed minus the Down Payment. You can calculate the
payment two ways:
l By the amount the patient wants to pay monthly
l By the number of payments a patient wants to make

8. Under Select How to Calculate the Payment, do one of the following:
l To calculate a payment by the amount the patient wants to pay monthly,

choose Monthly Payment. Type in the monthly payment amount. Click the
Calculate button, then click Yes to save the arrangement.

l To calculate the payment by the number of payments a patient wants to make,
choose Number of Payments. In the text box, type in a number of monthly
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payments. Click the Calculate button, then click Yes to save the arrangement.
If you are assessing interest, the default interest rate or rebill fee will be displayed
in the Summary section.

9. In the First Payment Due Date and Payment Due Day text boxes (if you don’t
want to use the default dates), type in changes.

Note: The monthly payment calculation or the number of payments does not assess
interest or a rebill fee for the grace period specified in Practice Settings.

Tip: If you want to charge principal only (no interest), click the General tab in the
Account window and uncheck Finance Charges. Then recalculate the financial
arrangement.

About account statements

When an account’s financial arrangement includes automatic payments, the
account’s statements and statement previews include:

l “Auto-Pay” next to the payment type, such as ACH, Visa, or MasterCard

l The sentence “Financial arrangement payment will be automatically billed on next
due date,” and the amount of the payment

Tip: If the final payment is less than the regular monthly payment, then the statement
will show the correct payment amount.

Use the Financial Arrangement Summary report

You can filter the Financial Arrangement Summary report (R2113) for all payments,
payments made with auto-pay or payments made without auto-pay.
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Note: For more information on auto-Pay, see "Set up an auto-pay financial
arrangement " on page 187 .

In the Account window, you run the report from the Reports menu.

On the report you see the following information for accounts with financial
arrangements that have auto-pay:

l Last Payment Date

l Next Payment Date

l Last Transaction Status

l Overdue

► To run the Financial Arrangement Summary report:

1. From the DAISY toolbar, click .

2. From the Reports menu, select Financial Arrangement Summary, then select one
of the following:
l All to include all financial arrangements.
l With Auto-Pay to include only auto-pay financial arrangements.
l Without Auto-Pay to exclude auto-pay financial arrangements.
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3. In the Print Options window, click Print to print the report.

Note: You can also filter and run the report from the Report Gallery.

► To run the Financial Summary Report from the Report Gallery:

1. From the DAISY toolbar, click .

2. Double-click the Financial Arrangements folder.

3. Right-click the Fin. Arr. Summary report and select Properties.

4. Click Reset to remove any filtering from the last time you ran the report.

5. Click the Auto-Pay tab.
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6. Choose the filters you want to apply.
In the following example, the filters are set to show all auto-pay payments.

7. Click OK.

8. In the Financial Arrangements window, double-click the Fin. Arr. Summary report.
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Change patient relationships on insurance coverage

► To change patient relationships on insurance coverage:

1. From the DAISY menu, select Insurance, then Ins. Coverage.

2. Search for and select the subscriber you want and click OK.

3. In the Coverage window, click the Patients tab.
You see a list of all patients on this account who are under this coverage.

4. In the Patients section, right-click and select Reassign Patient Coverages.

5. From the Relation drop-down list, select the patient’s new relationship to the
subscriber.

6. Click OK.

7. Click , then close the Assign Patient Coverage window.
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Change the subscriber’s identification number
Because of HIPAA requirements, many insurance plans no longer use Social Security
Numbers as identification numbers, so you may need to change some subscriber
identification numbers in DAISY.

► To change the subscriber’s identification number:

1. From the DAISY menu, select Insurance, then Ins. Coverage.

2. Search for and select the subscriber you want and click OK.

3. Click the Subscriber tab.

4. In the Subscriber ID text box, type the subscriber’s new ID number.

Note: Use only alphanumeric characters in subscriber identification numbers. Other
characters, such as hyphens, slashes, and periods, may cause claims to be rejected or
delayed.

5. Click , then close the window.
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View account aging by provider
Account aging is split out by provider, so you can see how much of the balance is
outstanding for each provider.

► To view account aging by provider:

1. From the DAISY toolbar, click .

2. Click the Financial Info tab.

Use the Account Aging w/Provider Detail report

The Account Aging w/Provider Detail report lets you generate an aging report for a
provider or a group of providers. This report is available from the Account folder in
the Report Gallery, and from the Reports menu in the Ledger, Transactions, and
Statement Manager.
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Report filters allow you to refine the report by account provider, performing provider,
and account balance.

► To view the Account Aging w/Provider Detail report:

1. From the DAISY toolbar, click to open the Report Gallery.

2. Double-click on the Account folder.

3. Double-click on Account Aging w/Provider Detail.

In this example, the report is filtered to show account aging for the provider Richard
M. Smith.

Inactivate and Reactivate Accounts and Patients
Inactive accounts and patients can be deactivated so they do not clutter up reports
and searches with irrelevant information. When an account or patient is inactivated,
it remains in the DAISY database as an inactive record and can be easily accessed at
anytime. All account and patient history remains attached to the inactive account or
patient record.

Accounts and patients can also be quickly reactivated, keeping all account and
patient history intact.

l When an account is inactivated, all patients associated with that account are
inactivated as well unless they are associated with another active account.

l If an account has multiple patients, specific patients can be inactivated.

l If a patient on the account has an appointment scheduled, DAISY warns that the
appointment will be deleted before the account is inactivated.

l Offices can continue to send statements for inactivated accounts that have
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balances.

l Inactivated accounts continue to show up in the Accounts Receivable report and
in Statement Manager as long as they have a balance.

l Patients that are inactivated do not appear in Recall Manager, even if the recall is
still attached to the patient.

l Recall and treatment plan reports are automatically filtered to exclude patients
and accounts that are inactivated. However, using the Inactive tab in the Property
Editor, report filters can be set to include inactive accounts or patients.

l DAISY users who have the “Allow deleting/removing Info?” permission can
inactivate and reactivate accounts and patients.

l Deactivation and reactivation activities are logged in the DAISY Activity Log report
(Report Gallery > System Lists > Activity Log). Log information includes when the
activity occurred and who made the change.

Note: Patient and account records can still be deleted.

Inactivate an account

l When you inactivate an account, all patients associated with the account are
inactivated as well unless they are associated with another active account.

l If a patient on the account has appointments scheduled, DAISY warns you that the
appointments will be deleted before the account is inactivated.

l You can inactivate accounts with balances and continue to send statements for
those accounts.

Note: You may want to remove the patient’s insurance coverage before you inactivate an
account.

► To inactivate an account:

1. From the DAISY toolbar, click .

2. Search for and select the account you want to inactivate, then click OK.

3. In the Account window, check the Inactive check box, then click .
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If no patients on the account have appointments, then the account is inactivated.
If any patient on the account has appointments scheduled, DAISY warns you that
the appointments will be deleted before the account is inactivated.

4. Do one of the following:
l Click OK to delete the appointments and inactivate the account.
l Click Cancel to keep the appointments scheduled and the account active.

DAISY grays out the guarantor information (except the e-mail address) and all patient
information, and makes the Inactive check box name red.
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Reactivate an account

l When you reactivate an account, all patients on the account are reactivated.

l All account history and history associated with patients on the account remains
intact.

► To reactivate an account:

1. From the DAISY toolbar, click .

2. In the Search For – Account window, check the Show Inactive check box.

3. Search for the account you want to reactivate.
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Inactive accounts are grayed out.

4. Select the account, then click OK.

5. In the Account window, uncheck the Inactive check box.

6. Click .
All patients on the account are reactivated and all history associated with the
account is still attached to both the account and patients.
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Inactivate a patient

l If a patient has appointments scheduled, DAISY warns you that the appointments
will be deleted before the patient is inactivated.

l When you inactivate a patient, DAISY grays out the patient’s information in the
Account window.

► To inactivate a patient:

1. From the DAISY toolbar, click .

2. Search for and select the patient you want to inactivate, then click OK.

3. In the Patient window, check the Inactive check box, then click .

If the patient has no appointments, then the patient is inactivated. If a patient has
appointments scheduled, DAISY warns you that the appointments will be deleted
before the account is inactivated.

4. Do one of the following:
l Click OK to delete the appointments and inactivate the patient.
l Click Cancel to keep the appointments scheduled and the patient active.
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DAISY grays out the patient information (except the e-mail address) and makes the
Inactive check box name red.

Reactivate a patient

When you reactivate a patient, all history previously associated with the patient
becomes available again.

► To reactivate a patient:

1. From the DAISY toolbar, click .

2. In the Search For –Patient window, check the Show Inactive check box.

3. Search for the patient you want to reactivate.
Inactive patients are grayed out.
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4. Select the patient, then click OK.

5. In the Patient window, uncheck the Inactive check box.

6. Click .
All history associated with the patient is now viewable.

Troubleshooting accounts
Q. How can I get back to the last account I viewed without searching again?

Not only can you reopen the last account without browsing, you can reopen an
account from a list of the last ten accounts you viewed. In the Account window, do
the following:

l From the File menu, select Reopen, then select the account you want to reopen.

l In the DAISY Central window, under Accounts in the Recent Items tree, double-
click the account.

l In the Search For - Account window, click Recent.

Q. How do I indicate in DAISY that an account has been turned over to collections?
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To indicate an account is in collections, open the Account. Click the General tab. In
the Account Options section, check the Collection Account check box.

This action prevents the account from being assessed a finance charge and turns off
statements for the account.
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6 Manage patient information

Add a patient reminder
Users can add, edit, or delete patient reminders from the Reminders/Tags tab in the
Patient window. Each reminder is limited to 60 characters, including spaces.

► To add a reminder for a patient:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Patient window, click the Reminders/Tags tab.

4. In the Reminders section, click .
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5. In the Date column, type a different date, if needed.

6. Press Tab to move to the Reminder column.

7. Do one of the following:
l Type a reminder for this patient.

l Click the Reminder column, click , select a reminder from the list, then
click OK.

8. Click , then close the window.

Once the patient reminder is added, the reminder pops up whenever you open a
patient-related window for the patient, such as the treatment plan.

Note: Patient reminders are included in the Patient Profile report.

Delete a patient reminder

► To delete a reminder for a patient:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Patient window, click the Reminders/Tags tab.
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4. In the Reminders section, select the reminder to delete, then click .

5. In the Confirm dialog box, click Yes.

Set up automatic reminders for a patient
Whenever you set up an appointment for a patient or you access a patient’s
information, you can set up the patient to receive automatic reminders. A patient can
be set up to use the practice’s default reminder scheme, or you can select a personal
reminder scheme for the patient.

Note: To use Autoremind, first set up the practice’s AutoRemind settings.

Once a patient is set up for automatic reminders, any appointment you set up for the
patient is automatically assigned that patient’s default reminder scheme.

Set up the practice’s default reminder scheme for a patient

► To use the practice’s reminder scheme for a patient:

1. From the DAISY toolbar, click .

2. Search for and select the patient you want, then click OK.

3. In the Patient window, click to edit the patient’s personal information.
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4. In the Reminder Scheme section, check the Use AutoRemind check box to use the
practice’s default reminder scheme for this patient.
Note: For more information about setting up the default reminder scheme for the
practice, see "Manage reminder schemes" on page 574 .

5. Click and close the Personal Info window.
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Set up a personal reminder scheme for a patient

► To set up a personal reminder scheme for a patient:

1. From the DAISY toolbar, click .

2. Search for and select the patient you want, then click OK.

3. In the Patient window, click to edit the patient’s personal information.

4. To enable AutoRemind for this patient, check the Use AutoRemind check box.

5. In the Reminder Scheme section, uncheck the Use Practice Default check box.

6. In the Personal Scheme drop-down list, select the reminder scheme to use for this
patient.
Note: If the selected Personal Scheme requires information that is not available in the
patient’s Personal Info, such as Basic E-mail for someone who does not have an e-mail
address, you see a warning icon next to the Personal Scheme drop-down list.

7. Click and close the Personal Info window.

Note: Because DAISY is integrated with AutoRemind, changes in the Personal Info
window, such as phone number or e-mail address, upload automatically to the
AutoRemind service.
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7 Manage appointments
You can use DAISY to manage all of your scheduling needs. The Schedule window can
display a schedule in four modes: by day, week, month, or as a list of all
appointments. In addition, day mode has two types of views: the Master View, which
shows appointments for all resources, and individual views for each resource.

On the far right is the Organizer, where you can organize and store appointment
information. You can use the Organizer to:

l Store cancelled appointments

l Store “short call” requests for people who want an appointment but couldn’t get in
when they called. You can easily find them if someone else cancels

l Drag appointments you want to delete into the schedule’s recycle bin

l Create and store templates, which are generic appointments that contain all the
information required to set up an appointment except the patient's name

Tip: You can also use DAISY to schedule your staff meetings.
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Tip: If the Organizer is not open in the Schedule window, select Organizer from the View
menu to open it.

Work with schedules

Open a Schedule
During installation, your schedule resources get set up by provider, by operatory, or
both. Some practices need to have more than one schedule. For example, a practice
might have more than one office location. With DAISY, you can set up as many
schedules as you need and simply select the one you want to view. You can have
more than one schedule open at a time.

► To open a schedule:

1. From the DAISY toolbar, click .

2. Search for and select a schedule, then click OK.
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The resource bar on the left side of the Schedule window helps you schedule
resources more efficiently. For example, you might want to stagger appointments.

Each resource has its own column and is represented by a unique color. The number
in the colored box indicates that this resource is booked during this time slot and by
how much. For example, a 1 in the colored box means the resource is single-booked.

Use the Quick Access toolbar

You can use the Quick Access toolbar to move through the schedule.
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Use this
button...

To do this...

View today/this week/this month

View the prior day/week/month

View the next day/week/month

Fast forward button

Rewind button

Change the Schedule mode

You can view the selected Schedule by day, week, month, or as a list of all
appointments.

► To change the schedule mode from the Schedule window:

1. From the View menu, select one of the following:
l Day for a daily view.
l Week for a weekly view.
l Month for a monthly view.
l List to view a list of all appointments.

Change the Schedule view

In Day mode only, the Schedule window contains two types of views: the Master
View, which shows appointments for all resources, and individual schedule views for
each resource.
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► To change the Schedule view, do one of the following in the Schedule
window:

l To view all resources in the schedule, click the Master View tab.

l To view a single resource, click the resource’s individual tab.

Change the date you are viewing

Depending on the Schedule mode, you can move through the Schedule day by day,
week by week, or month by month. In addition, toolbar buttons can move you to
special points in the Schedule, such as the date of the last scheduled appointment.

► To change the date you are viewing, do one of the following:

l In the upper left corner of the Schedule window, select the date in the date text
box, type the new date, then press Tab.

l Click the arrow to the right of the date text box to open the pop-up calendar.
o Click the left and right arrows to scroll by month and year.
o To select a specific day, click on the calendar day.

Use the Quick Access toolbar in the Schedule window
The Quick Access toolbar in the Schedule window makes it easy to navigate through
the schedule.
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l

Use the Fast Forward button

Use the Fast Forward button to advance through the schedule in any the following
intervals: one week, two weeks, one month, three months, four months, six months,
and one year.

► To use the Fast Forward button:

1. Click on the arrow to the right of the Fast Forward button and select the
“jump” interval from the drop-down list.
The “jump” interval is how much you want to advance through the schedule each
time you click the Fast Forward button. The selected interval displays to the right
of the button.  For example, 6M means the selected interval is 6 months.

2. Click to advance by the selected “jump” interval through the Schedule.
DAISY retains the selected “jump” interval until you change it.
Note: If you close and reopen the Schedule, DAISY remembers the last “jump” interval
you selected.

The Fast Forward button is also available in the Search for Best Fit window.
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You can use the Fast Forward button in the Search for Best Fit window to select how
far ahead to start searching for an opening when you create an appointment from an
appointment template. For example, to find the best fit for a prophy appointment,
you could set the Fast Forward button’s “jump” interval to “6 Mo” to start the search
six months from the current date.

► To use the “jump” interval to start the search for an appointment opening:

1. Open the Organizer in the Schedule window.

2. Right-click on the template and select Schedule Like… to open the Search for Best
Fit window.

3. In the Search for Best Fit window, click the arrow to the right of the Fast Forward
button and select the appropriate jump interval from the drop-down list.
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The date in the Begin On text box moves forward by the selected interval.

4. To move the date forward by the selected interval again, click .

Use the Rewind button

Use the Rewind button to reverse your progression through the Schedule since
you last opened it. For example, if you moved through the Schedule from May 1st to
June 3rd to July 14th, you could “rewind” from July 14th to June 3rd to May 1st.

Note: Once the Schedule closes, the Rewind button resets.

Set up an appointment
DAISY gives you a variety of ways to set up an appointment for a patient. If you find
yourself scheduling appointments in a hurry, DAISY enables you to add an
appointment with just the minimum of information. Later you can go back and fill in
additional details.
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► To set up an appointment:

1. From the DAISY toolbar, click .

2. Click the Master View tab.

3. Scroll down and double-click the starting time slot for the appointment.
The Appointment window opens.

4. In the Description text box, type the appointment description.

5. In the Detail tab, do one of the following:
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l In the Patient text box, type in a new patient name.

l Next to the Patient text box, click to search for an established patient.
Select the patient, then click OK.
You see the patient's information.

6. Do one of the following:
l Enter the patient’s primary contact phone number and other contact

information.
l For a new patient, go to step 7.

7. Click the Priority text box and select a priority.
Select Standard for most appointments. You can also select ASAP if a patient wants
to come in sooner if something opens up, or Emergency if a patient needs an
appointment right away.
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8. Click and close the Appointment window.
The appointment is added to the schedule.
Tip: If the patient has cancelled appointments, you can click the red Cancellation link
to either open the cancelled appointment or to select from a list of the patient's
cancelled appointments. For more information, see "Reschedule a cancelled
appointment" on page 107.

Add AutoRemind to a specific appointment
A specific appointment can be set up to use AutoRemind.

l If the patient is not set up to use AutoRemind, DAISY applies the practice’s default
reminder scheme to the appointment. For more information, see "Manage
reminder schemes" on page 574.

l If the Use AutoRemind check box is checked in the Patient’s Personal Info
window, then all appointments created for the patient will automatically use that
patient’s reminder scheme. For more information, see "Set up automatic
reminders for a patient" on page 83.

► To add AutoRemind to a specific appointment:

1. From the DAISY toolbar, click to open the appropriate schedule.

2. In the Schedule window, double-click the appointment to open it.

3. In the Confirmation section, check the Use AutoRemind – scheme name check
box.
Scheme name is the name of reminder scheme associated with this patient.
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4. Click and close the Appointment window.

Note: AutoRemind can also be added to a specific appointment from the Confirm
Appointments window.

Find the best fit appointment
DAISY helps you find the best fit appointment for a patient. The Schedule window
must be open.

Martin Aguila, an established patient, is on the phone and wants to come in for an
appointment as soon as possible. You don’t have any immediate openings, so he
agrees to have you find the best appointment for now and asks you to call him if
something better opens up.

Tip: A scheme is a saved selection of search filters. You can define schemes for the
common searches you make for best fit appointments. When you select a scheme in the
Best Fit window, DAISY automatically chooses the correct search choices for the particular
type of appointment you want to find. The scheme can specify the appointment duration,
as well as patient and resource availability requirements.
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► To find the best appointment:

1. From the DAISY toolbar, click .

2. If the Schedule is in Day mode, click the Master View tab.

3. On the Quick Access toolbar, click .

4. In the Begin On text box, select a schedule starting date.

5. In the Duration text box, select the appointment duration.

6. In the Patient Availability section, do the following:
a. Check the check box next to each day the patient is available.
b. Select the range of times the patient is available.

7. In the Resource Availability section, do the following:
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a. Check which of the resource schedules to search.
b. Choose which of those checked resources must be available for the

appointment.
For example, if all of the checked resources must be available, choose All. If
only one needs to be available, choose Any One.

8. Click Find First.

9. If you don’t like any of the choices, click Find Next.

10. Repeat step 9 until you find a suitable date.

11. In the search results text box, double-click the day you want.

12. Double-click Morning or Afternoon.

13. Click the time you want.
The Schedule window navigates to the time you just selected, so you can inspect
the Schedule before adding the appointment.

14. Click OK.
Note: If you’ve chosen a new combination of search criteria, you will see the Save
Search Scheme dialog window. If you want to save the search criteria, type a name in
the Scheme Name text box, then click Yes. If you don’t want to save the search
criteria, click No.

15. Click Yes to add the appointment.
DAISY opens the New Appointment window for this patient so you can add
appointment information.

Add appointment information

When you set up an appointment, you can choose to enter a variety of information.
For example, you can:

l Add patient contact information

l Set a priority, such as Emergency for patients who have an emergency, or ASAP for
patients who need an appointment sooner if one opens up

l Refine the amount of time the resources will be used

l Indicate lab requirements and pre-medications

l Enter the procedures this patient will receive during the visit

Tip: You can refine how a resource is utilized for an appointment.

For example, a 60-minute hygiene appointment may only require the dentist for the last
15 minutes. You can specify this when you set up the appointment and then schedule the
dentist elsewhere during the first 45 minutes.
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► To add appointment details:

1. In the Description text box, type the description of the appointment.

2. Click the Detail tab.

3. Do one of the following:
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l Next to the Patient text box, click to search for an established patient.
Select the patient, then click OK.
DAISY uses existing patient information to fill in appointment details, such as
home phone number.

l In the Patient text box, type in a new patient name.
You’ll also need to enter the patient’s home phone number and other contact
information.

4. From the Priority drop-down list, select a priority.
Use Standard for most appointments. You can also select ASAP for a patient who
wants to come in sooner if something opens up, or Emergency for a patient who
needs an appointment right away.

You can also add procedures to an appointment. Then, when you check out the
patient, the procedures automatically appear as unposted charges in the Transactions
window. For more information about the Transactions window, see "Manage financial
information" on page 155.

Tip: To add procedures to an appointment from the patient’s treatment plan, right-click
in the procedure text box and select Add Treatment Plan Procedures.
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► To add procedures to an appointment:

1. Click the Procedures tab.

2. Click the Prov Name column.

3. Search for and select the appropriate provider, then click OK.

4. Press Tab.

5. In the Proc. column, do one of the following:
l Type the appropriate procedure code.

l Click , search for the appropriate procedure code, then double-click code
you want.

6. When appropriate, fill in the Tooth, Surface, and Quad columns.
DAISY automatically fills in the description, fee, and duration for the procedure.

7. To add another procedure, right-click in the Appointment Procedures text box and
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select Add.

8. Repeat steps 6 through 7 until all necessary procedures are added to the
appointment.
Note: If any additional procedures are performed during the appointment, you can
add them to the appointment before checkout, or later when you post charges in
DAISY.

9. Close the New Appointment window, then click Yes to save the appointment.
The appointment is added to the Schedule.

Print a route slip
If your office uses route slips, you can use DAISY to print either a blank route slip or
one that is for a specific patient.

► To print a route slip:

1. From the Schedule window, do one of the following:
l To print a blank route slip, click an empty area of the Schedule to make sure no

appointments are selected. From the Reports menu, select Blank Route Slip.
l To print a route slip for a specific patient, click the patient’s appointment to

select it. From the Reports menu, select Appointment Route Slip for patient’s
name.

Print route slips for a single resource
Route slips can be printed for a single resource and grouped in appointment order.

► To print route slips for a single resource:

1. From the DAISY toolbar, click .

2. Search for and select a schedule, then click OK.

3. From the Reports menu, select “Route Slips for appointments on date in schedule
Daily”, then select the resource.
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4. In the Print Options dialog box, click Print to print the route slips for the selected
resource.

Create an appointment from a template
Common appointment types, such as adult or child hygiene exams, crown
preparation, or restorations, can be stored as a template and used as the basis for
setting up a patient appointment. You store templates in the Organizer under the
Templates folder.

A template must have:

l The description of the appointment

l The number of units (minutes) for that appointment

l At least one resource

You can also add procedures or other information that is typical for this kind of
appointment. By using a template, you have less typing to do to create an
appointment. And for established patients, you simply search for the patient, and
DAISY attaches information, such as phone numbers, from the patient’s account.

Note: If any additional procedures are performed during the appointment, you can add
them to the appointment before checkout, or later when you post charges in DAISY.

► To create an appointment from a template:

1. From the Schedule window, select View, then Organizer.

2. In the Organizer, click the Templates folder to open it.
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3. Click on the template and hold the primary mouse button down.

4. Drag the template to an open slot in the Schedule window, then release the
primary mouse button.

5. Click Yes to create the appointment.

6. Double-click on the appointment to open it.

7. Click the Detail tab.

8. Do one of the following:

l Next to the Patient text box, click to search for an established patient.
Select the patient, then click OK.

l In the Patient text box, type in a new patient name.
You’ll also need to enter the patient’s primary contact phone number and other
contact information.

9. Click the Priority text box and select a priority.
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Select Standard for most appointments. You can also select ASAP if a patient wants
to come in sooner if something opens up, or Emergency if a patient needs an
appointment right away.

10. Close the New Appointment window, then click Yes to save the changes.
The appointment is added to the schedule.

Tip: Appointments can be resized to increase or decrease the appointment’s duration. To
resize the appointment, rest the mouse pointer on the appointment’s top or bottom
border. Click the primary mouse button and drag the border up or down, then release the
mouse button and click Yes to save the changes.

Tip: To delete an appointment from the Schedule, right-click the appointment and select
Delete. Click Yes to confirm the deletion. The appointment moves to the Organizer’s
Recycle Bin.

Reschedule a cancelled appointment
DAISY gives you a variety of ways to set up an appointment for a patient. To save
time, you can reschedule a cancelled appointment rather than creating a new
appointment.

In the Detail tab in the Appointment window, the number of cancellations, if any,
displays as a red link (e.g., 1 Cancellation) below the patient's name.

Note: To calculate this number, DAISY uses the patient's cancelled appointments in the
Cancellations folder in the Organizer.
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► To reschedule a cancelled appointment:

1. From the DAISY toolbar, click .

2. Click the Master View tab.

3. Scroll down and double-click the starting time slot for the appointment.
The Appointment window opens.

4. In the Description text box, type the appointment description.

5. Next to the Patient text box, click to search for an established patient. Select
the patient, then click OK.
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You see the patient's information. This patient has one cancelled appointment.

6. Do one of the following:
l If the patient has one cancelled appointment, click the red "1 Cancellation"

link to open the cancelled appointment.
l If the patient has two or more cancelled appointments, click the red "x

Cancellations" link and select the preferred appointment, then click OK.

7. Change the date and time for this appointment.

8. In the Status drop-down list, select Scheduled.
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9. Click the Priority text box and select a priority.
Select Standard for most appointments. You can also select ASAP if a patient wants
to come in sooner if something opens up, or Emergency if a patient needs an
appointment right away.

10. Click and close the Appointment window.
The appointment is added to the schedule.

11. Close but do not save the original Appointment window.

Work with existing appointments

Find a scheduled appointment
DAISY makes it easy to locate existing appointments, such as when patients call to
find out when they are scheduled.

► To find a scheduled appointment:

1. From the DAISY toolbar, click .

2. Search for and select a schedule, then click OK.

3. From the File menu, select Open, then Find Appointments.

4. In the Search By drop-down list, select the type of information you want to search
by.
For example, select Patient to search by the patient’s name.
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5. If present, choose either the Begins With or the Contains option.
For example, if you want to find Amber Taylor, choose Begins With.

6. In the next text box, type the information you want to match.
For example, type Taylor, Amber to find her appointment.

7. Click .
Search results display in the lower half of the window.

Note: To always search automatically without having to click , check the Auto
Search check box in the Search window.

8. Double-click on the appointment you want.
The Schedule displays the appointment in its current slot. Notice that the patient’s
phone number and other account details are displayed without opening the
appointment.

9. To open the appointment, double-click on the appointment.
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Tip: You can set up DAISY to search for future appointments by default. From the DAISY
menu, select Appointment, then Practice Configuration. Click the Definition tab, then
check the Pre-filter Appointment Search for Future check box. Close the window and click
Yes to save the changes.

Reschedule an appointment
Once you locate a scheduled appointment, you can reschedule it by:

l Opening the appointment to change its date and time or use Best Fit to find
another appointment time slot.

l Clicking on the appointment and dragging it to its new location.

You’ve contacted Susan Taylor and she would like to move her appointment to an
earlier time slot on the same day. She’s scheduled for the afternoon, and you want to
move her to the morning.

► To reschedule an appointment:

1. From the Schedule window, click on the appointment and hold the primary mouse
button down.

2. Drag the appointment to its new time slot, then release the mouse button.

3. Click Yes to move the appointment to its new time.

Track appointment requests
Most offices need to keep track of patient requests to be scheduled if, for example, an
appointment slot becomes available. These types of requests can include
emergencies, cancellations, recalls, and requests to move an appointment to an
earlier date or time if a slot becomes available. You can use the Schedule’s Organizer
to store these requests until you can schedule them.

Tom Nielsen, a new patient, just called to cancel his appointment, but he plans to call
back later in the week to reschedule. Since he’s a new patient, you’d like to save his
appointment information so you won’t need to reenter it when he reschedules. You
can store his old appointment in the Organizer‘s Cancellations folder, then drag it to
its new time slot on the Schedule when he calls back.
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► To store an appointment in the Organizer:

1. From the DAISY toolbar, click .

2. Search for and select a schedule, then click OK.

3. From the View menu, select Organizer.

4. From the Schedule window, click on the appointment you want to store and hold
the primary mouse button down.

5. Drag the appointment to the Cancellations folder in the Organizer window, then
release the mouse button.

6. Click Yes to move the appointment to the Organizer’s folder.

Tip: To change the procedures attached to an appointment, double-click on the
appointment, then click the Procedures tab. Add or delete procedures as needed.

View the status of AutoRemind appointments
The Confirm Appointments window includes an AutoRemind filter. You can use this
filter to easily view the confirmation status of appointments with AutoRemind or just
those without. For example, you may want to view the day’s appointments that are
not set up with auto-reminders so you can call the patients directly.

► To view the confirmation status of AutoRemind appointments:

1. From the DAISY menu, select Appointment, then select Confirmation to open the
Confirm Appointments window.

2. In the AutoRemind drop-down list, do one of the following:
l Select Yes to view the confirmation status of AutoRemind appointments.
l Select No to view the confirmation status of appointments that are not set up

for AutoRemind.
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l Select All to view the confirmation status of all appointments.

Check in a patient
DAISY helps you see at a glance if a patient has been checked in.

► To check in a patient:

1. From the Schedule window, right-click the appointment.

2. Select Check In.
You see a green check mark at the top of the appointment.

Check out a patient
If you entered procedures for an appointment, they are automatically transferred as
unposted charges into the Transactions window when you check out the patient. For
more information about the Transactions window, see "Add a charge" on page 157.

Questions? www.softwarefordentists.com 1.800.368.6401114

http://www.softwarefordentists.com/


Chapter 7  Manage appointments

Note: Patients must be in set up in DAISY and associated with the appointment before
you can check them out.

► To check out a patient:

1. From the Schedule window, right-click the appointment and select Check Out.
DAISY displays the procedures that are attached to the appointment.

2. Check the check box next to each procedure that was completed during this visit.
Note: If the procedures performed on this patient were different from those attached
to the appointment, you can adjust them later from DAISY’s Transactions window.

3. Click OK.
DAISY tells you the charges have been generated.

4. Click OK.
In the Day view of the Schedule window, the check mark at the top of the
appointment changes from green to red and the appointment displays with hatch
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lines.

Use Quick Estimate
With Quick Estimate, you can quickly provide patients with verbal estimates without
having to create a treatment plan or request a pre-authorization.

You can add procedures from an existing treatment plan, or include charges from the
current visit, so you can use Quick Estimate to collect a payment from a patient
during checkout. You do not need to enter the charges in DAISY first or enter the
tooth or tooth surface for a procedure since that information does not affect the
estimate.

Quick Estimate is available from the DAISY toolbar, as well as the Quick Access
toolbar in several DAISY windows, such as the Schedule, Transactions, and Recall
Manager. Quick Estimate includes the procedures already entered for a patient, but
the procedures it includes by default vary depending upon where you access it.
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Click from the Quick Access
toolbar in this window...

To automatically include...

Transactions Charges entered for the current date
for the selected patient

Treatment Plan Current treatment plan procedures
for the selected patient

Schedule (pending or checked-in
appointment)

Procedures from the selected
appointment

Schedule (checked-out
appointment)

All of the day’s posted or pending
procedures from the selected
appointment

Schedule (Hot-list appointment) Procedures from the selected Hot-
list appointment

Appointment Procedures from the appointment

Recall Manager Charges entered for the current date
for the selected patient

Note: Quick Estimate does not generate a printed estimate. In a pinch, you can print a

screenshot of the Quick Estimate window. From the Quick Estimate window, click .

Generate a Quick Estimate for a selected patient

You can generate a Quick Estimate from the DAISY toolbar, from an appointment in
the schedule, or from an appointment template in the Organizer.

Here’s how to generate a Quick Estimate for a selected patient from the DAISY
toolbar.

► To generate a Quick Estimate from the DAISY toolbar:

1. From the DAISY toolbar, click .

2. Search for and select the patient’s name, then click OK.
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3. In the Patient Responsibility Estimation section:

a. Click to start entering a procedure.
b. Click the Procedure column and search for the appropriate procedure code.

4. To remove a procedure, select it and click .

5. To include today’s charges, click the Include Today’s Charges check box.

6. To display insurance coverage information, click the Show Insurance check box.
The total amount of fees, as well as the patient’s portion, displays in the lower
right corner of the window.

Generate a Quick Estimate from an appointment

► To generate a Quick Estimate from an appointment in the schedule:

1. Open the Schedule.

2. Right-click the appointment and select Quick Estimate.
If the appointment is pending or the patient is checked in, Quick Estimate pulls in
procedures from the appointment. If the patient is checked out, all of the day’s
posted or pending procedures from the appointment are included.
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Generate a Quick Estimate from an appointment template

If you have appointment templates in the Organizer, you can use these to provide a
Quick Estimate for a patient.

► To generate a Quick Estimate from an appointment template:

1. Open the DAISY Schedule.

2. From the Schedule window, select View, then Organizer.

3. In the Organizer, click the Templates folder to open it.

4. Click the template you want to use.

5. On the Quick Access toolbar, click .

6. Search for and select the patient’s name, then click OK.
The Quick Estimate window opens and displays an estimate for the procedures
based on the patient’s insurance information.

View the history of an appointment
The Status History section in the Appointment window tracks how many times an
appointment has been rescheduled.

► To review an appointment’s history:

1. From the DAISY toolbar, click .

2. Search for and select a schedule, then click OK.

3. Search for the appointment, then double-click on the appointment to open it.

4. In the Appointment window, click the More tab.
The Status History section shows how many times an appointment has been
rescheduled.
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You also see detailed information about AutoRemind confirmations.
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Troubleshooting appointments
Q. I use Best Fit to search for appointment openings. Sometimes Best Fit goes into a
never-ending search and finds no available appointments. I have to click the Stop
button to end the search. Why doesn't Best Fit find any available appointment
times?

A never-ending search in Best Fit can occur when:

l The Start Date of the new appointment is beyond the End Date of the resource's
availability pattern, so Best Fit will never find an available time for that resource.

For example, it is now April and your resource's current availability ends on May
31st. Your resource has a new availability for summer hours, which begins on June
1st and ends on August 31st. No additional availability patterns have been set
beyond summer hours.

You need to schedule six- and twelve-month recall appointments now, but the
resource's availability does not extend beyond the summer hours. For Best Fit to
find available time slots six and twelve months out, the resource must have
availability set to cover the longest period of time that you typically schedule recall
appointments. In this case, your resource must have availability set for at least 12
months into the future.

l Your patient availability does not match your resource availability.
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For example, your patient is only available on Tuesdays, but your resource
availability is Monday, Wednesday, and Friday. Best Fit can never find a match
that works for both this patient and this resource.

l You are trying to schedule an appointment that contains more than one resource,
and the resources do not share availability.

For example, your patient finds either of two resources acceptable for an
appointment. In the Search for Best Fit window under Resource Availability, you
searched for available times for both resources. Since these resources do not share
common availability, you need to change the Resource Availability option to "Any
one" before Best Fit can locate an open appointment time. The default Resource
Availability setting "All" only works when the selected resources share the same
availability.
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8 Work with treatment plans
Patients can have multiple treatment plans, and treatment plans can be phased. Each
phase can include multiple visits. Treatment plan information can be easily
reorganized and sorted, and completed treatment can be hidden.

l In the Treatment Plan window:

o Account and insurance information is stored in the Account and Insurance tab.

o A Provider drop-down list enables you to select the provider who proposed the
treatment plan.

o A Hide Completed Procedures check box enables you to filter out completed
procedures.

o Planned treatment can be omitted from the appointment route slip.

o Treatment plan information, such as providers, procedures, teeth, etc. can be
sorted by clicking on the column headings.

o Phases, visits, and procedures can be reordered using drag and drop or the new
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up/down arrows .

o The TP Seq (treatment plan sequence) can be used to indicate the sequential
order for procedures in the treatment plan.

l The appointment date of scheduled treatment plan procedures shows in the Appt
Date column in both the Treatment Plan and the Chart windows. To open the
appointment, right-click the appointment date and select Open Appointment.
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l The Select Procedures window includes Phase, Visit, and Add Date columns. This
window lists the patient’s treatment in order of treatment plan, phase, visit, and
procedure. For more information, see "Create a treatment plan" on page 126 .

l Treatment plan reports:

o Under the Reports menu in the Treatment Plan window, menu selections
accommodate multiple treatment plans. Each of the main menu selections,
Treatment Plan and Treatment Without Fees, includes a variety of selections
that enable you to print all phases, all visits, specific phases, specific visits, and
specific procedures. For more information, see "Print a treatment plan " on
page 144.
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o The treatment plan report displays the financial and insurance information at

the bottom of the report. The printer icon prints the entire treatment
plan. To print only parts of the treatment plan, use the Reports menu.

o Printed comments can be any length. Printed comments display below the
financial and insurance information.

o Completed treatment does not print on Treatment Plan reports.

o In an office with multiple doctors or multiple locations, regardless of whom is
listed as the performing provider, a provider can be selected on the treatment
plan. Provider information is pulled from the Provider window.

l The Patient History window shows all planned procedures, regardless of which
treatment plan they are attached to.

Create a treatment plan
In this example, the treatment plan requires three visits in two phases. The resulting
treatment plan will include fillings and wisdom tooth extractions.

► To create a treatment plan:

1. From the DAISY toolbar, click .

2. Search for and select the patient you want, then click OK.

3. Click .

4. Do one of the following:
l If the patient does not have a treatment plan, go to step 5.

l If the patient already has a treatment plan, click to create a new treatment
plan.

l If the patient has two or more treatment plans, the Search For – Treatment Plan
window opens. Click New Treatment Plan to create a new treatment plan.
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5. In the Treatment Plan window, click the Procedures tab.
In the Procedures section, you see a treatment plan tree at left with two default
entries: Phase 1 and Visit 1.

6. In the Description text box, type a name for the Treatment Plan.
For example, type Fillings and Extractions.
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7. In the treatment plan tree:
l Click the phase label and type a new name for the phase. For example, click

Phase 1 and type Fillings.
Note: Renaming the phase is optional, but label names are required for all phases.

l In the <Type comments here> cell, type an optional comment.

Note: Comments associated with phases do not print on the Treatment Plan
report.

l Click the visit label and type a name for the visit. For example, click Visit 1 and
type Fillings.
Note: Renaming the visit is optional, but label names are required for all visits.

l In the <Type comments here> cell, type an optional comment.
Note: Comments associated with visits do not print on the Treatment Plan report.

8. Click to add a procedure.
You see the procedure entry section. DAISY automatically associates the
procedures with the first phase and the first visit.
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9. In the  Proc. column, do one of the following:
l Type the appropriate procedure code.

l Click , search for the appropriate procedure code, then double-click the
code you want.

10. When appropriate, fill in the Tooth, Surface, and Quad columns.
DAISY automatically fills in the procedure’s description, fee, and duration.

11. To enter additional procedures, repeats steps 8 through 10.
Note: You can also generate treatment plans from the Chart window in DAISY Chart.
All treatment is initially placed in Phase 1, Visit 1 by default.

12. To create another phase, right-click in the Procedures section and select Add
Phase.
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13. Repeat steps 7 through 11 to finish entering treatment for the first visit of this next
phase.
For example, name the next phase Wisdom Teeth Extractions, and enter the
information for the extractions visit.
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14. To add another visit to the Wisdom Teeth Extractions phase, right-click in the
phase’s Procedures section and select Add Visit.
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You see the visit added to the treatment plan tree under the appropriate phase.
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15. Click the visit label and type a name for the visit. For example, click Visit 2 and
type Left Side.

16. To enter procedures for this visit, repeat steps 8 through 11.

17. Click to save the treatment plan.

Modify a treatment plan

► To modify a treatment plan:

1. From the DAISY toolbar, click .

2. Search for and select the patient you want, then click OK.

3. Click .
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4. Do one of the following:
l If the patient has one treatment plan, the Treatment Plan window opens. Go to

step 5.
l If the patient has two or more treatment plans, the Search For – Treatment Plan

window opens. Select the treatment plan, then click OK.

Note: If the patient does not have a treatment plan, DAISY creates a new treatment
plan.
You see the Treatment Plan window.
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5. Modify the treatment plan as needed.
l To change the provider (which is the default provider associated with this

patient’s account), select the provider from the Provider drop-down list.
Provider information is pulled in from the Provider window. This provider’s
name and address displays on the Treatment Plan report.

l To add treatment plan phases, visits, or procedures, see "Create a treatment
plan" on page 126.

l To edit a procedure, click the appropriate procedure cell, then type or select
the new information.

l To delete a procedure, see "Remove treatment plan information" on page 136
.

l To move or reorder treatment plan information, see "Move or reorder
treatment plan information" on page 135.

6. Click to save the treatment plan.

Move or reorder treatment plan information

► To move a visit or phase:

1. Open the treatment plan.

2. Click the phase or visit label name and hold down the mouse button.

3. Drag the phase or visit to the location you want, then release the mouse button.
Visits associated with a phase move with it.

4. Click to save the treatment plan.
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► To move a procedure to another phase or visit:

1. Open the treatment plan.

2. Do one of the following:

l Select the procedure and click the up/down arrow (                  ).
l Select the procedure and hold down the primary mouse button. Drag the

procedure to the location you want, then release the primary mouse button.
l To move more than one procedure at a time, press the <Ctrl> key and click

each procedure you want to select, then either drag and drop the procedures to
another visit or phase, or use the up/down arrows (                  ) to move the selected

procedures.

3. Click to save the treatment plan.

Remove treatment plan information

► To remove a phase from a treatment plan:

1. Open the treatment plan.

2. Right-click the phase label, then select Remove Phase.

3. In the Confirm dialog box, click OK.
All visits associated with the phase are also removed.
Note: At least one phase is required for all treatment plans. To remove the last phase,
delete the treatment plan.

► To remove a visit from a treatment plan:

1. Open the treatment plan.

2. Right-click the visit label, then select Remove Visit.

3. In the Confirm dialog box, click OK.
All procedures associated with visit are also removed.
Note: At least one visit is required for each phase. To remove the last visit, delete the
phase.

► To remove a procedure from a treatment plan:

1. Open the treatment plan.

2. Click to expand the phase and visit tree to view the procedure.

3. Right-click the procedure description, then select Remove procedure code.

Questions? www.softwarefordentists.com 1.800.368.6401136

http://www.softwarefordentists.com/


Chapter 8  Work with treatment plans

Procedure code is the code number of the selected procedure, such as D1204.

Delete a treatment plan

► To delete a treatment plan:

1. From the DAISY toolbar, click .

2. Search for and select the patient you want, then click OK.

3. Click .

4. Do one of the following:
l If the patient has one treatment plan, the Treatment Plan window opens. Go to

step 5.
l If the patient has two or more treatment plans, the Search For – Treatment Plan

window opens. Select the treatment plan, then click OK.

5. From the File menu, select Delete.

6. In the Confirm dialog box, click OK.

Note: The treatment plan is not deleted from the database; it is changed to inactive.

Migrate the patient treatment plan to a new account
When a patient is moved to a different account, the patient’s treatment can be
migrated to the new account as well. The patient must either be moved to an existing
account, or you must create the account before you move the patient.

In this example, the patient will be moved to an existing account.
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► To migrate a patient’s treatment plan:

1. From the DAISY toolbar, click .

2. Search for and select the patient’s current account, then click OK.

3. Click the Patients tab.

4. Select the patient and click .

5. In the Confirm dialog box, click Yes.

6. In the next Confirm dialog box, click Migrate.
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7. Search for and select the patient’s new account, then click OK.
The patient and all associated treatment plans are moved to the new account.

Manage planned treatment from the patient chart
If a patient has multiple treatment plans, you can choose which planned treatment to
display on the patient’s chart using the revised Planned Treatment display option.
Tooth graphics and treatment history display treatment associated only with the
selected treatment plan.

The Planned Treatment display setting also affects how you enter treatment if the
patient has more than one treatment plan.
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View planned treatment from the patient chart
If a patient has multiple treatment plans, you can choose which planned treatment to
display on the patient’s chart. When you first open a patient chart, the Planned
Treatment defaults to <All>, which displays all planned treatment for the patient.

► To display selected treatment for this patient:

1. From the DAISY toolbar, click .

2. Search for and select the patient you want, then click OK.

3. In the Patient window, click to open a chart for this patient.
By default, you see all planned treatment for the patient.

4. To the right of the Planned Treatment check box, click              .

5. In the Search for –Treatment Plan window, select the treatment plan you want,
then click OK.
In the following example, the hygienist selected the patient’s Pro, Fills, Ext
treatment plan. You only see the treatment associated with this plan in both the
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tooth graphics section and the treatment history section of the window.

Modify a treatment plan from the patient chart
The Planned Treatment display setting also affects how you enter treatment if the
patient has more than one treatment plan, and the Planned Treatment display option
is set to <All>. DAISY will ask you to select which plan to add the treatment to, but
only the first time you enter a procedure.

In this example, the patient has two treatment plans. The dentist wants to add a
ceramic crown for tooth 4 to the Crowns and Bridge treatment plan.

► To modify a treatment plan from the patient chart:

1. From the DAISY toolbar, click .

2. Search for and select the patient you want, then click OK.

3. In the Patient window, click to open a chart for this patient.
By default, you see the entire patient’s planned treatment.

4. In the Pass navigation area, click the appropriate buttons to select the
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Treatment Plan pass.
In this example, the pass has been set to Treatment Plan, and the Planned
Treatment display option is set to <All> by default.

5. Click tooth 4, then click Ceramic Crown.
You see the Search For – Treatment Plan window.

6. Select the treatment plan and click OK.
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The Planned Treatment display option changes to the selected treatment plan, the
tooth graphics section changes to display treatment associated with the plan, and
the crown is added to tooth 4.

7. Click and close the Chart window.
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Print a treatment plan
You can print the following with or without individual fees:

l The entire treatment plan

l Individual phases and their associated visits

l Specific visits within a phase

l One or more procedures

Print a treatment plan with fees
In this example, the front office wants to print a complete treatment plan, including
all phases and visits.

► To print a complete treatment plan with fees:

1. Open the Treatment Plan window.

2. Do one of the following:

l Click to print the entire treatment plan.
l From the Reports menu, select Treatment Plan, then select All Phases.

Print a specific phase of a treatment plan
In this example, the front office wants to print a specific phase of a treatment plan,
excluding fees. The phase name is Cleaning and Fillings, and the Visit name is Fillings.
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► To print a specific phase of a treatment plan, excluding individual fees:

1. Open the Treatment Plan window.

2. From the Reports menu, select Treatment Plan Without Fees, then select phase
name, then select visit name.
For example, select the phase name Cleanings and Fillings, then select the visit
name Fillings.

3. Do one of the following:

l To preview the report first, click Preview, then click to print it.
l To print the report without previewing it, click Print.

Print selected procedures in a treatment plan
In this example, the front office wants to print only selected procedures in a
treatment plan, including fees.

► To print selected procedures, including fees:

1. Open the Treatment Plan window.

2. From the Reports menu, select Treatment Plan, then select By Procedure.
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3. Place a check mark next to each procedure to print, then click OK.

4. Do one of the following:

l To preview the report first, click Preview, then click to print it.
l To print the report without previewing it, click Print.

You see the report with the selected treatment plan procedures and fees.
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Generate treatment plan reports
You can filter treatment plan procedures by whether or not they are scheduled or
unscheduled and whether or not the patient has benefits remaining.

Note: Procedures attached to an appointment have a status of “accepted.”

In addition, the Tx. Plan Proc. Not Done report has three parameter tabs:

l Tx Plan Add Date allows you to filter by the date that unscheduled treatment plans
were added.

l Proc. Add Dt allows you to filter by the date that unscheduled treatment plan
procedures were added.

l Tx Plan Provider allows you to filter by treatment plan provider.
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View scheduled treatment plans

► To view the status of all scheduled treatment plans:

1. Open the Treatment Plan window.

2. Do one of the following:
l To generate a summary report of scheduled treatment plan procedures, from

the Reports menu, select Treatment Plan Status, then select Scheduled.
l To generate a detailed report of scheduled treatment plans, from the Reports

menu, select Treatment Plans – Not Completed, then select Scheduled.
You see a report containing all scheduled treatment plans.

View patients with unscheduled treatment plans

► To view a list of patients with unscheduled treatment plan procedures:

1. Open the Treatment Plan window.

2. Do one of the following:
l To generate a summary report of unscheduled treatment plan procedures, from

the Reports menu, select Treatment Plan Status, then select Unscheduled.
l To generate a detailed report of scheduled treatment plans, from the Reports

menu, select Treatment Plans – Not Completed, then select Unscheduled.
You see a report containing all unscheduled treatment plans.

Note: Additional treatment plan status reports are available from the Report Gallery
under the Treatment Plans folder.

View unscheduled treatment for a range of dates
In this example, the office wants to view all unscheduled procedures planned between
6/1/2010 and 9/30/2010.

► To view a report of patients with unscheduled treatment plan procedures
for a range of dates:

1. From the DAISY toolbar, click , then double-click the Treatment Plans
folder.

2. Right-click the TX Plan Proc. Not Done report and select Properties.

3. Click Reset to remove any filtering from the last time you ran the report.
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4. In the Parameters section, select the Scheduled? tab.

5. Set the filters to Is Equal to N.

6. In the Parameters section, select the Proc. Add Dt tab.

7. Set the filters to Is Between, and type the date range.

8. Click OK to save the filter setting.

9. Double-click the TX Plan Proc. Not Done report.
You see all treatment plan procedures added between 06/01/2010 and 9/30/2010
that have not been scheduled.

What's New in DAISY 4.4 149



Chapter 8  Work with treatment plans

It also shows a patient’s accepted treatment plan procedures, even when those
procedures are attached to a canceled or pending appointment.
For example, the following canceled appointment for Christine Zane has one
accepted treatment plan procedure attached:

You see that the accepted procedures attached to Christine’s canceled
appointment show on Tx Plan Proc. Not Done report (R2003):
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View patients with outstanding treatment and remaining benefits
In this example, the office wants to view all patients with outstanding treatment who
have remaining benefits.

► To view a report of patients with treatment plan procedures not completed
for a range of dates:

1. From the DAISY toolbar, click , then double-click the Treatment Plans
folder.

2. Right-click the TX Plan Proc. Not Done report and select Properties.

3. Click Reset to remove any filtering from the last time you ran the report.

4. In the Parameters section, select the Pri. Benefits Remain tab.
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5. Set the filters to Is Greater Than 0.

6. In the Parameters section, select the Procedure Status tab.
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7. Set the filters to Is Equal to Proposed.

8. Click OK to save the filter settings.

9. Double-click the TX Plan Proc. Not Done report.
You see all patients with outstanding treatment who have remaining benefits
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9 Manage financial information
Any activity involving money is a transaction. This kind of activity includes charges,
payments, and adjustments. You manage all your transactions from DAISY’s
Transactions window.

For offices that either do not use DAISY to schedule appointments or do not enter
procedures and then check their patients out in the DAISY scheduler, charges are
entered in this window. Even if procedures are entered with the appointment and
patients are checked out, payments and adjustments still have to be entered in
DAISY.

Tip: Prior to posting, charges can be changed or removed. To remove a charge, right-click
the charge and select Remove. After posting, incorrect charges must be reversed in the
ledger.

Filter transactions by provider
The Transactions window under the By Type button can be filtered by provider. This
makes it easier, for example, for doctors to review their transactions and finalize them
without having to wait for other doctors in the practice.

Once transactions are filtered by provider, all other functionality, such as selections
in the right-click menu, operates on the provider you’ve selected. For example, if you
select Dr. Richard Smith, and generate Unposted Transactions reports, only Dr.
Smith’s unposted transactions will show up in the report. If you change service dates
or post charges, only Dr. Smith’s service dates or charges will be affected.

► To filter transactions by provider:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Type button.

3. In the Show Summary For drop-down list, select the type of transaction.

4. Do one of the following:
l If the selected transaction type is Charges, then in the Performing Provider

drop-down list, select the performing provider.
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l If the selected transaction type is Payments or Adjustments, then in the Billing
Provider drop-down list, select the billing provider.

Manage charges
You use the Charges tab in the Transactions window to enter all charges for
procedures performed on patients.
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Add a charge

► To add a charge:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Account button, then click the Charges tab.

3. Do one of the following to enter a patient’s charges:
l If the patient is listed in the Accounts/Patients tree on the left-side of the

window, click the patient’s name.
l If the patient is not listed, right-click in the Account/Patients section and select

Select a Patient. Search for the patient, then double-click the patient name.

4. In the Proc. column, do one of the following:
l Type the appropriate procedure code.

l Click , search for the appropriate procedure code, then double-click code
you want.

5. When appropriate, fill in the Tooth, Surface, and Quad columns.
DAISY automatically fills in the procedure’s description, fee and duration in
minutes.
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6. To add another procedure, right-click in the charges text box and select Add
Transaction.

7. Repeat steps 4 through 6.

Tip: If you commonly enter the same group of procedures for a particular type of
appointment, you may want to set up an Explode Code.

Post charges
Added charges are not automatically posted so they do not immediately affect your
accounts receivable. Once you post the charges, account balances are updated and
claims are created. To batch post charges, see "Batch post transactions" on page 166.

► To post charges for a patient:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Account button, then click the Charges tab.

3. Select a patient in the Accounts/Patients tree.

4. Right-click in the charges text box and select Post Charges for patient name.

5. To post the charges, click Yes.

6. If you want to view the new claim, click Yes; otherwise click No.

Tip: Prior to posting, you can easily change the service dates on all or selected charges.

Manage payments
You use the Payment tab to add insurance payments to an account or to add amounts
that patients pay on their accounts. If you always enter the deductible amount
withheld (shown on the insurance payment voucher), DAISY will track individual and
family deductible accumulations.
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Add a payment

► To add a payment:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Account button, then click the Payments tab.

3. Do one of the following to add a payment:
l If the account is listed in the Accounts/Patients tree on the left-side of the

window, click the account name.
l If the account is not listed, right-click in the Accounts/Patients section and

select Select an Account. Search for the account, then double-click the account
name.

4. To add a payment, right-click in the payments text box, then select Add
Transaction.

5. Click the Method column and select the payment type.

6. If the payment type is a check, click the Check ID column and type the check
number.

7. If the payment is from an insurance company, do one of the following:
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l Click the Claim No. column, then click to search for the claim number.
l Select the claim number.

8. Click the Amount column and type the payment amount.

9. To add another payment for this account, repeat steps 4 through 8.

Tip: Use the Tag column to refine the description of a payment. For example, if a down
payment was made with a check, the Payment Type would be Check, but the Tag could
be Down Payment.

Transfer an unposted personal payment
If you accidentally enter a personal payment, such as a credit card payment, ACH
payment, check, or cash payment on the wrong account, you can transfer the
unposted payment to the correct account. You do not need to reverse the payment.

You can only transfer personal payments to another account. Payments from an
insurance company or other third party cannot be transferred.

Note: When you transfer a personal payment to another account, all related refunds, if
any, transfer with it.

► To transfer an unposted personal payment:

1. Open the Transactions window.

2. Search for and select the account, then click OK.

3. Click the Payments tab.

4. Right-click the payment and select Transfer to Another Account.

5. Search for and select the account, then click OK.
You see a transfer confirmation.

6. Click OK to close the dialog window.
DAISY opens the Transactions window and you see the transferred payment for
this account.
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Note: The Activity Log records the transfer of unposted payments, including the account
information and the transaction amount.

Post payments
Added payments are not automatically posted so they do not immediately affect your
accounts receivable. Once you post the payment, account balances are updated. To
batch post payments, see "Batch post transactions" on page 166.

Tip: Prior to posting, you can easily change receive dates on all or selected payments.

► To post payments:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Account button, then click the Payments tab.

3. Select an account in the Accounts/Patients tree.

4. Right-click in the payments text box and select Post Payments for Account account
number.

5. To post the payments, click Yes.

Manually distribute payments to providers
DAISY automatically distributes payments to providers on a first-in, first-out (FIFO)
basis (oldest charges are paid first). However, since some multiple provider offices
prefer to pay associates upon collection, or they may prefer to distribute payment on
some other basis, you can choose to manually override DAISY’s default method of
payment distribution.

Note: A payment distribution cannot be changed after it is posted. The payment must be
reversed in the ledger and then reentered as new transaction.

► To manually distribute a payment:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Account button, then click the Payments tab.

3. Search for and select an account in the Accounts/Patients tree.

4. Add the payment to the selected account.

5. With the payment selected, right-click and select View Distribution.
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6. In the Distribution column, redistribute the payment as desired.
Only providers with unpaid charges display in the Distribute Payment window.
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7. Click OK.
Once a distributed payment is posted, you can view the distribution from the
ledger.

Distribute a prepayment to a specific provider
When a patient prepays for a service, by default DAISY treats the prepayment as
undistributed and then applies it to the next charge on the account. However, you
can choose to distribute the prepayment for a specific provider in advance of the
service.

Note: Prepayments can only go to a single provider. You can use this option even if the
account does not have a zero balance.

► To distribute a prepayment to a specific provider:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Account button, then click the Payments tab.

3. Search for and select an account in the Accounts/Patients tree.

4. Add the prepayment to the selected account.

5. With the prepayment selected, right-click and select Distribute Prepayment.

6. In the Search For – Provider window, select the provider who will receive the
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distribution.

7. In the Confirmation dialog box, click Yes to complete the distribution.

Manage adjustments
You use the Adjustments tab in the Transactions window to enter adjustments types,
such as:

l Discounts, such as cash, senior, doctor, courtesy

l Refunds, such as in the case of overpayment

l Collection fees or other fees, such as when a patient misses an appointment

Add an adjustment

► To add an adjustment:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Account button, then click the Adjustments tab.
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3. Do one of the following to add an adjustment:
l If the account is listed in the Accounts/Patients tree on the left-side of the

window, click the account name.
l If the account is not listed, right-click in the Accounts/Patients section and

select Select an Account. Search for the account, then double-click the one you
want.

4. To add an adjustment, right-click in the adjustments text box, then select Add
Transaction.

5. Click the Adjustment Type column and select the adjustment type.
Tip: Adjustment types are defined in DAISY in the Lookup List Maintenance window.
To change adjustment types:
From the DAISY menu, select Configure, then List Maintenance. Click the Simple Lists
tab. From the Simple Lists drop-down list, select Adjustment Types.

6. Click the Amount column and type the adjustment amount.
If you enter a negative number, the CR column will display CR for credit.

7. To add another adjustment for this account, repeat steps 4 through 6.

Post adjustments
Adjustments are not automatically posted so they do not immediately affect your
accounts receivable. Once you post the adjustments, account balances are updated.
To batch post adjustments, see "Batch post transactions" on page 166.
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Tip: Prior to posting, you can easily change receive dates on all or selected adjustments.

► To post adjustments:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Account button, then click the Adjustments tab.

3. Select an account in the Accounts/Patients tree.

4. Right-click in the adjustments text box and select Post Adjustments for Account
account number.

5. To post the adjustments, click Yes.

Batch post transactions
Once a transaction is posted, it becomes a permanent record that can’t be altered
without leaving an audit trail. This method enables you to review all transactions
prior to posting so you can find and fix errors. The By Type button in the Transactions
window contains all transactions (charges, payments, and adjustments) that have not
been posted.

Tip: To help you review the day’s transactions you may want to run one or more
Unposted Transactions reports. From the Transactions window, click the By Type button.
From the Reports menu, select an Unposted Transactions report, then click Print to print
the report.

Tip: Before you post, you can easily change all service dates to a new date. To change the
dates, right-click anywhere in the transactions list. Select Change transaction type Service
Dates, then select All. Type the new date, then click OK.
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► To batch post transactions:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Type button.

3. From the Show Summary For drop-down list, select the transaction type you want
to post.

4. Check service dates and other information that may be incorrect.

5. Right-click in the transactions text box, and select Post transaction type.
For example, if you chose to post charges, you’d select Post Charges.

6. To post the transactions, click Yes.

7. Repeat steps 3 through 6 for each remaining transaction type.

Note: You can determine if any accounts still have unposted transactions. From the
Transactions window, click the By Account button, then press F5 to refresh the window. If
any accounts are displayed in the Accounts/Patients tree on the left side of the
Transactions window, then those accounts have some unposted transactions.
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Manage electronic remittances
Electronic remittances (or remits) enable you to receive, review, edit, and approve
your claims payments and adjustments more quickly and efficiently.

Instead of printing and mailing the Explanation of Benefits (EOB), some insurance
companies have the ability to send electronic remits, an electronic version of the
explanation of benefits (EOB). Each remit is called an Electronic Remittance Advice
(ERA).

In addition, some insurance companies may also offer electronic funds transfer (EFT)
of monies directly into your bank account.

Note: To enroll in this service, contact DAISY customer support at (800) 368-6401 or
(503) 765-3471 in the Portland area.

Here’s a comparison of how EOBs can be processed in DAISY:
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Printed EOB Electronic Remittance Advice

Receive explanation of benefits
via US Mail

Receive electronic remit advice (ERA) via
Data Exchange

Manually select account for
posting

DAISY selects the account automatically

Manually enter payment data:
method, check ID, amount,
deductible, comment

Payment information is automatically
entered. Processing comments can be viewed
in the ERA

Manually select the claim to
attach to the payment
information

DAISY automatically selects the claim (in
most cases)

View the claim detail in a
different window from the
payment transaction window

Claim detail can be viewed in the same
window (Electronic Remits tab in the
Transactions window)

Manually enter adjustments
(when needed)

DAISY automatically enters the adjustments

Manually note on EOB or other
paper that follow-up research is
required

When additional research is required, simply
check a check box in the Electronic Remits
tab in the Transactions window to mark the
claim as needing further research. This
reminder then displays in the Claim History
window

If a patient has a secondary
claim, make a copy of the EOB
and black out the information
that does not apply, and then
print a copy and mail it to the
secondary insurer

Open the related claim on screen, view both
the secondary claim and the ERA associated
with the patient’s primary claim, and print
them and mail to the secondary insurer

File EOBs for future reference View the ERA on screen

Switch to different window to
generate a QuickStatement

Generate a QuickStatement from the
Electronic Remits tab in the Transactions
window

Balance the payment entries to
the EOB

Payment entries automatically match the
ERA

Attach a paper check to a
deposit slip and go to the bank

Funds are directly deposited into bank
account via EFT (when the payer offers this
service)
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Review electronic remittances
When new electronic remittances are ready for review in the Transactions window,
you see an alert in the DAISY Central window.

Note: You only see this notice until you view the new remittances in the Transactions
window.

► To review the electronic remittances:

1. Do one of the following:
l In the DAISY Central window, click New Electronic Remits.

l From the DAISY toolbar, click to open the Transactions window, then
click the Electronic Remits button.

The Payer/Remits tree on the left side of the window shows all the new or recently
received electronic remittances. The tree is organized first by insurance payer, and
then by remittance. Each branch displays the issue date and total amount of each
remit.
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2. Click the remit to display the payments, adjustments, and notices associated with
it.

l Each payment includes the DAISY claim number, claim patient, account
number, guarantor, patient’s benefit amount, amount applied to the
deductible, and a comment.

l Each adjustment includes the DAISY claim number, claim patient, account
number, guarantor, patient’s benefit amount, and the reason for the
adjustment, such as “Writeoff.” For more information on handling adjustments,
see "Manage remittance adjustments" on page 175.

l Each overpay notice includes the DAISY account number, guarantor, patient’s
benefit amount, amount applied to the deductible and the reason for the
notice, such as “ERA Correction.” For more information about overpayment
notices, see "Update the UCR schedule" on page 178.

l Each overpayment recovery includes the DAISY account number, guarantor,
patient’s benefit amount, amount applied to the deductible and the reason for
the notice, such as “ERA Correction”. For more information about overpayment
recoveries, see "Update the UCR schedule" on page 178.
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l If a patient has a secondary insurance claim on hold, DAISY displays in the
RC column.

l If a claim was submitted on paper but paid electronically, then the Claim No.
and the Claim Patient columns are blank. Click the Claim No. column, then

click to select the appropriate claim for viewing.

3. To view the original remit from the insurance company, right-click on the remit
and select View Entire Remit.

4. To view claim details, click a payment or adjustment associated with the claim. 
You see claim details in the section below the claim. Below that section is an
Account Info section, which shows the same information found in the Account
Info tab in the Transactions window.
Use this section to view:
l What the balance on the account will be once the payment or adjustment is

posted.
l Request a QuickStatement. These QuickStatements are generated during the

next Daily Closing.

5. If a payment or adjustment requires additional research, check the check box in
the Research column in the Remit Detail section to open the Reason for Research
dialog box. 
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DAISY automatically fills in the date, time and an introductory phrase.

6. Type a reason for researching the claim, then click OK.

Once you approve the remittance, you can view the claims that required more
research from the Claims History window.  For more information, see "Research a
claim" on page 222.

7. If a patient has a secondary insurance claim on hold, do the following:

a. In the RC column, double-click to view related claims.
b. Select the secondary claim and click the View button to open the Claim

window.

c. Click to print the secondary claim.
d. Close the Claim window.
e. From the Reports menu in the Electronic Remits window, select Current EOB

to print the primary payment EOB.

8. When you are done reviewing the payment or adjustment, check the checkbox in
the Rev’d column.

9. Review all other payments or adjustments, and if they are correct, check the check
box in the Rev’d column. 
Note: For more information on handling adjustments in electronic remits, see
"Manage remittance adjustments" on page 175 .

10. When you are done reviewing the payments and adjustments, click to
approve the payments and adjustments in the remit.
Note: The check box in the Rev’d column must be checked for all of the payments and
adjustments in the remittance before you can save your work.
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11. In the Confirm window, click Yes to approve the payments and adjustments.
The payments and adjustments are added to the list of unposted transactions in
the Transactions window.
Note: Overpay Notices do not generate an adjustment entry. The notice is simply
deleted.

12. Do one of the following:
l If the Select UCRs to Update window opens, go to "Update the UCR schedule"

on page 178.
l If the Select UCRs to Update window does not open, go to step 13.

13. To view the list of unposted transactions, click the By Type tab in the Transactions
window.
Handle these unposted transactions the same as those you would enter manually.
Note: Once the remittance is posted, it no longer displays in the left-hand tree of the
Electronic Remits tab.

The payment methods for transactions generated from approved remittances are
as follows:

This payment
method…

Indicates…

EFT The payment will be deposited directly into your
practice’s bank account

Check The insurer will issue a paper check and send it by US
Mail to your office

If the insurance company sends a paper check, you may want to wait to generate
the unposted payment transaction from a remit until you have the check in hand,
so you can verify the funds and balance against your end-of-day deposit slip.
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On the other hand, if the insurance company sends the payment via EFT, you may
want to wait to generate the unposted payment transaction from a remit until you
have verified that the payment has been deposited into your bank account.

Manage remittance adjustments
In DAISY, all remittance adjustments arrive with a default adjustment type of
“Writeoff”.  You see this designation in the Adj. Type column. You can choose to
select a different adjustment type.

► To choose a different adjustment type:

1. Click in the appropriate cell in the Adj. Type column, then click to open the
Select Adjustment Type dialog box.
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2. Select the adjustment type, then click OK.

Sometimes you may want to remove an adjustment included in the remit, such as
when you know that a charge reduced by the primary insurer due to a provider
discount may be covered by the patient’s secondary insurance. 

► To remove an adjustment:

l Right-click on the adjustment, and select Remove Transaction.

Note: If you accidentally remove an adjustment, you will have to manually reenter it. The
removal cannot be undone.

Manage insurance overpayments
If an insurance company overpays a patient claim, it corrects the error by including
either an “overpay notice” or an “overpayment recovery” entry in the next electronic
remittance.

l An overpay notice tells you that an overpayment has occurred. You are responsible
for sending back the overpaid amount.
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Note: When you approve the remit, the Overpay Notice does not generate an
adjustment entry.  The notice is simply deleted.

l An overpayment recovery deducts the entire payment from the remittance, not
just the amount that was overpaid. The insurance company will issue a subsequent
payment in the correct benefit amount either in the same remit or a later remit.

In this example, the dollar amount of the overpayment recovery is bracketed
(205.00). This is the amount that the insurance company is taking back.

An overpayment recovery has an Adjustment Type of ERA Overpayment Recovery. 

Note: You cannot change the adjustment type on an overpayment recovery because (1)
it reopens the claim and adds money back to the account balance and (2) on the
Deposit Record report, it changes the total for that deposit by the amount of the
recovery.

When you receive an overpayment recovery, DAISY:

o Reopens the claim that was originally overpaid. 

o Alters the deposit grant total in the Deposit Record report to reflect the amount
of the overpayment recovery. For example, Mutual Insurance Company
overpaid $20 on a prior remittance. In the next remittance, you receive benefits
of $100. When you run the Deposit Record report, the $20 overpayment will be
subtracted from the overall deposit amount.
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Update the UCR schedule
Whenever you approve the payments and adjustments in an electronic remit, DAISY
checks to see whether one or more UCR values are associated with a claim. If the
values in the current ERA are different from the UCR schedule in the system, DAISY
opens the Select UCRs to Update window so you can easily update the UCR
schedule.

Note: DAISY looks at the date of service in the remit and always uses the fees associated
with latest date of service.

► To update the UCR schedule:

1. In the UCR Schedules section on the left side of the window, select the name of
the UCR schedule to update.
You see UCR updates associated with this schedule on the right side of the
window.

2. Do one of the following:
l To accept all of the updates associated with the UCR schedule, check the

checkbox next to the URC schedule name. DAISY checks the check boxes for all
of the UCR updates listed on the right side of the window.

l To accept a specific UCR update, check the checkbox next to the update listed
on the right side of the window.

3. Do one of the following:
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l To add a participating provider to the insurance plan, check the “Add
Participating Providers to Insurance Plans When Missing” check box. DAISY
adds the billing provider from the associated claim.

l If a provider is not participating in the insurance plan, uncheck the “Add
Participating Providers to Insurance Plans When Missing” check box.

4. For each UCR schedule, repeat steps 1 through 3.

5. Click OK to complete the UCR updates.
All accounts associated with that insurance plan will now have updated UCR
information.

Reverse transactions from the ledger
Two kinds of situations require a reversal from the account ledger:

l You entered and posted an incorrect procedure code or amount for a charge,
payment or adjustment.

l You entered and posted an incorrect transaction date on the wrong account,
wrong patient, or the wrong provider.

Reverse a transaction entered with a non-monetary error
Use this method to reverse a transaction that was entered and posted on the wrong
account or provider, or with the wrong date.

► To reverse a charge, payment or adjustment posted in error:

1. From the DAISY toolbar, click .

2. Search for and select the account, then click OK.

3. In the Ledger window, right-click the charge, payment or adjustment that you
want to reverse, and select Reverse transaction.
A transaction is a Charge, Payment, or Adjustment.

4. In the New Amount text box, leave the amount at zero.

5. In the Comment text box, type in a comment, if desired.

6. Do one of the following:
l If you leave the amount at zero, you see the Would You Like to Create a New

Charge Transaction dialog box. Go to step 7.
l If you enter an amount, go to step 8.
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7. Do one of the following:
l Click Yes to create a new charge. This takes you to the Transactions window.

Enter a new transaction using the correct information.
l Click No to exit the ledger.

8. Click OK.

Reverse a transaction posted with an incorrect amount
You can either reverse the amount of a charge, payment, or adjustment to zero, or
you can re-post a new amount.

► To reverse a transaction posted with the wrong amount:

1. From the DAISY toolbar, click Post and select .

2. Search for and select the account, then click OK.

3. In the Ledger window, right-click the charge, payment or adjustment that you
want to reverse, and select Reverse transaction.
A transaction is a Charge, Payment, or Adjustment.

4. In the New Amount text box, type in the amount or leave it zero.

5. In the Comment text box, type in a comment, if desired.

6. Do one of the following:
l If you leave the amount at zero, you see the Would You Like to Create a New

Charge Transaction dialog box. Go to step 7.
l If you enter an amount, go to step 8.

7. Do one of the following:
l Click Yes to create a new charge. This takes you to the Transactions window.

Enter a new transaction using the correct information.
l Click No to exit the ledger.

8. Click OK.
You see the original transaction is now shown in gray and italicized. The reversal is
displayed as an adjustment.

Transfer a posted personal payment
If you accidentally post a personal payment to the wrong account, you can transfer
the payment to the correct account. You do not need to reverse the payment.
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You can only transfer personal payments to another account. Payments from an
insurance company or other third party cannot be transferred.

Note: When you transfer a personal payment to another account, all related refunds, if
any, transfer with it.

► To transfer a posted personal payment:

1. Open the Ledger window.

2. Search for and select the account, then click OK.

3. Right-click the payment and select Transfer to Another Account.

4. Search for and select the account, then click OK.
You see a transfer confirmation.

5. Click OK to close the dialog window.
In the Ledger window, you see a payment reversal on the original account.

Note: The Activity Log records the transfer of unposted payments with account
information and the transaction amount.

Use DAISY InCharge
DAISY InCharge integrates credit card and automatic clearing house (ACH) processing
(also known as electronic check transactions) between DAISY and TransFirst, a
leading provider of payment processing services. With DAISY InCharge, dental offices
no longer need to manage and balance two separate electronic transaction systems:
using a credit card terminal and using DAISY to enter payments.

This DAISY feature:

l Automatically creates a payment transaction, helping you manage account
receivables and reducing payment processing time

l Minimizes transaction errors caused by duplicate entry

l Prevents patient and staff fraud since all transactions are directly connected to the
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patient’s account

l Eliminates maintenance costs and phone lines associated with a separate credit
card terminal

l Fully complies with Payment Card Industry (PCI) and HIPAA regulations

l Supports automatic recurring electronic payments as part of a financial
arrangement on a patient account

However, settlement batch reports as well as ACH returns and voiding transactions
are handled on the TransFirst side via their Virtual Terminal web interface.

Credit card transactions automatically settle at midnight. ACH transactions
automatically settle at midday.

Note: DAISY does not store user credit card or bank account information. Only the last
four digits of the credit card or bank account number are stored in DAISY.

commSet up a payment profile
To process electronic transactions for an account, especially for recurring payments,
you can save payment information, such as credit card or checking account numbers,
in a payment profile. Each account can have one or more payment profiles. These
profiles are Payment Card Industry (PCI) compliant.

Note: Users must have the “Allow access to Transactions” permission to set up, modify,
and delete payment profiles.

Set up a credit card payment profile

► To set up a credit card payment profile:

1. From the DAISY toolbar, click .

2. Search for and select the account, then click OK.

3. In the Account window, click the Payment Profiles tab.

4. Click .

5. In the Add a Payment Profile dialog window, click Credit Card.
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6. Do one of the following:
l Swipe the credit card through the credit card reader to feed in the credit card

information, then go to step 11.
l If you are entering all card information manually, go to step 7.

7. In the Card Number text box, type the credit card number.

8. In the Expiration Date drop-down list, select the month and year.

9. In the Card Holder Name text box, type the card holder name.

10. In the Zip Code text box, type the billing address zip code for this credit card.
Note: DAISY automatically fills in this text box with the guarantor’s primary zip code.

11. From the Location drop-down list, select the office where the payment is being
made.

12. Click Submit to save the profile.
l If the credit card is approved, you see the DAISY A/R dialog box with the word

“Approved.”
Note: A status of Approved is not a guarantee that funds are available.

l If the credit card is denied, you see the DAISY A/R dialog box with the word
“Denied.”

13. Click OK to close the window.
You see the new credit card payment profile.
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Set up an ACH payment profile

► To set up an ACH payment profile:

1. From the DAISY toolbar, click .

2. Search for and select the account, then click OK.

3. In the Account window, click the Payment Profiles tab.

4. Click .

5. In the Add a Payment Profile dialog window, click ACH.
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6. In the Routing # text box, type the bank routing number.

7. In the Bank Account # text box, type the bank account number.

8. In the Check Type section, choose the type of check to process.

9. In the Account Type section, choose the type of bank account.

10. In the Check Signer text box, type the name of the person who authorized the
payment.
For example, the authorizer could be the patient or the person whose name is on
the bank account. You can type up to 25 characters, including spaces.

11. In the Memo text box, type a memo about this profile, if needed.
The memo displays in the Comment column for this payment in the Ledger
window.
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12. From the Location drop-down list, select the office where the payment is being
made.

13. Click Submit to save the profile.
l If the routing number and bank account number are approved, you see the

DAISY A/R dialog box with the word “Approved.”
Note: A status of Approved is not a guarantee that funds are available.

l If the routing number or bank account number are denied, you see the DAISY
A/R dialog box with the word “Denied.”

14. Click OK to close the window.
You see the new ACH payment profile.
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Delete a payment profile
When you delete a payment profile in the Account window, DAISY also inactivates the
profile information on TransFirst.

► To delete a payment profile:

1. From the DAISY toolbar, click .

2. Search for and select the account, then click OK.

3. In the Account window, click the Payment Profiles tab.

4. Select the payment profile you want to delete.

5. Click .

6. Click OK to close the DAISY A/R dialog window.

Set up an auto-pay financial arrangement
You can use a payment profile to set up automatic recurring payments as part of a
financial arrangement on a patient account.

► To set up a financial arrangement with automatic recurring payments:

1. From the DAISY toolbar, click .

2. Search for and select the account, then click OK.

3. In the Account window, click the Financial Arrangement tab.

4. Click New to create a new financial arrangement.
Note: This also removes the previous financial arrangement.

5. In the Auto-Pay Profile drop-down list, select the payment profile to use for auto-
pay.
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6. To clear the financial arrangement when the account balance reaches zero, check
the Automatically Remove If Balance Goes to Zero check box.
Clearing the arrangement prevents DAISY from withdrawing funds once the
account balance reaches zero. DAISY clears the arrangement during auto-pay
processing.
Note: You only see the check box if you select a payment profile.

7. To add to the default disclaimer for this financial arrangement, do one of the
following:

l Next to the Disclaimer text box, click , then select a canned disclaimer, and
click OK.

l In the Disclaimer text box, type a new disclaimer.
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Note: By default, DAISY uses the disclaimer from the Financial Setup tab in the
Practice window.

8. In the Enter the Amount Owed text box, type in the total amount owed.
This is the gross amount before deducting the down payment.

9. In the Enter the Down Payment text box, type in the down payment, if any.

10. In the First Payment Due Date and Payment Due Day text boxes (if you don’t want
to use the default dates), type in changes.

11. Under Select How to Calculate the Payment, do one of the following:
l To calculate the payment by the number of payments a patient wants to make,

choose Number of Payments. In the text box, type in a number of monthly
payments. Click Calculate, then click Yes to save the arrangement.

l To calculate a payment by the amount the patient wants to pay monthly,
choose Monthly Payment. Type in the monthly payment amount. Click
Calculate, then click Yes to save the arrangement.

In the Summary section, you see that the amount financed is calculated for you; it
equals the Amount Owed minus the Down Payment. If you are assessing interest,
you also see the default interest rate or rebill fee displayed in the Summary
section.
Note: DAISY calculates the final payment amount when you click Calculate.

Process a credit card payment
You can process a credit card payment from the following DAISY windows:

l Transactions

l Ledger

l Quick Estimate

You enter the payment either by swiping the credit card through a credit card reader
connected to your computer, by typing in the credit card information, or by selecting
a payment profile.

Note: For more information about payment profiles, see "commSet up a payment
profile" on page 182.

► To process a credit card payment from the Transactions window:

1. From the DAISY toolbar, click .

2. In the Transactions window, click By Account.

3. Click the Payments tab.
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4. Do one of the following:
l If the account is listed in the Accounts/Patients tree on the left-side of the

window, click the account name.
l If the account is not listed, right-click in the Accounts/Patients section and

select Select an Account.  Search for the account, then double-click the
account name.

5. Do one of the following:
l From the Tools menu, select Credit Card Payment.
l Swipe the credit card through the credit card reader to feed in the credit card

information.
You see the Credit Card Payment dialog window.

6. Do one of the following:
l If you are entering all card information manually, go to step 7.
l If you swiped the card,  you see the card number, expiration date, and card

holder name filled in. Go to step 10.
l If you are using a payment profile for this account, select the profile in the

Payment Profile drop-down list, type the payment amount in the Amount text
box, then go to step 14.

Questions? www.softwarefordentists.com 1.800.368.6401190

http://www.softwarefordentists.com/


Chapter 9  Manage financial information

Note: For more information about payment profiles, see "commSet up a payment
profile" on page 182.

7. In the Card Number text box, type the credit card number.

8. In the Expiration Date drop-down list, select the month and year.

9. In the Card Holder Name text box, type the card holder name, if available.

10. In the Zip Code text box, type the billing address zip code for this credit card, if
available.

11. In the Amount textbox, type the payment amount.

12. In the CVV2 text box, type last three digits on the signature panel on the back of
the credit card, if available.

13. From the Location drop-down list, select the office where the payment is being
made.
Note: DAISY defaults to this location the next time you make a payment.

14. Click Submit.
l If the payment is approved, you see the DAISY A/R dialog box with the word

“Approved.”
l If the payment is denied, you see the DAISY A/R dialog box with the word

“Denied.”
Note: For security reasons, you cannot post the same dollar amount on the same day
from the same card.

15. Click OK to close the window.
In the Transactions window, you see the unposted payment in the Payments tab.
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If you used a payment profile to make the payment, you also see “CC On File” in
the Comment column.

Print a credit card receipt
After you complete a credit card transaction, you can print a Visit Summary report
that includes a responsibility statement and signature line. This report can be used as
a credit card receipt.

► To print a credit card receipt:

1. Open the Transactions window.

2. Search for and select the account, then click OK.

3. From the Reports menu, do one of the following:
l Select Visit Summary.
l Select Visit Summary with Patient Responsibility.

4. Do one of the following:

l To preview the report first, click Preview, then click to print it.
l To print the report without previewing it, click Print.
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Void a credit card payment
You can only void credit card payments that are not settled and only for the full
amount of the original payment.

You can void transactions from the Transactions and Ledger windows.

Note: TransFirst settles credit card transactions each day at midnight.

► To void a credit card payment from the Transactions window:

1. Open the Transactions window.

2. Search for and select the account, then click OK.

3. Click the Payments tab.

4. Right-click the credit card payment and select Remove.
Daisy removes the payment from the Transactions window.

Note: If TransFirst has settled the credit card payment, the right-click menu will not
show a Remove option; you can only refund the amount. To refund a credit card
payment, see "Refund a credit card payment" on page 193.

Refund a credit card payment
After TransFirst settles a credit card payment, you can no longer void the payment.
However, you can issue a refund for:

l Unposted credit card payments from the Transactions window

l Posted credit card payments from the Ledger window

Credit card refunds are issued to the cardholder who made the original payment.

Note: TransFirst settles credit card transactions each day at midnight. To void an
unsettled credit card payment, see "Void a credit card payment" on page 193.

► To refund a credit card payment:

1. From the DAISY toolbar, click to open the Ledger window.

2. Search for and select the account, then click OK.

3. Right-click the credit card payment and select Refund to Credit Card.
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You see the Credit Card Refund dialog window.

4. In the Refund Amount text box, type the refund amount, then click OK.
Note: You can do full or partial refunds.
You see the adjustment in the ledger as a Refund to CC and the transaction ID in
the Comment column.
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Process an ACH payment
An automatic clearing house (ACH) payment is handled as an electronic debit to
checking and savings accounts. You can make automatic clearing house (ACH)
payments from the Tools menu in the following DAISY windows:

l Transactions

l Ledger

l Quick Estimate

You enter the payment either by typing in the bank routing and account information
or by selecting a payment profile.

Note: For more information about payment profiles, see "commSet up a payment
profile" on page 182.

► To process an ACH payment from the Transactions window:

1. From the DAISY toolbar, click .

2. In the Transactions window, click By Account.

3. Click the Payments tab.

4. Do one of the following:
l If the account is listed in the Accounts/Patients tree on the left-side of the

window, click the account name.
l If the account is not listed, right-click in the Accounts/Patients section and

select Select an Account. Search for the account, then double-click the account
name.
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5. From the Tools menu, select ACH Payment.
You see the ACH Payment dialog window.

6. Do one of the following:
l If you are entering all payment information manually, go to step 7.
l If you are using a payment profile for this account, select the profile in the

Payment Profile drop-down list, type the payment amount in the Amount text
box, then go to step 16.

Note: For more information about payment profiles, see "commSet up a payment
profile" on page 182.

7. In the Routing # text box, type the bank routing number.

8. In the Bank Account # text box, type the bank account number.

9. Under Check Type, choose one:
l Personal to process a personal check.
l Business to process a business check.

10. Under Account Type, choose one:
l Checking for a checking account.
l Savings for a savings account.

11. In the Check Signer text box, type the name of the person who authorized the
payment.
For example, the authorizer could be the patient or the person whose name is on
the bank account. You can type up to 25 characters, including spaces.

12. In the Amount text box, type the payment amount.

13. In the Check # text box, type the check number, if available.
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Some individuals may want to void a personal or business check and use it as a
record of the payment transaction.

14. From the Location drop-down list, select the office where the payment is being
made.

15. In the Memo text box, type a memo about this transaction, if needed.
The memo displays in the Comment column for this payment in the Ledger
window.

16. Click Submit.
l If the ACH payment is approved, you see the DAISY A/R dialog box with the

word “Approved.”
l If the ACH payment is denied, you see the DAISY A/R dialog box with the word

“Denied.”

17. Click OK to close the window.
In the Transactions window, you see the unposted payment in the Payments tab.

If you used a payment profile to make the payment, you also see “ACH On File” in
the Comment column.
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Print a receipt for an ACH payment
After you complete the ACH payment, you can print a Visit Summary report that
includes a responsibility statement and signature line. This report can be used as a
receipt for the ACH payment.

► To print a receipt for an ACH payment:

1. Open the Transactions window.

2. Search for and select the account, then click OK.

3. From the Reports menu, do one of the following:
l Select Visit Summary.
l Select Visit Summary with Patient Responsibility.

4. Do one of the following:

l To preview the report first, click Preview, then click to print it.
l To print the report without previewing it, click Print.

Questions? www.softwarefordentists.com 1.800.368.6401198

http://www.softwarefordentists.com/


Chapter 9  Manage financial information

Void an ACH payment
You cannot void ACH payments in DAISY. To void an ACH payment, you must first
log on to TransFirst Virtual Terminal and cancel the transaction, and then you remove
it like any other transaction from the Ledger in DAISY.

You can cancel a transaction in TransFirst only if it has not been settled and only for
the full amount of the original payment. After an ACH payment has been settled, you
must issue a refund.

Note: ACH settlement occurs at midday.

For more information about voiding an ACH payment, see the Transfirst Virtual
Terminal documentation.

Manage ACH returns
ACH payments may be returned due to non-sufficient funds. To view returned ACH
payments, you log on to the TransFirst Virtual Terminal and run the ACH Returns
report. For more information about running the ACH Returns report, see the Transfirst
Virtual Terminal documentation.

ACH returns also need to be reversed in the DAISY ledger.

► To reverse an ACH payment in the DAISY ledger:

1. From the DAISY toolbar, click to open the Ledger window.

2. Search for and select the account, then click OK.

3. Right-click the ACH payment and select Reverse Payment.

4. In the Payment Reversal window, optionally type a comment, then click OK.
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5. In the Confirm window, click No to complete the adjustment.
You see the ACH payment reversed in the ledger.

Process auto-pay transactions
When one or more auto-pay payments are due, you see an Auto-Pay Is Due link on
both the Transactions window and the Daisy Central window.
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► To process auto-pay transactions:

1. In the Transactions or DAISY Central window, click Auto-Pay Is Due.
You see all of the auto-pay payments that are ready to be processed.
Note: Payments that are overdue for processing may have been declined. For more
information, see the TransFirst Virtual Terminal documentation.
To process an auto-pay payment, the check box next to the auto-pay payment
must be checked. All payments are checked by default.

2. Uncheck any auto-pay payments that you do not want to process.

Note: Regardless of an account’s balance, this dialog window does not show auto-pay
accounts that are in collection.

3. Click OK.
In the Transaction window, DAISY creates an unposted transaction for each
automatic payment. In the Comment column of each transaction you see “Auto-
Pay.”

After you process automatic payments, DAISY does the following:
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l Calculates the next payment due date based on the prior due date, even if the
prior payment was processed late or declined.

l If the prior payment’s due date was on the 29th, 30th, or 31st of the month, and
the next payment is due on a month that does not have as many days, DAISY sets
the payment due date for the last day of the month.

l When an automatic payment is declined, it remains in the Process Auto-Pay dialog
window, so you can include it the next time you process auto-pay payments.Other
Enhancements

Manage collection accounts
You can manage collection accounts by removing collection balances from the
doctor’s accounts receivable (A/R) until the patient makes a payment.

Set up adjustment types for collections
To manage collection balances, set up the following adjustment types:

l Collection Agency Fee

o Collection Account Write-off

o Collection Balance Forward

Note: If you already have adjustment types with the same meanings but with different
names, use them instead of creating new ones.

► To add an Adjustment Type:

1. From the DAISY menu, select Configure, then List Maintenance.

2. Click the Simple Lists tab.

3. From the Simple Lists drop-down list, select Adjustment Types.

4. Right-click and select New Item.

5. Type in the new item.
You see the new item added to the table.
Note: DAISY automatically alphabetizes the list for you, so the item you added may
not be at the bottom of the table.

6. For each additional adjustment type, repeat steps 4 through 5.

7. Click and close the Lookup List Maintenance window.
Note: If you want to track collection payments, set up and use a Collection Account
payment type.
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Remove collection balances from the A/R
Using this method, you turn over the account to a collection agency, then when
payment is made, you enter the payment.

Turn over the account to a collection agency

► To turn the account over to a collection agency:

1. From the DAISY toolbar, click .

2. Click the By Account button, then click the Adjustments tab.

3. Do one of the following:
l If the account is listed in the Accounts/Patients tree on the left side of the

window, click the account name.
l If the account is not listed, right-click in the Accounts/Patients section and

choose Select an Account. Search for the account, then double-click the one
you want.

4. Click the Adjustment Type column.

5. From the list, select the adjustment type for noting a collection account write-off,
then press Tab.
For example, select Collection Account Write-off.

6. In the Amount column, type a minus (-) in front of the outstanding amount, then
press Tab to save the amount.

7. Click and then close the window.

Once the payment is made, you need to enter it. For example:

The patient sends the collection agency $100.00. The collection agency keeps $40.00
and sends your office $60.00.

Before you begin, the account balance is $0.00. You add the collection balance forward
($100.00), then you subtract the collection agency fee ($-40.00). You must use a minus
when you enter the amount. Finally, you subtract the payment ($60.00). Payments
automatically subtract. The account balance is $0.00 again.
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Enter the collections payment

► To enter a payment from the collection agency:

1. From the DAISY toolbar, select Transactions.

2. Click the By Account button, then click the Adjustments tab.

3. Do one of the following:
l If the account is listed in the Accounts/Patients tree on the left-side of the

window, click the account name.
l If the account is not listed, right-click in the Accounts/Patients section and

choose Select an Account. Search for the account, then double-click the one
you want.

4. Click the Adjustment Type column.

5. From the list, select the appropriate adjustment type for noting a collection
balance forward, then press Tab.
For example, select Collection Balance Forward.

6. In the Amount column, type the entire amount the patient paid the collection
agency.

7. Press the Down Arrow key to move to the next row.

8. Click the Adjustment Type column.

9. From the list, select the appropriate adjustment type for noting the collection
agency’s fee, then press Tab.
For example, select Collection Agency Fee.

10. In the Amount column, type a minus (-) in front of the outstanding amount, then
press Tab to save the amount.

11. Click to post the adjustment.

12. In the Transactions window, click the Payments tab.

13. Enter a payment for the amount of the check received from the collection agency.

14. Click to post the payment.

Frequently asked questions

Q. (Troubleshooting collections) Is there an easy way to send a collection letter to
one account?
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Yes. If you don’t already have a collection letter set up as an Instant Merge
document, you must first create the appropriate collection letter and place it in the
Report Gallery under the Instant Merge folder in the Account subfolder. Then you
open the appropriate account and select the collection letter from the Reports menu.

► To create and place the merge document in the Account folder:

1. Open the Report Gallery.

2. Double-click the Instant Merge folder, then double-click the Account folder.

3. In the Account window, move the cursor until it points at an empty spot (not at a
report).

4. Right-click and select New, then Merge Document.

5. In the Select Merge Template search window, search for and select the appropriate
collection letter template, then click OK.

► To generate the collection letter for a specific account:

1. Open the Account window. From the Reports menu, select Merge Docs and then
choose the collection letter.

2. Do one of the following:

l To preview the letter first, click Preview, then click to print it.
l To print the letter without previewing it, click Print.

For more information about using Mail Merge and the Instant Merge folder, see "Use
Mail Merge" on page 237.

Manage capitation plans
With a capitation plan, a dentist signs a contract and is paid a small monthly fee for
each patient or each family who has signed up with the plan. The dentist receives this
small monthly fee even if the patient does not show up at the office for treatment. In
return for that fee, the dentist provides exams, cleanings, x-rays and sometimes
emergency visits for contracted patients who appear at his door.

In addition, he agrees to a fee schedule for a set number of procedures, some of
which may be paid partly by the patient and partly by the insurance company, or may
be paid entirely by the patient.
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To manage a capitation plan in DAISY, you need to complete the following
steps in this order:

1. Set up a generic capitation account called Capitation Plan with a special capitation
provider.

2. Set up an individual capitation account for each patient on the capitation plan and
assign the capitation provider to it.

3. Enter and post charges to the patient’s capitation account.

4. Enter payments in the generic capitation account.

5. Track capitation plan results (optional).

Set up a generic capitation account

► To set up a generic account to manage the capitation plan:

1. Add a new provider in Practice Configuration to track your Capitation Plan
patients.
For example, Gerome Hanks DDS Capitation.

2. Create an “Capitation Plan” Adjustment type in Simple Lists.

3. Create a generic account called “Capitation Plan” and assign the new capitation
provider to it.

Set up an individual capitation account

► To set up an individual capitation account for a patient:

l Set up each patient on his or her own capitation account and assign the new
capitation provider.

l If an existing patient’s coverage changes to a capitation plan, change the current
provider on the account to the new capitation provider. This can only be done if
the account has a $0.00 balance. If the patient’s current account has an
outstanding balance, a second account must be set up for the capitation plan.
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Post charges to the patient’s capitation account

► To post charges to a patient’s capitation account:

1. In the Transaction window, enter all charges.
These can be posted as you go or batch-posted at the end of the day. Posting the
charges will generate a claim for the capitation plan.

2. Enter a negative adjustment on each account for the total amount of the charges
posted to the patient that day.

3. Select the Capitation Plan adjustment type.
The balance on the patient account should be $0.00 at the end of the day.

Enter payments in the generic capitation account
All payments are entered in the generic capitation account that you created.

► To enter payments in the generic capitation account:

1. Open the Capitation Plan account.

2. In the Transaction window, enter the payment.

3. In the Comment column, type the dates for which the payment applies.

4. Enter a positive adjustment on the capitation account for the total amount of the
payment.

5. Select the Capitation Plan adjustment type.
Use the same adjustment type you chose when you posted the charges. The
balance on the generic capitation account should be $0.00 at the end of the day.

Track capitation plan results (optional)

► To track payments made to the generic capitation account:

l Print a Transaction Analysis report from the Monthly Closing folder in the Report
Gallery.
The total amount of the capitation account adjustments helps you track whether
the capitation plan is earning or losing money for your practice.

Troubleshooting transaction reports
Q. What should I look for when my reports don’t balance?
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l Check daily report filters. Have the filters changed since these reports were last
generated?

l Were the adjustment transactions correctly entered as debits or credits?

l Were the filters on the production reports set for the correct billing provider?

l Were the filters on the accounts receivable reports set for the correct billing
provider?

l Should finance charges or minimum balance write-offs be taken into consideration
(i.e. was a monthly closing done yesterday or today)?

l After reports were printed and the closing was run, were more transactions entered
and posted later that day? These transactions would not show up on the report if
filtering was set by posting date for the current day and printed on the following
day.

l Were the reports incorrectly filtered by both posting date and transaction date?

l Was treatment posted to a performing provider who is not being selected by the
filters set for the report? For example, if the report is currently filtered by
Performing Provider, try filtering it by Billing Provider to see if other providers
show up on the report, or to see if you get a different total.

l Were the correct filters set for Finance Charge and Minimum Balance Write-off
reports to identify the charges and write-offs that occurred during that month?

Q. I’m missing an adjustment type. What should I do?

Under Lists in DAISY, you create a list of adjustment types (such as discounts,
refunds, or send to collections) then select from this list when you enter an
adjustment in the Adjustments tab in the Transactions window.

► To add an Adjustment Type:

1. From the DAISY menu, select Configure, then List Maintenance.

2. Click the Simple Lists tab.

3. From the Simple Lists drop-down list, select Adjustment Types.

4. Right-click and select New Item.

5. Type in the new item.
You see the new item added to the table.
Note: DAISY automatically alphabetizes the list for you, so the item you added may
not be at the bottom of the table.

6. For each additional adjustment type, repeat steps 4 through 5.

7. Click and close the Lookup List Maintenance window.
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View account history
When patients call with questions about their accounts, you can find many of the
answers in the ledger. For example, some typical questions might be:

l Has my insurance company paid?

l What’s my balance?

l Did you receive my check?

Tip: If an account has a large number of entries, you might want to filter them so only
certain entries are displayed.

From the Ledger window’s View menu, select Filter Ledger. Choose the appropriate filters,
then click OK.

► To view history for a specific account:

1. From the DAISY toolbar, click to open the Ledger window.

2. Search for and double-click the account.
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Sort the ledger
In the Ledger window, entries can be sorted either by ascending (oldest to newest
transaction) or descending order. Descending order is the default setting.

► To sort the Ledger by ascending order:

1. From the DAISY menu, select Account, then select Ledger.

2. Search for and select the account, then click OK.

3. From the View menu, select Sort Ascending.

When this menu option is set to ascending order, the window automatically scrolls to
the bottom of the transactions list to keep the focus on the latest entry.

Note: The Sort Ascending menu option is user specific per workstation.

View a payment distribution from the ledger
Once a distributed payment is posted, you can view the distribution from the ledger.
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► To view a payment distribution from the ledger:

1. From the DAISY toolbar, click to open the Ledger window.

2. Search for and double-click the account.

3. Right-click the distributed payment and select View Distribution.

4. Click OK to close the View Payment Distribution dialog box.

View remits from the ledger
Once an electronic payment has been posted, you can also view the original
remittance from the insurance company in the Ledger and Claim windows.

► To view the original remittance from the Ledger window:

1. Open the Ledger window and search for the transaction associated with the EOB.

2. Right-click the transaction and select View Remit to open the remittance.
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11 Manage claims
DAISY automatically generates claims each time you post charges. A separate claim is
created for each patient for each date of service for each billing provider. Until you
process a claim by either running Closing or by printing it, you can still make changes
to a claim. For example, you can modify the patient’s insurance coverage, such as:

l Add primary or secondary coverage

l Remove primary or secondary coverage

l Change the subscriber

DAISY is commonly set up to automatically put secondary claims on hold so you
won’t accidentally bill both insurance companies at the same time. However, should
you prefer to do this manually, you can also place individual claims on hold. In
addition, you can supply prosthetic and accident information, and add remarks about
a claim. For more information, see "Set up a service location address" on page 505.
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Work with claims

View a claim

► To view a claim:

1. From the DAISY toolbar, click to open the Claim History window.

2. In the top half of the Claim History window, set one or more of the following
filters to help you find the claim(s) you want:
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Under this
filter...

Do this...

Claim Status Check one or more claim statuses.

Claim Type Check one or more claim types.

Date Filter In the first drop-down list, select a type of date.
For example, select Service Date.

In the From and To drop-down lists, select a
starting and ending date.

Filter By Select the type of information to search by. For
example, select Patient.

Click . Search for and select the item you
want, then click OK. Your choice displays under
Currently Selected.

Billing Provider From the drop-down list, select the provider
who is billing the insurance company.

Routing From the drop-down list, select the routing
method for the claim, such as Send or Print.

Origin From the drop-down list, select the origin of the
claim, such as Rebill or Ledger.

3. Click Apply.

4. In the search results, double-click the claim you want to view.
In the following example, you see an Open claim for Nick Smith.
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5. Make the appropriate changes to the claim.
For example, if a claim is denied by the patient’s insurance company, change the
status to Denied.

6. Click , then close the Claim window.

Resend claim information
Sometimes you need to resend claim information to an insurance company. For
example:

l The patient didn’t provide insurance information when the charges were originally
posted.

l The patient gave inaccurate insurance information.

l Insurance information was accurate, but the insurance company did not receive
the claim.

Rebill and new ledger claims take existing claim information, modify it if needed, then
bill or rebill the appropriate insurance company.
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l The Rebill Claim option generates a duplicate of the original.

l The New Ledger Claim option generates a revised claim that includes any changed
account or insurance information.

Rebill an insurance claim

A rebill claim creates a duplicate of the original.

Tip: To select more than one procedure, press CTRL while you click the primary mouse
button.

► To rebill a claim:

1. From the DAISY toolbar, click to open the Claim History window.

2. Search for the claim that needs rebilling.

3. Right-click on the claim, and select New Rebill Claim.

4. Select the procedures that need rebilling or click Select All to select all the
procedures.

5. Click OK.
The Claim window opens so you can review the New Claim in detail.
Note: The original claim status is automatically cancelled when the rebill claim is
created.
Your rebill claim gets transmitted to DMC during the next Data Exchange.

Create a ledger claim

A ledger claim generates a revised claim that includes any changed account or
insurance information. For example, you posted charges for a patient who did not
initially have insurance, or the claim was billed to the wrong insurance company.

Tip: You can also access the Ledger from the Quick Access toolbar in the Claim window.

Click to access ledger information for the specific account.

► To create a ledger claim:

1. From the DAISY toolbar, click and open the Ledger window.

2. Search for and double-click the account.

3. Right-click and select New Ledger Claim.
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4. From the Patient drop-down list, select the appropriate patient.

5. Select the procedures to include with the new claim or click Select All to select all
the procedures.

6. Click OK.

7. In the Confirm dialog box, click Yes to view the claim; otherwise click No.
Note: Remember to cancel the original claim once the ledger claim is created.
Your new ledger claim gets transmitted to DMC during the next Data Exchange.

Send primary and secondary claims simultaneously
Even if DAISY is set up to automatically hold your secondary claims, you may
occasionally need to override the auto-hold setting to send both claims at the same
time. Both types of claims will be sent during Daily Closing.

Override the auto-hold on claims that are batch posted

► To batch post and override the secondary claim auto-hold:

1. From the DAISY toolbar, click to open the Transactions window.

2. Click the By Type button.

3. From the Show Summary For drop-down list, select the Charges transaction type.

4. Right-click in the Transactions window and select Post Charges.

5. To post the charges, click Yes.

6. From the DAISY toolbar, click .

7. In the Claim History window, search for the claim that you want.
The claim should have a status of New.

8. Double-click the claim to open it.

9. In the Claim window, click the Insurance tab.

10. To the right of the Other Carrier section, uncheck the Hold check box.
Note: The Hold check boxes in the Claim window only display when the claim status
is New.
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11. Click to save the change.

12. Close the window.

Override the auto-hold on individually posted charges

► To individually post charges and override the secondary claim auto-hold:

1. From the DAISY toolbar, click .

2. Click the By Account button.

3. Click the Charges tab.

4. To view a patient’s charges, click the patient’s name in the Accounts/Patients tree.

5. Click to post the charge(s).

6. In the confirmation window, click Yes to open the claim.
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7. Click the Insurance tab and then to the right of the Other Carrier section, uncheck
the Hold check box.

8. Click to save the change and then close the window.

Use the New Claim Summary report
Once you’ve posted all your transactions, you may want to run a New Claim Summary
report. Use this report as a worksheet to help you make changes to accounts or to
claims that were generated during the workday. The report lists every patient for
whom charges have been posted for that day, and whether or not each has insurance.

Note: If a patient’s insurance coverage isn’t entered, a claim won’t be processed for that
patient.

You can also see if the patient has both primary and secondary insurance.

Once the primary pays, DAISY tells you if you have a secondary claim on hold. DAISY
automatically releases the secondary claim when the primary is paid. The secondary
insurer can now pay the difference.

Tip: If a patient has a secondary insurance claim on hold, DAISY displays in the RC
column in the Transactions window when you enter the payment from the patient’s
primary insurance.

Note: A New Claim Summary report must be generated after posting, but before you run
Closing. Daily Closing clears the file from which this report is generated.

► To run a New Claim Summary report:

1. From the DAISY toolbar, click to open the Claim History window.

2. Click Reports and select New Claim Summary.

3. Do one of the following:

l To preview the report first, click Preview, then click to print it.
l To print the report without previewing it, click Print.

Work with claim history
Use the Claim History window to view a list of current claims, as well as claim
history. You can sort by claim status, type, date, billing provider, routing method, and
claim origin.
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The columns in this window can be moved and resized. You can then sort any column
into ascending or descending order. Also, filtering options at the top of the window
enable you to pare down the claims list so it is more manageable.

l To sort a column into ascending or descending order, click the column heading.

l To change filtering options, in the Claim Status section check the type of claims
you want to view. Uncheck the ones you don’t want to view.

This claim status... Means...

New Unprocessed claim

Hold Processed claim not yet sent to the insurance
company

Open Processed clain sent to the insurance company
and awaiting a response

Pending Secondary claim that was on hold and is ready to
be sent to the insurance company, or for an
unprocessed rebill

Paid A payment has been posted for the claim

Part-Paid Claim that requires additional payments

Approved Pre-authorized claim

Denied Claim denied by the insurance company

Cancelled Claim that you chose to cancel

Excluded Claim that is no longer needed
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Note: These changes apply only to the specific user on the specific computer.

Research a claim
If any claim payments in an electronic remittance required additional research, you
can filter for those claims in the Claim History window, and continue the research
process.

► To view claims marked for research:

1. Open the Claim History window.

2. Click .
You see only those claims that are marked for research.

3. Double-click the claim you want to view.
The Claim window opens. The information you typed earlier in the Reason for
Research dialog box now shows in the Claim Notes section of the Claim window.
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4. When you finish researching the claim, uncheck the check box in the claim’s
Research column.

5. Click to save your changes.

Troubleshooting claims
Q. How do I determine if services from a previous date were billed to a patient’s
insurance?

If a transaction in the ledger has an asterisk in the Code column, then the charge has
been billed to the patient’s insurance.
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► To determine if a service has been billed:

1. From the DAISY toolbar, click Post and select .

2. Search for and double-click the account.

3. Locate the appropriate charge and check the Code column for an asterisk.

4. To view the transaction’s claim history, right-click it and select Open Related
Claim.

Q. The information in the Claim History window doesn’t seem to be in any
particular order. Can I rearrange it?

Yes. The columns in this window can be moved and resized. You can then sort any
column into ascending or descending order. Also, filtering options at the top of the
window enable you to pare down the claims list so it is more manageable.

l To sort a column into ascending or descending order, click the column heading.

l To change filtering options, in the Claim Status section check the type of claims
you want to view. Uncheck the ones you don’t want to view.

Note: These changes apply only to the specific user on the specific computer.

Q. I submitted a claim for a patient, but the claim was denied because the patient
is no longer eligible for that coverage. However, the patient has new insurance.
What should I do?

If the patient has new insurance that is valid for the visit you billed, you need to:

l Update the patient’s insurance information.

l Change the original claims status to Cancelled.
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l Create a new ledger claim. A ledger claim can pull in procedures from previous
claims and attach them to the new claim. For information about setting up a
ledger claim, see the “Manage Claims” chapter in the Getting Started Guide.

Estimates on statements and quick statements, as well as your receivables, depend on
the accuracy of claims in DAISY. Always remember to change the original claim’s
status to Denied or Cancelled if it will never be paid.

Q. My claim rejection report says “Claim has a missing or invalid provider
number.” What does this mean?

Because of HIPAA regulations, some insurance carriers have decided to create a
Provider ID number that needs to be included (in addition to or instead of the
traditional Tax ID number or Social Security Number) on all dental claims. If you
receive this message, then you need to change the Provider ID information in DAISY.
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12 Use DAISY reports
Most DAISY reports are stored in the DAISY Report Gallery, but you can run many of
DAISY’s most common reports from the Reports menu in the appropriate DAISY
window. For example, common daily reports related to posting, such as the
Transaction Analysis report or the Unposted Transactions report, can be run from the
Transactions window. Common reports, such as route slips or the daily schedule, can
be run from the Reports menu in the Schedule.

These common reports can be run without setting filters. Other reports are run from
the Report Gallery. For more information, see "Define the scope of a report" on page
231.

Whenever you run a report, you can choose to preview it first or send it directly to
the printer. You can also export generated reports into other file formats, such as
Microsoft Word (.doc) and Excel (.xls), and Adobe Acrobat (.pdf).

About the Report Gallery
Most DAISY reports are stored in the Report Gallery. Each folder in the gallery houses
reports or documents that pertain to the title of the folder. For example, the Account
folder contains account reports, such as Account Aging. You can run any of these
reports directly from the Report Gallery.
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Note: A few reports, such as the Visit Summary, can only be accessed from the Reports
menu in specific DAISY windows.

Tip: If you have a set of reports that you run on a regular basis, such as those you run at
the end of each day, you can set up a special folder and place copies of those reports in
the folder.

Tip: If you have Microsoft Word, you can also merge patient and account information
into Mail Merge documents. For more information, see "Use Mail Merge" on page 237.

Reports in the Report Gallery are organized as follows:
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This folder... Contains...

Account Account status reports, particularly financial status,
such as account aging and history.

Appoint Appointment reminders, details, lists.

Claims/Insurance Claim aging and insurance coverage reports, such as a
list of everyone covered under a specific insurance
plan.

Daily Closing Reports an office typically runs at the end of each day.
For example, a transactions report, new accounts
receivables.

The Aging Report by Provider Summary must be run
and printed every day if you use it for balancing your
accounts. The details of this report cannot be recreated
once you have posted new payments, charges, and

adjustments.

Financial
Arrangements

Reports to help you with accounts (insured and
uninsured) that have financial arrangements.

Instant Merge Mail Merge documents that you want to access from
Account or Patient window Report menus.

Labels Several kinds of print labels (patient address, chart,
recall, and referral).

Mail Merge All Mail Merge documents.

Be sure to set filters prior to running a Mail Merge
document to avoid generating letters for every account
or patient in the system.

Monthly Closing Reports an office typically runs at the end of each
month. For example, Aging by Provider Summary,
Statement History, Finance Charges, and Minimum
Balance Write-off.

Patient Reports and forms associated with patient information.
For example, route slips, prescription forms, patient
list reports.

Procedures/Fees Reports about procedures or fees entered into the
system. For example, the Fee Schedules report lists all
procedures and their associated fees.

Production Reports that show the amount of charges each provider
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This folder... Contains...

Tracking has produced for a specific time period, such as day,
month, or year. The Activity Analysis report breaks
down this activity by procedure code.

Quarterly Closing Reports an office typically runs at the end of each
quarter.

Recall Recall reports, and recall cards and labels. The Recall
by Patient report can show you recall status for all
patients.

Referrals Reports that show the number of patients that were
referred to you, referred by you, and by what means.
You can also print labels for doctors to whom you refer
patients.

System Lists Reports that show the contents of system lists found
under the Lists menu of DAISY.

Treatment Plans Reports about the treatment plans in your system. For
example, you can view outstanding treatment plans, or
treatment plan status by provider.

Yearly Closing Reports an office typically runs at the end of the year.

Run a pre-filtered report
The filters on reports you run from the Reports menu in DAISY are preset and
unchangeable. Should you need to use different filter settings for any of these reports,
you can change the filters and run the report from the Report Gallery. For more
information see "Define the scope of a report" on page 231.

The following procedure illustrates how you can run a report from the Account
window. From there you can print information about the account you are currently
displaying, such as financial arrangements, account profile, statement history, and a
visit summary.

Tip: To cancel a report while it is generating, click on the DAISY Report Viewer
toolbar.
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► To run a pre-filtered report from the Account window:

1. From the DAISY toolbar, click .

2. Search for an select the account, then click OK.

3. From the Reports menu, select the report you want to run.

4. Do one of the following:

l To preview the report first, click Preview, then click to print it.
l To print the report without previewing it, click Print.

If your DAISY database is large, the report may take a minute or two to generate.

Define the scope of a report
Each report has a number of changeable properties (also called filters) that you can
define, so you can select the information you want reported. You can set one or more
filters for a report. When you install DAISY, the properties of each report are preset to
the most common settings.

On some reports you don’t need to set filters. However, if no filters are set, the report
will include information you may not want to see. For example, if you don’t filter the
Account Aging report, you’ll see all accounts including those with a zero balance.

► To define the scope of a report:

1. From the DAISY toolbar, click .

2. Double-click on the appropriate reports folder.

3. Right-click on the report you want and select Properties.
For example, if you right-click on the Account aging report, you see:
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4. Click Reset to remove any filtering from the last time you ran the report.

5. Click a tab and choose the filters you want to apply.
For example, click the Account Provider tab. Now you can select the filters you
want. In the previous example, the filter selected is Account Provider Is Equal To
Smith DMD, Jane [1].

6. To set more filters, repeat step 5.

7. Click OK.

Tip: To cancel a report while it is generating, click on the DAISY Report Viewer
toolbar.
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Run a report from the Report Gallery
When you run a report, it automatically displays first on your screen so you can
review the contents, then you can choose to print it.

► To run a report from the Report Gallery:

1. From the DAISY toolbar, click to open the Report Gallery.

2. Double-click on the appropriate reports folder.

3. Double-click on the report you want to run.

4. To print the report, click .

Archive a Report Gallery folder's reports
Reports can be stored in the DAISY document archive directly from the Report
Gallery. For example, if you have a folder of reports that you print everyday, you can
easily run and archive all of the reports in that folder to the practice.

► To archive all of the reports in a Report Gallery folder:

1. From the DAISY toolbar, click to open the Report Gallery window.

2. Double-click on the folder that contains the reports.

3. For each report, do the following:
a. Right-click on the report and select Properties.
b. Set the properties for the report to generate the correct information when the

report runs.
c. Click OK.

4. Right-click on the folder to archive and select Archive.
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5. Select the document type you want to use for all of the archived reports, then click
OK.
You see an information dialog box showing you the progression as each of the
reports are archived.
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6. When done, click OK.

Note: For more information about the DAISY document archive, see "Use Document
Manager" on page 289.
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13 Use Mail Merge
You can use Mail Merge to easily merge information from DAISY into a Microsoft
Word document. DAISY provides you with a variety of common Mail Merge templates
that you can use to merge with information from DAISY’s Account and Patient
windows. For example, you can generate a customized welcome letter for all new
patients during the current month.

You can also create your own Mail Merge documents and access them from the
Report Gallery in the Mail Merge folder. And, if you store these Mail Merge
documents in the Instant Merge folder inside the Account or Patient subfolder, you
can access them from the Reports menu in the Account or Patient windows, and from
the Transactions window in the By Account view. For example, you may want to
generate consent letters from the Patient window.

Create a Mail Merge document
If you want to use more merge documents than are provided in DAISY, you can create
your own Mail Merge document.

Note: You must have Microsoft Word installed on your system to create a Mail Merge
document.

Tip: If you don’t know which template to search for, you can view a list of all available
templates:

In the Select Merge Template search window, click .

► To create a Mail Merge document:

1. From the DAISY toolbar, click .

2. In the Report Gallery, double-click the Mail Merge folder to open it.

3. In the Mail Merge folder, right-click and select New, then Merge Document.

4. In the Select Merge Template search window, search for and select the
appropriate template to use for your merge document, then click OK.
For example, select Continuing Care. The document you want displays in the
Mail Merge folder.
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Note: If you already have a document based on the same template, the name of the
new icon will have a number after it in parentheses to indicate that you have that
number of letters based on the same template. For example, Continuing Care (2).

5. Right-click the icon you want and select Properties.

6. Set the appropriate filters, then click OK.

7. Double-click the new icon. The document opens in Microsoft Word.

8. If you need to make changes or add text, edit the document.
Note: You can also bring in variable data such as the patient’s first name, last name,
and address. For example, in Word 2003, click the Insert Merge Field button on the
Word toolbar and select the merge field you want to include.

9. From the Word menu bar, select File, then Save.

10. Close the Word window.

Make a Mail Merge document available from the
Reports menu
If you want a document to be available as an Instant Merge document so it can be
accessed from the Reports menu, copy it into the appropriate subfolder in the Instant
Merge folder.

► To make the document available from the Reports menu in a DAISY
window:

1. From the DAISY toolbar, click .

2. In the Report Gallery, double-click the Instant Merge folder.
You see the Account, Patient and Insurance Coverage folders.

3. Double-click the folder that corresponds with the window from which you want
to generate a merge document.

4. Add the document to the appropriate folder.

5. Close the Report Gallery windows.

Generate a Mail Merge document
You can create merge documents from the Report Gallery and access them from the
Reports menu in the Account and Patient windows, as well as the Transactions
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window from the By Account view.

Note: You must have Microsoft Word installed on your system to create a Mail Merge
document.

Generate a document from the Report Gallery

► To generate a Mail Merge document from the Report Gallery:

1. From the DAISY toolbar, click Reports.

2. In the Report Gallery, double-click the Mail Merge folder to open it.

3. Right-click the icon you want and select Properties.

4. Set the appropriate filters, then click OK.

5. Double-click the document you want to use.
The merged letters open in Microsoft Word. Use the arrows in Word’s Merge
toolbar to view each letter.

6. To print the letters, do one of the following:
l To print the letters one at a time, use Word’s print function. From the File

menu, select Print.
l To print the entire group, close the report in Word. In the Mail Merge folder,

right-click the report and select Print.

Generate a document from a DAISY window
If you want a Mail Merge document to be available from the Account, Patient, or
Insurance Coverage windows, copy it into one or more of the appropriate subfolders
(Account, Patient, or Insurance Coverage) in the Instant Merge folder.

► To generate Mail Merge documents from a DAISY window:

1. In the appropriate window, click Reports and select Merge Docs, then select a
document.

2. In the Print Options window, select one of the following:
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Choose this option... To do this...

Preview Preview the report and optionally print it from
the Preview window.

Print Print the report.

Cancel Cancel the report.

Generate a Mail Merge document for a selected
group
You can send personalized documents to a selected group, such as a form letter to all
patients whose accounts show no activity for the last seven months.

► To generate a Mail Merge document for a selected group:

1. From the DAISY toolbar, click Reports.

2. In the Report Gallery, double-click the Mail Merge folder to open it.

3. In the Mail Merge folder, select the icon of the document you want, then right-
click and select Properties.

4. In the Property Editor window, click the General tab.

5. Click the Reset button to reset all the filters.

6. In the Parameters section, click each tab and select the filter settings you want
(or leave them as is) to filter the patients you want to include.

7. When finished setting filter parameters, click Apply, then click OK.

8. Double-click the icon of the document to generate the personalized letters. The
generated letters open in Microsoft Word.

9. Use the arrows in Word’s Merge toolbar to view each letter.

10. To print the letters, do one of the following:

Questions? www.softwarefordentists.com 1.800.368.6401240

http://www.softwarefordentists.com/


Chapter 13  Use Mail Merge

l To print the letters one at a time, use Word’s print function. From the File
menu, select Print.

l To print the entire group, close the report in Word. In the Mail Merge folder,
right-click the report and select Print.

Generate a referring provider envelope
A new Mail Merge template enables you to create a #10 business envelope addressed
to a referring provider.

► To generate an envelope for a referring provider:

1. From the DAISY menu, select Configure, then select List Maintenance.

2. Click the Referring Providers tab.

3. Do one of the following:

l To select a referring provider, click to open the Search For – Referring
Provider window, and select the provider.

l To add a new referring provider, click and type the name and address of

the referring provider, then click .

4. From the Reports menu, select Merge Docs, then select Referring Provider
Envelope.
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5. In the Print Options window, do one of the following:
l Click Preview to preview the envelope in Microsoft Word.
l Click Print to print the envelope.
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14 Closing
Closing is usually the last activity you perform at the end of your day. This activity
runs backups and generates claims and statement files to send to DMC.

Run Daily Closing
During most of the month, you run a Daily Closing which includes:

l A Quick Backup

l Generation of a claims file

l Transmission of claims and statement files to DMC

When needed, you may also generate interim statements called QuickStatements.

Note: To minimize problems during Closing, close all other programs and allow all print
jobs to complete before you start the Closing process.

Why you need to run daily backups
The information you enter into DAISY is stored in only one location — a computer in
your office.

DAISY does not have a duplicate copy of your database. If your disk drive fails, your
backups are the only way you can recover your database.
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► To run Daily Closing:

1. From the DAISY toolbar, click .

DAISY automatically checks the Send Claims check box. If you have no claims,
DAISY simply creates an empty claims file.

2. If you’re sending QuickStatements, check the Send QuickStatements check box.

3. If you want to clear all account statement messages after other Closing activity
completes, check the Clear Account Messages check box.

4. If you want to clear all provider-specific account statement messages after other
Closing activity completes, check the Clear Provider Broadcast Messages check
box.

5. Click Next.

6. In the Backup Options section, choose Quick Backup.
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7. In the Backup Directory section, check your backup’s destination path, then click
Next.
The drive letter should always be set to the removable disk or tape drive on your
system and the pathname set to the DMC directory. For example, D:\DMC.

8. Review your selections, then click Process.
DAISY checks your database, performs a backup, then generates claim and
statement files and places them in your DAISY Outbox.

Use the Closing Practice Summary report
The Closing Practice Summary report provides a snapshot of all of the practice’s
financial transactions since the last Daily Closing. This report is generated and
archived automatically during Daily Closing. The report can be accessed and printed
from the Documents panel in the Practice Settings window and in the Document
Manager window.

View the Closing Practice Summary report

► To view the Closing Practice Summary report:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the “handle” on the right-side of the Practice window to open the
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Documents panel.

3. Navigate through the tree to the appropriate document folder, then double-click
the Closing Practice Summary report you want to view.

4. Double-click the report.
You see a summary of what happened since the last closing, including:
l Previous accounts receivable balance
l Charges by provider and charge reversals
l Payments by type and payment reversals
l Adjustments by type
l Finance charges and rebill fees
l Minimum balance write-offs
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l Ending accounts receivable balance

Print the Closing Practice Summary report during closing
The Closing Practice Summary report can be optionally printed from the Daily Closing
dialog box.

► To print the Closing Practice Summary report during closing:

1. From the DAISY menu, select Closing, then Daily Closing.

2. Check the Print Closing Practice Summary check box.
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Note: The Print Closing Practice Summary option will be grayed out if no financial
transactions have been posted since the last closing.

3. Check any other Daily Process Options that apply to the practice.

4. Click Next.

5. In the Backup Options section, choose the appropriate type of backup.

6. Click Next.

7. Review your selections, then click Process.
DAISY processes the Daily Closing and then archives and prints the report on the
default printer.
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Transmit Closing files to DMC
If you keep your computer running overnight, Data Exchange, which transmits the
claims and statement files to DMC, will automatically run at the scheduled time set
up for your system. To use Data Exchange, you must have an Internet connection.

Tip: If the Data Exchange icon is not in the task bar, you can start it another way.

From the DAISY menu, select Closing, then select Data Exchange.

► To transmit immediately, do the following:

1. To run Data Exchange, double-click on your Windows task bar in the lower
right corner of your Desktop.

2. In the DMC Data Exchange window, click Go Now!
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You may want to minimize this window when Data Exchange completes.

3. From the DAISY menu, select Closing, then Outbox to verify that your Outbox is
now empty.
If your Outbox is not empty, your claims and statements were not sent to DMC.
Try sending the files later on or contact DAISY customer support.

Important: You must successfully complete a Data Exchange before your claims and
statements can be received at DMC.

Run Monthly Closing
You run Monthly Closing once a month. This closing includes:

l A Full Backup

l Generation of a claims file

l Generation of monthly statements

l Account aging and finance charge assessments

l Transmission of claims and statement files to DMC

Note: DAISY won’t permit you to run monthly closing more than once every 20 days. To
run monthly closing sooner, contact DAISY customer support for instructions.
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► To run Monthly Closing:

1. From the DAISY menu, select Closing, then Monthly Closing.
Send Claims and Send Statements are automatically selected.

2. If appropriate, check one or more of the following:.
l If you want to clear all account statement messages after other Closing activity

completes, check the Clear Account Messages check box.
l If you want to clear all provider-specific account statement messages after

other Closing activity completes, check the Clear Provider Broadcast Messages
check box.

3. Click Next.

4. In the Backup Directory section, check your backup’s destination path, then click
Next.

5. Review your selections, then click Process.
DAISY checks your database, performs a backup, then generates claim and
statement files and places them in your DAISY Outbox.
If you keep your computer running overnight, Data Exchange, which transmits the
claims and statement files to DMC, will automatically run at the scheduled time
set up for your system.

6. To transmit immediately, double-click on your Windows task bar to run Data
Exchange.

7. In the DMC Data Exchange window, click Go Now!
This window closes when Data Exchange completes.

8. From the DAISY menu, select Closing, then Outbox.
If your Outbox is not empty, your claims and statements were not sent to DMC.
Try sending the files later on or contact DAISY customer support.

Review claim and statement receipts
Check your Inbox in the DAISY Central window at the beginning of every workday to
review your electronic claims status reports. Your Inbox also contains DAISY’s
Business Matters newsletter and other files.

Electronic claim status reports include the number of claims accepted electronically,
along with their dollar amount, and the number of claims rejected and their dollar
amount.

Always review the electronic claims status reports. After you review them, you can
safely delete these reports from your Inbox.
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This file
extension...

Is an electronic claims status report for...

.NIC WebMD (NEIC)

.THN Regence Blue Cross Blue Shield of Oregon

.CPS WebMD

Details about rejected claims, which contain information about why the claims were
rejected, such as an invalid subscriber ID number, or an incorrect birth date, will be
sent in the next report. A contact phone number for the insurance carrier is also
included.

Important: You must successfully complete a Data Exchange before your claims and
statements can be received at DMC.

Tip: If your DAISY Central window is not displaying the Inbox, then do the following:

From the View menu, select Inbox. A check mark indicates that the item is selected.

Tip: If the Data Exchange icon is not in the system tray, you can start it another way:

From the DAISY menu, select Closing, then select Data Exchange.

Note: If DAISY is installed on a server, the Data Exchange icon only displays on that
computer.

► To open an electronic claims status report:

1. Open the DAISY Central window.

2. In the Inbox section, double-click the report file.
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Troubleshooting Closing
Q. I get a “Receipts not found” message when I try to run Daily Closing. What
should I do?

This message is generated by the Receipt Checker program, which monitors your
DAISY Inbox for receipt files. This program runs each time you run Closing. If it
detects that you have not received receipts for one or more claim, statement and
recall card files (generated by Recall Manager), it sends this message to alert you
about a potential problem.

Note: Receipt Checker will only generate this message for missing receipt files associated
with claim, statement, and recall card files that were created over four days (96 hours)
ago.

These things may interfere with retrieving your receipts:

l Files were deleted from your DAISY Outbox so they were not sent to DMC.

l Problems connecting to the Internet prevented Data Exchange from working
correctly, so you could not receive DAISY receipts.

l Incorrectly configured firewall software (e.g. Norton Personal Firewall, Norton
Internet Security) interfered with Data Exchange, even if your Web browser and e-
mail application functioned normally.

If you receive this message then:
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l Claim, statement and recall card files may not have been sent and are still in your
DAISY Outbox. If this is the case, run Data Exchange (click Go Now). Wait 15 to 30
minutes for DMC to produce a receipt file, then run Data Exchange again to
retrieve the receipt file(s).

l The files may have been transmitted to DMC and the receipts are available but
have not been retrieved. Run Data Exchange and click Go Now to retrieve the
receipt file(s).

Tip: To minimize the chances you’ll receive the “Receipts not found” message, always run
Data Exchange:

l In the morning to retrieve files at DMC.

l After Closing to transmit claim, statement and recall card files to DMC.

Q. What should I look for if an insurance claim is rejected?

l The insurance company may no longer use the Social Security Number (SSN) for
the Subscriber ID number.

l If the Subscriber ID is the person’s Social Security Number, you may have included
dashes, such as 316-24-9585. Make sure the ID number is entered exactly as it
appears on the patient’s insurance card. Most insurance companies will only
accept the SSN without dashes.

l If a person has multiple insurance plans, you may have entered the wrong
Subscriber ID for one of the plans.

l Check for a valid subscriber birth date.

l Gender is required for some electronic claims. Make sure gender has been
specified.

Questions? www.softwarefordentists.com 1.800.368.6401254

http://www.softwarefordentists.com/


15 Manage recall
Recall helps you make the most of your resources because it keeps patients coming
back for routine treatment. For example, recall can be updated each time a person
comes in for a recare appointment.

In DAISY, you can choose how much you want to automate patient recall:

l Hands-free Recall is DAISY’s highest level of recall management. When you use
DAISY to set up an appointment, you can indicate what type of recall will be
performed during that appointment. Whenever you make a change to the
appointment, such as cancelling, rescheduling, or checking out the patient, the
patient’s recall information is automatically updated in DAISY.

l Auto-create Recall. You can use this DAISY feature to automatically set up a
patient for recall when you enter a charge associated with a recall procedure for
this patient for the first time. After that, DAISY updates the patient’s recall
whenever you enter charges associated with a recall procedure.

l Manual recall setup. If your office wants to be selective about who gets put on
recall, you can still use DAISY to update recall for those selected patients. First,
you manually set up a patient for recall. After that, DAISY updates the patient’s
recall whenever you enter charges associated with a recall procedure.

No matter which recall method you use, DAISY warns you if you schedule a recall
appointment before the patient is due, and also warns you if a patient is overdue for a
recall.

Work with recalls

Manually set up a patient for recall
Use this procedure if you prefer to be selective about who gets set up for recall. If you
have Auto-create Recall enabled, skip to "Update a patient’s recall" on page 256. If
you use Hands-free Recall, skip to "Add a recall type to an appointment" on page
258.

Sun Valley Dental Clinic uses DAISY to track patient recalls. However, since its staff
often schedule cleanings for patients who reside in the area only during the summer
months, they prefer to select who they set up for recall.
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► To manually set up a patient for recall:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. Click the Recall tab.

4. Click .

5. Select the recall type you want to set up for this patient, then click OK.
The recall type is added for this patient.
Note: For information about setting up recall types, see "Set up recall card messages
" on page 556.

6. From the Notification Method drop-down list, optionally select a notification
method.
Indicate the method that the patient prefers to be notified. Otherwise, the
practice’s default notification method is used.

This notification type... Means this...

Phone Call the patient

Card Print a postcard

Label Print a label to attach to an
envelope or hand-written
card

None Patient does not need or
want a recall reminder

7. Click and close the Patient window.

Update a patient’s recall
If you use Auto-create Recall, use this procedure to automatically set up a patient for
recall. You also use this procedure to update recall for patients who are already set up
for recall.

Tip: To determine if your practice is set up for Auto-create Recall, open any DAISY
window. From the DAISY menu, select Configure, then Practice Configuration.

Click the System Defaults Tab. In the Patient Recall Options section, Auto-create Recall is
enabled if the Auto-Create Recall check box is checked.
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However, if you use Hands-free Recall skip to "Add a recall type to an appointment"
on page 258.

► To update a patient’s recall:

1. From the DAISY toolbar, click .

2. Click the By Account button.

3. Click the Charges tab.

4. To view the patient’s transactions, do one of the following:
l If the patient is listed in the Accounts/Patients tree on the left-side of the

window, click the patient’s name.
l If the patient is not listed, right-click in the Accounts/Patients section and

select Select a Patient. Search for the patient, then double-click the patient
name.

5. Type or select the charge that has been set up as a recall type.
In this example, D1110, a prophy procedure, has been set up as a recall type.

6. Double-click in the column to open the Patient window.

7. Do one of the following:
l If the patient isn’t set up for this type of recall, you’ll be asked if you want to

set it up. Click Yes to set up the patient.
l If the patient is set up for recall, you’ll be asked to update the recall type. Click

Yes to update recall for this patient.
In the Patient window, DAISY inserts the charge date under the Last Recall column
and calculates the period and minutes based on the information stored for this
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recall type.

Note: The Due Date indicates when the patient is due, but the Next Recall date may vary
because of patient or appointment availability.

Add a recall type to an appointment
If you’re using Hands-free Recall, use this procedure to manage a patient’s recall from
the Schedule. With this method, you specify which recall type applies to an
appointment. Then, whenever you make a change to the appointment, such as
canceling, rescheduling, or checking out the patient, the patient’s recall information
is automatically updated in DAISY.

If you aren’t using Hands-free Recall, see "Update a patient’s recall" on page 256.

► To add a recall type to a scheduled appointment:

1. From the DAISY toolbar, click .

2. Search for the scheduled appointment.
Note: For more information on finding a scheduled appointment, see "Find a
scheduled appointment" on page 110.

3. Double-click on the appointment.
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4. In the Affected Recall section, click .

5. Search for and select the recall type, then click OK.

Use Recall Manager
Recall Manager enables you to generate a list of recall cards, then send the list to
DMC via the Internet. Recall Manager selects patients based on the recall information
stored in DAISY. DMC prints the recall cards and mails them to your patients.
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Note: You must use DAISY to track patient recall if you want to use Recall Manager.

To use Recall Manager to notify your patients, you need to complete the
following steps in this order:

1. Generate a preliminary list of patients whose recall is due or past due.

2. From this list, select those patients who should receive recall cards and include
appropriate recall card messages.

3. Print a Recall Card Audit report.

4. Send the recall list to the DAISY Outbox. The recall cards are sent to DMC during
the next Data Exchange.

Generate a recall list
Recall Manager selects patients based on the information stored in DAISY under the
Recall tab of the Patient window. Before you produce the recall list, you choose
options that help Recall Manager generate a preliminary list of patients whose recall
is due or past due. Some of these options are the Next Recall date, the Recall Type,
and whether the patient is already scheduled for a recall appointment.

To generate the recall list, Recall Manager uses information stored in DAISY’s Patient
window under the Recall tab. For more information, see "Manage recall" on page 255.

Note: Each time you run Recall Manager, the Start Date and End Date are automatically
set to the start and end of the next calendar month, respectively. The other filter settings
are set to All. Anyone whose next recall date falls within this date range is automatically
displayed in the Search Results text box.

Tip: You might want to generate two lists: one with pre-scheduled appointments, and
one without, so you can customize your recall messages and card styles to reflect the needs
of each group.

► To generate a recall list:

1. Log in to DAISY.

2. From the DAISY toolbar, click .
You use the filters in the Filter Scheme section of the Recall Manager window to
generate the recall list.
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Tip: Sort the search results by Home Phone to determine if patients with different
names live at the same residence. Then you’ll only need to send one card or make one
phone call about recall if they all come in at the same time.

3. Under Filter Scheme, select options from one or more of these recall filters:
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Use this filter... To do this...

Recall Type Select a specific recall type. For example,
Prophy. Or select All to include all recall
types.

Account Provider Select a specific provider or select All to
include all providers.

Scheduled? Choose Y to select those recall patients with
pre-scheduled appointments. Choose N to

select those recall patients without
scheduled appointments. Select All to
include both.

Start Date Select all patients whose next recall date
falls on or after this date.

End Date Select all patients whose next recall date
falls on or before this date.

Notification
Method

Select all patients with this notification
method.

Note: Although you can select more than one item at a time from a table in DAISY,
you cannot do a multi-select in Recall Manager.
Tip: To ensure that all patients whose recall is due or past due are included in the
preliminary recall list, select all notification methods.

4. Click Apply.
A list of patients (whose next recall falls within the filter settings you selected) is
displayed in the search results text box on the left.
The recall list you just generated can be sorted different ways to help you work
with the results. You can sort by account number, patient last name, home phone,
or next recall date.

5. To sort the recall list, click the appropriate column heading in the recall list.
For example, to sort by Home Phone, click the Home Phone heading.

6. To deselect a patient from the list, double-click on the patient name.
In the asterisk column, the Y changes to an N, indicating that the patient will not
be included in the list of those who will receive recall cards.

Review the recall list
The various tabs in the Recall Manager window give you additional information about
each of the patients in the recall list. You can use this information to exclude patients
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who no longer use your services, have an outstanding balance, or for some reason
should not receive a recall card.

Use this tab... To do this...

Patient View the patient’s demographic information, such as
name, phone, current recall type and account number.
Also edit this patient’s recall information and the
messages you want included on the recall card.

More View the patient’s medical alerts, prescriptions, tags,
and reminders. Also add a note about the patient.

Account View the patient’s account status, such as current
balance, account options, and insurance information.

Preview View the patients who are selected to receive a recall
card and the information that will be included on each
card. Also select the card style that will be sent.

Change a patient’s recall information

► To change a patient’s recall information:

1. From the recall list, select a patient.

2. Click the Patient tab.

3. In the Description section, click .

4. Change the recall information, then click OK.

Note: Changing the recall information here does not affect any appointment information
in the Schedule. If you use DAISY for appointments, always make these changes in the
Schedule. Once made, they will automatically be updated in Recall Manager.

Create the recall card list
After you review the recall list, you are ready to create the recall card list.
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► To create a recall card list:

1. From the Recall Manager window, click the Preview tab.

Make sure the preview list is empty.

2. To empty the preview list, click , then click OK.

3. Do one of the following:
l To add a patient to the preview list, click the patient name in the patient list,

then click . Repeat this step until all the patients you want to receive a
recall card are in the preview list.

l To add all patients from the patient list to the preview list, click .

4. From the Card Style drop-down list, choose a card style.
Note: All patients in the list will receive this card style.
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To view the card you’ve selected, as well as other card options, click next to
the Card Style drop-down list.
You must be connected to the Internet to view these cards.

5. To print a Recall Card Audit report, from the Reports menu select Print Audit.
DAISY recommends that you always print an audit report. This report contains a
list of the patients who will receive these cards, along with the messages on each
card.
Note: Always run the audit report before you click Send in the Recall Manager
window, otherwise this information will not be available in the Recall Card Audit
Report.

6. Click Send to generate the cards.
The cards will be sent for processing the next time you transmit to DMC.
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16 Manage insurance plans and
benefits
In DAISY, you set up insurance plans to track plan benefits as well as the subscribers
and patients who participate in each plan. You can also track which employer
sponsors a specific plan. You use plan information when you set up treatment plans
for patients.

DAISY comes pre-loaded with a list of insurance companies currently receiving claims
from DAISY, but you can add to this list as well.

Important: Always search for the insurance plan first to avoid duplicating it in your
DAISY database.

Work with insurance plans

Set up an insurance plan
Insurance plans help you track plan benefits, such as deductibles and maximums.
Plans are distinguished by a group number and employer name. Benefit information is
unique to each plan. If another patient comes in with that same plan, you won't need
to reenter plan information when you set up the new patient’s account.

► To set up an insurance plan:

1. From the DAISY menu, select Insurance, then Ins. Plan.

2. In the Search For – Insurance Plan window, search for the plan.
If you don’t find it, go to step 3 to set up a new plan.

3. Click New Insurance Plan.
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4. In the Group ID text box, type in the plan’s group ID number.

5. Next to the Employer text box, click and do one of the following:
l Search for and select the employer associated with the plan, then click OK.
l If the employer is new, click New Employer to open the Employer window. Add

the employer’s information, click , then close the window.
DAISY automatically adds a plan name that is a combination of the employer’s
name and the word “Plan” to the Insurance Plan text box.

6. Next to the Insurance Company text box, click .

7. Search for and select the insurance company associated with the plan, then click
OK.
Note: If the insurance company is not listed, you’ll need to contact DMC to obtain a
valid insurance company code.
DAISY opens the Insurance Plan window.

8. In the Benefits section, under Reset By, choose one:
l Calendar Year to reset benefits at the beginning of the year.
l Benefit Year to reset on a given date.

From this window, you can also edit the insurance plan name, set up plan benefits
and coverage for each category of procedures, enter benefit exceptions for specific
procedures, track participating providers, and add notes about the plan.
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Use this tab... To do this...

Benefits Enter the plan information, including
deductibles, maximum benefits, and
eligibility rules. (Add insurance plan
benefits )

Coverage by Category Enter the insurance plan percentages for
each category of procedures. Set up
insurance plan percentages )

Specific Procedure
Coverage

Enter benefit exceptions for specific
procedures.

Participating Providers Enter the names of providers who have
signed a participating provider agreement
for this plan.

Plan Notes Enter free-form notes about the plan.

Add insurance plan benefits
Tip: To prevent duplicate benefit payments, some insurance companies have agreements
that define how benefits are applied when secondary insurance is available.

To have DAISY consider non-duplication of benefits when it calculates a treatment plan
or a Quick Estimate, check the Non-duplication of Benefits check box.
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► To add plan benefits:

1. From the DAISY menu, select Insurance, then Ins. Plan.

2. Search for and select the plan you want to view.

3. Click the Benefits tab.

4. Click each Deductible or Maximum Benefits text box that you want to change and
type the information.

5. For each Eligibility Rule, type or select the number of years.

6. Click , then close the window.

Set up insurance plan percentages
Insurance plan percentages are used to estimate benefits in treatment plans.

► To set up plan percentages:

1. From the DAISY menu, select Insurance, then Ins. Plan.

2. Search for and select the plan you want to view.

3. Click the Coverage By Category tab.
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4. If the plan provides an incentive or deductible for a procedure, click the
appropriate Incentive or Deductible column, then type or select Y from the drop-
down list.

5. For each procedure category, click the Percent Coverage column and type the
percentage of coverage the plan provides.

6. Click , then close the window.

Change insurance company information
DAISY comes pre-loaded with all insurance companies currently receiving claims from
DAISY. However, sometimes you may need to change the address, phone number,
Web site addresses or other company information.

Important: When you change insurance company information in your database, this
information does not automatically change at DAISY. Please notify DAISY before you
make changes. Contact us at 1-800-368-6401 outside of Portland or (503) 243-3966
locally. Wait for the welcome message and make the appropriate selection.

Note: The insurance company code determines which company will receive the insurance
claim. You cannot change this code.

Tip: If an insurance company’s Web sites are added to DAISY, you can connect to them
from the Quick Access toolbar in the Account, Patient, Insurance Coverage, Insurance
Plan, Insurance Company and Claim windows.

l Click to access the company’s Web site.

l Click to access the company’s benefits information Web site.

► To change insurance company information:

1. From the DAISY toolbar, click .

2. Search for and select the company you want to view.

3. Click the Contact Info tab and type the changes.

4. Click the Internet Websites tab.

5. Optionally, type the company’s main Web site address and benefit information
Web site address.

6. Click , then close the window.
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Change insurance coverage information
When you set up an account, you specify the insurance coverages, if any, for each
patient listed on the account. From the Coverage window, you can change patient or
subscriber details, add or remove patients from the coverage, or add notes about a
coverage.

Note: Removing a patient from the coverage does not remove the patient from the
account.

Tip: You cannot remove the last patient associated with a coverage from the Coverage
Window. To remove the last patient, delete the coverage from the Coverage window.

Tip: You can also change coverage information from the Account window. Click in
the Insurance Coverage section of the window.

► To change coverage information:

1. From the DAISY menu, select Insurance, then Ins. Coverage.

2. Search for and select the subscriber you want and click OK.

Tip: You can also change coverage information from the Account window. Click
in the Insurance Coverage section of the window.

3. Click the appropriate tab, then change the information.

Use this
tab...

To do this...

Patients View and edit patients who have this
coverage. You can only change
information in the Relationship and
Priority columns.

From here you can right-click to:

Add patient to or remove patients from
the coverage

Reassign patient coverages

Subscriber Show information about the person who is
the employee or member on the insurance
plan, and assign or change the Subscriber
ID number.

Notes Type a note about the plan.
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4. Click , then close the window.

Add an insurance company and code
Sometimes you may not find an insurance company name and code in DAISY when
you want to add it to an account.

If you can’t find the correct insurance company name and address in DAISY, then
verify that you have the correct insurance information. You may need to call the
patient or the insurance company. If the information is correct, then go to the Web
site and check DAISY’s master insurance list.

Important: When you change insurance company information in your database, this
information does not automatically change at DAISY.

Note: The insurance company code determines which company will receive the insurance
claim. You cannot change this code.

Before you add a new insurance company name and code to DAISY, you need
to complete the following steps in this order:

1. Check for the correct name and code in the insurance list on the DAISY Web site.

2. If the correct name and address is listed, download the latest version of the
DAISY insurance table.

3. Install the DAISY insurance table.
The new code is included in your insurance company table.

Check for the insurance company name on the DAISY Web site

► To check for the correct company name:

1. Connect to the Internet and start your Web browser.

2. Go to www.daisydental.com.

3. From the left-hand navigation links, click Support.

4. Under DAISY System Support, click Insurance Company Lookup.

5. Follow the instructions to search for the insurance company.

6. Do one of the following:
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l If you find the correct insurance company name, go to "Download and install
the DAISY insurance table" on page 274.

l If you can’t find the correct insurance company name, contact DAISY support.

Download and install the DAISY insurance table

► To download and install the latest version of the DAISY insurance table:

1. Connect to the Internet.

2. From the DAISY menu, select Insurance, then Download Insurance.

3. Click Download Insurance List.
You’ll be asked to save the file INSCO.DUP.

4. Select Open the File.
The file downloads and then the insurance table automatically updates.

Note: To avoid having the insurance claim returned to your office, which delays payment,
the correct insurance company code must be entered before you submit the claim.

Access insurance company Web sites
For each insurance company, you can store Web site addresses in DAISY for the
company’s home page and its eligibility lookup page, if they are available. Then you
can access those Web pages from within DAISY’s Insurance Company window.

► To set up quick access to insurance company Web sites:

1. From the main toolbar, click .

2. Search for and select the company you want to view.

3. Click the Internet Websites tab.
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4. In the Company Website text box, type the insurance company’s home page Web
address.
For example, for the Met Life dental site, type:
https://www.metdental.com.

5. In the Benefit Information text box, type the insurance company’s eligibility
lookup address.
For example, for Met Life dental eligibility lookup site, type:
https://www.metdental.com/prov/execute/PesEntry

6. Click , then close the window.

You can access these Web links from the Insurance Company, Account, and Patient
windows in DAISY.

l To access the insurance company’s home page from DAISY, open one of the

appropriate DAISY windows and click .
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l To access the eligibility lookup page from DAISY, open one of the appropriate

DAISY windows and click .

Note: If the icon is grayed out, then quick access to the insurance company’s home

page is not set up. If the icon is grayed out, then quick access to their eligibility
lookup page is not set up.

Make online eligibility inquiries
Online eligibility inquiries through Emdeon are available via the Request Benefit
Information icon (        ) on the Quick Access toolbar from the following DAISY
windows:

l Account

l Patient

l Schedule

l Appointment Detail

l Treatment Plan

l Insurance Coverage

The Request Benefit Information icon is active only if the company that provides the
patient’s insurance coverage participates in Emdeon’s electronic eligibility inquiry
program, otherwise the icon is grayed out.

Inquiry requests are sent via the Internet and are processed within approximately six
seconds.

Note: The format of eligibility information may be different for each insurance company.

When the first patient on the day’s appointment schedule is checked for benefits,
DAISY automatically checks all the other patients with appointments scheduled that
day who are eligible for online benefit checking. DAISY caches the results for seven
days. Caching of eligibility information enhances the performance of online inquiries.

The cache is emptied for a specific patient after the seven-day period or if any of the
following events occur:

l The subscriber ID for the coverage changes.

l The insurance company on the plan changes.

l The insurance is removed or deleted from the patient record.
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l The group number is changed.

l Participating provider information is changed on the plan.

Here is an example of an eligibility inquiry initiated from the Patient window.

► To make an online eligibility inquiry from the Patient window:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Patient window, click .

Your default web browser opens and the inquiry begins. You see the results in the
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browser window. 

In DAISY windows that have multiple patients listed, such as the Account or
Insurance Coverage, select the patient to check his or her eligibility.

Here is an example of an eligibility inquiry that is initiated from the Account window.
The guarantor is Rhonda Vineyard and the inquiry is for John Vineyard.

► To make an online eligibility inquiry from the Account window:

1. From the DAISY toolbar, click .

2. Search for and select the account, then click OK.

3. In the Account window, select the patient, then click .
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Your default web browser opens and the inquiry begins. You see the results in the
browser window. 

Note: If you are interested in subscribing to this service, contact DAISY Sales at
503.765.3471 or daisysales@dmcdental.com.

Frequently asked questions
Q. How can I change the way patients are assigned to Insurance Coverage without
removing and re-adding the insurance?

1. Open the Account, Patient, or Insurance Coverage window.

2. From the Edit menu, select Reassign Patient Coverage.

3. Make the appropriate changes, then click OK.

4. Click and close the window.
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17 Use Statement Manager
Statement Manager enables you to conveniently complete all of your month-end
closing preparations in a single DAISY window. With Statement Manager, you can:

l Specify which accounts should receive statements

l Track which accounts have been reviewed

l Preview individual account statements for accuracy

Statement Manager selects accounts with a balance less than zero or greater than the
minimum balance write-off that have not received a QuickStatement since the last
month-end closing. These accounts display in an account list that you can filter, sort,
and view in greater detail.

To help you select and review accounts in the list in preparation for month-end
closing, you can define schemes for common searches you need to make during
month-end closing preparations or use schemes provided by DAISY. A scheme is a
saved selection of search filters.

You can preview the account statement to ensure that the statement messages and
estimates are accurate and appropriate. Once you’ve confirmed that an account is
accurate and should receive a statement, you can indicate that it has been reviewed
so you won’t duplicate effort.

After completing month-end preparations in Statement Manager, you run DAISY’s
monthly closing to generate the statements and then run Data Exchange to send them
to DMC for printing and mailing directly to patients. For more information on month-
end closing, see "Run Monthly Closing" on page 250.

► To open Statement Manager:

1. Log in to DAISY.

2. From the DAISY toolbar, click .
You see the Statement Manager window.

When you open Statement Manager the first time, the account list defaults to the
filter settings in the All Accounts scheme. The All Accounts scheme selects all
accounts that can receive a statement (those with a balance less than zero or greater
than the minimum balance write-off that have not received a QuickStatement since
the last month-end closing).
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Note: When the All Accounts scheme is selected, you can still change filter settings, but
those changes are only temporary. The All Accounts scheme reverts back to its original
settings the next time it is selected.

To help you select and review accounts in preparation for month-end closing, define
your own schemes for common searches made during month-end closing
preparations or use any of these schemes provided by DAISY:
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Choose this
scheme...

To do this...

All Accounts Select all accounts with a balance less than zero or
greater than the minimum balance write-off that
have not received a QuickStatement since the last
month-end closing.

Reviewed Accounts Select only those accounts that have been marked
Reviewed.

Changed Since
Review

Select those accounts that have changed since they
were marked Reviewed.

Credit Balance
Accounts

Select accounts with a balance less than zero.

Delinquent Balance
Accounts

Select accounts with a balance older than 90 days.

You can also select specific filters options for one-time use or to set up a custom
scheme. For information on setting up custom schemes, see "Set up custom
schemes" on page 285.
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Choose this filter
setting...

To do this...

Balance Select accounts based on the specified balance. The
default amount is $0.00.

Credit Balance Only select accounts with a credit balance amount.

Accounts with
Financial
Arrangement

Only select accounts with a financial arrangement.

Accounts that have
(or do not have)
claims

Select accounts with (or without) outstanding claims
based on treatment performed within a specified
number of days.

Accounts that have
(or do not have)
insurance (or
personal)
payments

Select accounts with (or without) insurance (or
personal) payments within a specified number of days.

Account Provider Select accounts that belong to a specific account
provider. The default setting is <All>.

Accounts with a
Balance

Select accounts with an aged balance over a specified
number of days (30, 60, 90, and 120). The default
setting is <Any>.

Statements Select accounts that are set (or not set) to receive
month-end statements or QuickStatements.

Insurance Select accounts with (or without) insurance coverage.
The default setting is <Any>.

Review Select accounts that are (or are not) marked as
Reviewed. The default setting is <Any>.

Est on Stmt Select accounts that have (or do not have) estimated
patient and insurance portions due printed on their
statements. The default setting is <Any>.

Generate an account list
Statement Manager generates an account list based on the current balance of an
account, as well as the filters selected. To generate an account list, choose specific
filter settings or the appropriate scheme.
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► To generate an account list:

1. Open Statement Manager.

2. Do one of the following:
l From the Scheme Name drop-down list, select the appropriate scheme.
l In the Filter Scheme section, select one or more statement options for groups

of accounts, then click Apply.
The results are displayed in the account list section of the window. This list can be
sorted different ways to help you work with the results. For example, you can click
on the Account column heading to sort alphabetically by guarantor name, or click
on the Balance column heading to sort by the account balance instead.
Note: Each selected filter item restricts the search to fewer accounts.

Set up custom schemes
To use the same filtering methods every month, save your filter settings in a scheme
and assign it a unique name. For example, you may want to set up schemes that
identify accounts with credit balances, outstanding insurance payments, or debit
balances that are flagged not to receive a statement.

► To create a scheme:

1. Open Statement Manager.

2. From the Scheme Name drop-down list, select <Add Scheme>.

3. Type the name of the scheme.
Note: The scheme name cannot be edited. To reuse a scheme name, you must delete
the existing scheme (with all its filter settings) and create a new one.

4. Select the filters for the scheme.

5. Click Save, then click Yes to confirm.
The new scheme automatically generates an account list that reflects its filter
settings.

View account details
The right side of the Statement Manager window displays details for an individual
account, such as the account guarantor, the current financial status, and any
insurance associated with the account.

Use the Options section to specify whether a statement gets generated and when,
what messages get attached and other items that affect statement output.
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Choose this
option...

To do this...

Send Statement Send a monthly statement to the account’s
guarantor.

Finance Charges Incur fees on the account’s outstanding balances
when monthly closing runs.

Collection Messages Add collection messages to the account statement.

Ortho Account Add an Ortho tab to the Account window. This
indicates the account is reserved for patients who
receive orthodontic treatment.

Request
QuickStatement

Generates a QuickStatement during daily closing.

Tip: You can generate statements on demand from the Account or Transaction windows.
These QuickStatements are generated during the next Daily Closing.

► To view account details:

1. Open Statement Manager.

2. Do one of the following:
l From the Scheme Name drop-down list, select the appropriate scheme.
l In the Filter Scheme section, select one or more statement options for groups

of accounts, then click Apply.

3. In the Account List section, select the account whose details you want to view.
The right side of the Statement Manager window displays details for an individual
account. In the following example, Christina Babcock’s account is selected. Her
account details are displayed on the right side of the window.
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Once you’ve confirmed that an account is accurate and should receive a
statement, you can mark it as reviewed. The account remains flagged until:
l DAISY generates a statement for the account
l End-of-month closing completes

Note: You can also flag accounts as reviewed from the Transactions and the
Account windows. Marking an account Reviewed creates an entry in Account Notes
that lists the date and user who made the selection.

4. In the Account List section, under the Rev’d column, check the check box next to
the reviewed account.

Tip: You can change the positions of account details in the Statement Manager window.

From the View menu, select one of the following:

l Align Right Account Info to display account details on the right side of the window

l Align Bottom Account Info to display account details at the bottom of the window

l Hide Account Info to hide account details altogether
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18 Use Document Manager
Document Manager enables you to store and manage electronic copies of documents
associated with your practice—safely and securely.

You can use Document Manager to:

l Reduce the amount of paper documents you have to store. Document Manager
helps you decrease the costs associated with filing and storing paper documents.

l Enhance office efficiency. Your staff can access documents from any computer,
and multiple people can look at the same document even if they are in different
offices or cities. Plus, a tidy office and efficient staff make your practice more
attractive to patients.

l Store a variety of file formats, including Word, Excel, and PowerPoint files, as well
as PDF, HTML, WAV or MP3. Print documents can be scanned into DAISY.
Documents can be attached to patients, providers, accounts, or the practice. 
Documents received in advance of a patient, for example, can be stored ahead of
time and attached later.

l Ensure that confidential information is protected and reviewed appropriately. You
can capture and use digital signatures to verify the integrity of documents. Ensure
that only authorized staff can access the appropriate documents. You can also flag
documents for attention during the review process, or tag them as a clinical note.

How It Works
With Document Manager, documents can be attached to patients, providers,
accounts, or the practice. Documents can be attached in any of the following ways:

l Import a file into DAISY

l Scan a printed document

l Archive a DAISY report

l Archive a mail merge

Documents added from the Patient window, for example, are attached to the selected
patient. Once a document is attached to the patient, it can be accessed from any
window that is patient-related, such as the Chart, Perio Exam, Patient and
Appointment windows. 

However, documents attached to a patient are not, for example, accessible from the
patient’s Account window. To access the document from the Account window, you
must attach another copy to the patient’s account.
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Documents can be added to the DAISY archive either from the Document panel on
many DAISY windows, or from the Document Manager window. 

Note: For more information about the Document panel, see "About the Document
Panel" on page 290. For more information about the Document Manager window, see
"Manage archived documents" on page 309.

Documents are stored in the DAISY document archive.  Because this archive is part of
your DAISY system, documents stored there are automatically backed up along with
your DAISY database.

About the Document Panel
The Document Panel lists all documents associated with a window.

To view attached documents, you click on the blue “handle” on the right side of the
window.

Note: Only windows that support attachments display a handle, even when no
documents are currently attached.

For example, click the handle in the Patient window to open the Document panel and
view the documents attached to the selected patient, such as a consent form, patient
registration form, health history form, or treatment plan.

Documents in the Document panel can be sorted into folders either by Document
Type or Document Date.
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To view all of the documents stored in the DAISY document archive, open the
Document Manager window and search for the document you want.  For more
information about the Document Manager window, see "Manage archived
documents" on page 309.

Archive documents

Import a document file into the DAISY archive
Use the Import File option to attach a file to patients, providers, accounts, or the
practice.  You can import:

l Documents including PDF or Word files

l Email messages saved as a file

l Images, including JPG, PNG, or TIF formats

l Spreadsheets
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l PowerPoint presentations

l Audio files such as WAV or MP3

l HTML files

l Executables files, including those with .com, .exe, or .bat extensions, cannot be
imported into DAISY.

Note: Files larger than 200 MB cannot be imported. When you import files larger than 10
MB, you will receive the warning “This file is larger than 10 MB. Performance may be slow
when archiving large files.”

In this example, the receptionist is attaching a referral notice to the patient’s record
that arrived via email. She’s saved the referral notice to a folder.

► To import a document file into the DAISY document archive:

1. From the DAISY toolbar, click and search for the appropriate patient.

2. Click the “handle” on the right-side of the Patient window to open the Document
panel.

3. Right-click in the Document panel and select Import File.
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4. Navigate to the folder that contains the file to import.

5. Double-click on the file.
The Document Properties dialog box opens.

6. In the Description text box, type a description of the document.
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7. Next to the Document Type text box, click to open the Search – Document
Type dialog box.

8. Select the Document Type.
For example, if the document is a referral letter, select Correspondence.
Note: For more information about Document Types, see "Manage document types"
on page 565.

9. If the document is a clinical note, then check the Clinical Note check box.
For example, a letter from a specialist that you want to become part of the
patient’s clinical record. If the document needs to be reviewed, do the following:

10. Check the Review check box.
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a. In the Status section to the right of the Review check box, click the appropriate
status button.

This status
button…

Does this…

In Progress Indicates that the document is incomplete.
The document is usually assigned to the
person who has archived it.

Ready for
Review

Indicates that the document is ready for
review. This is the default setting. You can
pick who will be the reviewer in the Ready
for Review drop-down list.  This list includes
all users, even those who are not authorized
to review documents.

If an unauthorized person tries to review it,
they see a dialog window that says, “A valid
reviewer and password is required to save
Reviewed items.”

Reviewed Indicates that an authorized user reviewed
the document and “signed off” on it.

b. From the Ready for Review drop-down list, select the reviewer.
Note: Documents can also be assigned for review later on from either the Document
panel or the Document Manager window. To assign a document for review, right-click
on the document in the Documents list and select Properties. Check the Review
checkbox, select the Review Status, then click OK.

11. To add a non-clinical note about the document, click the Memo tab, and type a
message in the Memo text box.
Note: The memo does not show up when you print document.

12. Click OK to close the Document Properties dialog box.
You see the Info dialog box confirming that the file was successfully archived and
attached to the patient.

What's New in DAISY 4.4 295



Chapter 18  Use Document Manager

13. Click OK to close the Info dialog box.
The attached document is now listed in the Document panel.

Scan a document into DAISY
Use the Scan option to scan black and white or color documents, including print
documents and photos, directly into the DAISY document archive.

Note: Any TWAIN-compliant scanner should be 100% compatible. Contact DAISY
customer support for specific recommendations.
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In this example, the office manager is scanning in a new patient form to attach to the
patient’s record. This office uses the Visioneer Strobe XP 300 scanner.

► To scan a print document into DAISY:

1. From the DAISY toolbar, click and search for the appropriate patient.

2. Click the “handle” on the right-side of the Patient window to open the Document
panel.

3. Right-click in the Document panel and select Scan, then select the item type.
For example, select Document.

4. Insert the document into the scanner, then click Scan.
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5. When scanning is complete, click Done.

6. In the Scan Document window, preview the scanned document, then close the
window.

The Document Properties dialog box opens.

7. In the Description text box, type a description of the document.
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For example, type New Patient Form.

8. Next to the Document Type text box, click to open the Search – Document
Type dialog box.

9. Select the Document Type, then click OK.
You see the Info dialog box confirming that the scanned document was
successfully archived and attached to the patient.

10. Click OK to close the Info dialog box.

The scanned document is now listed in the Document panel.

Archive a DAISY report
With Document Manager, you can archive a copy of any DAISY report. For example,
you can use this feature to store a signed copy of a treatment plan, or to archive daily
and monthly closing reports.

In this example, Dr. Jones wants to archive an Activity Analysis report for future
reference. He will attach this document to the practice.

► To archive a DAISY report from the Report Gallery:

1. From the DAISY toolbar, click .
Note: Reports generated from the Report menu in any DAISY window can also be
archived. For more information, see "Capture an electronic signature and archive
the signed document" on page 302.
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2. Navigate to the appropriate reports folder, then double-click the report you want
to run.

3. At the top of the Report Viewer window, click .

4. In the Select Link Type dialog box, choose where to attach the report, then click
OK.
In this example, Dr. Jones wants to attach the report to the practice.
Note: Use the Unfiled option to link the archived document later from the Document
Manager window. For example, if your office receives a referral letter before the new
patient arrives, archive it now and link it to the patient once the new patient’s record
is created in DAISY.
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The Document Properties dialog box opens.

5. In the Description text box, type a description of the document.

6. Next to the Document Type text box, click to open the Search – Document
Type dialog box.

7. Select the Document Type, then click OK.

8. Click OK to close the Document Properties dialog box.
You see the Info dialog box confirming that the file was successfully attached to
the practice.

9. Click OK to close the Info dialog box.

10. Close the Report Viewer window.
The archived report can now be accessed from the Practice window.
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Capture an electronic signature and archive the signed document
In this example, the office manager wants to archive a signed treatment plan.

► To capture an electronic signature and archive the document:

1. From the DAISY toolbar, click and search for the appropriate patient.

2. Click to open the Treatment Plan window for this patient.

3. From the Reports menu, select Treatment Plan.

4. In the Select Procedures dialog box, check the check box next to each procedure
to print, then click OK.

5. In the Print Options window, click Archive.

The Document Properties dialog box opens.

6. In the Description text box, type a description of the document.
For example, type Tx Plan Standard.
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7. Next to the Document Type text box, click to open the Search – Document
Type dialog box.

8. Select the Document Type, then click OK.

9. To obtain a digital signature for this form, click .
By default, DAISY adds the patient name to the Print text box. 
Note: If someone else is signing the form, you can type a different name.
The patient uses the digital signature pad to sign the document.
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10. Do one of the following:

l If the signature is okay, then click to accept the signature.

l If the signature is not okay, then click to erase the signature, then go to step
9.

11. Do one of the following:
l To add another digital signature to the document, repeat steps 9 through 10.
l To save the document, go to step 12.

12. Click OK.
You see the Confirm dialog box confirming that the document was successfully
archived and attached to the patient.
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13. Do one of the following:
l To print the signed, archived document, click Yes. The document opens in PDF

format.
l To not print the document, click No.

The signed document is now listed in the Document panel of the patient’s
Treatment Plan window, as well as any other patient-related window.

Archive a Mail Merge document
DAISY Mail Merge enables you to merge patient information into a Microsoft Word
document. With Document Manager, you can store copies of correspondence created
with Mail Merge in the DAISY document archive.

In this example, the office manager is going to send a collection letter to Luke Kuhn
and wants to keep a copy of the letter in Luke’s account.
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► To archive a document created with Mail Merge:

1. From the DAISY toolbar, click .

2. Search for the appropriate account, then click OK.

3. From the Reports menu, select Merge Docs, then select the appropriate Mail
Merge template.
For example, select Collect Letter 1.

4. In the Print Options window, click Preview.

The document opens in Microsoft Word.

5. Review and print the document from Word.

6. Do one of the following:

l If using Microsoft Word 2003, click in the menu bar.
l If using Microsoft Word 2007, click the Add-Ins tab, then click DAISY Archive.
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The Document Properties dialog box opens.

7. In the Description text box, type a description of the document.

8. Next to the Document Type text box, click to open the Search – Document
Type dialog box.

9. Select the Document Type, then click OK.

10. Click OK to close the Document Properties dialog box.
You see the Info dialog box confirming that the file was successfully archived to
the account.

11. Click OK to close the Info dialog box.

Print a document to the DAISY Document Archive
DAISY installs a special printer on your computer called “DAISY Document Archive”. 
Anything you print to this printer is automatically stored in the DAISY document

What's New in DAISY 4.4 307



Chapter 18  Use Document Manager

archive.  For example, you can print web pages, screen shots, e-mails, and non-merge
documents to this printer and have them attached to a patient, account, provider, or
practice.

This printer can be selected from the Print dialog box in any Windows application,
including Word, Excel, and Internet Explorer.

In this example, the receptionist wants to archive a Word document to the practice.

► To print a Word document to the DAISY Document Archive:

1. Open the Microsoft Word document.

2. From the Office Button, select Print, then Print.

3. In the Name drop-down list, select DAISY Document Archive.

4. Click OK.

5. In the Select Link Type dialog box, choose where to attach the document, then
click OK.
For example, select Practice.

Questions? www.softwarefordentists.com 1.800.368.6401308

http://www.softwarefordentists.com/


Chapter 18  Use Document Manager

The Document Properties dialog box opens.

6. In the Description text box, type a description of the document.

7. Next to the Document Type text box, click to open the Search – Document
Type dialog box.

8. Select the Document Type, then click OK.

9. Click OK to close the Document Properties dialog box.
You see the Info dialog box confirming that the file was successfully attached to
the practice.

10. Click OK to close the Info dialog box.

11. Close Microsoft Word.

Manage archived documents
Use the Document Manager window to manage all of the documents stored in the
DAISY document archive.

In the Document Manager window, you can:

l Search for and view a specific document or list of documents stored in the archive.

l Refile a document if it is attached to the wrong patient, account, provider, or
practice.
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l Attach an Unfiled document to the appropriate patient, account, provider, or
practice.

l Review archived documents in a single location.

l Delete archived documents.

You can also add documents to the DAISY document archive from the Document
Manager window.

View a list of archived documents

► To view a list of documents:

1. From the DAISY menu, select Document Mgr.

Note: For easier access, add the Document Manager icon to the DAISY toolbar.
You see the Document Manager window.

2. Under Filter Scheme, select one or more options to filter the Documents list:
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Use this
filter…

To do this…

Link Type Search for and select the type of information to which the
document is attached, such as Patient, Account, Practice, or
Provider.  Or select <All> to view documents attached to any
type.

If the document is not attached to any type of information,
then select Unfiled.

Link Name Search for and select the name of the patient, account,
practice, or provider that the document is attached to.  For
example, if the document is attached to a patient, select the
patient’s name.

This filter is only activated if a specific Link Type is selected.

Review
Status

Select documents with a specific review status, such as Ready
for Review. Or select <All> to view documents with any status:
In Progress, Ready for Review, and Reviewed.

Reviewer Select the user who has been assigned the responsibility for
reviewing the document. Or select <All> to view documents
assigned to any user.

Date Filter Select the type of date:

Document Date: the date of the document itself.

Add Date: the date when the document was added to the
system.

Review Date: the date when the document was reviewed and
electronically signed off.

From Earliest date of documents to include in the list.

To Latest date of documents to include in the list.

Document
Type

Select the type of document, such as Correspondence, Forms,
or Treatment Plans.  Or select <All> to view any type of
document.

Description Type the description of the document.

This description was entered in the Description text box in the
Document Properties dialog box. For more information, see

What's New in DAISY 4.4 311



Chapter 18  Use Document Manager

Use this
filter…

To do this…

page "Archive documents" on page 291.

3. To view a document, double-click the document in the Documents list.
The document opens in the appropriate application.  For example, a Word
document opens in Microsoft Word.

Attach an “Unfiled” document
If you want to archive a document before you know where to attach it, you can save it
as an Unfiled document.  For example, your office receives a referral letter before the
new patient arrives, so you archive it ahead of time, and then link it to the patient
once the new patient’s record is created in DAISY.

In this example, the receptionist is attaching a referral letter to the new patient’s
record from the Document Manager window.

► To attach an unfiled document:

1. From the DAISY menu, select Document Mgr.
You see the Document Manager window.

Note: For easier access, add the Document Manager icon to the DAISY toolbar.

2. From the Link Type drop-down list, select Unfiled.
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3. In the Documents list, right-click on the document and select File Document.

4. In the Select Link Type dialog box, choose where to attach the document, then
click OK.

5. Search for and select the correct patient.

6. In the Confirm dialog box, click Yes.
The document is now attached to the patient.
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Refile an archived document
If you accidentally attach a document to the wrong patient, account, provider, or
practice, it can be refiled.  In this example, the receptionist is refiling a New Patient
Information form that was attached to the wrong patient.

► To refile an archived document:

1. From the DAISY menu, select Document Mgr.

Note: For easier access, add the Document Manager icon to the DAISY toolbar.
You see the Document Manager window.

2. In the Documents list, right-click on the document and select Refile Document.

3. In the Select Link Type dialog box, choose where to attach the document, then
click OK.
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4. Search for and select the correct patient.

5. In the Confirm dialog box, click Yes.
The document is now attached to the correct patient.

Review archived documents
Documents can optionally be assigned for review when they are archived, or they can
be reviewed later from either the Document panel or the Document Manager window.

► To review all archived documents that are ready for review:

1. From the DAISY menu, select Document Mgr.

Note: For easier access, add the Document Manager icon to the DAISY toolbar.
You see the Document Manager window.
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2. From the Review Status drop-down list, select Ready for Review.
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3. To view a document, double-click the document in the Documents list, then close
the document.

4. To mark the document as reviewed, in the Status section, click .
Document Manager moves to the next document in the list.
Note: To change the document to a different status, click the appropriate status
button. For example, if you determine that the document is incomplete, you can set
the status back to “In Progress”.  However, to change who the document is assigned to,
you need to open the Document Properties window.

5. For each document, repeat steps 3 through 4.

6. When you are done reviewing all documents, click              .
You see the Verify Review dialog window.
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7. From the Reviewer drop-down list, select your user name.

8. In the Password text box, type your password, then click OK.
The reviewed documents are saved and electronically signed off with your user
name.

Note: If you are not authorized to sign off on documents or to change the status from
Ready for Review to In Progress, then when you save the documents, you will see a dialog
window that says “A valid reviewer and password is required to save Reviewed items.” For
information about how to obtain authorization to make these status changes to
documents, see "Set up access permissions for Document Manager" on page 519.

View and modify document properties
You can view and modify the document properties of a document from the Document
Manager window. For example, you can:

l View the e-signature of a document.

l Add an e-signature to a document.

Note: E-signatures cannot be deleted from an archived document.

l Mark the document for review.

l Change the document’s review status.

Note: Documents can also be modified from the Document Panel. Open the appropriate
window, then right-click on the document in the Documents list and select Properties. 
For more information about the Document Panel, see "About the Document Panel" on
page 290.

► To view or change the properties of a document:

1. From the DAISY menu, select Document Mgr.

Note: For easier access, add the Document Manager icon to the DAISY toolbar.
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You see the Document Manager window.

2. Search for and select the appropriate document.

3. In the Documents list, right-click the document and select Properties.
The Document Properties window opens.
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4. Make the appropriate changes, then click OK.

Add a document to the archive
Documents can be added to the DAISY document archive directly from the Document
Manager window.

► To add a document to the archive:

1. From the DAISY menu, select Document Mgr.

Note: For easier access, add the Document Manager icon to the DAISY toolbar.
You see the Document Manager window.
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2. From the Tools menu:
l Select Import File to import a document file. For more information on

importing a document file, see "Archive documents" on page 291.
l Select Scan, then select the item type to scan in a document. For more

information on scanning a document into the archive, see "Scan a document
into DAISY" on page 296.

Delete an archived document

► To delete an archived document:

1. From the DAISY menu, select Document Mgr.

Note: For easier access, add the Document Manager icon to the DAISY toolbar.
You see the Document Manager window.
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2. In the Documents list, right-click on the document and select Delete.

3. In the Confirm Delete dialog box, type a reason for deleting the document, then
click OK.

4. To view information about the deleted document, including who deleted it:
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a. In the Document Manager window, check the Deleted Documents check box to
display deleted documents.

b. In the Documents list, right-click on the document and select Properties.
c. In the Document Properties dialog box, click the Delete Information tab.

d. Click Cancel to close the dialog box.
Note: Deleted documents display in gray text in the Document Manager window. For
more information, see "View a list of archived documents" on page 310.
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Printed prescriptions

Print a prescription (without e-prescribing enabled)
Prescriptions print with the address of the provider’s service location.

l Service location addresses are pulled from the Location tab in the Practice Settings
window under the Location tab (DAISY > Configure > Practice Config).

l New prescriptions use the provider’s default service location, which is specified in
the Provider window (DAISY > Configure > Providers). You can also select a
different service location.

Prescriptions can be printed from the Patient, Chart, Perio Exam, and Patient History
windows. The following procedure illustrates how you can print a prescription from
the Patient window, and include the address of the provider’s service location.

► To print a prescription from the Patient window:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. Click the Prescriptions tab.

4. Click to add a prescription.

5. Search for and select the prescription ID.

6. In the Service Location drop-down list, select the service location.
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7. If your office does not subscribe to DAISY eRx or does not have e-prescribing
enabled, leave the Issue Method blank to automatically default to Print when you
print a prescription.

8. Add or modify other prescription information.
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9. Click to save the prescription.

10. From the Reports menu, select Prescription.
The prescription prints with the selected service location.

After you print the prescription, you see Print in the Issue Method drop-down list and
the Prescription window becomes read-only.

Electronic Prescribing
DAISY eRx enables dental offices to issue electronic prescriptions through Clinician, a
service managed by Emdeon. This feature enables you to access patients’ existing
drug prescriptions covered by insurance and order new prescriptions electronically.
DAISY eRx also offers improved prescription security and auditing, and real-time
eligibility checking.

With DAISY eRx, you can:

l Write and send e-prescriptions directly to the patient’s pharmacy.

l Track a patient’s current medications and prescriptions.

l Determine which medications are covered by your patient’s insurance before you
write the prescription.

l Download a patient’s prescription history (if available) from Clinician into DAISY.

l View a patient’s allergies, existing prescriptions, and potential drug interactions,
before you prescribe a particular drug.

l Ensure that only authorized providers can issue a prescription.

l Write a prescription anytime or anywhere from your mobile device (smart phone
or tablet) using the DAISY Mobile service.

l Authorize refills electronically requested by the pharmacy.
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How DAISY eRx Works
The DAISY e-Prescribing window gives you direct access to Clinician, where you can
issue and manage e-prescriptions, instantly access drug formularies and drug
information, and review and download patient medication history (if available) into
DAISY.

When e-prescribing is enabled, patient prescription information moves from Clinician
to DAISY securely and automatically.

You can connect directly from DAISY to specific windows in Clinician. For example:

l To create a prescription from the Prescriptions tab in the Patient window, click .

l To connect to the Patient Chart window in Clinician from the Patient window,
click in the Quick Access toolbar.

About the Prescriptions tab
The Prescriptions tab in the Patient window displays the patient’s current and past
prescriptions.

l In the Rx Type column:

o eRx indicates an e-prescription issued through Clinician.

o Rx indicates a prescription issued directly in DAISY.
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When you view prescriptions that originated in DAISY (Rx), they automatically
open in the DAISY Prescription window. When you view prescriptions that
originated in Clinician (eRx), they automatically open in the Rx History Details
window in Clinician. For more information on the Rx History Details window, see
"Manage prescription history" on page 340.

Note: If e-Prescribing is not enabled, then prescriptions with an Rx type of eRx open
in the DAISY prescription window for viewing only.

l The Dispense column shows the amount of medication dispensed, such as the
number of pills or the amount of liquid.

l The Status column shows the current status of an e-prescription.
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This
prescription
status…

Indicates that…

Active The patient is currently taking the prescription.

Authorized The provider approved the prescription.

Discontinued The patient discontinued taking the prescription during
the course of treatment.

Lapsed The days supply specified for the prescription has been
reached, such as 30-days supply.

Pending The prescription was placed on hold in Clinician.

Void The prescription was voided prior to being filled by the
pharmacy.

l The Issue Method column shows the method used to issue the prescription or that
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the prescription was reported by the patient.

This issue
method…

Indicates…

Electronic The prescription was issued as an e-prescription and sent
directly to the patient’s pharmacy.

Electronic/Print The prescription was issued as an e-prescription and
printed in the dental office.

Hand Written The prescription was written on a prescription pad and
given to the patient.

Print The prescription was printed in the dental office and given
to the patient to take to the pharmacy.

Reported Self-reported medication that the patient is currently
taking.

Sample A medication was given to the patient in the office.

Telephone The provider phoned in or faxed a prescription to the
pharmacy.

l The Type column shows whether the prescription is new or a refill.

About the Medications tab
The Medications tab in the Patient window displays the patient’s current
medications. If e-prescribing is enabled, then current medications download into this
tab automatically from Clinician.

If a days supply has been specified for the medication and the supply has lapsed,
DAISY automatically removes the medication from this tab.
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About the Patient History window
The Patient History window differentiates between medications and prescriptions.

l Issued prescriptions have an entry type of RX.

l Reported medications have an entry type of MEDS.
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Connect to DAISY eRx
To get started, connect to DAISY eRx from the Patient window.

► To connect to DAISY eRx:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Patient window, click the Prescriptions tab.
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You see the patient’s prescriptions. This tab contains all of the prescriptions that
have been issued to this patient, including current and past prescriptions.
Note: To view current prescriptions, click the Medications tab.

4. In the Quick Access toolbar, click .
The e-Prescribing window opens. The first time you connect to DAISY eRx, you are
required to install two e-prescription modules on each workstation.

5. Click Install to install the first MeadCo’s Scriptx software module.
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You see an Advanced Printing installation dialog box.

6. Click Yes, Allow to enable e-prescription printing.
You see the eRx Patient Chart window.
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Add patient chart information
The first time you add an e-prescription for a patient, be sure the patient’s phone
number is in the Patient Chart in DAISY eRx. You might also want to add the
pharmacy that the patient commonly uses.

Note: All of the patient’s chart information updates automatically in the eRx Patient
Chart when you update the Patient or Account window in DAISY.

► To add patient chart information:

1. In the Home Ph. text box, type the patient’s phone number.

2. Next to the Default Pharmacy text box, click to open the Pharmacy Search
window.

3. In the Step 1 – Search for a Pharmacy section, type the pharmacy information,
then click Search.

4. In the Step 2 – Select a Pharmacy section, choose the pharmacy, then click Select.
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The pharmacy is added to the patient chart.
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5. Click Save to save the patient chart.

Add drug allergies to a patient chart
Use the following procedure to enter the patient’s drug allergies and related allergens
in DAISY eRX. This information automatically downloads into the Medical Alerts tab
in the DAISY Patient window after you close the e-Prescribing window.

► To add drug allergies to a patient chart:

1. In the eRx Patient Chart window, click the Drug Allergies tab.

2. In the Allergies drop-down list, select Has Allergies.

3. Click Add Allergen(s) to open the Allergy Search window.
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4. In the Type drop-down list, select the type of allergen.

5. In the Description, type the allergen, then click Search.

6. In the Search results, check the appropriate allergens, then click Use Selected.

7. Click Save.
The allergen is added to the patient chart.
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Manage prescription history
With DAISY eRx, you can:

l Review the patient’s prescription history before you issue a prescription.

l View current prescriptions issued by external providers and download them into
the Medications tab in the Patient window in DAISY.

l Void, renew, or discontinue a prescription.

l View prescription details.

► To manage a patient’s prescription history:

1. In the eRx Patient Chart window, click the Rx History tab.
You see all of the e-prescriptions issued to the patient by your office.
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2. Click External Drug History to open the Patient Formulary History window.
You see all of the patient’s current prescriptions issued by external providers.
Note: Not all insurance companies or employer group plans allow prescriptions issued
by external providers to show in the patient chart.

3. To download these prescriptions into the Medications tab in the Patient window
in DAISY, do one of the following:
l To download all of the prescriptions, click Select All, then click Add Selected to

History.
l To add specific prescriptions, check the check box next to each prescription,

then click Add Selected to History.
Note: For more information about the Medications tab, see "About the Medications
tab" on page 331.

4. Click Close.
You see the Patient Chart window.

5. Do one of the following:
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l To void a prescription, check the check box to the left of the prescription, then
click Void.

l To renew a prescription, check the check box to the left of the prescription,
then click Renew.

l To Discontinue a prescription, such as when a patient has had an allergic
reaction, check the check box to the left of the prescription. In the Reason to
Discontinue text box, type the reason for discontinuing the medication, then
click Discontinue.

l To view a prescription’s details, check the check box to the left of the
prescription, then click Details.

The prescription details window shows you if the patient has allergies. You can
also use the prescription details window to void, renew, or discontinue a
prescription.
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6. Click Cancel to return to the eRx Patient Chart window.

Add reported medications
Use the following procedure in DAISY eRX to enter any current medications that the
patient reported. This information automatically downloads into the Medications tab
in the DAISY Patient window after you close the e-Prescribing window.

► To add patient-reported medications:

1. In the eRx Patient Chart window, click the Rx History tab.

2. Click Reported Rx to open the Reported Rx window.

3. Next to the Drug text box, click to open the Drug Search window.
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4. In the Description text box, type the name of the drug.

5. Click Select next to the drug the patient reported.

6. Enter other information about the medication, if available.

7. Click Save to close the window.
You see the eRx Patient Chart window.

Add a prescription
After you add reported medications, if any, use the Rx Pad window to add a
prescription.
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► To add a prescription for a patient:

1. Click New Rx.

You see the e-Prescribing Benefit Plans window.

2. Do one of the following:
l Click Select next to the appropriate benefit plan to apply the insurance

formulary to the prescription.
l Click Use None to use no benefit plan.

In this example, no benefit plan information is available for Oliver Swift. The
doctor clicks Use None.

You see the Rx Pad window for the patient.
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3. In the Prescriber drop-down list, select the prescriber.
Note: You must select a prescriber before you can enter other prescription information.

4. Next to the Drug text box, click to open the Drug Search window.

5. In the Description text box, type the name of the drug.

6. Click Select next to the drug you want to prescribe.
Note: DAISY eRx automatically issues a Drug Utilization Review (DUR) warning
when appropriate. Click View to open the DUR Summary.

7. In the SIG drop-down list, select the appropriate directions.

8. Do one of the following:
l In the Quantity text box, type the quantity of medication.
l In the Days Supply text box, type the number of day’s supply of medication.
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Note: The days supply is automatically calculated based on the SIG and quantity,
where appropriate. If the medication is a liquid, however, you must enter both the
quantity of medication and the days supply.

9. In the Refills text box, type the number of refills for this prescription.

10. In the Issue To drop-down list, select the receiving pharmacy for this e-
prescription.
Note: The patient's default pharmacy displays automatically when you start a new
prescription.

11. In the Issue Via drop-down list, select from the following options:

Use this Issue
Via option…

When you…

Electronic Send an e-prescription directly to the pharmacy.

Electronic/Print Send an e-prescription directly to the pharmacy and print a
copy for your records.

Hand Written Issue a paper prescription in the office. This prevents
DAISY eRx from sending the prescription to the pharmacy
and documents that you wrote the prescription.

Print Print the prescription in the dental office and give it to the
patient to take to the pharmacy.

Reported Record a medication that the patient reported.

Sample Dispense the medication at the office.

Telephone Phone in or fax a prescription to the pharmacy.

12. Do one of the following:
l Click Issue to issue the prescription.
l Click Hold to put the prescription on hold.

13. Do one of the following:
l If the medication has a contraindication or allergy alert, go to step 14.
l If the medication does not have a contraindication or allergy alert, go to step

15.

14. In the DUR Summary window, review the information, then do one of the
following:
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l To issue the prescription, click Review & Return.
l To change the medication, click Close to return to the RX Pad window.

You see a confirmation window.

15. Close the e-Prescribing window.

Note: You cannot alter or delete an e-prescription after it is issued. You can, however,
view the prescription’s details. For more information, see "Manage prescription history"
on page 340.

Authorize a pending prescription
A prescription that has been placed on hold requires someone with the appropriate
Clinician authorization permissions to issue the prescription.
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Note: If you need to authorize prescriptions, or if you need your authorization permissions
changed, contact your DAISY Security Officer.

When a prescription is placed on hold in Clinician, it displays with a status of Pending
under the Prescriptions tab in the Patient window.

► To authorize a pending prescription:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Patient window, click the Prescriptions tab.

4. In the Prescriptions section, select the pending prescription.

5. Click .
You see the Issue eRx dialog box.
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6. In the Prescriber drop-down list, select the user who can issue the prescription.

7. In the Password text box, type the password for this DAISY user, then click OK.
You see the Patient Chart window in Clinician.

8. Click Rx Inbox to view pending prescriptions.

9. Check the check box next to the appropriate prescription.

10. Click Authorize to issue the prescription.
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Create a list of drug and SIG preferences
Each time you issue a prescription in DAISY eRX, you have the option of adding the
drug and the SIG to a list of preferences that you can use whenever you want to
prescribe the same drug to one of your patients. You can create a preference list for
the facility and one for each prescriber.

To select from the list of drug preferences, you click to the right of the Drug text
box, then select the medication. Prescriber preferences appear in the top section of
the list, and facility preferences show in the bottom section.

To select from the list of SIG preferences, you click to the right of the SIG text box,
then select the SIG. The top section shows SIGs that were attached to a drug in the
list of drug preferences, and the bottom section shows standard SIGs for the selected
drug.
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► To add a drug and SIG to your list of preferences:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Quick Access toolbar, click to open the eRx Patient Chart window.

4. In the eRx Patient Chart window, click the Rx History tab.

5. Click New Rx.

6. Do one of the following:
l Click Select next to the appropriate benefit plan to apply the insurance

formulary to the prescription.
l Click Use None to use no benefit plan.

You see the Rx Pad window for the patient.

7. Enter all of the information for the prescription.
Note: For more information about adding a prescription, see "Add a prescription" on
page 344.
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8. Do one of the following:
l To add this drug and SIG to the preference list for the prescriber, choose Save

as Prescriber Preference.
l To add this drug and SIG to the preference lists for the facility, choose Save as

Facility Preference.

9. Complete the prescription.
The drug and SIG are added to the preference lists.

View the status of e-prescriptions
The eRx Inbox provides information about the following:

l Prescriptions that the provider still needs to authorize

l Prescription renewals

l Prescriptions with errors that prevented the pharmacy from filling the order

DAISY automatically updates eRx status information every 10 minutes.
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Note: To access the eRx Inbox, you must be assigned the “Allow managing prescriptions?”
permission. For more information, see "Set up access permissions for DAISY eRx" on
page 516.

► To view the eRx Inbox for the practice:

1. From the DAISY Central window, do one of the following:
l Click the Check eRx Inbox link.
l From the Daisy menu, select eRx Inbox.

Note: You can also add an eRx Inbox button (      ) to the DAISY toolbar. If the eRx
Inbox has at least one pending item, the icon is red; otherwise it is green.

2. In the Access eRx Inbox, type your DAISY password.
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You see the e-Prescribing window with today’s prescription status.
Note: If you are using Internet Explorer 9, you must click the Download /Update
Scriptx Here link to enable you to print prescriptions from your computer. 

Search for prescriptions
You can search for a patient’s prescriptions by:

l Prescription status, such as lapsed, authorized, or pending

l Issue type, such as electronic, handwritten, or print

What's New in DAISY 4.4 355



Chapter 19  Manage prescriptions

You can also search for a patient’s prescription types by days supply.

► To search for a patient’s prescriptions by issue type:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Quick Access toolbar, click to open the Search For – Prescriptions
window.

4. In the drop-down list, select Issue Type.

5. Click either Begins With or Contains.

6. Type the name of the issue type, such as Electronic.

7. Select the result you want, then click OK to open the prescription.
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► To search for a prescription by status:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Quick Access toolbar, click to open the Search For – Prescriptions
window.

4. In the drop-down list, select Status.

5. Click either Begins With or Contains.

6. Type the status of the prescription, such as Lapsed.

7. Select the result you want, then click OK to open the prescription.

Search for prescription types

► To search for a patient’s prescription types by days supply:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. Click the Prescriptions tab.

4. In the Prescription tab, click to open the Search For – Prescription Type
window.

5. In the Search By drop-down list, select Days Supply.
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6. Select whether the days supply is less than, greater than or equal to the number of
days you are searching for.

7. Type the number of days.

8. Select the result you want, then click OK to open the prescription type.
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About Perio Exams
In DAISY Chart, exam methods control how you navigate through a periodontal exam.
The method controls the path through the mouth, the type of measurements to
perform, and the views for each tooth. You can always override the exam method and
directly access any tooth, tooth site, or measurement.

One or more unique exam methods can be set up for each clinical staff member. For
example, you may want a method for a comprehensive perio exam and another for an
oral cancer screening. Your office colleagues may want to perform the same types of
exams, but their methods may be set up differently because, for example, they prefer
to take a different path through the mouth or want to perform measurements in a
different order.

When you open a perio exam, DAISY selects a method based on your user settings.
Each method moves forward through the exam automatically. For more information
about user settings, see "Configure DAISY Chart" on page 579.

As you move through the exam, DAISY Chart outlines the current location and
measurement in red to show you where you are. For example, the following exam is
currently positioned to record pocket depth for sites on tooth 32.
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Movement through the mouth follows a hierarchical progression that is determined
by the exam method. As you perform an exam, exam status indicators show you where
you are in the exam method.

Note: Anytime during an exam, you can take a different kind of measurement or
observation, and then return to where you left off in the method. For example, if you’re in
a Probing Depth pass, you can also note bleeding.
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This exam status
indicator...

Shows...

Pass A major sequence through the mouth as defined by
the method. Passes, for example, could be missing
teeth, probing depths on the upper arch, bleeding on
the upper arch, etc.

Measure The type of information to record. A measurement
can have any number of steps. For example, pocket
depth can be measured on three sites of a tooth

Section The current quadrant, such as lower right (LR), lower
left (LL), upper right (UR), upper left (UL)

Tooth The current tooth

Surface The current surface: buccal or lingual

Site The point on the tooth where a measurement is
being recorded, such as distal, direct, or mesial

Create and complete an exam

Create a new perio exam
Because the method can be defined to fit the needs of each performing provider, the
path through the mouth, the type of measurements to perform, and the views for each
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tooth can vary. Here’s an example of a typical comprehensive perio exam to get you
started. The order of the passes for this exam are shown in the following illustration:

Note: Set up your workstation for Perio Charting before you use this DAISY feature. For
more information, see "Configure DAISY Chart" on page 579.

Tip: You can also create a new perio exam from the Schedule window. From the Schedule

window, click the patient’s appointment, then click on the Quick Access toolbar to
open the Search For - Perio Exam window. Click New Perio Exam to open the Perio Exam
window.

Important: If you prefer to enter perio exam information in DAISY after the exam is
performed, be sure to set the correct exam date when you open the Perio Exam window.

► To create a perio exam:

1. From the DAISY toolbar, click .

2. In the drop-down list, select the type of information to search by.
For example, you can search by patient, birth date, or Social Security number. In
this example, select Patient.

3. If present, choose either the Begins With or the Contains option.
For example, if you want to find a patient whose name begins with Abr, choose
Begins With.

4. In the next text box, type the information you want to match.
In this example, you would type Abr.
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5. Click .
Search results display in the lower half of the window.

Note: To always search automatically without having to click , check the Auto
Search check box in the Search window.

6. Select the patient you want, then click OK.
The Patient window opens.

7. Click to open the Search For - Perio Exam window.

8. Do one of the following:
l If no prior exams exist, the Perio Exam window opens. Go to step 9.
l If this is an established patient, you see a list of previous exams. Click New

Perio Exam to open a new exam.
When you create a new perio exam for an established patient, your user
settings determine whether or not previous exam information is brought
forward. If your account is set up to require a confirmation before previous
exam information is brought forward, you see:

Click Yes to bring previous information forward. Click No to open a blank exam.
Go to step 9.

9. From the Exam Date drop-down lists, select the date and time.
Today’s date and time is automatically selected. Select a different date and time if
you’re entering exam information after the exam was performed.

10. From the Method drop-down list, select the method.
Tip: You can configure the age when permanent dentition is automatically applied to
the patient record. From the DAISY menu, select Configure, then Practice
Configuration. Click the System Defaults tab. In the General Options section, select
the age for permanent dentition.
A method is automatically selected based on your user settings. You can select a
different method if you’re performing a different type of exam.

What's New in DAISY 4.4 363



Chapter 20  Use perio charting

Chart tooth status
You use the Tooth Status window to quickly mark missing teeth, implants, and teeth
that should not be probed. You can also use it to set the patient’s overall dentition
(permanent or primary).

Note: The Tooth status window is also available from the Perio Exam window. If tooth
status information is entered from there, then it becomes available automatically in the
Chart window.
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► To chart a patient’s tooth status:

1. From the Quick Access toolbar, click .

2. In the Select Toggle section, choose the tooth state you want to chart.
For example, choose Missing/Present to set a “missing” tooth state.

3. Do one of the following:
l Click an individual tooth to apply the selected tooth state to the tooth.
l Click one of the Toggle As Block buttons to apply the selected tooth state to a

group of teeth.

4. To apply another state to a tooth, repeat steps 2 and 3.

5. To undo a state from a tooth:
a. Select the tooth’s current state in the Select Toggle section.
b. Click the tooth that has the state, or click the appropriate Toggle As Block

button to undo the state for a group of teeth.

6. When done, click OK.
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Measure pocket depth

► To measure pocket depth:

1. From the Pass drop-down list in the Perio Exam window, select Probing Depths
Upper.
Note: During a perio exam, all missing or unerupted teeth are skipped.

2. Do one of the following to record pocket depths for this tooth:
l Type the correct measurement number on the keyboard.

For example, type 3.
l Click the correct measurement number on the exam keypad.

For example, if pocket depth is 3 on the distal buccal (DB) side of tooth 2, then
click 3 on the keypad.

DAISY Chart records the measurement then advances to the next pocket location.

3. For each upper tooth, repeat step 2.
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At the end of the Probing Depths Upper pass, the exam automatically moves to the
next pass. In this example, the next pass is Probing Depths Lower.

4. Repeat step 2 for each lower tooth.
At the end of the Probing Depths Lower pass, the exam automatically moves to the
next pass. In this example, the next pass is Recession Upper.

Chart bleeding
This example method does not include a pass for bleeding, so you can chart this type
of observation at any time. You can chart individual bleeding points without going
tooth by tooth. For example, if there is no bleeding on the lingual side of the upper

arch, you can move to the next section. Use the buttons to navigate to the
tooth you want.

Bleeding measurements can be charted as Inflamed, Delayed, or Immediate.
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► To chart bleeding:

1. Move to the tooth that shows bleeding.

Use either the buttons, the button, or click on the
appropriate column heading (such as DB, B, MB, DL, L, or ML) for the tooth.

2. Do one of the following:

l Click , then click the condition you want, such as Inflamed.
l In the Bleeding row, click the appropriate cell for the tooth you want. Click

again to toggle through the selections.
Note: If a cell is gray, then Bleeding is set to None. When you save the exam, that
cell becomes blank (white) again.

3. Repeat steps 1 and 2 to record bleeding for another tooth.

4. When all bleeding is noted, begin the next pass.
The easiest way to return to the start of the pass, should you need to, is to select
the pass from the Pass drop-down list.

The Delayed Bleeding window is another way to chart delayed bleeding, especially for
more than one tooth or for multiple sites on a tooth.

► To chart delayed bleeding:

1. Click to open the Delayed Bleeding window.

2. Click the tooth number to select the tooth.
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3. Do one of the following:
l Click the site that has delayed bleeding.

Note: You can also select a tooth number, then click the appropriate site button,
such as Distal Buccal, Direct Lingual, or Mesial Buccal.

l To chart more than one site on the tooth, click the site or site button, then
click Record. Repeat this step to record another site on the same tooth.

l To chart multiple sites on the tooth, click All Buccal or All Lingual.

4. Click OK to close the window.

Note: Occasionally during an exam, click on the Quick Access toolbar to ensure that
measurements and observations are not accidentally lost.

Tip: You can also use the keyboard to enter mobility measurements. For +, I, II, III, and
IV, type +, 1, 2,3, and 4. For the plus measurements, use the <Alt> key and a number key.
For example, type <A1t> 1 to enter 1+.

Measure recession and hyperplasia
In DAISY Chart, recession measurements are assumed to be a negative number to
indicate receding gums. When hyperplasia is present, a plus (+) is added to the left
side of the measurement number.
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► To measure recession:

1. Do one of the following:
l To measure recession, type the correct measurement number on the keyboard

or click the correct measurement number on the exam keypad.
For example, type 3 on the keyboard.

Note: Be sure the Plus/Minus button is set to before you type or click a
recession measurement. If not, click the button to change it.

l To measure hyperplasia, click the plus/minus button to Plus, then type the
correct measurement number on the keyboard or click the correct
measurement number on the exam keypad.
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Note: Be sure the Plus/Minus button is set to before you type or click a
hyperplasia measurement. If not, click the button to change it.
DAISY Chart records the measurement, then advances to the next site.
Note: You can also measure individual recession and hyperplasia sites without
going tooth by tooth. For example, if there is no recession on the buccal side of the

lower arch, you can move to the next section in the pass. Use the buttons
to navigate to the site you want.

2. Repeat step 1 for each upper tooth.
The exam automatically moves to the next pass. In this example, the next pass is
Recession Lower.

3. Repeat step 1 for each lower tooth.
At the end of the Recession Lower pass, the exam automatically moves to the next
pass. In this example, the next pass is Contacts.

Measure mobility
This example method does not include a pass for mobility, so you can chart this type
of observation at any time.

► To measure mobility:

1. Do one of the following:
l Click the mobility box below the tooth graphic.

l Navigate to the tooth, then click .
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2. In the Mobility window, click the measurement you want or click None to clear
the measurement.

3. Repeat steps 1 and 2 for each upper tooth.
The exam automatically moves to the next pass. In this example, the next pass is
Mobility Lower.

4. Repeat steps 1 and 2 for each lower tooth.
At the end of the Mobility Lower pass, the exam automatically moves to the next
pass. In this example, the next pass is Contacts.

Note: When the method includes a mobility pass, use number keys on the keyboard, or
the keypad in the Perio Exam window to record mobility. DAISY Chart records the
measurement and then advances to the next site.

Chart contacts
Use the Contact measurement to record any type of inadequate contact between two
teeth.
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► To chart contacts:

l For each tooth, do one of the following:

o Click to record a contact problem.
o On the exam keypad, click Yes to record a contact problem or click No to

advance to the next tooth.

At the end of the Contact pass, the exam automatically moves to the next pass. In this
example, the last pass is Furcations.

Measure furcations
Use the Furcation measurement to record any class of furcation, including the
academic extension of Class II furcations (a,b,c,d). The furcation marker is always
placed at the root tip of the tooth.

During the Furcation pass, DAISY Chart only shows the teeth in a quadrant that can
be marked with a furcation.
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► To chart furcations:

1. For each tooth, click .

2. In the Furcation window, click the measurement you want or click None to clear
the measurement.
Here are the chart graphics for each furcation measurement:
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Class I Class II Class II
(a)

Class II
(b)

Class II
(c)

Class II
(d)

Class III Class IV

Chart keratinized tissue, calculus, plaque, and infection
Anytime during an exam, you can chart other conditions that are not part of the
selected method. This example method does not include a pass for keratinized tissue,
calculus, plaque, and infection.

Tip: The Periodontal Graphic Chart provides similar information as the Perio Exam Full
View, but in a different layout. You can send this report home with the patient or along
with an insurance claim.

From the Reports menu, select Perio Graphic Chart. Click Yes to print the report.

► To chart keratinized tissue:

1. Move to the site that has the tissue.

Use either the buttons, the button, or click on the
appropriate column heading (such as DB, B, MB, DL, L, or ML) for the tooth.
Note: If you use the Go Tooth button, the tooth and site you select must exist in the
current pass. For example, if you select tooth 21during the Probing Depths Upper
pass, DAISY Chart will not move to tooth 21. Instead, it remains on the current tooth.

2. Click , then click the number that represents the distance from
the mucogingival junction to the gingival margin.
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► To chart plaque:

1. Move to the site that has plaque.

2. Do one of the following:

l Click , then click Slight, Moderate, or Heavy.
l In the Plaque row, click the appropriate cell for the tooth you want. Click again

to toggle through the selections.

► To chart calculus (hard plaque):

1. Move to the site that has calculus.

2. Do one of the following:

l Click .
l In the Hard Plaque row, click the appropriate cell for the tooth you want.

Add a prescription

► To add a prescription for the patient:

1. From the Edit menu, select Patient Prescriptions.

2. Do one of the following:
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l If a prescription is already associated with the patient, search for and select the
prescription, then click OK.

l If this is a new prescription for the patient, click New Patient Prescriptions -
patient name, search for and select the prescription, then click OK.

3. Modify prescription information to fit the patient.

4. Click and close the Patient Prescription window.

Save the perio exam
When you’re done entering all measurements and observations, save the exam.

► To save the exam:

l Click and close the Perio Exam window.

Note: To minimize the possibility of losing data, you may want to save periodically
during the exam.

Use the Perio Exam Full View
The Perio Exam Full View shows the exam results in a single view. You can also use
this view to show the patient the results of the exam.
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In the DAISY Chart Workstation Settings window, the option you choose for the
Pocket Depth Red Indicator Line affects the appearance of the Full View as well as
other DAISY Chart reports.

Note: For more information about DAISY Chart Workstation Settings, see "Configure
DAISY Chart" on page 579.

If the Pocket Depth Red Indicator Line option is set to:

l Pocket + Recession, then the Indicator Line is red when the combination of the
site’s pocket depth plus recession are 4 or greater.

l Pocket Only, then the Indicator line is red only when the pocket depth is 4 or
greater. The recession measurement does not affect the Indicator Line’s color.
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► To open the Perio Exam Full View:

l From the View menu in the Perio Exam window, select Perio Exam Full View.

► To print the Perio Exam Full View:

l From the Report menu in the Full View window, select Perio Exam Full View.
The report prints to the default DAISY Chart printer. For more information about
changing this default printer, see "Change printer settings for DAISY Chart" on
page 590.

Use the Perio Exam Comparison Chart
The Perio Exam Comparison Chart lets you compare results from up to seven existing
exams in a graphic format. You might want to show this report to a patient or send it
with the patient to give to a periodontist.

► To view a perio comparison chart:

1. From the View menu in the Perio Exam window, select Perio Exam Comparison.

2. To select the exams to compare, press CTRL while you click the primary mouse
button on the exams you want.
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3. Click OK.
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Each exam is displayed top to bottom from the oldest exam to newest. A plus sign
on the tooth indicates that the overall pocket depth has improved. A minus sign
indicates that the overall pocket depth is worse. No sign means there is no
significant change.
Calculations are based only on the measurements from the newest exam and the
prior exam on this chart. For each site, DAISY Chart subtracts the newest
measurement from the prior measurement. If the result is +2 or more, the
measurement is retained. If the result is -2 or more, the measurement is retained.
If the result is 1, -1, or 0, the measurement is thrown out.
In the following example, all the measurements are thrown out, so the tooth gets
no sign because the change was not significant.
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1st pocket 2nd pocket 3rd pocket

Prior exam 4 2 3

Newest exam    3 3 3

Results 1 -1 0

Missing teeth display with hatch lines, similar to the way they are displayed in the
Perio Exam window.
Perio exams can be sorted by ascending or descending order.
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View an existing perio exam

► To view an existing perio exam:

1. From the DAISY toolbar, click .

2. Search for and select the patient you want, then click OK.
The Patient window opens.

3. Click to open the Search For - Perio Exam window.
You see a list of previous exams.

4. Select the exam to open, then click OK.
The Perio Exam window opens.

Delete a perio exam

► To delete a perio exam:

1. From the DAISY toolbar, click .

2. Search for and select the patient you want, then click OK.
The Patient window opens.

3. Click to open the Search For - Perio Exam window.
You see a list of previous exams.

4. Select the exam to delete, then click OK.
The Perio Exam window opens.

5. From the File menu in the Perio Exam window, select Delete.

6. In the Confirm window, click Yes to delete the exam.

7. Click OK to close the Delete Exam window.
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21 Use voice recognition for a
perio exam
Perio exams (but not hard tissue exams) can be performed using DAISY Chart’s voice
recognition capability. To help you get a feel for using voice recognition, here’s a
hands-free example of a typical comprehensive perio exam.

To get the most from this section, become familiar with charting a perio exam using
the keyboard and mouse first. For more information, see "Create and complete an
exam" on page 361.

Important: Before you use voice recognition to chart a perio exam, you must configure
the voice recognition software for each computer that you plan to use.

Navigation commands
To navigate through the chart, say the command “Next” or “Previous” followed by one
of these areas:

l Measure

l Site

l Tooth

l Quadrant

l Pass

l Surface

To pause voice recognition, say “Stop listening”.

For a complete list of voice commands, say “What Can I Say?”

If you lose track of where you are in an exam, say “Where am I?” In your headset, you
will hear a detailed explanation of where you are. For example, “Where. The tooth
number is nine. The surface is buccal. The site is distal. The measure is depth.

Tip: You can use voice recognition to print an exam to the DAISY Chart default printer.
To print an exam from the Perio Exam window, say “Print Exam”, then say “Yes”. You
may be asked to save the exam. Say “Yes” to save changes to the exam.
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Train the patient
Before you begin the exam, make the patient aware that you are using voice
technology. Since the computer can also hear the patient, the patient needs to be
quiet to prevent erroneous data entry in the exam.

Suggest that patients raise a hand when they need to say something. This signal gives
you a chance to mute the headset or tell DAISY Chart to stop listening.

Create a perio exam using voice

► To create a perio exam using voice:

1. Open a new perio exam for the patient.
For information about creating a new perio exam, see "Create and complete an
exam" on page 361.

2. Say “Start Listening” to activate voice recognition.

Tip: To pause voice recognition, say “Stop listening”.

Tip: For a complete list of voice commands, say “What Can I Say?”

When voice recognition is activated, the red dot in the lower right corner of the Perio
Exam window changes to green. You also hear “voice recognition active” in the
headset.
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Throughout the exam, DAISY Chart echoes each command that you say so you can be
sure the correct measurement or observation was recorded. This feedback (combined
with the method, which helps to ensure that you always chart in the same order)
enables you to chart without having to look at the screen to see where you are.

Now you’re ready to use voice commands to record the exam. In this example, the
first pass is Missing Teeth.

Chart missing teeth

► To chart missing teeth:

1. Do one of the following to open the Tooth Status window:
l Say “Missing”.
l Say “Tooth Status”.

2. In the Select Toggle section, speak the command for the tooth state you want to
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chart.
For example, say “Missing” to set a “missing” tooth state.

3. Do one of the following:
l Speak the number of an individual tooth to apply the selected tooth state to

the tooth. For example, say “Three” to mark tooth number 3 as “missing”.
l Speak the command for one of the Toggle As Block buttons to apply the

selected tooth state to a group of teeth. For example, say “Ortho” to mark teeth
5, 12, 21, and 28 as “missing”.

4. To apply another state to a tooth, repeat steps 2 and 3.

5. To undo a state from a tooth:
a. Speak the command for the tooth’s current state.
b. Say the number of the tooth that has the state, or speak the appropriate Toggle

As Block command to undo the state for a group of teeth.

6. When done, say “OK”.
The Tooth Status window closes.

7. To move to the next pass, say “Next Pass”.
In this example, the next pass is Probing Depths Upper.

Measure pocket depth

► To measure pocket depth:

1. To record pocket depth, do one of the following:
l Speak the pocket measurement for the site.

For example, say “Two” to mark a pocket depth of “two” for the current site.
l If all pocket depths for a tooth are the same, such as “three”, say “All Threes”.

Note: The “All” command only works with “Ones”, “Twos” or “Threes”.
DAISY Chart records the measurement(s) then advances to the next pocket
location.
Important: Voice recognition only responds when single numbers or groups of three
numbers, such as 3-2-4, are spoken.

2. To navigate backwards, say “Previous” followed by the type of location.
For example, say “Previous pass” to move to the prior pass in the method or
“Previous site” to move to the prior site.
Note: If the current pass charts more than one site per tooth, such as distal buccal,
direct buccal, mesial buccal, then the command “Previous Tooth” moves to the first
measurement site on the previous tooth rather than the closest site.

3. For each upper tooth site, repeat step 1.
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At the end of the Probing Depths Upper pass, the exam automatically moves to the
next pass. In this example, the next pass is Probing Depths Lower.

4. Repeat step 1 for each lower tooth.
At the end of the Probing Depths Lower pass, the exam automatically moves to the
next pass. In this example, the next pass is Recession Upper.
Note: Occasionally during an exam, say “Save Exam” to save the exam to ensure that
measurements and observations are not accidentally lost.

Chart bleeding
This example method does not include a pass for bleeding, so you can chart this type
of observation at any time. The method remains on its current pass even as you
record bleeding measurements. You can chart individual bleeding points without
going tooth by tooth. For example, if there is no bleeding on the lingual side of the
upper arch, you can move to the next section.

Bleeding measurements can be charted as Inflamed, Delayed, or Immediate.

Tip: If the method has a Bleeding pass, you can speak the command “Yes” to note
bleeding or “No” to indicate that no bleeding is present.

► To chart bleeding:

1. Use navigation commands to move to the tooth that has bleeding.
For example, say “Tooth 3”
Note: The tooth must be part of the current section, such as Upper Lingual.

2. Do one of the following:
l To record immediate bleeding, say “Bleeding” or “Immediate”.
l To record delayed bleeding, say “Delayed”.
l To record inflammation, say “Inflamed”.

3. When all bleeding is noted, return to the next pass using the appropriate voice
commands.
In this example, the next pass is Recession Upper.

Measure recession

► To measure recession:

1. Speak the recession measurement for the tooth.
For example, say “Three” to mark a recession of “three”. DAISY Chart records the
measurement(s) then advances to the next tooth or site.

2. For each upper tooth, repeat step 1.
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At the end of the Recession Upper pass, the exam automatically moves to the next
pass. In this example, the next pass is Recession Lower.

3. Repeat step 1 for each lower tooth.
At the end of the Recession Lower pass, the exam automatically moves to the next
pass. In this example, the next pass is Mobility Upper.

Measure mobility

► To measure mobility:

1. Speak the mobility measurement for the tooth.
For example, say “Two Plus” to mark a mobility of “II+”. DAISY Chart records the
measurement then advances to the next tooth.

2. Repeat step 1 for each upper tooth.
The exam automatically moves to the next pass. In this example, the next pass is
Mobility Lower.

3. Repeat step 1 for each lower tooth.
At the end of the Mobility Lower pass, the exam automatically moves to the next
pass. In this example, the next pass is Contacts.

Chart contacts

► To chart contacts:

l For each tooth, do one of the following:
o Say “Yes” to record a contact problem.
o Say “No” to advance to the next tooth.

At the end of the Contacts pass, the exam automatically moves to the next pass. In
this example, the last pass is Furcations.

Chart furcations

► To chart furcations:

1. Speak the class measurement for the tooth.
For example, say “Class Two” to mark a furcation of Class II.
DAISY Chart records the measurement then advances to the next tooth or site.

2. Repeat step 1 for each tooth.
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Note: If you try to chart a furcation for a tooth that doesn’t have one, you hear “Furcation
not available for this tooth.”

Chart plaque
Anytime during an exam, you can chart other observations or measurements that are
not part of the current pass. For example, during a Mobility pass, you might notice
some plaque. Since you are in a Mobility pass, when you record the plaque, the pass
does not advance to the next tooth. The pass advances only after you make a mobility
measurement.

You can only navigate to sites that exist in the current pass. For example, in this
Mobility pass, only the direct site can be charted. So if you want to chart a
measurement or observation on a mesial or distal site, you have to do it from a pass
where those sites are available, such as Probing Depths Upper.

► To chart plaque:

1. Move to the site that has plaque.
For example, if you are on tooth 4, say “Previous Tooth” to return to tooth 3.

2. Do one of the following:
l Say “Plaque” or “Heavy” to indicate heavy plaque.
l Say “Moderate” to indicate moderate plaque.
l Say “Slight” to indicate slight plaque.

Plaque is recorded on tooth 3 and the pass remains there. If you do not need to
change the mobility measurement for tooth 3, then say “Next Tooth” to move to
tooth 4.

Use the Perio Exam Full View

► To open the Perio Exam Full View:

l Say “Full View”, then “Yes” to save the exam.

► To print the Perio Exam Full View:

l Say “Print”.

► To close the Full View window:

l Say “Close”.
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Save the perio exam
When you’re done entering all measurements and observations, save the exam.

► To save the exam:

1. Say “Save Exam”.

2. Say “Stop Listening” to pause voice recognition.
The Perio Exam window remains open. When voice recognition is paused, the
green dot in the lower right corner of the Perio Exam window changes to red. You
also hear “Voice recognition in pause mode” in the headset.

3. Close the Perio Exam window.
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Troubleshoot voice recognition
Occasionally, voice recognition may stop responding to your voice. This can happen
for a variety of reasons, such as when someone else uses your voice profile, the
headset is disconnected, or your voice profile becomes corrupted.

If voice recognition stops responding, do the following in this order:

l Check that the Perio Exam window is active. An active window is the currently
focused window. Click the window to be sure it is active.

l Check the headset to be sure it is properly connected (plugged in), the mute
button is not enabled, and the volume is not turned down completely or set too
low.

l Make sure voice recognition is enabled.

l Restart DAISY.

l Retrain voice recognition on the specific computer.

Check that voice recognition is enabled
If the headset’s physical connections are okay, then check that voice recognition is
enabled in Windows.

► To check that voice recognition is enabled:

1. Log in to DAISY.
The voice profile is always associated with a specific account, so be sure to log in
to your user account. For more information, see "Log in to DAISY" on page 25.

2. Create a new perio exam.
Create a new exam for any patient. You can use this exam to try out voice
activation in perio charting. For information on creating a new perio exam, see
"Create and complete an exam" on page 361.

3. From the Tools menu, select Voice Settings.

4. Click the Voice Settings tab.
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5. Make sure the following check boxes are checked:
l Enable Voice
l Echo Commands

6. Make sure the Sound Playback drop-down list shows the correct device.

7. Click OK.

Restart DAISY

► To restart DAISY:

1. From the File menu in any DAISY window, select Exit.

2. On the Windows Desktop, double-click the DAISY icon.

3. Log in to your account.
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For more information, see "Log in to DAISY" on page 25.

4. Create a new perio exam.
For more information, see "Create a perio exam using voice" on page 386 .

5. Try using voice recognition to record a perio exam.

Retrain voice recognition
If voice recognition still doesn’t work after you have checked all the physical
connections and you know that voice recognition is enabled, your voice profile may
be corrupted. You need to delete your voice profile, and retrain voice recognition to
respond to your voice.
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► To retrain voice recognition:

1. Delete your voice profile:
a. From the Windows Start menu, select Control Panel.
b. In the Control Panel window, double-click Speech.
c. Click the Speech Recognition tab.
d. In the Recognition Profiles section, select your user name, then click Delete.

e. Click OK.

2. Log in to DAISY.
The voice profile is always associated with a specific account, so be sure to log in
to your user account.

3. Create a new perio exam.
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Create a new exam for any patient. You can use this exam to try out voice
activation in perio charting. For information on creating a new perio exam, see
"Create a perio exam using voice" on page 386.

4. From the Tools menu, select Voice Settings.

5. From the Voice Dialogs drop-down list, select Mic Training, then click Open.

6. Follow the instructions in the Windows Microphone Wizard.
The Windows Microphone Wizard walks you through microphone training so voice
recognition works with DAISY perio charting.

7. From the Voice Dialogs drop-down list, select User Training, then click Open.

8. Follow the instructions in the Voice Training Wizard.

9. When complete, click Finish.

10. From the Voice Dialogs drop-down list, select DAISY Voice Training, then click
Open.

11. Follow the instructions in the DAISY Voice Training Wizard.

12. When complete, click Finish.

13. Click OK to close the Voice Settings window.

You now have a new voice profile on this computer. Try using voice recognition again
to record a perio exam. If you still have problems, contact DAISY customer support.

What if Voice Recognition Stops Working?
If voice recognition is not responding, make sure the headset’s mute button is not
enabled. If it is not enabled, then you may need to retrain voice recognition.

Tip: If you lose track of where you are in an exam, say “Where am I?” In your headset,
you will hear a detailed explanation of where you are. For example, “Where. The tooth
number is nine. The surface is buccal. The site is distal. The measure is depth.
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About Hard Tissue Exams
DAISY Chart’s hard tissue charting enables you to graphically record the conditions in
a patient’s mouth, including existing restorations and hard tissue pathologies, while
you record the procedure codes associated with the treatment provided. You can also
use hard tissue charting to set up treatment plans.

Methods
In hard tissue charting, exam methods control the passes through the patient’s mouth
during an exam. The hard tissue chart provides two exam methods:

l Default Chart Method charts the passes through a patient’s mouth in this order:
existing restorations, conditions of teeth, and treatment planning.

l Free Form Method charts the passes through a patient’s mouth in this order:
existing restorations and treatment planning, but you can also record pathologies
during any pass.

In addition, both the Default Chart Method and Free Form Method include a
Complete pass that you can use to bypass treatment planning, such as during an
emergency visit.

During a hard tissue exam, methods control the order of the passes through the
patient mouth, such as when existing restorations, conditions, and treatment

What's New in DAISY 4.4 399



Chapter 22  Use hard tissue charting

planning are recorded. However, you can override the method anytime during an
exam.

Note: When you use the Default Chart Method, you can break out of the current pass, but
only in a limited manner. During an existing restoration pass, for example, you can click
the Conditions tab and chart a pathology, but the method immediately returns to the
Restorations tab. In the Free Form Method, whichever tab you choose remains selected
until you choose another.

Chart tabs and buttons
As you move through each pass in the Default Chart Method, Daisy Chart
automatically selects the most appropriate Chart tab. Each Chart tab contains up to
16 Chart buttons that you can use to record information associated with the pass. For
example:

l The Restorations tab includes buttons for recording tooth-related procedures,
such as amalgams, buildups, and root canals.

l The Conditions tab includes pathologies, such as abfractions, caries, and tooth
fractures.

l The Exam tab includes non-tooth-related procedures, such as adult prophy,
comprehensive exam, and x-rays.

l The By Category tab includes shortcuts to all of the ADA procedure categories,
such as Endodonics, Diagnostics, and Oral Surgery, as well as conditions and user-
defined procedures.
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Each Chart button contains a subset of the codes for procedures you perform most
often. For example, if you routinely install ceramic crowns, you can click the Ceramic
Crown button and the ADA code associated with that procedure is automatically
added to the patient chart. If more than one code is associated with a Chart button,
you can select which codes apply from a subset of codes.

You can also use the Select Procedure button to search for and select from the entire
code set.

Tip: You can create your own Chart tabs and buttons. For more information, see
"Customize Chart tabs and buttons" on page 583.

Tip: By default Chart buttons display alphabetically in columns from left to right. To
rearrange the order, right-click in the Chart button section and select Rearrange Buttons.
Drag each button to the preferred position. When done, right-click and deselect
Rearrange Buttons.

Navigation
As you move through the exam, DAISY Chart outlines the current location in red in
the tooth graphics section of the chart to show you where you are. For example, the
following exam is currently positioned to record information for tooth 1.
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As you perform an exam, exam status indicators near the top of the window show
where you are in the exam method.

This exam status
indicator...

Shows...

Pass A major sequence through the mouth as defined by
the method. Passes, for example, can be Existing
Restorations, Conditions of Teeth, and Treatment
Plan

Section The current quadrant, such as lower right (LR), lower
left (LL), upper right (UR), upper left (UL)

Tooth The current tooth, even if the tooth is missing from
the location

Site Same as the current pass

To move through the exam, use the buttons near the top of the window to
navigate to the pass, section or tooth you want.

Procedures
Procedures that have been performed on the patient display in the tooth graphics
section as well as in a list at the bottom of the Chart window. The most recent entry
is shown at the top of the list and the list cannot be sorted. Columns can be
rearranged, however.

How Tooth Graphics Display
Tooth procedures display in layers on the graphics chart from bottom to top: existing,
completed, conditions, planned.

Procedure color codes
The list of procedures at the bottom of the Chart window are color-coded as follows
to help you scan more efficiently. The color codes can be customized; the supplied
colors are:

l Blue - Planned treatment

l Red - Completed treatment that has not been posted

l Gray - Completed treatment that has been posted

l Black - Existing restorations and conditions
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This procedure
column...

Shows...

Srv. Date The date of the procedure

Th. The tooth that received the procedure

Description Description of the service performed

Note A clinical note is associated with the performed

procedure when is present

Surface The tooth surface

Quad. The quadrant

Status The status of the procedure line item:

Existing indicates an existing restoration

Planned indicates planned treatment

Completed indicates completed treatment

Condition indicates a tooth condition, such as
missing tooth, a failing restoration or a tooth fracture

Fee The fee associated with the procedure

Performing Provider The provider who performed the procedure

Appt The appointment (when a series of appointments
have been scheduled) when the procedure should be
performed

When treatment planning, you can establish an order
for treatment. If multiple appointments are required
for the treatment, this number indicates at which
appointment the procedure should be performed.
This information is then applied to the treatment
plan in DAISY

Display options
Display Options control what displays in the Chart window and when you print the
chart. For example, uncheck the Planned Treatment check box to remove planned
treatment from the tooth graphic chart and the procedure list at the bottom of the
window. This same setting hides Planned Treatment if you print the chart.
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Depending on what is most important for you to view, you can also change the size of
the tooth graphics chart. For example, to see more of the procedures list, you can
make the tooth graphics smaller.

► To change the size of the tooth graphics:

l From the View menu in the Chart window, select Graphic Size, then select the size
of the graphics.

Create a hard tissue chart
Because each exam can be performed according to the needs of each provider, the
information recorded can vary. Here’s an example of a typical exam to get you
started.

► To create a hard tissue chart:

1. From the DAISY toolbar, click .

2. In the Schedule window, click the patient appointment to chart.

3. On the Quick Access toolbar, click .
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The Chart window opens.

4. From the Method drop-down list, select the method.
This example uses the Free Form Method.
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Tip: You can also create a new hard tissue exam from the Patient window. Click the
Chart icon on the Quick Access toolbar.

Chart tooth status
Unlike the Perio Exam window, the Tooth Status window shows all the teeth in a
single view. You can use this window to quickly mark missing teeth, implants, and
teeth that should not be probed. You can also use it to set the patient’s overall
dentition (permanent or primary).

All measurements (such as bleeding, pocket depth, recession, and mobility) can be
recorded either as part of a pass or outside of a pass.

To record a measurement as part of a pass, the measurement must be set up as a pass
in the selected method.

Note: The Tooth status window is also available from the Chart window. If tooth status
information is entered from there, then it becomes available automatically in the Perio
Exam window.
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l Use the Select Toggle section to designate which tooth state you want to apply to
a tooth. For example, choose Missing/Present to designate missing teeth.

l Use the Toggle as Block buttons to apply the selected tooth state to a group of
teeth. For example, the Wisdom button applies the selected tooth state, such as
unerupted, to all the wisdom teeth.

l Use the Set Overall Dentition section to specify which tooth graphics should be
used in the perio and hard tissue chart. For example, if the patient’s teeth are
permanent, click Set to Permanent.
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► To chart a patient’s tooth status:

1. From the Quick Access toolbar, click .

2. In the Select Toggle section, choose the tooth state you want to chart.
For example, choose Missing/Present to set a “missing” tooth state.

3. Do one of the following:
l Click an individual tooth to apply the selected tooth state to the tooth.
l Click one of the Toggle As Block buttons to apply the selected tooth state to a

group of teeth.

4. To apply another state to a tooth, repeat steps 2 and 3.

5. To undo a state from a tooth:
a. Select the tooth’s current state in the Select Toggle section.
b. Click the tooth that has the state, or click the appropriate Toggle As Block

button to undo the state for a group of teeth.

6. When done, click OK.
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Note: You can also chart missing teeth in the Perio Exam window. During the Missing
Teeth pass, click the tooth, then click Yes on the keypad to mark the tooth as missing.
Click No to put a missing tooth back.

Chart existing restorations
The easiest way to chart existing restorations, such as amalgams, buildups, and root
canals, is to use the buttons in the Restorations tab.

Tip: To chart the same information on multiple teeth, press CTRL while you click the
primary mouse button to multi-select the teeth, then click the appropriate button to
apply the procedure.

► To chart existing restorations:

1. In the Pass navigation area, click the appropriate buttons to select the
Existing Restorations pass.

2. Click the tooth to chart.
In this example, tooth 15 has an existing amalgam.

3. Click the Restorations tab, then click Amalgam.

4. Check the appropriate surfaces for this amalgam, then click OK.

The chart graphic for an amalgam is applied to the tooth in blue, the color for
existing restorations. A charted procedure is also added to the list at the bottom of
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the Chart window.

Chart conditions
The easiest way to chart conditions (also known as pathologies), such as abfractions,
caries, and tooth fractures, is to use the buttons in the Conditions tab. In the Free
Form method, conditions can be charted during any pass.

Tip: Procedures that are not associated with a tooth can be added directly to the
procedures list at the bottom of the Chart window.

To add a procedure, click to add a blank line, then type in the appropriate
information in each column. When done, save the chart.

► To chart conditions:

1. Click the tooth to chart.
In this example, the amalgam on tooth 15 is fractured on the occlusal surface.

What's New in DAISY 4.4 411



Chapter 22  Use hard tissue charting

2. Click the Conditions tab, then click Fractured Restoration.

3. Check the appropriate surface for this fractured amalgam, then click OK.
The fractured restoration tooth graphic is applied to tooth 15 in green, the color
for tooth conditions. A charted procedure is also added to the list at the bottom of
the Chart window.

Chart a treatment plan
The easiest way to chart a treatment plan is to use the buttons in the Restorations
tab.

► To chart a treatment plan:

1. In the Pass navigation area, click the appropriate buttons to select the
Treatment Plan pass.

2. Click the tooth to chart.
In this example, tooth 15 has a large filling with a fractured surface. The provider
decides to replace the filling with porcelain-fused-to-gold crown during a future
appointment.

3. Click the Restorations tab, then click PFG.
The porcelain-fused-to-gold crown graphic is applied to tooth 15 in red, the color
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for planned treatment.

Chart Unplanned Treatment
Treatment planning is not always appropriate for some appointments, such as when a
patient comes in with a sensitive spot on a tooth that requires an immediate filling.

► To chart unplanned treatment:

1. Open a hard tissue exam for the patient.

2. Select any method.

3. In the Pass navigation area, click the appropriate buttons to select the
Complete pass.

4. Click the tooth to chart.
In this example, tooth 32 needs a filling.
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5. Click the Restorations tab, then click Composite.

6. Check the appropriate surfaces for this filling, then click OK.
The filling graphic is applied to tooth 32 in purple, the color for completed
treatment.

Charting completed treatment generates an entry in the DAISY Transactions window.
For more information on transactions, see "Manage financial information" on page
155.

Note: Once treatment is completed and posted, it cannot be deleted from the chart.

Tip: To remove a procedure associated with a tooth, right-click the tooth, select Remove
Entry, then select the procedure. To remove any procedure from the chart, right-click the
procedure in the charted procedures list and select Remove entry entry number.

Add a tooth note
You can associate a clinical note with a specific tooth.
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► To add a tooth note:

1. In the Chart window, right-click on the tooth, then select Add Note.
The Clinical Notes - General form opens.

2. Complete the form.

3. Click and close the window.

The note is added to the procedure list at the bottom of the Chart window. DAISY
assigns the procedure number C0086 and the description “Observation” to the note.

Add a prescription

► To add a prescription for the patient:

1. From the Edit menu, select Patient Prescriptions.

2. Do one of the following:
l If a prescription is already associated with the patient, search for and select the

prescription, then click OK.
l If this is a new prescription for the patient, click New Patient Prescriptions -

patient name, search for and select the prescription, then click OK.

3. Modify prescription information to fit the patient.

4. Click and close the Patient Prescription window.

Print the chart
Important: Display options in the Chart window affect the content of the printed chart.
For example, if Display Options are set to display only planned treatment, then the
printed chart shows only planned treatment. For more information on Display Options in
the Chart window, see "Display options" on page 404.

► To print the patient’s chart:

1. From the Report menu in the Chart window, select Patient Chart.

2. Do one of the following:

l To view the chart first, click Preview, then click to print it.
l To print the chart without previewing it, click Print.

What's New in DAISY 4.4 415



Chapter 22  Use hard tissue charting

The report prints to the default DAISY Chart printer. For more information about
changing this default printer, see "Change printer settings for DAISY Chart" on
page 590.

Save the hard tissue chart
When you’re done entering all the chart information, save the chart.

Questions? www.softwarefordentists.com 1.800.368.6401416

http://www.softwarefordentists.com/


Chapter 22  Use hard tissue charting

► To save the chart:

l Click and close the Chart window.

Complete a planned procedure from the chart
Treatment plan procedures are shown in the Chart window in both the tooth graphic
section and in the procedure list at the bottom of the window. Once you complete
the planned treatment, you need to indicate that those procedures are complete.

In this example, the patient comes in for a follow-up appointment to have a
porcelain-fused-to-gold crown placed on tooth 15.

► To complete a treatment plan procedure:

1. From the DAISY toolbar, click .

2. Search for and select a schedule, then click OK.

3. In the Schedule window, click the patient appointment to chart.

4. On the Quick Access toolbar, click .
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5. To mark the treatment as complete, do one of the following:
l In the procedure list at the bottom of the Chart window, right-click the

procedure, then select Mark Completed.
l Right-click a tooth with planned treatment, select Mark Completed, then select

the procedure.
The Status of the procedure changes to Completed and the completed item is
automatically added to the Transactions window in DAISY.
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6. Click and close the Chart window.

Tip: If you enter procedures when you set up an appointment, they will automatically be
marked as Completed in the Chart window when you check out the patient. For more
information about adding procedures to an appointment and marking them as
Completed during checkout, see "Set up an appointment " on page 94 and "Check out
a patient" on page 114.
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Design a Detail template
Detail templates are a starting point for creating clinical notes. You design
customized Detail templates to document patient chart information, such as medical
history, treatment notes, phone conversations with the patient, and other clinical
information. Here is an example of an Adult Medical History template.

All forms created from these templates can be accessed directly from DAISY and
DAISY Chart. Access to templates and clinical information can also be restricted to
specific users. For more information about user access to these templates and clinical
information, see "Set up access to Detail templates" on page 515.

Some templates are designed to bring previously entered information forward. For
example, you may want a patient’s medical history brought forward so you can note
the changes since the patient's last visit.

If a template contains fields that all respondents will answer in the same way, you can
pre-populate them with correct information before you save the template. When users
open the form, these fields will already be filled in.
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Note: Use caution when you pre-populate fields in templates with multiple tabs. These
fields will show up on Detail forms even if the tab was not otherwise filled out.

DAISY keeps an audit trail of changes that are made to clinical information. When a
user changes a patient’s clinical information, DAISY prompts the user for a reason.
DAISY records who performed the action, when it occurred, and the reason for the
change. Changes in some forms can be made on a field-by-field basis, and the user
must provide a reason for each of those changes. When needed, audit trails are easy
to access.

To design a Detail template, you need to complete the following steps in this
order:

1. Create a new template.

2. Add a tab sheet.

3. Add objects, such as text boxes, drop-down lists, radio buttons, check boxes, and
lines.

4. Modify the template's properties.

5. Rename object labels.

6. Modify object properties.

7. Specify the sequence of data entry, which is the order in which fields are selected
as you press <Tab> or <Enter> on a Detail form created from the template.

8. Change the default color of the Note icon.

Note: DMC recommends that you create a mockup of the template on paper first before
you design it in DAISY.

Use the Editing toolbar
Use the Editing toolbar in the template window to add objects, such as text boxes,
drop-down lists, radio buttons, check boxes, and lines to a Detail template.

Note: For more information about the template window, see "Create a new Detail
template" on page 425.
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Use this
button...

To do this...

Add a tab sheet to the template. For example:

For more information, see "Add a tab sheet to a Detail template" on
page 440.

Add a section label. Used to name specific sections of a form. For
example:

Add a label associated with a data object such as a text box, check
box, or drop-down list. For example:

Add a gray rectangle. Used as a 4-sided border to separate sections
on a form.

Add a gray vertical line. Used as a border to separate sections on a
form.

Add a gray horizontal line. Used as a border to separate sections on a
form.

Add a check box. For example:

Add a group of radio buttons. The buttons can have a vertical or
horizontal orientation. For example, this object has a vertical
orientation:

Note: When you show or hide the label for radio button group, DAISY
automatically resizes the group to use the minimum amount of space in
the template.

Add an empty drop-down list. For example:
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Use this
button...

To do this...

Items in the drop-down list are added separately. For more
information, see "Modify a drop-down list" on page 445.

Add a single-line text box. This can be used for short amounts of text.
For example:

Add a text box for monetary amounts. This object automatically
assigns a dollar sign ($) to the entered amount. For example:

Add a text box for entering integers, such as 357 and -98. For
example:

Decimal numbers, such as 357.2, cannot be entered in this type of
text box.

Add a text box for precise numbers, such as 67 or -45, and decimal
numbers, such as 479.33 and –29.2. For example:

Add a date and time selector. For example:

Add a date selector. For example:

Add a time selector. For example:

Add a multi-line text box. For example:
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Use this
button...

To do this...

Note: This object must be placed at the bottom of the template or on its
own tab sheet, otherwise text may overlap other fields when you print a
Detail form derived from this template.

Add an electronic signature line including date and time
(MM/DD/YYY HH:MM AM/PM) to the template. Unsigned
electronic forms created from this template do not display the date
and time.

Note: For more information about object properties, see "Modify data object properties"
on page 430.

Create a new Detail template
Create customized Detail templates to document patient chart information, such as
medical history, treatment notes, and phone conversations with the patient.

Note: DMC recommends that you create a mockup of the template on paper before you
create it in DAISY and during construction, and save often.

► To create a new Detail template:

1. Log in to a user account that has permission to create templates.
For more information on user account permissions, see "Set up access to Detail
templates" on page 515.

2. From the DAISY menu, select Configure, then Detail Templates.
Note: If the Detail Templates menu selection is grayed out, then the user does not
have permissions to edit templates. For more information, see "Set up access to
Detail templates" on page 515.

3. In the Search for – Detail Template window, click New Detail Template.
The new template opens.

4. Click to create a tab sheet.
The tab sheet is where you add objects to your template, such as text boxes, drop-
down lists, radio buttons, check boxes, and lines.

5. In the Rename Tab window, type the name of the tab sheet, then click OK.

What's New in DAISY 4.4 425



Chapter 23  Work with Detail templates

For example, type Comprehensive Exam.
You see the Editing toolbar on the left side of the window and the tab sheet to the
right. The Editing toolbar enables you to add objects, such as text boxes, drop-
down lists, radio buttons, check boxes, and lines, to the template. For more
information, see "Add objects to a Detail template" on page 429.

6. Click to save the template.

7. In the Detail Name window, type the name of the new template, then click OK.
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Set up Detail template properties
Use the Detail Properties window to customize template settings, such as the
template name, its accessibility, and how forms created from the template are built.

► To set up Detail template properties:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. From the File menu, select Properties to open the Detail Properties window.
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3. Modify the properties that apply to this template.

This property... Does this...

Detail Name Defines the name of the template.

Medical History If checked, designates that the template
may be used to create a Medical History
form, and enables you to:

l Filter for these forms in the Patient
History window.

l Open the most recent Medical
History form (if available) or create a
new medical history form when you

click the Medical History button .

l Click in a medical history form to
open the Search For - Details window
filtered for the patient's other medical
history forms created from the same
template.

Note: This property also affects existing
medical history forms derived from this
template.

Keep History If checked, DAISY keeps a record of
revisions made to clinical notes created
from this template.

If unchecked, revision history is not
retained once you save the clinical note.

Bring most recent entries
forward

l If set to Always, DAISY pre-loads the
form with the patient's most recent
entries.

l If set to Never, DAISY does not load
the form with the most recent entries.

l If set to Prompt, DAISY prompts the
user about whether to pre-load the
form with the most recent entries.
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4. In the Detail Template Links section, do one of the following:

l Click to link clinical notes based on this template to a patient or a
procedure if the note is created in the specified DAISY window, such as
Account, Treatment Plan, or Appointment Detail. Once linked, the note can be
accessed from the Patient History window.

l Select a link and then click to delete the link.

5. Click OK.

6. Click , then close the window.

Add objects to a Detail template
Use the Editing toolbar in the template window to add objects, such as text boxes,
drop-down lists, radio buttons, check boxes, and lines to a Detail template. For more
information, see "Use the Editing toolbar" on page 422.

► To add objects to a Detail template:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. On the Editing toolbar, click an object button.

3. Move the object to its position on the tab sheet, then click to release the object.

4. Right-click the object and select Rename to rename the object label.

What's New in DAISY 4.4 429



Chapter 23  Work with Detail templates

5. Type the new label name, then press Enter.

6. Right-click the object and select Properties.

7. Modify the properties of this object, then click OK.
Note: For more information, see "Modify data object properties" on page 430.

8. Repeat steps 2 through 7 to add more objects.

9. Click , then close the window.

Modify data object properties
Data objects in a Detail template can include drop-down lists, text boxes, check
boxes, and time and date selectors. Only data objects have properties that can be
modified. Modify the properties of data objects to customize them for your Detail
template.

Note: Non-data objects include vertical lines, horizontal lines, and rectangles for
separating form sections.
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► To modify the properties of a data object:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Right-click the object and select Properties.
You see the object's properties window.

3. Modify the properties that apply to the object.

This property... Does this...

Detail Item Name Defines the label of a data object.

Hint Displays a short description when the
mouse is held over the data object.

Show Name If checked, displays the label of the data
object.

If unchecked, hides the label of the data
object.

Required If checked, the data object must be filled
in to complete the Detail form.

If unchecked, the data object may be left
blank on the Detail form.
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This property... Does this...

Office Use Only If checked, the data object does not
display when you view the Detail form in
DAISY Forms Anywhere or when you
print the form using the Detail Form
report.

Tip: You can also right-click an object and
select Office Use Only.
Note: If an object is associated with a
section or data label, you must also set the
section label or data label to For Office Use
Only.

If unchecked, the data object displays
whenever the form is viewed or printed.

Max. Length Sets the maximum number of characters
for an object. This property is only
available for the short text edit box.

Note: Text entered in a Detail form cannot
print properly if its character count
exceeds the object's maximum number of
characters.

Canned Text If checked, this property links a specified
canned text list to the data object. The
user can fill out the text box by selecting
from the list or by typing in the text box.

If unchecked, the user types a response
into the text box.

This property is only available for the
short text edit box and multi-line text
box.

Allowed Range Specifies the minimum and maximum
amounts that can be entered. This
property is only available for the Money,
Integer, and Precise Number objects.

Precision Specifies the number of digits allowed
after the decimal point. This property is
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This property... Does this...

only available for the Precise Number
object.

Orientation Sets the relative position of object
choices. This property is only available
for a set of radio buttons.

If your object is a drop-down list or radio button set, you also need to set the
Choices property.

4. To add a choice to the list:

a. Click to open the Add Choice dialog box.
b. Type the name of the choice, then click OK.
c. Repeat Steps a and b to add more choices.

5. Click OK.

6. Repeat steps 2 through 5 to modify additional objects.

7. Click , then close the window.

Modify the sequence of data entry in a Detail form
When you press <Tab> in a Detail form, the cursor moves from one field to another.
DAISY bases this entry sequence on the order that you added objects to the template
you selected to create the form. You can change the order to fit the needs of your
practice.

Note: The entry sequence setting also affects the order of information displayed in the
Detail Report and the Narrative section of the Patient History window.

► To modify the sequence of data entry:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Right-click the tab sheet background and select Change Entry Sequence.
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You see the list of objects in this template. They are listed from first to last in the
sequence.

3. Select an object, then use the arrows or drag it to the correct position in the list.

4. Repeat step 3 until all objects are in the correct data entry order.

5. Click OK.

6. Click , then close the window.
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Modify the color of the Note icon
You can set up different colored icons to distinguish Detail notes (also known as
clinical notes) prepared by the hygienist, dentist, front office, and so on to make them
easier to spot in the Note column of the Patient History window.

If you set up the default color of the Note icon in the template, then Detail notes
derived from that template will always have the same color of icon.

► To modify the default color of the Note icon:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Click Set Color.

3. Select a color, then click OK.

4. Click , then close the window.
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Open a Detail template
Before you can modify, rename, or copy a Detail template, you need to open it.

► To open a Detail template:

1. Log in to a user account that has permission to edit templates.

2. From the DAISY menu, select Configure, then Detail Templates.
Note: If the Detail Templates menu selection is grayed out, then the user does not
have permissions to edit templates. For more information, see "Set up access to
Detail templates" on page 515.
In the Search For – Detail Template window, you see the list of all available
templates.

3. Search for and select the appropriate Detail template, then click OK.
The template opens.
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You see the Editing toolbar on the left side of the window. The toolbar enables you
to add objects, such as text boxes, drop-down lists, radio buttons, check boxes,
and lines, to the template. For more information, see "Use the Editing toolbar" on
page 422.

Copy a Detail template
An easy way to create a new template is to make a copy of an existing one and then
customize it.

Note: You can also create a new template then copy the tab sheets from an existing
template. For more information, see "Create a new Detail template" on page 425 and
"Copy a tab sheet from another Detail template" on page 442.

► To copy a Detail template:

1. Open the template you want to copy.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. From the File menu, select Export template name Template.

3. Save the template to your desktop.
On the desktop, you see a DPX file. For example, if your existing template is called
Doctor Exam, you see a file called Doctor Exam.dpx.

4. On your desktop, double-click the DPX file to import the new template.

5. From the DAISY menu, select Configure, then Detail Templates.

6. In the Search for – Detail Template window, select the new template.
For example, you see a new template called Doctor Exam-1.

7. Customize the new template.
For more information on customizing a template, see "Design a Detail template"
on page 421.

8. Click , then close the window.

Select multiple objects in a Detail template
When you design a template, you may want to perform the same action
simultaneously on multiple objects in the tab sheet. You can select multiple objects,
then right-click a selected object to do the following:

l Move the objects. Drag or use the arrow keys, then click or press <Enter> to
complete the move. Click <Esc> to cancel a move.

l Delete the objects. Deletions cannot be undone.
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l Hide or display their labels. The object you right-click determines if the others will
be hidden or displayed.

l Resize to the same height or width. The object you right-click determines the
width or height of the selected objects.

l Designate as "For Office Use Only." Objects with this designation do not display
when you view the form in DAISY Forms Anywhere or when you print the clinical
note using the Detail Form report.

l Evenly space the objects horizontally or vertically.

l Align left, right, top, or bottom. Selected objects are aligned to the object you
right-click.

In the following example, you want to move three objects.

► To select and move multiple objects:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Place the cursor at one corner of the area you want to select.
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3. Drag the mouse across and down (or up) to the opposite corner of the area you
want to select.

4. Release the button when you are finished outlining the area.
The objects you selected become outlined in red.
Note: You can also select multiple objects by pressing <Shift> and clicking each object.

5. Right-click a selected object and select Move.

6. Move the selected objects to their new position, then click to release them.

7. Click , then close the window.

Tip: To select non-contiguous objects, press <Shift> and click each object. To deselect one
object at a time, press <Shift> and click the object. To deselect all of the objects, click the
tab sheet background.

Add a tab sheet to a Detail template
You can add one or more tab sheets to a Detail template and reorder the tab sheets
after they are added.

You can then add objects, such as text boxes, drop-down lists, radio buttons, check
boxes, and lines, to the new sheet.
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Note: If clinical notes or medical history forms were created from the template, you will
not be able to bring information forward after you reorder the tab sheets.

► To add a tab sheet to a template:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Do one of the following:

a. Click .
b. Right-click the tab sheet background and select Add Tab.

3. In the Rename Tab window, type the name of the tab sheet, then click OK.

4. To reorder the tab, drag and drop the tab to its new position.

5. Click , then close the window.

Note: You can also add tab sheets by copying one or more tab sheets from another Detail
template. For more information, see "Copy a tab sheet from another Detail template"
on page 442.

Reorder tabs in a Detail template
Reorder tabs to better organize information in forms created from the template.

► To reorder tabs in a template:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Drag and drop the tab to its new position.

3. Click , then close the window.
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Delete a tab sheet from a Detail template
A template must have at least one tab sheet. You may delete all other tab sheets.

► To delete a tab sheet from a template:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Click the tab you want to delete.

3. Right-click the tab sheet background, and select Delete Tab tab name.

4. In the Confirm window, click Yes.

5. Click , then close the window.

Note: A deleted tab sheet cannot be undone.

Copy a tab sheet from another Detail template
You can copy one or more tab sheets from one Detail template to another Detail
template. You can reorder the tabs after you add them.

► To copy tab sheets from a template:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Right-click the tab sheet background and select Add Tabs from Detail Templates.
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You see the Select the Tabs to Add window. The Detail Name column displays
template names. The Tab Name column displays tab sheet names. If a template
has more than one tab sheet, you see the template name listed more than once.

3. Select the tab sheet to add, then click OK.
Note: To select more than one tab sheet, press <CTRL> and click the tab sheet name.

4. To reorder the tab, drag and drop the tab to its new position.

5. Click , then close the window.

Modify the label of a data object
Data objects in a Detail template include drop-down lists, text boxes, check boxes,
radio buttons, and time and date selectors. All data objects have labels. You can
rename labels or choose whether or not to show them.

Hiding a label gives you more flexibility on where to place a label or a question in
relation to the field. For example, if you have a long question that you want above the
field, you can hide the data object's label and then add a separate data label that can
be placed in a more appropriate position.

Note: Non-data objects include vertical lines, horizontal lines, and rectangles for
separating form sections.

► To rename the label of a data object:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.
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2. Right-click the object and select Rename.
In the following example, you are renaming the label “Performing Dentist.”

3. Type the new name, then press <Enter>.

4. Click and close the window.

► To hide or show the label of a data object:
1. Open the template you want to modify.

For more information on opening a template, see "Work with existing
templates" on page 437.

2. Do one of the following:
l To hide the object label, right-click the object and select Hide Name.
l To show a hidden label, right-click the object and select Show Name.

3. Click , then close the window.
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Modify a drop-down list
You can add, delete, and reorder the choices in a drop-down list. You can also specify
whether:

l The drop-down list is required.

l The label name of the drop-down list should show on forms that are created from
the template.

l The drop-down list is for office use only. Objects with this designation do not
display when you view the form in DAISY Forms Anywhere or when you print the
clinical note using the Detail Form report.

Note: You cannot rename a choice in a drop-down list. To change the name of a choice,
you have to delete it and add it again using a different name.

► To modify a drop-down list:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Right-click the drop-down list and select Properties.
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You see the Drop Down List Properties window.

3. To make this a required drop-down list, check the Required check box.

4. To hide the drop-down list label, uncheck the Show Name check box.

5. To make this drop-down list for office use only, check the Office Use Only check
box.

6. To add a choice to the list:

a. Click to open the Add Choice dialog box.
b. Type the name of the new choice, then click OK.

7. To reorder the choices in the list:
a. Select the choice you want to move.
b. Click the up and down arrows to move the choice to its new position in the list.

8. To delete a choice from the list:
a. Select a choice from the list.

b. Click .

9. Click OK to close the Drop Down List Properties window.

10. Click , then close the template window.
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Resize an object
You can resize any object to accommodate the length of the label name, as well as
the number of characters in a text box or drop-down list choices. This example shows
how to resize a multi-line text box called Pt Concerns.

► To resize a multi-line text box:

1. Right-click the text box and select Resize, then select Item.

2. Place the mouse cursor over the appropriate black dot (this is called a handle) on
the boundary of the object until you see an arrow icon overlaying the handle.

3. Click and hold the mouse button and then drag and drop the handle to the
position you want.

4. Click the mouse button to complete the action.
Important: Use caution when resizing objects. Some labels are not associated with the
object. For example, you might accidentally cover up a label when you resize the
object.

5. Click , then close the template window.
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Clear a response in a data object
If a template contains fields (data objects) that all respondents will answer in the
same way, you can pre-populate them with correct information before you save the
template. When users open the form created from the template, these fields will
already be filled in. You can clear data objects in a template when the response is no
longer valid or needed.

► To clear a response in a data object:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Right-click the data object and select Clear Response.

3. Click , then close the template window.

Align objects in a Detail template
You can align multiple objects relative to each other by their left, right, top, or
bottom sides. You select the objects to align, then right-click one of them to make it
the "anchor" object, which remains stationary. Selected objects align with the anchor
object.

Note: Objects include drop-down lists, text boxes, check boxes, radio button groups,
electronic signature lines, and time and date selectors, lines, and rectangles.

► To align objects:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Select the objects you want to align. For more information on selecting multiple
objects, see "Select multiple objects in a Detail template" on page 438.
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3. Right-click the anchor object and select Align Controls, then select one of the
following:
l Left Sides aligns selected objects with the left side of the anchor object.
l Right Sides aligns selected objects with the right side of the anchor object.
l Top Sides aligns selected objects with the top of the anchor object.
l Bottom Sides aligns other objects with the bottom of the anchor object.

In the following example, you are aligning the left sides of Lips, Buccal Mucosa,
and Vestibules. Vestibules is the anchor object.

4. Click , then close the window.
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Rename a Detail template
You rename a Detail template from the Detail Properties window.

► To rename a Detail template:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. From the File menu, select Properties to open the Detail Properties window.

3. In the Detail Name text box, type the new name for this template.

4. Click OK.

5. In the Confirm window, do one of the following:
l Click Yes to save the new template name. Go to Step 6.
l Click No to keep the original name. Go to Step 8.

6. Do one of the following:
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l If one or more existing clinical notes are based on this template, the Confirm
window opens. Go to Step 7.

l If no clinical notes are based on this template, you see the template window.
Go to step 8.

7. Do one of the following:
l Click Yes to rename the existing clinical notes with the new name of the

template.
l Click No to retain the old name for the existing clinical notes.

8. Click , then close the window.

Link canned text to a data object
When you link canned text to a text box, the user can fill out the text box by selecting
from a list of canned text or by typing in the text box. You can only add this object
property to short text edit boxes and multi-line text boxes.

► To link canned text to a data object:

1. Open the template you want to modify.
For more information on opening a template, see "Work with existing templates"
on page 437.

2. Right-click the object and select Properties.

3. In the Memo Editor Properties window, check the Canned Text check box.

4. Click to open the Search For - Canned Text Type window.
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5. Do one of the following:
l Select the canned text type, then click OK.
l Click New Canned Text Type, type a new canned text type, then click OK.

In this example, the canned text type is "Soft Tissue Exam Notes."

6. Click OK to close the properties window.

In the template, you now see next to the object.

7. Click , then close the window.
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24 Manage clinical information
DAISY helps you track your patients’ treatment progress. Existing restorations,
treatment planned and completed procedures, prescriptions, and referral to other
providers are automatically logged at the time you enter them in the Chart and Perio
Exam windows, as well as the Patient window.

In addition, DAISY enables you to create Detail templates that you can use for
entering routine clinical information, such as clinical findings, daily progress notes,
and patient medical history.

A detailed view of clinical information is available from the Patient History window.

About patient history
To access the Patient History window, click the Patient History icon on the
DAISY toolbar.
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l To edit an existing note, double-click the note or right-click the note and select
Open Note.

l The vertical height of the Narrative section is saved per user per workstation. The
setting does not transfer to other users on the same workstation or to other
workstations for the same user.

Tip: To resize the Narrative section, point to its top border. When the mouse pointer
changes to a two-headed arrow, drag the border to shrink or enlarge the section.

l Use the Select All/None toggle button to select or deselect all of the display
option settings.

l Display Options are saved per user per workstation. The settings do not transfer to
other users on the same workstation or to other workstations for the same user. In
the Display Options section:

o Check the Medical History check box to display a list of the patient's medical
history forms.

o Check the Clinical Notes check box to display a list of the patient's clinical
notes.

o The Medical Info button under Display Options selects the appropriate check
boxes for viewing all medical history forms, prescriptions, reported
medications, and medical alerts for the patient.

l Double-click a medical alert entry in the Patient History window to view all of the
patient's medical alerts.

l When you remove a medical alert for a patient, a record of it remains in the
Patient History window as a deleted item to enable you to track changes to a
patient’s medical record.

l When you click the Add Note button, you see a Search For dialog window that is
filtered to show only patient-related Detail templates.

l To add a procedure note, right-click a procedure code in the Entry Type column
and select Add Procedure Note.

l To delete a note, open the note, then select File > Delete from the DAISY menu in
the Clinical Note window.

Add a clinical note
You can add a clinical note to a patient record from a variety of windows, including
the Patient, Chart, or Patient History windows.
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► To add a clinical note:

1. From the DAISY toolbar, click .

2. Search for and select the patient.

3. Click the Add Note button.

4. In the Search For – Patient Details window, search for and select the appropriate
Detail template.

5. Enter clinical information in the template.

6. In the Status section, click the appropriate status button.

This status
button…

Does this…

In Progress Indicates that the note is incomplete. The note is
usually assigned to the person who is composing it.

Ready for Review Indicates that the note is ready for review. This is the
default setting for all notes. You can pick who will be
the reviewer in the Ready for Review drop-down list. 
This list includes all users, even those who are not
authorized to review notes.

If an unauthorized person tries to review it, they see a
dialog window that says, “A valid reviewer and
password is required to save Reviewed items.

Reviewed Indicates that an authorized user reviewed the note
and “signed off” on it.

7. Do one of the following:
l If the status is set to In Progress or Ready for Review:

i. From the drop-down list in the Status section, select the user who is
responsible for the next task..

ii. Click and close the window.

l If the status is set to Reviewed, click .
The Verify Review dialog window opens.
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a. Select the reviewer.
i. Type the reviewer’s user password.
ii. Click OK.

b. Close the Details form window.
Note: If you are not authorized to review clinical notes or to change the status from
“Ready for Review” to “In Progress”, then you will see a dialog box that says, “A valid
reviewer and password is required to save Reviewed items.” For information about
how to obtain authorization to make these status changes to notes, see "Set up
permissions for electronic sign-off" on page 517.

Modify a patient’s clinical note
Sometimes you need to make a change to a clinical note because, for example,
information was entered incorrectly. Changes to clinical notes can be made on a field-
by-field basis, and a reason must be provided for each of those changes.

Note: Use the Details revision feature to make corrections to a clinical note or other
Details forms rather than using it to track information that will naturally change over
time, such as a person's medical history.

Tip: To apply the same reason to multiple changes, right-click on the Reason for Change
column header, select Apply Reason To, then select All Changes.

In this example, the dosage of a medication listed in the patient’s Medical-Dental
History form is incorrect.

► To modify a patient’s clinical details:

1. From the DAISY toolbar, click .

2. Search for and select a schedule, then click OK.

3. In the Schedule window, click the patient appointment to select it.

4. On the Quick Access toolbar, click
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.
The Chart window opens.

5. On the Quick Access toolbar, click .

6. Search for and select the details form, then click OK.

7. Revise the information, then click .
The Reason for Change window opens.

8. In the Reason for Change column, type the reason for the change.

Note: All changes in the list are automatically checked. If you only want to keep some
of them, uncheck the ones you don’t want. To uncheck all of them at once, click Select
None.

9. Click OK.

10. Close the details form.
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Set the Note icon color
Patient Detail forms, such as adult medical history, hard tissue exam, or perio
therapy, have a Set Color button. Use this button to set the color of the note icon
that displays in the Note column in the Patient History, Clinical Notes Manager, and
Appointment Manager windows. This feature makes it easy, for example, to color code
types of notes, notes for specific providers, or to bring a particular note to someone’s
attention.

Setting the color affects the individual note only, not the Details template. For
example, in this Patient History window, the Note icon color for Emily Abbott's
11/05/2014 clinical note has been set to green. Other Note icons are yellow or blue.

Questions? www.softwarefordentists.com 1.800.368.6401458

http://www.softwarefordentists.com/


Chapter 24  Manage clinical information

► To change the color of the Note icon for an individual note:

1. Open a clinical note.
Note: You can also set the color of the icon when you create a new note.

2. Click the Set Color button.

3. In the Color window, click the new color, then click OK.
The color of the icon changes in the Set Color button, as well as in the Note
columns in the Patient History, Clinical Notes Manager, and Appointment
Manager windows.

Note: You can also change the default color of the Note icon in a Details template, so
that all Detail forms created from that template display Note icons of the same color. For
more information on changing the default color, see "Modify the color of the Note icon"
on page 435.

Clear a response in a clinical note
You can clear a response in a text box, drop-down list, check box, radio button group,
or time and date selector in a clinical note.

Note: Cleared responses in a saved clinical note are added to the note's revision history.
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► To clear a response in a clinical note:

1. Open the clinical note for the patient.
For more information on opening a clinical note, see "View patient details" on
page 460.

2. Right-click the field and select Clear Response.

3. Click to save the change.
You see the Reason for Change dialog window.

4. In the Reason For Change column, type the reason for the change, then click OK.

5. Close the clinical note.

View patient details
You can access patient details, such as clinical notes and medical history, from a
variety of windows, such as the Patient, Chart, or Patient History windows.

Questions? www.softwarefordentists.com 1.800.368.6401460

http://www.softwarefordentists.com/


Chapter 24  Manage clinical information

► To view patient details:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.
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3. Click in the Patient window.

Note: The button displays a paperclip only when clinical notes are associated with
the patient.

4. Search for and select the details to view.
For example, select Crown/Bridge Prep entered on 10/29/2014.
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The patient’s clinical note opens.

5. When finished, close the window.

Print a Detail form
Use the Detail Form report to print a clinical note, medical history, or a blank Detail
form as formatted.

This report:

l Displays the practice's name and contact information at the top of the first page.

l Gives you the option of printing all tabs or a specific tab.

l Prints the information in each tab on a separate page.

For best printing results:

l Design your form to be no more than 104 characters wide.

l Adjust all margin settings in the Page Setup window to 0.5 inches.

Note: Form fields, such as text boxes, drop-down lists, radio buttons, check boxes, and
lines, that are designated as "For Office Use Only" do not print on this report. Drop-down
lists print as a blank text box.
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► To print a Detail form:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK to open the Patient window.

3. Click to open the Search For - Patient Details window.

Note: If the patient has no existing Detail forms, click to open the search window.

4. Do one of the following:
l Select a Detail form, then click OK.
l To create a new Detail form, click New Patient Details. In the Search For -

Patient Details Template window, select a template, then click OK. Fill out the
form or leave it blank.

5. From the Reports menu, select Detail Form, then select All Tabs.

6. Do one of the following:

l To preview the report first, click Preview, then click to print it.
l To print the report without previewing it, click Print.
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Here is an example of the Detail form.

Note: The Detail Report is also still available in the Reports menu. Use it to print a
summary of a clinical note. Only fields that contain information show on that report.

Print a patient chart
You can use the Patient Chart report (R2601) report to print selected patient details
for review, when you need to send patient records to a specialty office, or when you
want to transfer a patient to another dental office. This report is available from the
Reports menu in the Patient History window or from the Report Gallery.

► To print a patient chart:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.
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3. In the Patient window, click to open the Patient History window.

4. In the Display Options section, check the options that you want to include in the
report or click Select All to include the entire chart.
In this example, the office wants to print a report of all of the patient's
prescriptions and reported medications.

5. From the Reports menu, select Patient Chart.

You see the Patient Chart report with both prescriptions (RX) and reported
medications (MEDS).

Questions? www.softwarefordentists.com 1.800.368.6401466
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Review a list of clinical notes
The Clinical Notes Manager window shows you a list of clinical notes in a single
window. This window lets you work through the list of clinical notes, marking them as
reviewed, and then saving them all at once. You can, for example, view a range of
notes over multiple days, or view only notes that haven’t been reviewed.

Since some notes are not related to the appointment schedule, this window also helps
you to find and review them. For example, if Mrs. Philips calls in with a problem
tooth, and Dr. Taylor issues a prescription to ease the pain until she can get in for an
appointment, the note about this will not be tied to an appointment.

► To review a list of clinical notes:

1. From the DAISY menu, select DAISY, then Patient, then Clinical Notes Mgr.

Tip: For easier access, add the Clinical Notes Mgr icon to the DAISY toolbar.
You see the Clinical Notes Manager window. In the Reviewer field, DAISY
automatically selects the user who is logged in.

2. Under Filter Scheme, select one or more options to filter the Notes list:

Use this filter... To do this...

Review Status Select notes with a specific review status,
such as Ready for Review. Or select <All> to
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Use this filter... To do this...

view clinical notes with any status: In
Progress, Ready for Review, Received, and
Reviewed.

Reviewer Select the user who has been assigned the
responsibility for reviewing the note. Or
select <All> to view notes assigned to any
user.

Note Type Select the type of clinical note, such as
Clinical Notes – PARQ or Comprehensive
Exam. Or select <All> to view any type of
note.

Date Filter Select the type of date:

l Entry Date: the date of service that the
note is attached to.

l Add Date: the date when the note was
added to the system.

l Review Date: the date when the note was
reviewed and electronically signed off.

From Earliest date of notes to include in the list.

To Latest date of notes to include in the list.

3. Select a clinical note from the filtered list.
In the Narrative section at right, you see a summary of the clinical note's details.

4. To open the selected note, do one of the following:

l In the Note column, double-click .
Note: The color of this icon may vary. For more information, see "Set the Note
icon color" on page 458 .

l In the Narrative section, click .

5. View or modify the note, then click .
If you modify the note, you see the Reason for Change dialog window.

6. In the Reason For Change column, type the reason for the change, then click OK.

7. Close the note.
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8. To mark the note as reviewed, in the Status section, click   .
The Clinical Note Manager moves to the next clinical note in the list.
Note: To change the note to a different status (other than “Reviewed”), click the
appropriate status button. For example, if you determine that the note is incomplete,
you can set the status back to “In Progress.” However, to change who the note is
assigned to, you need to open the note.

9. For each note, repeat steps 3 through 8.

10. When you are done reviewing all notes, click .
You see the Verify Review dialog window.

11. From the Reviewer drop-down list, select your user name.
Note: Only users with the permission "Allow Review of Detail Responses" are included
in the Reviewer drop-down list. For information about how to obtain authorization to
make these status changes to notes, see "Set up permissions for electronic sign-off"
on page 517.

12. In the Password text box, type your DAISY password, then click OK.

The reviewed clinical notes are saved and electronically signed off with your user
name.

View revisions to clinical details
When changes are made to existing clinical details, DAISY tracks the revisions for
auditing purposes.
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► To view revisions to clinical details:

1. From the DAISY toolbar, click .

2. Search for and select the patient.

3. Click OK.

4. Click in the Patient window.
Note: This button displays only when there are details associated with the patient.

5. Search for and select a details form that has been revised.

6. Click OK.
The details form opens.

7. Click Revisions.

Note: The Revisions button displays only if revisions have been made to the form.
The Revision History window opens.
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The items in this example window are arranged in the same order as the tabs on
the Medical - Dental History form. Items are sorted by these tabs in the order that
the information was entered from newest to oldest. Items are then sorted
according to the order that information would be entered if the user were to tab
through the form.

8. In the Show drop-down list, select which items to view.

9. Click OK to close the window.

Note: Revision History can also be accessed from any details form window. From the
View menu, select Revision History, then select the type of items to view. Even if an item
has not been revised, you can use the Revision History window to view original entries to
determine who entered the information and when.

Run the Clinical Note List report
A Clinical Note List report is available from Clinical Notes Manager window. The
report shows patient information, such as name, address, and last service date, and
also provides clinical notes for the patient.

Note: This report can also be run from the Patient folder in the Report Gallery.

You can use this report to:

l Review the day's notes at home or during lunch before assigning them to another
provider for final review.

l Print all the notes for a particular patient in a more concise format instead of just
one per page.
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► To run the Clinical Note List report:

1. Open the Clinical Notes Manager window.

2. From the Reports menu, select Clinical Note List.
The report uses the filter settings from the Clinical Notes Manager window. In the
following example, the filters were set to show only the clinical notes for services
performed from 8/10/2007 to 8/11/2007 that Kate needed to review.

When Kate ran the Clinical Notes List report from the Reports menu in Clinical Notes
window, it included the following information:
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Use Appointment Notes Review
The Appointment Notes Review window provides a list of all the appointments
scheduled on a selected day, along with an easy way to view all the patient history
information (such as clinical findings, clinical notes, or a patient’s medical history)
for those appointments. This is the same information that you see in the Patient
History window.

This window helps to ensure that the day’s treatment for each patient has been
documented and that it is accurate. Using this window, you can easily review the
progress notes for each patient on the day’s schedule. You can also create notes for
any appointments that do not have them.

This window is also useful for viewing the next day’s appointment list and related
patient information, such as medical history, what services were performed during the
last visit, and what treatment is planned for the next appointment.

► To review the day’s treatment for each patient:

1. From the DAISY menu, select DAISY, then Appointment, then Appt Notes Review.

Note: For easier access, add the Appt Notes Review icon (              ) to the DAISY toolbar.
You see the Appointment Notes Review window.
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The Appointment List section contains a list of appointments based on:
l A selected appointment date
l A resource, such as the doctor or hygienist, or all resources

2. From the Appointment List, select an appointment.
You see the patient’s history on the right side of the window. If no note is attached

to service that occurred on the selected date (look for in the Note column),
you need to add a note.
Note: If the appointment is for a new patient, you will see this warning in the Patient
section of the window: “This is a New Patient appointment. There is no Patient
History corresponding to this appointment.”

3. Do one or more of the following:
l In the Narrative section, view a summary of the selected note’s details attached

to this appointment.
l Filter the information that displays in the patient history list by selecting:
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l A range of service dates
l Tooth number
l Procedure
l Performing provider
l Description (what is shown in the Description column)

o To view or modify the note attached to the patient associated with this

appointment, in the Note column, double-click to open the clinical
note. View or modify the note, then close the note window.

Note: The color of this icon may vary.  For more information, see "Set the Note
icon color" on page 458.
i. To track which appointments have been reviewed, in the Appointment List

section, check the check box next to the patient’s name in the Rev’d
column.
Note: This review is not the same as the electronic sign-off review for
clinical notes. For more information about electronic sign-off, see "Set up
permissions for electronic sign-off" on page 517 .

ii. When you are done reviewing all appointments, click and close the
window.

► To add a note from the Appointment Notes Review window:

1. In the Appointment List, select the patient that is missing a note.

2. To add patient-related details:
a. Click the Add Note button.
b. Select a Details template for the note.

c. Fill out the note, then click and close the window.

A icon is added to the Note column for the selected patient.

3. To add procedure-related details:
a. Right-click the Entry Type column in any cell that contains a procedure code,

and select Add Procedure Note.
b. Select a Details template for the note.

c. Fill out the note, then click and close the window.

A icon is added to the Note column for the selected procedure.
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Note: Although notes can be individually opened and marked “Reviewed” from this
window, the Clinical Notes Manager lets you mark a list of clinical notes as “Reviewed”
without having to open each note. For more information, see "Review a list of clinical
notes" on page 467.
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Dental practices commonly ask new patients for medical information at their first
appointment. They may also ask established patients to review the old medical
history form periodically and either update existing information or indicate that the
information is still correct.

You can use the patient's existing medical history form to create a new blank one or
bring forward the most recent entries and have the patient update information that
has changed. For more information, see "Create a medical history form" on page 477.

After you create a medical history form for the patient, you can:

l Print the form using the Detail Form report and have the patient complete it, then
transcribe the information into the patient's medical history form on the
computer. For more information, see "Print a medical history form" on page 479.

l Hand patients an electronic device (such as a tablet) in the office that they can
use to fill out the form. For more information, see "Fill out medical history on an
office tablet" on page 483.

l Use DAISY Forms Anywhere to enable patients to access and complete the form
online from any device with an Internet connection. For more information, see
"Use DAISY Forms Anywhere" on page 485.

Create a medical history form
For new patients, you can create a blank medical history form. For established
patients, you can:

l Create a blank form.

l Bring forward the medical information provided last time into a new form so the
patient can note changes or indicate that the information is still correct.

l Open an existing form so the patient can complete the form if information has
been omitted.

Create a medical history form for a new patient

Christine Able is a new patient at Centerpointe Dental. Sharon in the front office
wants Christine to complete a medical history form on paper. She creates a medical
history form for Christine and prints it when Christine arrives for her appointment.
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► To create a medical history form for a new patient:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Patient window, click to open the Search For - Medical History
Template window.

Note: If the patient is new, the Medical History button will be grayed out in the
Confirm Appointments and Follow Up Appointments windows and it will not display
in the Appointment window.

4. Search for and select the template, then click OK.
The medical history form opens.

5. Click to save the form.

Create a medical history form for an established patient

Emily Abbott is an established patient at Centerpointe Dental. Sharon in the front
office wants Emily to update her a medical history information when she arrives for
her appointment. Sharon pulls Emily's prior responses into a new form so Emily can
save time updating her information.

► To create a medical history form for an established patient:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.
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3. In the Patient window, click to open the patient's most recent medical history
form.

4. Click to open a new medical history form.

5. In the Confirm window:
l Click Yes to pull in the patient's prior responses.

Note: If the template used to create the original medical history form no longer
exists, DAISY warns you that it cannot create new details and that the template
was deleted, renamed, or is no longer allowed to link to the same kind of data.
DAISY will not pull in prior responses.

l Click No to leave the form blank.

6. Click to save the form.

Tip: To use a different Detail template from the one that opens when you click , select
File > New > Other Details for Patient xxx. Select the template to use and click OK. Note
that all Detail templates appear in the list rather than just those designated as Medical
History templates.

Print a medical history form
Use the Detail Form report to print a medical history form that patients can fill out.
Form fields, such as text boxes, drop-down lists, radio buttons, check boxes, and
lines, that are designated as "For Office Use Only" do not print on this report.

Tip: For best results, line up the right margin of the template with the right edge of the
"Ready for Review By" drop-down list. Drop-down lists print as a blank text box.

Christine Able is a new patient at Centerpointe Dental. Sharon in the front office
wants Christine to complete a medical history form on paper when she arrives for her
appointment. Sharon creates the form in advance, and then prints it when Christine
arrives for her appointment.

► To print a medical history form:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Patient window, click to open the most recent medical history form.

What's New in DAISY 4.4 479



Chapter 25  Manage medical history

For information on creating a medical history form, see "Create a medical history
form" on page 477.

4. From the Reports menu, select Detail Form, then select All Tabs.

5. In the Print Options window, click Print.
Here is an example of a medical history form.

For more information about printing other types of Detail forms, see "Print a Detail
form" on page 463.
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Set up an access code
You can set up a secure access code for a medical history form at any time. After you
set up the code, you can:

l Enter the code into a device (such as a tablet) that the patient can use to
complete the form in your office. For more information, see "Fill out medical
history on an office tablet" on page 483.

l Securely email the code to a patient who has subscribed to DAISY Forms
Anywhere. For more information, see "Email access to a medical history form" on
page 490.

Note: You cannot enable access to an existing medical history form if the Detail template
that the form was originally based on has been deleted or renamed.

Emily Abbott is an established patient at Centerpointe Dental. Beverly in the front
office wants Emily to update her medical history when she arrives for her
appointment. Beverly sets up an access code for Emily's medical history form, enters
the code on a tablet, and hands it to Emily to use for updating her information. Emily
makes the appropriate changes and submits the form.

► To set up an access code:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.
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3. In the Patient window, do one of the following:
l For a new patient or an established patient with no medical history on file,

click to open the Search For - Medical History Template window. Search for
and select the template, then click OK to open a medical history form.

l For an established patient, click to open the patient's most recent medical
history form.

4. From the Tools menu, select Allow Patient Access, then select one of the
following:
l New Form with Prior Responses for a new medical history form preloaded with

the patient's prior responses.
l New Blank Form for a blank medical history form.
l Existing Form for Revision for the last medical history form that the patient

submitted.

You see a new patient access code below the patient's name. To the right of the
code is an expiration date and time. The code's expiration date and time default to
11:59 p.m. on the current day. However, you can change it here before you send
the access code to the patient.
Note: Access codes are randomly generated. They are not in numerical order.
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Tip: To see the type of access granted to the patient, rest your cursor on the access
code.

Fill out medical history on an office tablet
You can give patients the option of filling out their medical history form on an
electronic device (such as a tablet) in the office. You create a medical history form,
set up an access code, enter the code on an office tablet, and hand it to the patient to
complete the form.

Note: To enable this feature, contact your DAISY representative.

Daniel Able is an established patient at Centerpointe Dental. Beverly in the front office
wants Daniel to update his medical history when he arrives for his appointment.
Beverly sets up an access code for Daniel's medical history form, enters the code on a
tablet, and hands it to Daniel to use for updating his information. Daniel makes the
appropriate changes and submits the form. Beverly then opens the form via the
Clinical Notes Manager window.

► To fill out a medical history form on an office tablet:

1. Create a medical history form. For more information, see "Create a medical
history form" on page 477.

2. Set up an access code. For more information, see "Set up an access code" on page
481.

3. Type the access code into the tablet, then click Submit.
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The patient's medical history form opens. Hand the tablet to the patient.

After reviewing and updating the information, the patient clicks Submit at the
bottom of the form.
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Use DAISY Forms Anywhere
With DAISY Forms Anywhere, patients can securely access and complete their
medical history information online from any type of electronic device with Internet
access, including Apple, Android, Kindle, and Microsoft Windows. Patients must
subscribe to DAISY Forms Anywhere before they can receive access.

Note: To set up DAISY Forms Anywhere for your dental practice, contact your DAISY
representative.

In this example, the office sends the patient an email to subscribe to DAISY Forms
Anywhere and then sets up an access code for the patient's medical history form.

Christine Able is a new patient at Centerpointe Dental. Sharon in the front office
wants Christine to complete a medical history form before she comes in for her first
appointment.

Sharon creates a medical history form for Christine. She then creates an access code
Christine can use to access the medical history form. Sharon sends Christine an opt-in
email for DAISY Forms Anywhere. Christine clicks a link in the email message and sets
up her passphrase and hint for this service.

After Christine subscribes, DAISY automatically emails Christine a second email that
has the access code and a link to the form. She clicks the link to open the form, enters
the access code and her passphrase, enters her medical history information, then
submits the form. Sharon then opens the form via the Clinical Notes Manager
window.
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In this example, the office first sets up an access code for the patient's medical
history form and then sends the patient an email to subscribe to DAISY Forms
Anywhere.

Robert Taylor is an established patient at Centerpointe Dental. Sharon in the front
office wants Robert to update his medical history before he comes in for his
appointment. Sharon creates a new medical history form that pulls in Robert's older
medical history information. She then creates an access code for Robert to use to access
the medical history form.

Sharon sends Robert an opt-in email for DAISY Forms Anywhere. Robert clicks a link
in the email message and sets up his passphrase and hint for this service. After Robert
subscribes, DAISY automatically emails Robert a second email that has the access code
and a link to the form. Robert clicks the link to open the form, enters the access code
and passphrase, enters his medical history information, then submits the form. Sharon
then opens the form via the Clinical Notes Manager window.

For more information, see "Set up a patient for online access" on page 486 and
"Email access to a medical history form" on page 490.

Set up a patient for online access
To set up a patient for online access, send the patient an opt-in email message for
DAISY Forms Anywhere. The patient clicks a link in the email message and sets up a
passphrase and hint for DAISY Forms Anywhere.

Note: Patients can unsubscribe from DAISY Forms Anywhere at any time. For more
information, see "Unsubscribe from DAISY  Forms Anywhere" on page 497.

► To set up a patient for online access:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.
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3. In the Personal Info window, click to send an opt-in email message to the
patient.

Note: You will not see the button if the Email text box has no email address.
The patient's online access status changes from "Unsent" to "Sent." You also see
an Info window that confirms the message was sent. For more information about
viewing a patient's access status, see "View the status of a patient's online access"
on page 495.
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Here's an example of an opt-in email message:

The patient clicks "please click on this link" and sees the DAISY Forms Anywhere
Terms and Conditions of Use window.

Note: Patients only see this window the first time they set their passphrase.

The patient scrolls to the bottom of the page and clicks "I Agree" to accept the terms
and conditions. Next, the patient sets up a passphrase and passphrase hint. Patients
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must use their passphrase each time they need to access their medical history form
online.

After clicking the Set button, the patient sees the following confirmation message:
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Email access to a medical history form
You can email a secure access code and link for a medical history form to any patient
who has subscribed to DAISY Forms Anywhere.

► To email access to a medical history form:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Patient window, do one of the following:
l For a new patient or an established patient with no medical history on file,

click to open the Search For - Medical History Template window. Search for
and select the template, then click OK to open a medical history form.

l For an established patient, click to open the patient's most recent medical
history form.
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4. From the Tools menu, select Allow Patient Access, then select one of the
following:
l New Form with Prior Responses for a new medical history form preloaded with

the patient's prior responses.
l New Blank Form for a blank medical history form.
l Existing Form for Revision for the last medical history form that the patient

submitted.
Note: You cannot enable access to an existing medical history form if the Detail
template that the form was originally based on has been deleted or renamed.

You see a patient access code below the patient's name. To the right of the code is
an expiration date and time. The code's expiration date and time default to 11:59
p.m. on the current day. However, you can change it here before you send the
access code to the patient.
Note: Access codes are randomly generated. They are not in numerical order.

Tip: To see the type of access granted to the patient, rest your mouse cursor on the
access code.

What's New in DAISY 4.4 491



Chapter 

5. Do one of the following:
l Right-click the code number and select Email Form.

l Click to the right of the access code.
l In the Tools menu, select Email Form.
Note: If the patient has not subscribed to DAISY Forms Anywhere, the Email Form
option will be grayed out. However, once the patient sets up a passphrase, DAISY will
automatically send out the access code you generated in Step 4 unless the access code
has expired. For more information on setting up a patient for DAISY Forms Anywhere,
see "Set up a patient for online access" on page 486.

6. In the Email Access Code window, add an optional personal message, then click
Yes.
DAISY adds this personal message to an email message containing an access code
and link to the patient's medical history form.
Note: DAISY automatically inserts the last personal message used, if any.

Tip: Click to insert a canned message.

You see an Info window that confirms the message was sent.

7. In the Info window, click OK.
Note: After you send the email to the patient, the access code's expiration date
automatically changes to seven days from the time the code was generated.
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The patient receives an email message with an access code and link to access the
form.
Here's an example:

The patient clicks "click here to access your form" and sees the DAISY Forms
Anywhere access window.
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The patient enters the access code and personal passphrase, then clicks Proceed.
Note: The patient may make up to five attempts to enter the correct access code and
five attempts to enter the correct passphrase.

The patient's medical history form opens.
Note: After 15 minutes of inactivity, DAISY issues a warning that the connection will
timeout in 5 minutes. After 20 minutes of inactivity, DAISY logs the patient out and
redirects the browser to the provider's landing page.
After reviewing and updating the information, the patient clicks Submit at the
bottom of the form. DAISY then opens the landing page specified in the Web Site
text box in the Practice Configuration window.
Note: If the patient receives access to the same form again, you see “Modified by
Patient” in the bottom left corner of the medical history window.

Revoke patient access to a medical history form
You can revoke a patient's access to a medical history form at any time, such as when
a patient cancels an appointment or prefers not to submit the form electronically.

Tip: To see the type of access granted to the patient, rest your mouse cursor on the access
code.
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► To revoke access to a medical history form:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Patient window, click to open the patient's most recent medical history
form.

4. From the Tools menu, select Allow Patient Access, then select None.

Note: If you delete the patient's Medical History form, DAISY automatically revokes the
access code.

View the status of a patient's online access
DAISY Forms Anywhere enables patients to securely access their medical history form
online. Patients must opt in to this free service. You can view their access status in
the following windows:

l Personal Info

l Patient

l Patient History

l Appointment Notes Review

l Appointment Confirmation

l Appointment Followup
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► To view a patient's access status from the Personal Info window:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.
You see the patient's access status for DAISY Forms Anywhere.

This status... Shows that the patient...

Unsent Has not been sent an opt-in email.

Sent mm/dd/yy Has been sent an opt-in email on the
specified date, but has not subscribed
yet.

Subscribed mm/dd/yy Subscribed to DAISY Forms Anywhere
on the specified date.

Unsubscribed Unsubscribed to DAISY Forms
Anywhere on the specified date.
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Unsubscribe from DAISY Forms Anywhere
Patients can unsubscribe from this service anytime as follows:

l Patients can click the "unsubscribe" link in any access code email message and
enter their date of birth and passphrase. The patient and the provider each receive
an email message confirming that the patient has unsubscribed.

Note: To receive this email, the provider's email address must be in the Email text box
in the Provider window .

l The dental provider can use an option in the Personal Info window.

► To unsubscribe a patient from the Personal Info window:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK.

3. In the Personal Info window, right-click on the DAISY Forms Anywhere status and
select Unsubscribe from DAISY Forms Anywhere.
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4. In the Warning window, click Yes.

The patient's DAISY Forms Anywhere status changes to Unsubscribed. For more
information about access status, see "View the status of a patient's online access"
on page 495.

5. Click , then close the window.

Reset a DAISY Forms Anywhere passphrase
You can reset a patient's passphrase as follows:

l Use an option in the Personal Info window. You can also use this method to set up
a passphrase for the first time.

l Click the "Forgot your passphrase?" link in the following DAISY Forms Anywhere
access window. Patients can use this method. For more information, see "Email
access to a medical history form" on page 490.

► To reset a patient's passphrase from the Personal Info window:

1. From the DAISY toolbar, click .

2. Search for and select the patient, then click OK to open the Personal Info window.
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3. In the Tools menu, select Email Link to Set Passphrase.
You see the following Info window.

4. Click OK.
The patient receives an email message with a link to set the passphrase.
Here's an example:

The patient clicks "please click on this link."
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The patient enters a passphrase and passphrase hint, then clicks Proceed.

Once the passphrase is reset, the patient receives a confirmation email. Here's an
example:
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Manage providers

NPI numbers
NPI numbers must be entered in DAISY in the Practice Settings and Provider windows
before claims can be processed.

l The Location tab in the Practice Settings window has an entry field for a default
National Provider Identifier (NPI) number (Type II) and a default claim location.

Note: If your office does not have a Type II NPI number, enter your Type I number in
the Default NPI field.

l If you have multiple locations, set a default location because when you set up a
new provider, DAISY automatically applies the default location and its NPI number
to the provider in the Provider window.

l For an existing provider, you must enter the NPI number in the Provider window.

l For a new provider, DAISY automatically applies the default location and its NPI

What's New in DAISY 4.4 501



Chapter 27  Manage practice settings

number.

Manage system defaults

Set up auto-hold for secondary claims
To set up DAISY to automatically send a secondary claim once the primary claim is
paid, you first have to enable auto-hold for secondary claims. Then, when you enter a

payment for the primary insurance and attach it to the claim, appears in the RC
(Related Claim) column.

DAISY automatically attaches the date paid and the amount paid by the primary
insurance company. The secondary claim is automatically sent the next time you run
closing.

► To set up auto-hold for secondary claims:

1. From the DAISY menu, select Configure, then Practice Configuration.

2. In the Practice window, click the System Defaults tab.

3. In the Claims section, check the Always Hold Secondary Claim check box.
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Enable pop-up reminders

Overview

PATIENT REMINDERS

Patient reminders open in a pop-up dialog box.

The Reminder dialog box opens whenever you access a patient record that has a
reminder attached to it. Reminders attached to the patient open in this dialog box
when you access the following patient-related windows:

l Patient

l Patient History

l Treatment Plan

l Chart

l Perio Exam

l Appointment Detail, either when you:

o Open this window with an appointment already selected in the Schedule.

o Select the patient in the Appointment Detail window.

In the Reminder dialog box, you can check the “Don’t show me this again today”
check box to dismiss a particular reminder for the rest of the day. This setting is user
specific per workstation.

ACCOUNT REMINDERS

You can also add reminders to accounts. Account reminders open in a Reminder pop-
up dialog box.

Reminders attached to an account open in the Reminder dialog box when you access
the following account-related windows:
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l Account

l Ledger

In addition, reminders attached to the patient’s account open in a pop-up dialog box
when you access the following windows associated with that patient:

l Patient

l Patient History

l Treatment Plan

l Chart

l Perio Exam

l Appointment Detail, either when you:

o Open this window with an appointment already selected in the Schedule.

o Select the patient in the Appointment Detail window.

In the Reminder dialog box, users can check the “Don’t show me this again today”
check box to dismiss a particular reminder for the rest of the day. This setting is user
specific per workstation.

► To enable pop-up reminders for the practice:

1. From the DAISY menu, select Configure, then select Practice Config.

2. In the Practice window, click the System Defaults tab.

3. Check the “Show popup reminder” check box.
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4. Click , then close the window.

Set up a service location address
Service location addresses are set up in the Practice Settings window.

► To set up a service location address:

1. From the DAISY menu, select Configure, then Practice Configuration.

2. In the Practice window, click the Location tab.

3. In the Office Locations section, right-click and select New Location.
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You see the warning "One a location is created, it cannot be deleted. Do you still
want to create a location?"

4. Click Yes.

5. In the Name text box, type the name of the location.

6. Complete the address information for the new location.

7. In the Type drop-down list, select the type of location.

8. In the Default NPI text box, type the NPI number for this location.
Note: DAISY requires NPI numbers to process claims. For more information, see
"Manage practice settings" on page 501.

9. Click to save the location.

Configure EDI settings

Set up electronic prescribing
To use DAISY eRx, your practice must have:

l An Emdeon Clinician username and password for each provider and staff member

l A Site ID number from Emdeon

When you subscribe to DAISY eRx, a DAISY representative adds the Emdeon
usernames and passwords and the Site ID number to your practice settings.

Before you can connect to Emdeon Clinician to manage patient e-prescriptions, you
must enable e-prescribing for the practice.
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► To set up electronic prescribing for the practice:

1. From the DAISY menu, select Configure, then select Practice.

2. In the Practice window, click the EDI tab.

3. In the e-Prescribing section, check the Enabled check box.

4. Click , then close the window.

Note: If you do not have the appropriate DAISY eRx access permissions, you see the Site
ID text box and the Enabled check box grayed out. For more information on EDI access,
see "Set up access permissions for DAISY eRx" on page 516.

Manage user accounts
Dental offices often have different types of users, such as front office staff, dental
hygienists, and dental assistants. DAISY enables you to set up each user with access
permissions that are appropriate for the work they do. You manage user accounts
from the User window.

Note: Only those who have full access rights can change user settings.

► To manage a user account:

1. From the DAISY menu, select Configure, then select Users.

2. Do one of the following:
l Search for and select the user account, then click OK.
l To add a user account, click New User.
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The User window opens.

3. Do one of the following:
l If you are adding a new user account, type the new user name, first name,

middle name, and last name.
l If you are modifying a user account, go to step 4.

4. Select or modify the appropriate permission and access settings.

5. Click , then close the window.
Note: DAISY logs changes to security settings in the Activity Log and the Security Log.

Copy user account permissions
Dental offices often have different types of users, such as office staff, dental hygienists
and dental assistants. Each user of the same type often requires a DAISY user account
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that has the same set of permissions.

The easiest way to set up accounts with the same permissions is to copy the
permissions from an existing user account. For example, copy the permissions from
the account of one dental hygienist to the account of another.

► To copy user account permissions:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the Security tab to view Practice Settings.
Note: Only those who have full access rights can change security settings.

3. Do one of the following:
l To copy permissions to a new account: from the File menu, select New, then

select User. In the User Name text box, type the name of the new user account,

then click .
l To copy permissions to an existing account: click to open the Search For –

User window. Search for and select the user whose permissions need to be
modified, then click OK.

4. From the Edit menu, select Copy Permissions From…

5. In the Select a User to Copy dialog box, search for and select the user whose
permissions will be copied.
Note: As a security precaution, the search results only show user accounts with
permissions less than or equal to the user account performing this task.
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6. Click OK.
The permissions are copied to the other account.

7. Click to save the changes.

Reset a user password
DAISY administrators with Security Officer access can now reset a user account to its
original default password.

Note: Users cannot reset their own passwords, and only DAISY support representatives
can change the password on a user account that has the Security Officer permission.

► To reset a user password:

1. From the DAISY menu, select Configure, then select Users.

2. Search for and select the user account whose password needs resetting.

3. Click OK to open the User window.
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4. Click the Security tab.

5. From the Tools menu, select Reset Password for user name.
In this example, the user name is REBECCA.

6. In the Info dialog box, click OK.

7. Close the User window.

Set up appointment security settings
DAISY offers a fine degree of control over user access to appointment scheduling and
resource management. You can limit users to Confirmation Only, Follow-Up Schedule
Viewing, Schedule Modifying, Configuration, or all of the above.

► To set up appointment security settings:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the Security tab to view Practice Settings.
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3. Click to open the Search For - User window.

4. Search for and select the user whose permissions need to be modified.

5. Click OK.

6. In the Practice window, select from the following appointment permissions:
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This permission... Does this...

Allow access to Appoint? Acts as a master switch. This permission
allows or prevents the user from
accessing appointment scheduling, such
as the Schedule, the Confirm
Appointments window, or from changing
Appointment configuration settings.

If checked, the user can access some
(depending on the other permissions
granted) or all areas of appointment
scheduling.

If unchecked, the user has no access to
appointment scheduling.

Allow access to
Confirmation?

If checked, the user can access and
modify information in the Confirm
Appointments window.

If unchecked, the user cannot access the
Confirm Appointments window.

Allow access to Follow-Up? If checked, the user can access and
modify information in the Follow Up
Appointments window.

If unchecked, the user cannot access the
Follow Up Appointments window.

Allow Access to Appt.
Config?

If checked, the user can change
Appointment configuration settings,
including practice availability, resource
availability, and schedule set up.

If unchecked, the user cannot change
Appointment configuration settings.

Scheduling If set to None, the user cannot view or
change appointment information.

If set to View, the user can open and
view schedules and appointments, but
cannot make changes.

If set to modify, the user has full access
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This permission... Does this...

to schedules, including modifying
appointment details, checking in and
out, scheduling and rescheduling
appointments, and using the Organizer.

7. Click and close the Practice window.

Set up access to adjustments
In the Security tab in the Practice Settings window, the control option “Allow Posting
Adjustments?” in the Permissions section limits the kind of access users have to
adjustment transactions.

Entering and posting adjustment transactions are treated as separate tasks. Users who
have permission to enter and reverse adjustments can be restricted from posting
them. This allows others to review adjustments before they are posted.

► To set up user access to adjustment transactions:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the Security tab to view Practice Settings.
Note: Only those who have full access rights can change security settings.

3. Click to open the Search For – User window.

4. Search for and select the user whose permissions need to be modified.

5. Click OK.

6. In the Practice window, in the Permissions section, check the “Allow access to
Transactions?” check box.
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7. To give the user permission to create adjustments and reversals, check the “Allow
Adjustments/Reversals?” check box.

8. To give the user permission to post adjustments, click the “Allow Posting
Adjustments?” check box.
Note: Only user accounts that have “Allow Adjustments/Reversals” permission can be
granted “Allow Posting Adjustments” access.

9. Click and close the Practice window.

Set up access to Detail templates
Before you can edit Detail templates, your DAISY user account needs to have the
correct permissions. These permissions are set in the User window.

Note: Only those who have full access rights can change user settings.

► To set up access to Detail templates:

1. From the DAISY menu, select Configure, then select Users.

2. Search for and select the user whose permissions need to be modified.

3. Click OK.
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4. In the User window, check the Allow Access to Detail Templates check box.

5. Click , then close the window.

Set up access permissions for DAISY eRx
Only DAISY users with full access rights can change user account settings.

► To set up user access permissions for DAISY eRx:

1. From the DAISY menu, select Configure, then Users.

2. Search for and select the user account, then click OK to open the User window.

3. Click the Security tab to view the user account settings.
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4. To allow the user to manage e-prescriptions, check the Allow Managing
Prescriptions check box.
Note: The user must first have the Allow Access to Patient setting enabled.

5. To allow the user to enable or disable DAISY eRx for the practice, change the EDI
setting to Modify.

6. Click , then close the window.

Set up permissions for electronic sign-off
The User window has an option that gives users permission to electronically “sign off”
on a Details form. With this permission, users can change a Details form from “Ready
for Review” to “Reviewed.” When they mark it as “Reviewed,” and save the form, they
must enter their user password to make the change permanent.

Note: Only those who have full access rights can change user settings.
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► To set up a user for electronic sign-off:

1. From the DAISY menu, select Configure, then select Users.

2. Search for and select the user whose permissions need to be modified.

3. Click OK to open the User window.

4. In the Permissions section, check the “Allow review of Detail Responses?” check
box.

5. Click , then close the window.
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Set up access permissions for Document Manager
The Security tab in the Practice Settings window now has an option that gives users
permission to access Document Manager. With this permission, users can access the
DAISY archive via the Document Panel and use all of the features of the Document
Manager window.

Document Manager permissions do not override other DAISY security settings.

l Filed documents. Users must have security access to a window to view filed
documents attached to it.  These same restrictions apply to the Documents list in
the Document Manager window. For example, if hygienists do not have security
access to the practice, they will not see documents attached to the practice.

l Unfiled documents. Users with Document Manager permissions can view any
unfiled document.  However, they can only attach unfiled documents to those
areas in DAISY that they have permission to access.

► To set up a user to access Document Manager:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the Security tab to view Practice Settings.
Note: Only those who have full access rights can change security settings.
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3. Click to open the Search For – User window.

4. Search for and select the user whose permissions need to be modified.

5. Click OK.

6. In the Practice window, in the Permissions section, check the “Allow access to
Document Mgr?” check box.

7. Click and close the Practice window.
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Set up access permissions for AutoRemind

► To set up a user to modify practice settings for AutoRemind:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the Security tab to view your practice’s security settings.
Note: Only DAISY users who have full access rights can change security settings.

3. Click to open the Search For – User window.

4. Search for and select the user whose permissions need to be modified.

5. Click OK.
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6. In the Practice window, in the Access to Practice Config. section, change the
AutoRemind setting to Modify.

7. Click and close the Practice window.

Set up access to clinical details
DAISY Chart offers a variety of Details templates that you can use to create forms for
entering routine clinical information, such as clinical findings, daily progress notes,
and patient medical history. You can limit access to the templates and the forms
created from these templates.

► To set up user access to Details:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the Security tab to view Practice Settings.
Note: Only those who have full access rights can change security settings.
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3. Click to open the Search For - User window.

4. Search for and select the user whose permissions need to be modified.

5. Click OK.

6. Check or uncheck the permissions that apply to this user.
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This permission... Does this...

Allow access to Detail
Responses

Acts as a master switch. This permission allows or
prevents the user from accessing Details.

If checked, the user has access to some (depending
on the other permissions granted) or all areas of
Details.

If unchecked, the user has no access to Details.

Allow access to Detail
Templates

If checked, the user has full access to Details,
including creating and modifying Details templates.

If unchecked, the user cannot create or modify
Details templates.

Allow access to Detail
Design

If checked, the user can modify a Details form on a
one-time basis, such as adding a field or changing a
field name. For example, the user needs to collect a
different kind of information than is usually
requested in the form. This change does not modify
the Details template.

If unchecked, the user cannot modify an existing
Details form.

This option is reserved for DAISY customer support
staff.

7. Click , then close the Practice window.

Security and auditing
Several security and auditing features make it easy to manage and monitor your
practice:

l Users can lock their DAISY session to prevent unauthorized access when they
leave their computer.

l If the password is the same as the user account name, DAISY prompts the user to
change the password whenever the user logs in. However, no prompt occurs if the
user logs in from the Change User window (DAISY > Change User).

l Users who have permission to enter and reverse adjustments can be restricted
from posting them. This allows another individual to review adjustments before
they are posted.

l The Status History section of an appointment tracks how many times an
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appointment is rescheduled.

l The Activity Log provides an audit trail of critical financial and other transactions.
This report is available from the Report Gallery.

l The Security Log report:

o Tracks who the user is, which computer the user was on, and what activity
occurred during the user’s session.

o Tracks user permission changes.

o Tracks abnormal database disconnects.

o Allows filtering by computer and event time.

l The Closing Practice Summary report provides a snapshot of all of the practice’s
financial transactions since the last Daily Closing. This report is generated and
archived automatically during Daily Closing. The report can be accessed and
printed from the Document Manager panel in the Practice Setting window and can
also be optionally printed from the Daily Closing dialog box.

l Permissions can be copied from one user account to another.

Use the Activity Log report
The Activity Log report provides an audit trail of critical financial activities and other
transactions in the DAISY system.

Note: Only those who have the Practice option set to View or Modify under the Security
tab of the Practice Setting window can run the Activity Log report.

The Activity Log report tracks:

l When users log in or out of DAISY

l User account permission changes

l Appointments that are:

o Rescheduled for a date in the past

o Set to “Pending” after the start time, but only if the appointment is deleted
from the Organizer’s Recycle Bin

o Changed from one patient to another

o Moved from one schedule to another

o Rescheduled more than two times

l Appointments where the patient’s name is significantly changed

l Appointments where the patient is changed from “On File” to “New”

l When a user changes or deletes unposted transactions
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l If the guarantor is changed on an account

l If the guarantor’s address is changed

Create the Activity Log report

The Activity Log report is not automatically accessible from the Report Gallery
window. You must create the report before it becomes available.

► To create the Activity Log report:

1. From the DAISY toolbar, click to open the Report Gallery.

2. From the File menu, select New, then select Report.

3. Search for and select the Activity Log report, then click OK.
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The report is added to the Report Gallery window.

Run the Activity Log report

► To run the Activity Log report:

l In the Report Gallery window, double-click Activity Log.
The Activity Log report shows the data and time of the activity, the user who
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performed the activity, and the type of activity that occurred.

Use the Security Log report
The Security Log report now includes the following information:

l Who the user is

l Which computer the user was on

l Which DAISY program modules were accessed during the user’s session

l What activity occurred during the user’s session

The report also tracks:

l User account permission changes

l Failed logins
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l Abnormal database disconnects, such as when a computer is shut off without
properly exiting DAISY

In addition, enhanced report filters enable you to filter by computer and event time.

Run the Security Log report

► To run the Security Log report:

l In the Report Gallery window, double-click Security Log.

Filter the Security Log

New Security Log report filters enable you to filter by computer and event time.

► To filter the report:

1. From the DAISY toolbar, click to open the Report Gallery.

2. In the Report Gallery window, right-click on Security Log and select Properties.
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3. In the Parameters section of the Property Editor – Security Log window, click a tab
and select the options to filter by.
For example, to filter for all activities that Betty performed, click the User tab and
select the appropriate filtering options.
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4. Repeat step 3 until all appropriate filters are selected.
Note: To clear all filter settings, click Reset.

5. Click OK.

6. In the Report Gallery window, double-click Security Log to run the filtered report.

Manage financial settings

Set up a default disclaimer for financial arrangements
You can set up a default disclaimer for financial arrangements. By default, this
disclaimer displays on all of the practice’s financial arrangements.

Note: You may also type a different disclaimer on individual financial arrangements.
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► To set up the default disclaimer for financial arrangements:

1. In the Practice window, click the Financial Setup tab.

2. In the Financial Arrangement Default Disclaimer section, type the disclaimer that
you want to show on every financial arrangement by default.

3. Click to save the settings.

Define a treatment plan disclaimer
Offices can define their own version of the disclaimer that appears on treatment
plans. This user-defined disclaimer replaces the default DAISY treatment plan
disclaimer that is printed on the treatment plan.

The user-defined disclaimer is limited to 500 characters and appears on all treatment
plans. Only one disclaimer per practice is permitted.

Note: Use caution when redefining the disclaimer. If you print a treatment plan with one
disclaimer, then change the disclaimer and print that treatment plan again, it will have
the new disclaimer.

► To define your own disclaimer:

1. From the DAISY menu, select Configure, then select Practice Config.

2. Click the Other Messages tab.

3. In the Treatment Plan Disclaimer text box, type or modify the disclaimer.
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4. Click to save the change.

Configure the schedule
DAISY Scheduler relies on default settings for both office hours, as well as resource
availability, to ensure that appointments and events are only scheduled when the
appropriate resources are available.

Office hours and resource availability are set up using time patterns. These patterns
are combinations of:

l Time ranges. You can specify up to three time ranges by beginning and ending
times. For example, morning hours could have the time range of 8:00 am to 12:00
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pm, and afternoon hours could have the time range of 1:00 pm to 5:00 pm.

Note: Time ranges must fall within a 24-hour period. In addition, time ranges in the
same pattern must not overlap.

l Recurring Patterns. You can specify how often the time range is repeated, and on
what days of the week, days of the month, or months of the year that it applies.

l Effective Dates. You can specify when this pattern begins and when it ends. For
example, winter hours are in effect from Oct 15, 2006 to March 15, 2007.

Time off for the practice, as well as resources, is specified using these same types of
time patterns. You can name each pattern to make it easier to identify.

Set up practice availability
Practice availability or office hours are set up using a series of recurring time patterns.
For example, you can use this feature to create seasonal schedules—one for winter,
and one for summer.

Practice availability settings have no direct effect on the scheduling of resources.
However, when you make changes to practice availability, you do have the option of
applying those changes to selected resources. This process is called synchronization.

► To set up practice availability:

1. From the DAISY menu, select Appointment, then Configure, then Practice.

2. Click the Availability tab.
Use this window to view the current office hours and time off for the practice. The
calendar shows six weeks worth of dates.
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3. Click the Availability button.

4. Do one of the following:
l In the Search For - Practice Availability window, search for and select a time

pattern, then click OK.
Note: The Search For - Practice Availability window does not show patterns whose
effective dates have expired. To view all Availability patterns, including expired ones,
click the Less button to clear the Ending filter.
l To create a new time pattern, click New Practice Availability.

5. In Name text box, type a name for this time pattern.
For example, if you're setting up a pattern for summer hours, type Summer Hours.
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6. In Time Range #1 do one of the following:
l Type the beginning and ending times for this pattern's first time range.
l Use the arrows to scroll through the times beginning and ending times for this

pattern's first time range.

7. Select beginning and ending times for Time Range #2 and #3, if required.
Note: Time ranges must fall within a 24-hour period. In addition, time ranges in the
same pattern must not overlap.

8. In the Recurrence Pattern section:
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a. From the Repeat Every lists, select how often the pattern should repeat and
whether it repeats by week, month, or year.

b. Choose one of the following:

If the pattern
repeats every...

Do this...

Week Check the check box next to each day of the
week on which the pattern should recur.

Month Select the number of days the pattern recurs or
select specific details from the drop-down lists.
For example, this selection repeats the pattern
on the first Wednesday of every month.

Year Select the month of the year that the pattern
recurs or select specific details from the drop-
down lists. For example, this selection repeats
the pattern on the third Friday of December
every year.

9. In the Effective Dates section, if required, select the beginning and ending dates
for this pattern as follows:
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l To add a beginning date, check the Beginning check box, and type or select a
date.

l To add an ending date, check the Ending check box, and type or select a date.
Note: If no effective date is selected, then the pattern takes effect immediately. If only
a beginning date is specified, then the pattern takes effect on that date and remains in
effect indefinitely. If only an ending date is specified, then the pattern is in effect for
all dates up to and including the ending date.

10. Click to save the time pattern.

11. In the Synchronize Practice Availability with Resources window, do one of the
following:
l Check the check box next to each resource whose availability needs to match

this time pattern.
l To synchronize all resources to this time pattern, click All.
l To add these changes to resources whose availability needs to match this time

pattern for the first time, click New Only.
l To only update resources whose availability previously matched this time

pattern, click Update Only.
l To synchronize none of the listed resources to these changes, click None.

12. Click Finish.
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13. Close the Availability - Practice window.

14. Close the Practice Configuration window.

Set up practice time off
Practice time off, just like practice availability, is set up using a series of recurring
time patterns. Use the Practice Time Off feature to schedule exceptions to normal
business hours. For example, you can use this feature to schedule holidays or other
events that affect the practice as a whole.

Practice time off settings have no direct effect on the scheduling of resources.
However, when you make changes to practice time off, you do have the option of
applying those changes to selected resources. This process is called synchronization.

► To set up time off for the practice:

1. From the DAISY menu, select Appointment, then Configure, then Practice.

2. Click the Availability tab.

3. Click the Time Off button.

4. Do one of the following:
l In the Search For - Practice Time Off window, search for and select a time

pattern, then click OK.
Note: The Search For - Practice Time Off window does not show patterns whose
effective dates have expired. To view all Time Off patterns, including expired ones,
click the Less button to clear the Ending filter.
l To create a new time pattern, click New Practice Time Off.

5. In the Reason text box, type a reason for this time pattern, such as Thanksgiving or
HIPAA Seminar.
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6. From the Type drop-down list, select the kind of time off.
For example, if the time off is for Thanksgiving, select Holiday.

7. Do one of the following:
l If the office is closed all day, select All Day.
l If the office is closed part of the day, select Time Between, then select the

beginning and ending times for this time off pattern.
Note: Time range must fall within a 24-hour period.

8. In the Recurrence Pattern section:
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a. From the Repeat Every lists, select how often the pattern should repeat and
whether it repeats by day, week, month, or year.

b. Choose one of the following:

If the pattern
repeats every...

Do this...

Day Select the number of days the pattern recurs.

Month Select the number of days the pattern recurs or
select specific details from the drop-down lists.
For example, this selection repeats the pattern
on the first Wednesday of every month.

Year Select the month of the year that the pattern
recurs or select specific details from the drop-
down lists. For example, this selection repeats
the pattern on the third Friday of December
every year.

9. In the Effective Dates section, if required, select the beginning and ending dates
for this pattern as follows:
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l To add a beginning date, check the Beginning check box, and type or select a
date.

l To add an ending date, check the Ending check box, and type or select a date.
Note: If no effective date is selected, then the pattern takes effect immediately.
If only a beginning date is specified, then the pattern takes effect on that date and
remains in effect indefinitely.
If only an ending date is specified, then the pattern is in effect for all dates up to and
including the ending date.

10. Click to save the time pattern.

11. In the Synchronize Practice Time Off with Resources window, do one of the
following:
l Check the check box next to each resource whose availability needs to match

this time pattern.
l To synchronize all resources to this time pattern, click All.
l To add these changes to resources whose availability needs to match this time

pattern for the first time, click New Only.
l To only update resources whose availability previously matched this time

pattern, click Update Only.
l To synchronize none of the listed resources to the changes, click None.
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12. Click Finish.

13. Close the Time Off - Practice window.

14. Close the Practice Configuration window.

Delete practice availability
Whenever you delete one of the practice's availability time patterns, DAISY looks for
resources that have time patterns that match. If any are found, DAISY asks if you want
to delete the time pattern from those resources as well.

► To delete a practice availability time pattern:

1. From the DAISY menu, select Appointment, then Configure, then Practice.

2. Click the Availability tab.

3. Click the Availability button.

4. In the Search For - Practice Availability window, search for and select a time
pattern, then click OK.
Note: The Search For - Practice Availability window does not show patterns whose
effective dates have expired. To view all Availability patterns, including expired ones,
click the Less button to clear the Ending filter.

5. From the File menu, select Delete.

6. In the Confirm dialog window, click Yes to delete the availability information.

7. In the Synchronize Practice Availability with Resources window, do one of the
following:
l Check the check box next to each resource whose availability needs to match

this change to practice availability.
l To match all resources to this practice availability change, click All.
l To synchronize none of the listed resources to this practice availability change,

click None.
Note: If you decide to synchronize a resource's availability to these changes, be sure
that the resource has an alternative availability time pattern; otherwise when you use
the Best Fit feature, it may not be able to find available appointment slots for the
resource.
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8. Click Finish.

9. Click and close the Practice Configuration window.

Delete practice time off
Whenever you delete one of the practice's time-off time patterns, DAISY looks for
resources that have time-off patterns that match. If any are found, DAISY asks if you
want to delete the time pattern from those resources as well.

► To delete a practice time-off time pattern:

1. From the DAISY menu, select Appointment, then Configure, then Practice.

2. Click the Availability tab.

3. Click the Time Off button.

4. In the Search For - Practice Time Off window, search for and select a time pattern,
then click OK.
Note: The Search For - Practice Time Off window does not show patterns whose
effective dates have expired. To view all Time Off patterns, including expired ones,
click the Less button to clear the Ending filter.

5. From the File menu, select Delete.

6. In the Confirm dialog window, click Yes to delete the time-off information.
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7. In the Synchronize Practice Time Off with Resources window, do one of the
following:
l Check the check box next to each resource whose time off needs to match

these changes.
l To match all resources to these changes, click All.
l To match none of the listed resources to these changes, click None.

8. Click Finish.

9. Click and close the Practice Configuration window.

Set up resource availability
Resource availability is set up using a series of recurring time patterns. For example,
you can use this feature to schedule a hygienist who works on Tuesdays and
Thursdays only.

► To set up when a resource is available:

1. From the DAISY menu, select Appointment, then Configure, then Resources.

2. In the Search For - Appointment Resource window, search for and select a
resource, then click OK.

3. Click the Availability tab.
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Use this window to view the resource's current availability and upcoming time off.
The calendar shows six weeks worth of days.

4. Click the Availability button.

5. Do one of the following:
l In the Search For - Resource Availability window, search for and select a time

pattern, then click OK.
Note: The Search For - Resource Availability window does not show patterns whose
effective dates have expired. To view all Availability patterns, including expired ones,
click the Less button to clear the Ending filter.
l To create a new time pattern, click New Resource Availability.

6. In Name text box, type a name for this time pattern.
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7. For Time Range #1, do one of the following:
l Type the beginning and ending times for this pattern's first time range.
l Use the arrows to scroll through the times beginning and ending times for this

pattern's first time range.

8. Select beginning and ending times for Time Range #2 and #3, if required.
Note: Time ranges must fall within a 24-hour period. In addition, time ranges in the
same pattern must not overlap.

9. In the Recurrence Pattern section:
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a. From the Repeat Every lists, select how often the pattern should repeat and
whether it repeats by week, month, or year.

b. Choose one of the following:

If the pattern
repeats every...

Do this...

Week Check the check box next to each day of the
week on which the pattern should recur.

Month Select the number of days the pattern recurs or
select specific details from the drop-down lists.
For example, this selection repeats the pattern
on the first Wednesday of every month.

Year Select the month of the year that the pattern
recurs or select specific details from the drop-
down lists. For example, this selection repeats
the pattern on the third Friday of December
every year.

10. In the Effective Dates section, if required, select the beginning and ending dates
for this pattern as follows:
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l To add a beginning date, check the Beginning check box, and type or select a
date.

l To add an ending date, check the Ending check box, and type or select a date.
Note: If no effective date is selected, then the pattern takes effect immediately. If only
a beginning date is specified, then the pattern takes effect on that date and remains in
effect indefinitely. If only an ending date is specified, then the pattern is in effect for
all dates up to and including the ending date.

11. Click and close the Availability window.

12. Close the Resource Configuration window.

Set up resource time off
Resource time off is set up using a series of recurring time patterns. For example, you
can use this feature to schedule vacation or convention attendance.

► To set up when a resource has time off:

1. From the DAISY menu, select Appointment, then Configure, then Resources.

2. Do one of the following:
l In the Search For - Appointment Resource window, search for and select a

resource, then click OK.
l To create a new appointment resource, click New Appointment Resource.

3. Click the Availability tab.

4. Do one of the following:
l In the Search For - Resource Time Off window, search for and select a time

pattern, then click OK.
Note: The Search For - Resource Time Off window does not show patterns whose
effective dates have expired. To view all Time Off patterns, including expired ones,
click the Less button to clear the Ending filter.

l To create a new time pattern, click New Resource Time Off.

5. In the Reason text box, type a reason for this time pattern.
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6. From the Type drop-down list, select the type of time off.
For example, if the time off is for vacation, select Vacation.
Note: You can also add more types to this drop-down list. In the Type text box, type
the name of the new type. After you save this pattern, the type becomes available
whenever you select from the Type drop-down list. You can also maintain the list of
time off types. From the DAISY menu, select Configure, then List Maint. Click the
Simple Lists tab, and from the drop-down list in the Lookup List Maintenance
window, select Time Off Types.

7. Do one of the following:
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l If the resource will be off all day, select All Day.
l If the resource has time off part of the day, select Time Between, then select

the beginning and ending times for this time off pattern.
Note: Time range must fall within a 24-hour period.

8. In the Recurrence Pattern section:
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a. From the Repeat Every lists, select how often the pattern should repeat and
whether it repeats by day, week, month, or year.

b. Choose one of the following:

If the pattern
repeats every...

Do this...

Week Check the check box next to each day of the
week on which the pattern should recur.

Month Select the number of days the pattern recurs or
select specific details from the drop-down lists.
For example, this selection repeats the pattern
on the first Wednesday of every month.

Year Select the month of the year that the pattern
recurs or select specific details from the drop-
down lists. For example, this selection repeats
the pattern on the third Friday of December
every year.

9. In the Effective Dates section, if required, select the beginning and ending dates
for this pattern as follows:
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l To add a beginning date, check the Beginning check box, and type or select a
date.

l To add an ending date, check the Ending check box, and type or select a date.
Note: If no effective date is selected, then the pattern takes effect immediately. If only
a beginning date is specified, then the pattern takes effect on that date and remains in
effect indefinitely. If only an ending date is specified, then the pattern is in effect for
all dates up to and including the ending date.

10. Click and close the Time Off window.

11. Close the Resource Configuration window.

Configure a schedule to show first names only
The Schedule window and the printed schedule (Schedule View Report) can be
configured to show the patients’ first names only.

► To configure a schedule to show patient first names only:

1. From the DAISY menu, select Configure, select Appointment, then select Practice.

2. In the Practice Configuration window, check the “Show first names ONLY on
schedule?” check box.
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3. Click to save the change.

► To print the schedule showing patient first names only:

1. From the DAISY toolbar, click .

2. From the Reports menu, select Schedule.

3. In the Print Schedule View Report dialog box, click the Appointments tab.
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4. Check the “Print first names ONLY” check box.

5. Click OK.

Set up recall for the practice
Before you can use DAISY’s recall capabilities, you have to set up these features at the
system level in DAISY:

l Set up recall defaults, such as the amount of time in-between recall appointments,
how you will notify patients that recall is due, and whether you want enable Auto-
create Recall.

l Define recall types. You give each recall type a unique name, and specify the
duration and time in-between this type of appointment. For more information, see
"Set up recall card messages " on page 556.

l Associate the recall type with a procedure. For example, if you define a recall type
of Prophy, you need to associate it with a basic cleaning procedure such as D1110
– Prophylaxis, Adult.

In addition, if you want to use Hands-free Recall you have to enable it at the system
level in the Scheduler. In most cases, your system is already set up to manage recall,
so you simply need to set up individual patients for recall.
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Set up recall card messages
Each recall card can contain three types of messages. You can set up default messages
that will appear on each recall card, then customize them to fit your immediate
needs.

l The Broadcast Message contains information that is specific to the type of recall,
such as Prophy or Perio. For example, a prophy message might say, “It is time for
your cleaning.”

l The Recall Message contains information that is specific to this recall card
mailing. A different message is printed depending on whether the patient has a
scheduled appointment or is unscheduled. For example, the scheduled message
might say, “Your appointment is on Sept. 30, 2005.”

l The Custom Recall Message defaults to a pre-defined custom message for all
patients, but it can also be customized to contain information that is specific to
the patient. For example, “If you are unable to keep your appointment, please
call.”

Setup the Broadcast Message

The Broadcast Message prints on all the recall cards that you send for a particular
recall type, such as prophy. You cannot customize this message for a specific patient.

► To set up the Broadcast Message:

1. From the DAISY menu, select Configure then List Maintenance.

2. Click the Simple Lists tab.
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3. From the Simple List Selection drop-down list, select Recall Types.

4. Scroll to the far right and select the message under the Recall Broadcast Message
column that you want to change.

5. Type a new message.

6. Click , then close the window.

Set up the Recall Message

The Recall Message prints on all recall cards. This message comes in two forms:

l If the patient has already scheduled a recall appointment, the message includes
the recall date and time.

l If the patient hasn’t scheduled a recall appointment, the message asks the patient
to make an appointment soon.

Note: You cannot customize this message for a specific patient.
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► To set up the Recall Message:

1. From the DAISY Recall Manager window, click the Patient tab.

2. In the lower right corner, click next to the Recall Message text box.

3. To change the message for patients with a recall appointment, click the Scheduled
Message text box and type the new message.

4. To change the message for patients without an appointment, click the
Unscheduled Message text box and type the new message.
When you change the message, you must include the symbols “%s” (a percent sign
followed by a lowercase s) if you want Recall Manager to automatically enter a
patient's appointment date and time. For example, the message might say, “Your
appointment is scheduled on %s.”
If you do not want to include the next recall date and time, simply omit the
symbols.

5. Click OK.

Set up the Custom Recall Message

You can either change the default Custom Recall Message or simply change the
Custom Recall Message for a specific patient.

► To change the default Custom Recall Message:

1. From the Recall Manager window, click the Patient tab.

2. Click next to the Custom Recall Message text box.

3. Click the Default Custom Message text box and type the new message.
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4. Click OK.
Note: To always reserve the Custom Message for specific recall cards, leave the Default
Custom Message text box blank.

► To customize the Custom Recall Message for a specific recall card:

1. From the Recall Manager window, select a patient from the recall list.

2. Click the Patient tab.

3. Do one of the following:
l Click the Custom Recall Message text box and type a different message.

l Next to the Custom Recall Message text box, click , select a canned
message, then click OK.

Note: If no canned messages exist, you’ll be asked to enter text for one.

Create a list of Custom Recall Messages

You can create a list of the most common Custom Recall Messages, then select from
that list when you want to customize a specific patient’s recall card.

► To create a list of Custom Recall Messages:

1. From the Recall Manager window, click the Patient tab.

2. Next to the Custom Recall Message text box, click .
If no Custom Recall Messages exist, then you see the Custom Recall Message
window. If a list already exists, then you see the Search For - Custom Recall
Message window.

3. Do one of the following:
l In the Custom Recall Message window, type a new message, then click OK.
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l In the Search For - Custom Recall Message window, search for and select a
message, then click OK.

l In the Search For - Custom Recall Message window, click the New Custom
Recall Message button. Type the new message, then click OK.

Add a default overdue message

A default overdue message can be added to Recall Manager.

► To add a default overdue message:

1. From the DAISY toolbar, click .

2. Next to the Recall Message text box, click .

3. In the Overdue Message text box, type the overdue message.

4. Click OK to save the message.

Set up DAISY InCharge
Before you can use DAISY InCharge, you need to configure your practice to process
electronic transactions as follows:

l Specify the credit cards that the practice accepts according to your contract with
TransFirst. These card types will display on account statements.
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l Set up the TransFirst connection in DAISY for each office location.

Note: A DAISY representative will help you set up this connection.

Set up accepted credit card types for the practice
To use DAISY InCharge, you need to specify all of the credit card types that the
practice accepts according to your contract with TransFirst. These credit card types
will display on account statements.

► To set up the credit card types accepted by the practice:

1. From the DAISY menu, select Configure, then Practice.

2. In the Practice window, click the Financial Setup tab.

3. In the Accepted Credit Cards on Statement section, check the check box for  each
credit card type that the practice accepts.
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4. In the Other text box, type the name of one or more additional credit cards that
the practice accepts, if any.
Use a space to separate the credit card names. You can type up to 25 characters,
including spaces.

5. Click to save the settings.

Set up each office connection to TransFirst
Next, you need to set up a connection to TransFirst for each office location. Each
location has its own TransFirst merchant ID and registration key.

Note: Please wait for a DAISY representative to help you set up this connection.
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► To set up an office connection to TransFirst

1. In the Practice window, click the Location tab.

2. In the Office Locations section, select a location.

3. In the DAISY InCharge section, do the following:
a. Check the Enable Card Services check box.
b. In the Merchant ID text box, type the TransFirst merchant ID for your practice.
c. In the Registration Key text box, type the TransFirst registration number.

4. Repeat steps 2 through 3 for each additional office location.

5. Click and close the window.

Set up access to TransFirst Virtual Terminal
You can access TransFirst Virtual Terminal directly from within DAISY. You use the
Virtual Terminal to view settlement reports and other financial reports, including:

l Transaction summary and detail reports

l Settlement summary and detail reports

l Return lists

l Recurring payments detail and problem summaries

l ACH statements

For more information, see the TransFirst Virtual Terminal documentation.

► To access Virtual Terminal:

1. From the DAISY menu, select Account, then TransFirst.

2. In the Merchant ID textbox, type your TransFirst merchant ID.

3. In the Password textbox, type your TransFirst password.

Note: For easier access, add the TransFirst button (          ) to the DAISY toolbar.

Maintain lists

Deactivate a referral provider
You can deactivate referral providers in the Lookup List Maintenance window. When
you add a referral for a patient under the Referral Info tab in the Patient window, the
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deactivated referral provider will no longer appear as one of the selections.

► To deactivate a referral provider:

1. From the DAISY menu, select Configure, then select List Maint.

2. Click the Referring Providers tab.

3. Search for and select the provider you want to delete.

4. Right-click and select Delete provider name.

5. Click to save the change.

Add adjustment types
Note: If you already have adjustment types with the same meanings but with different
names, use them instead of creating new ones.
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► To add an Adjustment Type:

1. From the DAISY menu, select Configure, then List Maintenance.

2. Click the Simple Lists tab.

3. From the Simple Lists drop-down list, select Adjustment Types.

4. Right-click and select New Item.

5. Type in the new item.
You see the new item added to the table.
Note: DAISY automatically alphabetizes the list for you, so the item you added may
not be at the bottom of the table.

6. For each additional adjustment type, repeat steps 4 through 5.

7. Click and close the Lookup List Maintenance window.

Manage document types
DAISY includes several preconfigured document types.  Document types are managed
from the Lookup List Maintenance window.

► To manage document types:

1. From the DAISY menu, select Configure, then List Maint.

2. In the Simple Lists drop-down list, select Document Types.
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Note: The Visit Summaries document type cannot be changed or deleted, because
Document Manager automatically archives any visit summary (walkout statement)
that is printed.  Visit summaries are attached to the account.

3. To add a new document type, right-click in the list of document types and select
New Item.

4. In the Document Types column, type the name of the document type.
For example, type Referral Slips to create a document type for referral letters.

5. In the Description column, type a description of the document type.

6. Click to save the new document type.

Add user defined tags

► To add an user defined tag:

1. From the DAISY menu, select Configure, then List Maint.

2. Click the Simple Lists tab.
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3. From the Simple Lists drop-down list, select User Defined Tags.

4. Right-click and select New Item.

5. Type in the new item.
You see the new item added to the table.
Note: DAISY automatically alphabetizes the list for you, so the item you added may
not be at the bottom of the table.

6. For each additional tag, repeat steps 4 through 5.

7. Click and close the Lookup List Maintenance window.

Use AutoRemind
DAISY AutoRemind uses a partner service that enables dental offices to automatically
remind patients of upcoming appointments, resulting in fewer missed appointments
and a more consistent revenue stream for your practice. Reminders can be
communicated by phone, e-mail, or SMS text.

This add-on service is fully integrated with DAISY. Database synchronization between
the two programs takes place automatically every hour. This synchronization sends
the latest appointment information to AutoRemind and updates the confirmation
status in the DAISY schedule.

With AutoRemind, you can decide when and how to send reminders. You can also
customize the look of your e-mail reminder messages using your practice logo or
another appropriate image.

You use reminder schemes to define a strategy for sending reminders to patients who
have upcoming appointments. DAISY provides the ability to create and name multiple
reminder schemes so you can set up customized strategies for different types of
patients or for individual patients.

For more information about subscribing to this service, contact DAISY Sales at
503.765.3471 or daisysales@dmcdental.com.

Set up AutoRemind
Before you can use AutoRemind, you need to set up this service for your practice by:

l Registering for the AutoRemind service via the Internet.

l Setting up the AutoRemind connection in DAISY.

Note: A DAISY representative will help you set up this connection.

l Configuring your office’s AutoRemind profile on the AutoRemind web site.

l Assigning AutoRemind access permissions for DAISY users.
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l Setting up the reminder schemes your office wants to use to send reminders to
patients.

Register for the AutoRemind service

► To register for the AutoRemind service:

1. Go to www.AutoRemind.us/trial.

2. Follow the instructions to sign up for an AutoRemind trial account.

3. Record the username and password you used to set up the account.

Within three days, your AutoRemind account information will be sent to Dentists
Management Corporation (DMC), and you will receive an e-mail message that DMC
has received this information. A DAISY representative will contact you to help you
configure AutoRemind for your practice.

Set up the AutoRemind connection

Note: Please wait for a DAISY representative to help you set up this connection.

► To set up the AutoRemind connection:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the AutoRemind tab.

3. In the Username text box, type your AutoRemind username.

4. In the Password text box, type your AutoRemind password.

5. In the Def Reminder drop-down list, select the default reminder scheme.
For more information about reminder schemes, see "Set up a reminder scheme"
on page 576 .

6. Click Verify to connect to AutoRemind and verify that the password and username
are correct.
DAISY displays the message “date time: Verified user” in the text box below the
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Web Site button.

Once you have connected, you can also use this window to manage your AutoRemind
service:

Click
this
button…

To do this …

Verify Verify your AutoRemind connection and download new AutoRemind
templates and offset settings

Sync Send the latest appointment information to AutoRemind and update
the confirmation status in the DAISY schedule

Web Site Log in to the AutoRemind website to configure your reminder
profile, monitor messages, and view service announcements

Set up the AutoRemind profile

The AutoRemind profile is managed from the AutoRemind website. Use the My Profile
page to:

l Define when AutoRemind should not send out reminder messages. For example,
you may not want to send reminders after 8:00 p.m. and before 9:00 a.m.

l Set the maximum number of voice call attempts per appointment.

l Upload a logo or other image to include in e-mail reminders. If you do not upload
an image, AutoRemind uses a generic image.

The following is an example of an AutoRemind e-mail message:
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► To set up the AutoRemind profile:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the AutoRemind tab.

3. Click the Web Site button to open your default web browser and automatically log
into your AutoRemind account.
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4. In the top navigation, click the Profile link.

5. In the Configure Your Messages section, do the following:
l Select the time range when AutoRemind should not send reminder messages.
l Choose the maximum number of voice call attempts to allow per appointment.
l Optionally upload your practice’s logo or other image to include in e-mail

reminders. Images must be 200 x 60 pixels and JPG format.
Note: If you do not upload an image, AutoRemind uses a generic image.

6. Click Update and close the browser window.

Rebuild AutoRemind Data
If AutoRemind data becomes corrupted on the AutoRemind website, you can use this
procedure to rebuild the information stored there.

Note: You must have Modify access permissions to perform this task. For more
information, see "Set up access permissions for AutoRemind" on page 521.
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► To rebuild data on the AutoRemind website:

1. From the DAISY menu, select Configure, then Practice Config.

2. From the Tools menu, select Rebuild AutoRemind.

3. In the Warning dialog box, click OK.

When complete, you see the message “Rebuilding Reminders Completed.” in the
text box below the Web Site button.

Synchronize AutoRemind with DAISY
AutoRemind and DAISY need to stay in regular contact with each other to ensure that
each has the same appointment and confirmation information.
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Database synchronization between the two programs occurs automatically every
hour. You can also choose to synchronize AutoRemind manually with your DAISY
database.

Synchronization sends the latest appointment information to AutoRemind and
updates the confirmation status in the DAISY schedule. In DAISY 4.0, the confirmation
status displays as bell icon on an appointment.

If the
bell
is…

The appointment status is…

White Unconfirmed

Green Confirmed through personal contact. Personal contact includes
responding to an automated call or to an email message

Yellow Message left

Red Could not confirm

► To manually synchronize DAISY and AutoRemind:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the AutoRemind tab.

3. Click the Sync button to upload updated appointment information and download
the latest confirmation results.
Note: You can also manually synchronize DAISY and AutoRemind by selecting Sync
AutoRemind from the Tools menu in the Schedule and Confirm Appointments
windows.

Discontinue the AutoRemind service
If you want to discontinue the AutoRemind service, you can use this procedure to
remove all AutoRemind data from DAISY and from the AutoRemind website.

Note: You must have Modify access permissions to perform this task. For more
information, see "Set up access permissions for AutoRemind" on page 521 .

► To discontinue the AutoRemind service:

1. From the DAISY menu, select Configure, then Practice Config.

2. From the Tools menu, select Reset AutoRemind.
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3. In the Warning dialog box, click OK.

All reminder data is removed from AutoRemind in DAISY and the AutoRemind
website.

Manage reminder schemes
A reminder scheme defines a strategy for sending reminders to patients who have
upcoming appointments. For example, one strategy might be to send a confirmation
e-mail seven days prior to an appointment, asking for the patient to confirm that
appointment. If the patient does not confirm, then the patient will receive a phone
call the night before the appointment at 5:00 p.m.

DAISY provides the ability to create and name multiple reminder schemes so you can
set up customized strategies for different types of patients. When you sign up for
AutoRemind, your practice is provided with the following default reminder schemes:

l Basic E-mail – AutoRemind sends the patient an appointment confirmation via e-
mail four days before the appointment. If the appointment is not confirmed, then
it makes a voice call two days before the appointment. AutoRemind also sends a
final reminder via e-mail one day before the appointment.

l Basic Phone – AutoRemind uses the primary contact phone number in the
patient’s Personal Info window to make a confirmation voice call two days before
the appointment.

l Basic SMS – Uses the primary contact phone number if it is a cell phone.
Otherwise it uses the first cell phone number in the Phone Numbers list.
AutoRemind sends a confirmation text message four days before the appointment.
If the appointment is not confirmed, then it makes a voice call two days before the
appointment. AutoRemind also sends a reminder text message two hours before
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the appointment.

During initial setup, you select a default reminder scheme for your practice. If a
patient is set up to use AutoRemind, all appointments set up for the patient will
automatically use the default reminder scheme, unless an alternate scheme is
selected for the patient.

Reminder schemes include reminder templates and reminder offsets.

Reminder templates

Reminder templates define the type of message, such as Confirm Appointment, and
the language, such as US English. In each reminder scheme, a template defines the
message content and the type of media (phone, e-mail, SMS text) that will be used to
send the appointment reminder. For example, the practice may have one reminder
template for e-mail reminders, and another one that asks the patient to confirm an
appointment via an SMS text message.

l Confirm appointment templates generate messages that ask the patient to
respond. For example:

o If the template is a voice confirmation, patients are asked to press 5 to confirm
that they received the message. AutoRemind considers this a personal contact
confirmation. If the patient responds, the confirmation status displays as a
green bell icon on the appointment in the DAISY schedule.

o If AutoRemind makes the call, and the patient does not answer but
AutoRemind can still leave a message, then it treats this result as a personal
contact confirmation. The confirmation status displays as a green bell icon on
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the appointment in the DAISY schedule.

o If the voice call is answered, but 5 is not pressed, then AutoRemind calls again
every hour until the maximum number of voice call attempts allowed per
appointment is reached. For more information about how to set the maximum
voice call attempts allowed, "Set up the AutoRemind profile" on page 569. The
confirmation status displays as a red bell icon on the appointment in the DAISY
schedule.

l Personal reminder templates do not ask the patient to respond. Once the reminder
is delivered, AutoRemind changes the appointment’s confirmation status to “left
message”. The confirmation status displays as a yellow bell icon on the
appointment in the DAISY schedule. For more information about confirmation
statuses, see "Synchronize AutoRemind with DAISY" on page 572.

Note: If the appointment’s confirmation status is already set to “personal contact”,
AutoRemind will not set the status back to “left message”.

Reminder offsets

Reminder offsets define the timeframe in which you want to send your reminder prior
to the appointment. Offsets tell AutoRemind how far in advance to send the reminder,
such as seven days before the appointment. Different offsets can be attached to
different templates. For example, you might want to e-mail patients a week in
advance, but text message patients only a day or an hour in advance.

If the time for sending the reminder falls into the range when AutoRemind is blocked
from sending messages, then AutoRemind will send the reminder one hour and 15
minutes before the block begins. For example:

l If the office has blocked the sending of reminders between 8:00 p.m. and 8:00 a.m.
and a patient is supposed to receive a reminder two hours before their 8:00 a.m.
appointment, then AutoRemind will send the reminder at 6:45 p.m. the prior
evening.

l If the appointment is on Monday, and the patient is supposed to receive a phone
call two days before, but the office has blocked calls on Saturday, then
AutoRemind will call the patient on Friday.

Each scheme can have one or more templates and offsets. Using combinations of
templates and offsets, a practice can build a variety of reminder schemes that address
patient needs.

Set up a reminder scheme

In this example, the front office wants to create a reminder scheme that sends a
confirmation text message a week before the appointment, then follows that with an
8:00 a.m. reminder on the day of the appointment, if the patient has not confirmed.
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► To set up a reminder scheme:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the AutoRemind tab.

3. In the Reminder Schemes section, click to add a reminder scheme.

4. In the New Scheme cell, type the name of the new reminder scheme.
Choose a name that is descriptive of the scheme’s strategy. For example, a scheme
called “Confirm Appt SMS” could be set up to send a text message in US English a
week before the appointment. If the patient does not confirm, then the scheme
will send a reminder at 8:00 a.m. the day of the appointment.

5. In the Scheme Name column, select the new scheme, then click to add reminder
templates and offsets to the scheme.

You see the Reminder Scheme window for the selected scheme.

6. In the Reminder Template column, click a blank row and select the appropriate
reminder template from the drop-down list.

7. Tab to the Reminder Offset column and select the appropriate offset from the
drop-down list.
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8. To add another template and offset, click .

9. Repeat steps 6 through 7.

10. Click and close the Reminder Scheme window.

11. To add another Reminder scheme, repeat steps 3 through 10.

12. Close the Practice window.

Note: Reminder schemes can be entered in the Reminder Scheme window in any order.

Modify a reminder scheme

► To modify a reminder scheme:

1. From the DAISY menu, select Configure, then Practice Config.

2. Click the AutoRemind tab.

3. In the Reminder Schemes section, select the scheme, then click to edit the
scheme.
You see the reminder templates and offsets associated with the scheme.
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4. In the Reminder Schemes window, do one of the following:
l To change the reminder template, click the template and select a different one

from the drop-down list.
l To change the reminder offset, click the offset and select a different one from

the drop-down list.
l To add a reminder template, click . Click the template column and select the

appropriate template. Tab to the Reminder Offset column and select the
appropriate offset.

l To remove a reminder template and its offset, click the template, then click .
In the Confirm dialog box, click Yes.

5. Click and close the Reminder Scheme window.

6. Close the Practice window.

Configure DAISY Chart

Configure workstation settings
Workstation settings apply only to perio charting, not hard tissue charting. Settings at
the top of the window (Pocket Depth Red Line Indicator and Probe) are specific to
the computer, so they apply no matter who logs in to the computer.
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Settings under the User Settings section, however, are user specific per computer. For
example, if you work in multiple operatories, you need to set up DAISY Chart on each
computer in those operatories. These settings will apply only to the account you log
into.
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Dr. William Taylor performs perio exams in operatory 2. Dr. Sharon Perez performs
perio exams in operatories 2 and 4. In operatory 2, Dr. Taylor logs in with his user
name and password to the computer, and in the Workstation Setting window, he
makes his perio setup selections under User Settings. He logs out.

Later, Dr. Perez logs in with her user name and password to the computer in
operatory 2, and in the Workstation Settings window, she makes her perio setup
selections under User Settings. She logs out. Next, she logs in with her user name and
password to the computer in operatory 4, and she completes the User Settings. She
logs out.

► To set up workstation settings:

1. Log in to DAISY.
Be sure to log in with the user account that the settings should apply to.

2. From the DAISY menu, select Chart, then Configure, then Chart Workstation
Settings.

3. Under Pocket Depth Red Line Indicator, choose the option that specifies what the
Pocket Depth Red Line Indicator should represent.
In the Perio Exam Full View, the Perio Comparison Chart, and the Periodontal
Graphic Chart, a red line on the tooth graphic indicates a pocket depth that is 4
mm or greater. You set up this indicator to specify the measurement for either the
pocket depth, or the pocket depth plus the recession.
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4. Under Probe, select the type of electronic probe attached to the computer, if any.

5. Under Bring Forward Previous Exam Data, select whether data from the patient’s
previous exam should be brought forward into a new exam:
l Choose Prompt to have DAISY Chart ask if previous exam data should be

brought forward.
l Choose Always to bring previous exam data forward automatically.
l Choose Never to always open a blank exam.

6. In the User Settings section, select the exam information that should be brought
forward, if any.
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Check all check boxes that apply: Contact, Depth, Recession, Furcation,
Keratinized, and Mobility.

7. In the Charting Method drop-down list, select the method for this user.
In DAISY Chart, exam methods control how you navigate through a periodontal
exam. The method controls the path through the mouth, the type of
measurements to perform, and the views for each tooth. For more information
about methods, see "About Perio Exams" on page 359.
Note: Exam methods are set up for each user during DAISY Chart installation and
training.

8. Under Chart Display, choose the order that the teeth are displayed onscreen and
when printed.
For example, Buccal / Lingual - Buccal/ Lingual displays the teeth in this order:
upper teeth cheek side, upper teeth tongue side, lower teeth cheek side, lower
teeth tongue side.

9. Click , then close the Workstation Settings window.

Customize Chart tabs and buttons
In hard tissue charting, Chart buttons, organized by tabs, can be customized to
include only those procedures you commonly use. For example, if you never fit
dentures or perform root canals, those Chart buttons can be removed. If you want a
button for a bridge instead of a pontic and an abutment crown, you can create a
Bridge button that contains both.

You can also select which procedure codes you want to associate with each Chart
button. For example, if you perform only simple extractions, you can remove the
procedures associated with bony or partial bony extractions.

Note: Changes made to Chart buttons and tabs affect all DAISY Chart users.

Add a Chart button

DAISY Chart comes with a list of pre-defined Chart buttons that have the appropriate
procedure codes attached. You can choose from the list or define your own buttons.

► To add a Chart button:

1. Log in to DAISY and open a hard tissue exam.

2. Click the appropriate Chart tab.
For example, click Restorations to add a button in the Restorations tab.

3. In the Chart button section, right-click and select Add Button.
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4. In the Search For - Button window, search for and select the button to add, then
click OK to close the window.
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Define a new Chart button

► To define a new button:

1. Log in to DAISY and open a hard tissue exam.

2. Click the appropriate Chart tab.
For example, click Restorations to add a button in the Restorations tab.

3. In the Chart button section, right-click and select Add Button.

4. Click New Button.

5. In the Name text box, type the name of the button.

6. In the Button Type section, select the type of button.
For example, a Multi type button applies a procedure code or set of codes
automatically to the tooth when you click the button. A List type button presents
a list of procedure codes you can choose from.

7. (Optional) In the Icon Name section, click to search for and select the
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graphic file for this button.
You only need to select an image if you want one to show up on the button.
Note: This graphic image is used on the button only. It does not affect what shows up
on the tooth graphic chart.

8. In the Display Setting section, select how the button is labeled.
For example, if Text Only is selected, then the button label is the text you typed in
the Name text box. If Icon Only is selected, then the button label is the Icon Name
graphic file.

9. In the Codes Assigned to this Button section, assign one or more procedure codes:

a. Click to open the Select A Procedure window.
b. Click the appropriate tab.

For example, if you want to search for a dental code, click the Dental tab.
c. In the Enter Procedure or Description text box, type part or all of the code

number or description.
d. Select the code, then click OK.
e. Repeat step 9 until all the appropriate procedure codes are selected.

10. Click and close the window.
The Chart button is added to the selected Chart tab.

Edit a Chart button

You might want to customize a Chart button to have a different name or to include
only those procedures you commonly use. For example, if you only perform simple
extractions, you can remove the procedures associated with bony or partial bony
extractions.

► To edit a Chart button:

1. Log in to DAISY and open a hard tissue exam.

2. Click the appropriate Chart tab to show the button.
For example, click Restorations to edit a button in the Restorations tab.

3. Right-click on the button and select Edit button name Button.
For example, right-click on the Extractions button and select Edit Extractions
Button.

4. In the Button window, change the definition of the button.
For example, delete one of the codes assigned to the button.
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5. Click to save the changes.

Remove a Chart button

When a Chart button is removed, it no longer displays in the Chart buttons section of
the Chart window. However, the definition of the button (including procedure codes
associated with it) remains in the DAISY Chart database, so you can easily add it
again to the Chart window.

► To remove a Chart button:

1. Log in to DAISY and open a hard tissue exam.

2. Click the appropriate Chart tab to show the button.
For example, click Restorations to remove a button in the Restorations tab.

3. Right-click on the button and select Remove button name Button.
For example, right-click on the Amalgam button and select Remove Amalgam
Button. The button is removed.
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Add a Chart tab

DAISY Chart comes with a list of pre-defined tabs that include a set of appropriate
buttons. You can choose from the list of tabs or define your own tabs.

► To add a Chart tab:

1. Log in to DAISY and open a hard tissue exam.

2. In the Chart button section, right-click and select Add Tab.

3. In the Search For - Tab window, search for and select a tab, then click OK.

4. In the Tab window, check the Display check box.

5. Click , then close the window.
The tab is added to the right of existing tabs in the Chart window.
Note: Tab order cannot be rearranged.

Define a new Chart tab

If an appropriate tab is not already available, you can define your own tab and assign
Chart buttons to it.
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► To define a new Chart tab:

1. Log in to DAISY and open a hard tissue exam.

2. In the Chart button section, right-click and select Add Tab.

3. In the Search For - Tab window, click New Tab.

4. In the Name text box, type the name of the tab.

5. Add the appropriate Chart buttons to the tab.
For more information about adding buttons to a tab, see "Add a Chart button" on
page 583.

6. Click and close the window.
The tab is added to the right of existing tabs in the Chart window.

Remove a Chart tab

When a Chart tab is removed, it no longer displays in the Chart buttons section of the
Chart window. However, the definition of the tab (including buttons associated with
it) remains in the DAISY Chart database, so you can easily add it again to the Chart
window.
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► To remove a Chart tab:

1. Log in to DAISY and open a hard tissue exam.

2. Click the Chart tab that you want to remove.
For example, click the Restorations tab.

3. Right-click and select Hide tab name Tab.
For example, right-click and select Hide Restorations Tab. The tab is removed.

Change printer settings for DAISY Chart
DAISY Chart installation assigns your Windows default printer settings as the default
printer settings for DAISY Chart. These settings determine where to print DAISY Chart
reports.

You may want to change the default printer for DAISY Chart, or you may want to send
a specific DAISY Chart report to a different printer.

Note: DAISY Chart printer setup does not change your DAISY or Windows printer
settings, nor does it change printer settings for DAISY Chart on any other PC.

► To change the default printer settings for DAISY Chart:

1. From the Reports menu in any DAISY Chart window, select Printer Setup.

2. From the Name drop-down list, select a printer.

3. If needed, change the printer settings, such as paper type and orientation.

4. Click OK.

Note: If you changed the settings for a specific report, be sure to change the settings back
to the original default printer when you are done.

Customize color coding for the tooth graphic chart
By default, DAISY Chart uses the standard set of color codes in the tooth graphic
chart: blue for existing restorations, green for condition of teeth, red for treatment
planning, and purple for completed treatment. However, you can customize these
colors to fit your practice.

Note: Changes made to colors in the tooth graphic chart affect all DAISY Chart users. Be
sure to check with them before making this change.

► To change color coding:

1. Open a hard tissue exam.

2. From the Tools menu, select Color Scheme.
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3. Click the appropriate Set Color button.

4. In the Color window, click the new color, then click OK.

5. To change another color code, repeat steps 3 and 4.

6. When done, click OK to close the Set Color Scheme window.

Note: You can also customize the graphics associated with each procedure. For more
information, contact DAISY customer support.
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